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INTRODUCTION
COURSE DESCRIPTION

This course covers the concepts and functionality you need to know in order to use the InEight
Estimate software successfully. As a result, you will be able to build cost estimates and bid proposals
with precision and efficiency.

COURSE OBJECTIVES

As a result of this course, you will be able to use the InEight Estimate software to:

¢ Construct and modify cost estimates

¢ Calculate profit and finalize bid proposals

HOW TO USE THIS MANUAL

This training manual serves as the working guide during the E101 Essentials of Project Modeling and
Estimating instructor-led course. The first seven lessons of this document follow a natural progression
of putting an estimate together, from set up of a project to finalization of a bid. The remaining lessons
cover additional functionality that will help you build and review your project estimate more
effectively.

LESSONS

The following lessons are covered in this course:

Course Lessons

Lesson Topic

Lesson 1 Estimating Core Concepts
Lesson2 General Navigation
Lesson 3 Library Setup

Lesson4 Project Setup
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Course Lessons

Lesson 5 Estimate Direct Costs
Lesson 6 Estimate Indirect Costs

Lesson 7 Finalize the Estimate

LESSON FORMAT

This manual is designed to be a “hands on” learning guide. As such, each lesson is organized into
sections:

(et | memww

Objectives  Specify what you will learn in each lesson.

Topics Organize the subject matter, with explanations of key concepts and terms.
Step by Walk you through the “mechanics” of how to perform specific functions in the
Steps software. For each step by step, you will use the Training Job that comes pre-

loaded in the InEight Estimate Estimating software.

Exercises Allow you to practice and reinforce what you learn. For each exercise, you will
use the Training Job that comes pre-loaded in the InEight Estimate Estimating

software.
Review Asks you questions to check what you have learned within each lesson.
CALL-OUTS

Throughout the document, you will also find important call-out banners.

TIP Tips are for important notes and information you want to remember.

J[eg= Notes are for critical information you need to know.

ONGOING USE

This manual is also designed to be a comprehensive reference guide you can use outside of the
classroom and revisit as needed. Each lesson is compartmentalized so that you can refer back to each
lesson as needed.
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LESSON 1 — ESTIMATING CORE

CONCEPTS

LESSON DURATION: 30 MINUTES
LESSON OBJECTIVES

After completing this lesson, you will be able to:
e Explain the estimating process in InEight Estimate

e Explain key terms and concepts

LESSON TOPICS

InEight Inc. | Release 25.7
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1.1 OVERVIEW OF THE ESTIMATING
PROCESS

The estimating process typically progresses through the following five steps. If you are an Owner you
may not take part in all five of these steps, but may instead do a few in an iterative process as you
progress through stage gate approval phases.

1. Enter project details.

2. Enter proposal deliverables.

3. Calculate Direct & Indirect Project Cost.

4. Add Markup, Contingency, & Fees.

5. Distribute Cost + Markup to required structure.

The below table displays how these five steps correspond with specific forms in InEight Estimate:

Distribute Cost +
Markup to required

Add Markup, Structure Completed
Calculate Direct CoOntingency, Estimate
& Indirect Fees InEight File

Project Cost Estimate -
InEight (Pay Item &)
Enter Proposal InEight Estimate — PROPOSAL
Deliverables Estimate — PPB_S Form Form
Enter Project CBS Form (Br;.lgidown
Details ] (Cost
InEight Breakdown Structure}
Estimate - Structure)
InEight PAY ITEM
Estimate - (& Proposal )
Job Form
Properties
Form

Note the forms used in InEight Estimate to accomplish the steps above:

Job Properties

Pay Item & Proposal

CBS (Cost Breakdown Structure)

PBS (Price Breakdown Structure)
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The rest of this section walks you through an overview of each step in the process and its
corresponding form in InEight Estimate.

STEP 1 - ENTER PROJECT DETAILS

When you decide to estimate a new project, the first step is to create a new estimate and set it up with
the general project details. In InEight Estimate, you’ll enter basic information and project specific
settings in the Job Properties form from the Setup tab.

The Job Properties form is organized into tabs to help you keep track of all the basic information and
settings for the project. It begins with the Overview tab. You will move from left to right entering your
project specific information and adjusting any settings that differ from the default.

Estimate Quote Price Execution System Integrations

B ¢ B o &Lr %M a4 8 B

22 Equipment
JobProperties  Foundation  Payltem & Bid Wizard | Resource Resource | Costltem Standard | Reports
- SetupData = Proposal Rates - (2% Materials  Assemblies | Assemblies  Tables
Initialize Resources Assemblies Reports S

Cost Breakdown Structure (CBS) Register Job Properties @

Overview | Security | CoverSheet | CostBasis | MinoritySetup | FuelCost | JobTracking | JobFolder Tags | Competitors | Pridng | Schedule | CashFlow | Equipment S

Identification

Location: 110 MP 100 to MP 120 Type: Highway and General Engineering Contract Duration: 160
City: Phoenix Engineer: | Example Engineer —Fred Jones o} Time Measure: | ContractDays -
County: Maricopa Ouner: | Example Owner - Jerry Slate [A] Forecast Start: | 6/11/2019
Country: | United States - Architect: | Example Architect - Robert Frost 0] ForecastFinish: | 11/20/2019
State: | Arizona Duration: 162
Latitude: 0.00000
Longitude: 0.00000
Proposal
Bid Date: | 12/23/2013 - Opening Type: Public
Bid Time:  10:00:00 PM Proposal Type: Unit Price
Estimstor: | Example Prime Contractor 1 --Tom Cross & Plan Holders: 5
BidLocation: Engineer's Office Liquidated Damages: §1,000.00
Oviners Estimate: $6,000,000.00  Lig. Damages Per: | Day
RFQ Contact: | Example Prime Contractor 1--Tom Cross [F]
As-Entered Currency  As-Entered Units  v19,1HD_19.1 QA2016  Training Job Accrued Costs OFF

STEP 2 - ENTER PROPOSAL DELIVERABLES

For Contractors who are submitting a proposal to a client, this step enables you to enter the client
provided deliverables clients are requesting pricing for. Most Owners will skip this step unless there is
a need to track various funding sources or prepare for internal or external company billing.

In InEight Estimate this list of items is recorded in the Pay Item & Proposal Register on the Setup tab.

* Notice that your pay items have no pricing when first entered because you have yet to figure out
costs. You will come back to this form later in the process to distribute your costs and markup.
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Pay Item & Proposal Register © S

e T e .
D S s e
. e o

Profit (Markup records) $313,781.00 $552,537.20 -

Pricing is now spread to
rag ks e o grup pay items Sovedviews: [Siiad &y

oy tiem — oy Fwccast@0) ol g [nteiee  Towpce  [untwaie | lok TowlMarkp unt Tol it

Norber Quntty  Quanaty vesase e @rren) Gaanced)  Quantty  banced | Pre  Davbuton  Devbuten | (arent

> 200 SITEWORK 8 ROADWAY Us. oler smm00 . smm (@ wnmy -
+ 11 sa1010 Mobization 100 10 wrpsum  Us.Dolr | smsen0  swseon|  szesas 2se.1s wsme s
+12 2002 Clarng 8 Guiiong 10 00 aqe Us. olr om0 sse000 s s somis sumLs
+13 2013 Undassfied Excavaton 50,0000 50,0000 Cubcrrd U, Doler s smm0m suu sssgsn2 sies v
+ 14 3035912 Aggregate Base 40,000.00 45,000.00 Ton U.S. Dolar $26.50  $1,060,000.00 $3.02 $120,771.08 414 $165733.22
+ 15 3034263 Asphalt Concrete Hot Mix Type A 138,000.00 35,000.00 Ton U.S. Dollar $42.45  $1,613,100.00 $7.61 $289,320.12 $9.87  $374948.12
a1z 00 WATER 8 SEWER Us. ooler $718,550.00 . sz (n s15498181
o2t 413() 0464 36 Inch RCP Culvert Class IIT 1,000.00 1,024.00 UnearFeet  U.S. Dolar $97.45 $97,450.00 $14.30 $14,297.53 $19.96 $19,959.98
+22 a0z 10 1nch PHC Force Mo (50R21) 120000 1200000 UnessFeet U5, Doler 55 540000 “e sss,406.82 €5 0T

STEP 3 - CALCULATE DIRECT & INDIRECT PROJECT
COST

Once you've set up your estimate, you will perform take-offs and cost analysis to determine the total
estimated cost to complete the entire scope of work.

The Cost Breakdown Structure (CBS) Register is the main form where you will do your cost estimating.

e Itis the hierarchy of work activities that make up the estimate

e Each row in the CBS represents a work activity and is called a cost item

Training Job - Estimate

Estimate Quote Price Execution Sy n Integrations Actions
& Print @ New R copy spit a Cost Item + Assembly /.( w 'n =
'%. Preview Delete Paste z} Toggle Suspended L, | "= subordinate CostTtem | f= Subordinate Assembly ” »
Expand / Filter  Clear
@11 Export to Excel Cut Fill Down Indent H Dependent Cost Item Collapse ~ - Filter
Print Edit Insert View *
Job Properties Cost Breakdown Structure (CBS) Register © B

Drag columns here to group Find: | [Search For...] Saved views:

Ssghon Code s Besamtice Slo:l;i;ﬂa\ 'E?ECEJ??:anhty ::;;Jra DnaEtost ?otra;f:sstg Allocated
e | 108 20,00 Mie §293,095.93  §5,861,918.63 | -
Prime Bond PRIME BOND 1.00  Lump Sum $47,069.88 $47,069.88
Price % Add-On PRICE % ADD-ON 100 Lump Sum $294,928.95 §294,928.95
Job Financing FINANCE EXPEMSE 1.00  Lump Sum $0.00 %0.00
Indirect Cost Escalation INDIRECT COST ESCAL... 100 Lump Sum 40,00 $0.00
Direct Cost Escalation DIRECT COST ESCALAT... 1.00  Lump Sum $18,837.35 $18,837.35
Indirect Cost Add-On INDIRECT COST ADD-ON 100 Lump Sum 40,00 $0.00
Job Management & Equipment JOB MAMAGEMENT &E... 1.00  Lump Sum $157,096.28 £157,096.28
+ General Expense GENERAL EXPENSE 1,00 Lump Sum £4,200.00 $4,200.00
Direct Cost Add-On DIRECT COST ADD-ON 1.00  Lump Sum $104,301.10 $104,301.10
+ 1 Mobilization 5410100 100 Lump Sum £11,909.51 £11,909.51
+ 2 Clearing & Grubbing 2010102 10.00 Acre $3,918.50 $39,184.97
= 3 Unclassified Excavation 2020183 50,000,00  Cubic Yard 468 §233,915.81
+ 31 Excavation 31 50,000.00  Cubic Yard $3.00 $149,922.88
+ 32 Embankment 32 50,000,000 Cubic Yard £l.68 £83,992.94
= 4 Aggregate Base 303 5912 45,000.00  Ton $15.40  $692,928.99
+ 41 Furnish & Haul Base Material 4.1 45,000.00 Ton §11.54 £519,513.30
+ 4.2 Finearade Subarade 4.2 400,000.00  Square Yard 80,19 £75,848.36
v
- an ___ . S an A% non nn | Tan PR #n7 cca n
106 §5,861,918.63
“ >
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STEP 4 - ADD MARKUP, CONTINGENCY, & FEES

Once you have estimated all project costs, you may need to add markup, contingency or other fees and
define the job’s profit in the Price Breakdown Structure form.

Description Assigned Unassigned | Total .T"_r;r':g'lzt
~ A | Price Breakdown Structure _—_—
~ jh TargetPrice £5,252,19... §645,755.99  £5,397,950.68 100.00
v % Markup £0.00  $315,692.95 $315,692.95 5,35
v i Target Profit £0.00 50,00 0,00
Indirect Cost Markup £0.00 £0.00 0.00
Direct Cost Markup 0,00 0,00 0,00
w ™=  Business Overhead £0.00 5315,692.95 £315,692.95 5.35
80 Price % Add-On £0.00 £265,407.78 £265,407.78 4,50
B8 3ob Financing $0.00  $33,105.26 $33,105.26 0.56
OC Indirect Cost Escala... $0.00  $2,131.11 $2,131.11 0.04
DL Dbirect Cost Escalation £0.00  §15,048.80 £15,048.80 0.26
i.'. Business Overhead .. £0.00 £0.00 £0.00 0.00
~ JA Total Cost $5,252,19... §330,063.05  $5,582,257.73 94,65
~ # Indirect Cost $0,00 $329,063.05 $329,063.05 5,58
+ = Job Overhead $0.00 $329,063.05 $329,063.05 5,58
B2 Prime Bond £0.00  §43,789.75 £43,789.75 0.74
B8 indirect Cost A... £0.00  £5,888.67 £5,888.67 0.10
BE Direct Cost Add... $0,00 $104,088.34 $104,088.34 1.76
B& Job OverheadI.. $0.00 $175,296.28 $175,296.28 2,97
~ s Direct Cost £5,252,19...  £1,000.00  £5,253,194.68 §9.07
B Direct Cost Items $5,252,19...  $1,000.00  $5,253,194.68 §9.07

STEP 5 -DISTRIBUTE COST + MARKUP TO REQUIRED

STRUCTURE

You now have a target price or total estimated value that you can spread to your required project

deliverables, back in the Pay Item & Proposal form. InEight Estimate has tools within this form to help

automatically distribute your cost, overhead and all markups to the listed items.

InEight Inc. | Release 25.7
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Pay Item & Proposal Register @ =

Proposal Recap - Training Job x Item Recap - 641 0100 Mobilization x
Current Target Forecast Variance Balanced Unit Current Unit
Price: $6,455,450.00 $6,553,976.75 $6,462,850.00 | $98,526.75 |ADD A Price: £18,300.00 | $386,800.00
Profit: §544,294.64 £642,821.40 $604,568.97 | §38,25243 |ADD k Profit: §2,049.63 £370,501.39
Margin%a: 8.43 9.81 9.35 | §32,502.50 |ADD Total Cost: $16,298.61 $16,298.61
F Business Overhead: $840.31
Y Job Overhead: §3,546.52
am | Unassigned Direct Cost: §2.26

- Assigned Direct Cost: $11,909.51

Drag columns here to group Find: Saved views: | Standard View -
Norber Descrpton Gty Ouy | Mesmne o TS ey |t sened

=+ 5410100 Mobiization 1.00 1,00 Lump Sum U.5. Dollar $386,800.00  $386,800.00 $18,300.00 $18,300 *
+ 2010102 Clearing & Grubbing 10.00 10.00 Acre U.5. Dollar $5,120.00 $51,200.00 $5,867.33 $38,672
+ 2020183 Undlassified Excavation 50,000.00 50,000.00 Cubic¥ard  U.S. Dollar $8.50  $425,000.00 $6.31  $315,50C
+ 3035312 Agaregate Base 40,00 $22.00  $830,000.00 $19.47 778,800
+ 3034263 Asphalt Concrete Hot Mix Type A a0 Pricing is now spread to $35.00  §1,330,000.00 §52.28  $1,986,640
+ 413(B) 0464 36 Inch RCP Culvert Class I 1,00 bid items $100.00 $100,000.00 $87.19  $87,190
+ 8000220 10 Inch PVC Force Main (SDR21) 12,0007007 TZ 00000 Linear Feet . U.5. Dollar $28.00  $335,000.00 $29.82  $357,84C
+ 8000330 24 Inch PVC Gravity Sewer (SDR35) 3,000.00 3,000.00 Linear Feet  U.S. Dollar $64.00  $192,000.00 $54.13  $192,39C
+ 800 0400 4 Foot Diameter Manhole 16.00 16.00 Each U.S. Dollar £AS00.00_£72.000.00. $4.579.64  $73.274 "

§6,455,450.00 $6,553,98...
« »

1.2 KEY CONCEPTS AND TERMS

To help you get started in InEight Estimate, you should know a few key terms:

e Job Folder

e Library

e Form

e Cost Item
e Payltem
e Resource

e Assembly

1.2.1 JOB FOLDER

Job folders hold all the information for an individual project estimate. It is possible to import master
data into a job folder, but when you work in a job folder it is independent, meaning any activity
performed in that folder will not affect any other jobs and will not affect the library.
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TIP

are in the right job.

1.2.2 LIBRARY

The Library is a storehouse for master data, such as:
e Labor, equipment, and material unit cost rates
e Standard account codes

¢ Units of measure

1.2 Key Concepts and Terms

When moving back and forth between jobs, make sure to always double-check that you

When you create a new job from scratch, default data and settings copy from the Library into your new
job folder, except for the resource rates. Multiple list of resource rates can be maintained in the library
so you must select which rates to populate a new estimate with. Four tag fields are available to filter
the resource rates you bring into an estimate from the master library. For example, you may select a
subset of your labor rates based on the geographical location of the project.

1.2.3 FORM

Any screen you open in InEight Estimate is considered a Form. There are three types of forms:

Standard, Register, and Record forms.

Standard Forms resemble typical data entry forms with fields available to fill in key project
information. They also may contain radio buttons or checkboxes to define settings for the job.

Job Properties @

Overview | Security | CoverShest | CostBasis | Minority Setup | Fuel Cost | JobTracking | JobFolderTags | Competitors | Pricing

Schedule | CashFlow Euuipmentl

Standard Shift An] agements Standard Wage Rate Composite Rules
ock Cost Items to Pay Items

Pay Item Unit Price Precision: 2

‘Waork Hours per Shift Scale 1: 100.00 %

[ factivate PBS Changes Log

Pay Hours per Shift: Scale 2: 0.00 %

[ factivate Quantity Checking

Ol

When man-count changes: @ Change UM / Man-Hour
| (@) Change Days

Standard Rates

Scale 3: 0.00 %

Shif
‘ Checkboxes

Shifts per Day:
2 g aintain CBS Structure at Level: 0

Days per Week:

Entry Fields
Currency

Default Currency: | .S, Dollar

Sales Tax Rate: 5.00 %

TIP

so that the information is easy to access.

Tabs
[] Preserve Onginal Cast ltem

Data Source

Radio buttons

InEight Estimate uses tabs to group and organize entry fields and settings in a logical way,

Register Forms have a grid format of rows and columns, giving it a spreadsheet look and feel. Register
forms allow you to see information for multiple items at once. The Cost Breakdown Structure (CBS)

Register is an example of a register form.

InEight Inc. | Release 25.7
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Cost Breakdown Structure (CBS) Register ©

Drag columns here to group

Entunn Code Descpbon
+ 1 Mobilization
+ 2 Clearing & Grubbing
=23 Unclassified Excavation
+ 31 Excavation
+ 3.2 Embankment
2 4 Aggregate Base
+ 41 Furnish & Haul Base Material
+ 4.2 Finegrade Subgrade
=2 43 Install Aggregate Base
+ 431 Place Aggregate Base
+ 432 Blue Top Aggregate Base
25 Asphalt Concrete Hot Mix Type A
+ 5.1 Furnish & Haul Hot Mix
2 |+ 52 Install Hot Mix Type A
=2 6 36 Inch RCP Culvert Class ITIT
+ 6.1 Furnish RCP Materials
+ 6.2 Excavate RCP Trench
+ 6.3 Install RCP Pipe

Fing: | [Search For...]

Optional Forecast

Code {T/O) Quantity

6410100 Loo
2010102 10.00
2020183 50,000.00
3.1 50,000.00
3.2 .00
303 - - .00
i1 _Vlew multiple o
a2 items at once a0
4.3 00
4.3.1 45,000.00
4.3.2 400,000.00
303 4263 35,000.00
5.1 35,000.00
5.2 35,000.00
413(8) 0464 1,024.00
6.1 1,024.00
6.2 1,858.56
6.3 1,024.00

Estimate Essentials User Guide

Saved views: | Standard View -
k'qzi;fjm Unit Cost ?ﬂtif;% Allocated
Lump Sum £11,909.51 $11,509.51 -
Acre $3,918.50 $39,184.97
Cubic Yard $4.54 $226,856.16
Cubic Yard 82,86 $142,863.22
Cubic ard £1.68 £83,592.94
Ton $15.40 $692,928.99
Ton 511.54 $519,513.30
Square Yard £0.1% £75,848.36
Ton §2.17 $97,567.33
Ton 5163 5$73,460.92
Square Yard 20.06 £24,106.42
Ton $42.62 | §1,491,580.59
Ton $39.27 | §1,374,562.54
Ton $3.34 $117,018.05
Linear Feet $57.54 $59,159.45
Linear Feet $33.48 $34,286.70
Cubic Yard 84,51 §8,379.59
Linear Feet 511.74 $12,017.60

In a register form, you can open a Record for individual items you want to drill into.

TIP
Enter key).

The Tab key is the best way to move among fields in InEight Estimate (instead of the

The below figure displays a Cost Item Record accessed by double clicking on that item on the Cost

Breakdown Structure (CBS) Register.

Cost Breakdown Structure (CBS) Register

Cost Item Record ©

CBS Code: Optional Code:  Description: Forecast (T/O) Qty:  Unit of Measure:
Ba 4 303 5912 AgaregateBase 45,000.00 | Ton
[®] 4.1 4.1 [ Furnish & Haul Base Material 45,000.00 | Ton |
PI Assignment: PILine Number: PIDescription: Cost Segment:
303 5912 40 AggregateBase Record focuses Direct Cost
- on 1 item

Cost Item Summary = Detail : $11.54 # Plug : 50.00 i
Drag columns here to group Find: | [Search For...] Saved views: | Previous View -

Row L Resource == Quantity Waste %

Mumber = Cade Assembly P 21 (Less Waste) Add-on Qua

1171 Teamster

- I R N o T
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45,500.00
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1.2.4 COST ITEM

Cost items are the individual cost-related activities that make up the project. Cost items are organized
into a hierarchy in the Cost Breakdown Structure (CBS) Register. Each row in the CBS is considered a

cost item.

EDB;ﬁon Code = Bescption gopggnal ?;gg?zsﬁanﬁty Eﬂgi;;:re SR Gast

+ 1 Mobilization 5410100 1.00  Lump Sum £11,909.51
+ 2 Clearing & Grubbing 2010102 10,00 Acre $3,913.50
= 3 Unclassified Excavation 2020133 50,000.00  Cubic Yard $4.68
+ 31 Excavation 31 50,000.00  Cubic Yard £3.00
+ 3.2 Embankment 3.2 50,000.00 Cubic Yard £1.68
=2 4 Aggregate Base 303 5912 45,000.00  Ton $15.40
+ 41 Furnish & Haul Base Material 4.1 45,000.00 Ton $11.54
+ 4.2 Finegrade Subgrade 4.2 400,000.00  Square Yard £0.19
= 43 Install Aggregate Base 4.3 45,000.00 Ton §2.17
ar Crshil Place Agaregate Base 4,31 45,000.00  Ton §1.63
+ 4.3.2 EBlue Top Aggregate Base 4.3.2 400,000.00  Square Yard £0.06

1.2.5 PAY ITEM

Pay items typically represent the owner required deliverables a contractor must submit pricing for. Pay
items are used to distribute the cost calculated in the Cost Breakdown Structure, with all markup,
including any fees or contingencies calculated in the Price Breakdown Structure. This allows the total
estimate value to be distributed to a structure that is different than the CBS. Pay Items are
predominantly used by contractors to prepare a bid sheet. Owners may use pay items to identify
funding sources or for various reporting needs.

I R owawion e A =
> =l 200 SITEWORK & ROADWAY U.S. Dollar $3,402,700.00
+ 6410100 Mobilization 100 1.00 | Lump Sum U.S. Dolar $395,600.00 $395,600.00
2010102 Clearing & Grubbing 10.00 10.00 Ace U.S. Dollar $5,300.00 $53,000.00
2020183 Undassified Excavation 50,000.00 50,000.00 CubicYard  U.S. Dolar $5.50 $275,000.00
303 5912 Aggregate Base 40,000.00 45,000.00 Ton U.S. Dollar $26.50  §1,060,000.00
3034263 Asphalt Concrete Hot Mix Type A 38,000.00 35,000.00 Ton U.S. Dollar $42.45  $1,613,100.00
400 WATER & SEWER U.S. Dollar $718,550.00
413(8) 0464 36 Inch RCP Culvert Class I 1,000.00 1,024.00 LinearFeet  U.S. Dollar $97.45 $97,450.00
800 0220 10 Inch PVC Force Main (SDR21) 12,000.00 12,000.00 Linear Feet  U.S. Dollar $29.50 $354,000.00

1.2.6 RESOURCE

Resources are the building blocks of a detailed cost estimate.
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Resources are the people, equipment, material, and supplies needed to complete the project.
Resources are employed to cost items to develop an estimate, and are organized into seven categories
or types:

Labor

Construction Equipment
Rented Construction Equipment
Installed Equipment

Installed Materials

Supplies

N o g s~ e bdh =

Unique

1.2.7 RESOURCE ASSEMBLY

A Resource Assembly is a group of resources that are often used together. For example, for civil work,
you may group together an operator foreman, operator, and laborer, along with a loader and
excavator. When estimating, you can employ this assembly which includes all of the pre-selected
resources.

Resource Assembly Register @

roup

Code Description ?EDD';E;D tion Quantity Hgi;sn:re Unit Cost Total Cost Currency ggsgiozahnnal gf;graphic
— CCOMC Concrete Crew Standard Assembly File 1.00  Hour §375.03 §375.03 U.5. Dollar Concrete
Qunty U ukcont ey B Bere
= 1 Lcz2 Carpenter Journeyman 2.00 Each §28.92 U.5, Dollar CIDura... Standard Labor Rate File Carpenter Southwest  Wage Zon...

2 LF2 Finisher 1.00 Each §28.07 U.S. Dollar CIDura... Standard Labor Rate File Finisher - Conc...  Southwest = Wage Zon...
3 w1 Iron Worker 1.00  Each §35.55  U.S. Dollar CIDura... Standard Labor Rate File Iron Worker Southwest ~ Wage Zon...
4 L2 Labarer 1.00 Each §26.37 U.5. Dollar CIDura... Standard Labor Rate File Laborer Southwest  Wage Zon...
5 ECRHC Hydraulic Crane 25 Ton 1.00 Each $117.60 U.5. Dollar CIDura... Standard Equipment Rate... Crane
6 LC1 Carpenter Apprentice 1.00  Each $27.48  U.S. Dollar CIDura... Standard Labor Rate File Carpenter Southwest  Wage Zon...
7 102 Operator Class 2 1.00 Each §28.07 U.5. Dollar CIDura... Standard Labor Rate File Operator Southwest  Wage Zon...
8 ETFT Flatbed Truck 1.00 Each §22.60 U5, Dollar CIDura... Standard Equipment Rate...  Truck
9 LC3 Carpenter Foreman 1.00  Each $31.47 U.S. Dollar CIDura... Standard Labor Rate File Carpenter Southwest  Wage Zon...

+ CGRADE Grading Crew Standard Assembly File 1.00  Hour $234.73 $234.73 U.S. Dollar Earthwork

+ CMAINT Equipment Maintenance Standard Assembly File 1.00  Each §73.60 §73.60 L5, Dollar Mechanic

+ CPAVE Paving Crew Standard Assembly File 1.00  Hour §475.24 £476.24 LS. Dollar Asphalt

1.2.8 COST ITEM ASSEMBLY

A Cost Item Assembly is a predefined group of cost items that has cost based on estimator inputs to a
set of questions. Cost item assemblies provide parameter-driven estimating and can also refer to
reference tables. They allow companies to create intelligent construction systems to automatically
estimate various scopes of work, based upon a user providing specification and dimension variables.
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Cost Ttem Assembly Register &

Drag columns here to group

Code =

RWO1
TEST

TEST -DRS
TEST DS

Desaription

Standard Retaining Wall Assembly
TEST

Test Cost Item Assembly - Ductbank
Test Cost Ttem Assembly - Ductbank

InEight Inc. | Release 25.7

Assembly Default

File Description Quantity

Standard CostIt... 20.00
1.00

Standard Cost It. 1.00

Standard Cost It. 1.00

Default
Unit of Measure

Cubic Yard
Each
Each
Each

Default
Unit Cost

$424.67
§0.00
£0.00
50.00

Default
Total Cost

£3,4932.33
£0.00
£0.00
£0.00

Default
Currency

U.5. Dollar
U.S. Dollar
U.S. Dollar
U.5. Dollar

1.2 Key Concepts and Terms

Organizational
Category

Cancrete

Cancrete

Excavator
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LESSON 1 REVIEW

1. Which InEight Estimate form is used to enter basic information about the job as well as
define our cost basis?

a. Pay Iltem & Proposal
b. Job Properties

C. Library

d. Job Folder

2. All default data and settings copy from the Library into your new job folder except:
a. Labor rates
b. Equipment rates
C. Material rates
d. All of the above

3. These are considered the “building blocks” of the job — you employ them to cost items to
develop your estimate.

a. Assemblies
b. Payltems
C. Resources

d. Forms

LESSON 1 SUMMARY

As a result of this lesson, you can:

e Explain the estimating process in InEight Estimate

e Explain key terms and concepts
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LESSON 2 — NAVIGATION

2.1 GENERAL NAVIGATION

As a new user to the InEight, the First-time sign in dialog box opens when you first sign in, and presents
guestions about your working environment in the Project Suite environment. Preferences are set for
language, date, and number formats and the User Agreement, which you must accept before you
begin. The First-time sign in dialog boxes only show for the initial sign-in to any of the InEight products.

STEP BY STEP — ESTIMATE PREFERENCES SETUP

1. Select your preferred language, and then click Next.

First time sign in

Language

Please choose your preferred language
(O Dutch (Mederlands)

(@ English

() Espafiol (América Latina)

(O) Frangais (Canada)

() Norsk (Bokmal)

O Portugués (Brasil)

Cancel m
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2. Scroll to the bottom of the user agreement, and then select the check box for the terms and
conditions and privacy policy. Click Next.

TIP Make sure you have scrolled to the end of the user agreement

3. Select a date format and number format, and then click Next.

RELEVANT LINKS

System settings options

Archive and restore jobs

Video - Navigating tabs within Estimate

Video - Backstage view

2.2 FIRST TIME ACCESS

Platform’s primary function lets you connect and share data between all Eight applications involved in
managing a project. This allows project management workflows to pass between jobsite, field office,
and front office seamlessly in a consistent and standardized user interface.

STEP BY STEP — LAUNCH ESTIMATE

1. After selecting a project from the home page, you can access Estimate from the Main menu in
Platform by selecting Estimate, or by clicking Launch on the Estimate tile.

InEight® Inight®
MODEL SCHEDULE

InEight® %0 InEight®
REPORT EXPLORE
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Estimate Essentials User Guide

2.2 First time access

2. When you select Estimate from the home page for the first time, you must click Download to

access the Estimate Launcher file.

® © & ® W @

Launch InEight Estimate
The Estimate Launcher must be installed to run InEight Estimate. If it is you
first launch, or you need the latest version of the Estimate Launcher select the
downlgad button below

n
» Close | Download

¢ The EstimatelLauncher.msi file shows.

InEight Inc. | Release 25.7
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PROJECT SETTINGS

Project home
Project details
Settings

Workflows

© 2022 InEight Inc Privacy Statement

e’ EstimatelLauncher.msi

¢ Opening the EstimateLauncher.msi file opens the InEight Estimate Launcher Setup
window.

3. Select Open, and then click Next to start the one-time Estimate Launcher download. Afterwards,
you will be able to open Estimate from the Main menu or the home page.

Welcome to the InEight Estimate Launcher
Installer Wizard

Project home
Let's get started on installing InEght Estimate Launcher on
Project details your computer, Ciick Next” to continue or "Cancel” to exit.

Settings

Workflows

18 Estimatelauncher.msi

Page 38 of 402 InEight Inc. | Release 25.7



Estimate Essentials User Guide 2.2 First time access

4. Click Finish to complete the Estimate Launcher Setup installation.

Completed the InEight Estimate Launcher
Saetup Wizard

Click the Finish button to exit the Setup Wizard.

5. Select Estimate again to start the Estimate Launcher, which extracts the required files to launch
the Estimate application.

InEight"

ESTIMATE

After setting up your Estimate preferences and installing the Estimate launcher, you can begin using
Estimate.
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STEP BY STEP — ESTIMATE SUBSEQUENT USE

1. Launch Estimate by selecting Estimate from the Main menu.

ineianT @)

InEight’
ESTIMATE

Build 06001

e Estimate in the cloud looks and functions much like the Estimate on-premise version. For
example, opening a job from the landing page brings you to the Cost Breakdown Structure
register, or the register designated as the start page in the application settings.

InEight Estimate - o x

InEight”
ESTIMATE

Create a new Job from...

Sarateh Tempipte Exsng Job B Waard
QOpen a recent Job H
Code Description Croamzation Project 1D
105031 Misty Mounain Hoos Mounitain Shadow Energy - Mty Mountain.
W0S091 2411 2411 [<ird 105091
105052:2411

R — ® o
= e ©ren  Bcoy T Teose Sumended ¥ e W w E CBS Tree Fiter Mode: i
2 orevew B ame - 58 Subordeate Cortliem | Subaedinate Assenbiy o L Fiter - 1

| @emrmens i—— St G I feesasre ||

Cost Breakdown Structure (CBS) Register @

CBS Tree (Filter Mode) ® = T Saved vt ™ -1 0
Code Descrpon o Optonal Forecast Unitof — Total Cost o
e Poston Code = Dasription Code (T0) Quantity Meanre e (Forecast) Subjec
xe

Prime Bond - [= 308 000 Mie SBLIEI $5835106.09

Price % Add-On Prame Bond PRIME BOND 100 Lump Sum $45,915.38 $46,915. 38

B Job Finandng Price % Add-On PRICE % ADD-ON 100 Lump Sum $W55HW 93,5839

Indrect Cost Eucalation Job Fimancing. FINANCE EPENSE 100 LumpSum 0.0 000

frect Cost Bscalaton Indirect Cost Escalation BCIRECT COST ESCALATIEN 100 LumoSum 000 0.0

Ideect Cost Add-On —p————— DIRECT COST ESCALATION 100 Lmpsum 0.0 0.0

| E ::«m'w' Indirect Cost Add-On POIRECT COST ADO-OM 100 Lmpsam .00 000
T AEQUIPMENT 100 Lumoum SIST0N IS0
EIE rebnien General Expense A BrEcE 100 Wmpsm $4,200.00 $4.200.00
O] [rryses Direct Cost Add-On OIRECT COST ADG-ON 100 Lumpsum SANLIE S40L0 8
» a3 Urdsssted Excavaton * 1 Misbilzateon 410100 100 wwmptum $11,908.51 $11,909.51
» A agrepste Bose +2 Cicaring & Grubbing 2w 000 Age e
» B Amhait Conaete HotMu Ty Ll Unclassified Excavation 208 0,000.00  Cube Tard s Emsss
» EwfB 36 inch RCP Cubvert Clags (X1 + [— T WA Cue Farrd am e
a2 10 inch PVC Farce Main (D, z ] z 0.00 = 000
BN 24 inch PV Grawity sewer ( 02 $5,835,106.09
Ju B0 4 Foct Dismeter Marhicle
ds-Brtered Currency  As-Ertered Liits 10922411

RELEVANT LINKS
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System settings options
Archive and restore jobs
Video - Navigating tabs within Estimate

Video - Backstage view

2.3 ESTIMATE RESILIENCY

As a SaaS product, Estimate is sometimes made the casualty of server-side interruptions in service,
which are out of Estimate’s control. The auto-save function makes attempts to save your data prior to
Estimate shutting down.

When an unexpected disruption occurs in Estimate and causes it to shut down, notifications show
alerting you of the restore process to minimize the impact on you when these interruptions occur:

¢ A Waiting to Reconnect notification box shows, alerting you that it is reconnecting to the server.

Waiting to Reconnect

( Please wait...
Something went wrong. Reconnecting to the Estimate Server.

(e ]

e When Estimate restarts, an Attention notification shows, alerting you that Estimate is being
restarted due to a service interruption.

Estimate has been restarted due to a service interruption. If the
problem persists, please contact InEight Support.

o)

RELEVANT LINKS

System settings options

Archive and restore jobs

Video - Navigating tabs within Estimate

Video - Backstage view
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2.4 Backstage View

2.4 BACKSTAGE VIEW

When you open Estimate, you land in the Backstage view. You can also get to the Backstage view from

other tabs, by selecting the File menu.

Estimate Essentials User Guide

InEight Estimate [m]
InEight”
Create a new Job from...
F -l * 6
+
Library
Scratch Template Existing Job Bid Wizard
Templates
Snapshots Open a recent Job | =
Code Description Organization Project ID
Archive [ Restore
& 106029 Training Job - Maricopa County No, TM2924 SE2017 - TIC Denver 106029
Settings
* 091020240012 Springville 220/86 KV (5) - RUCES1.5Emerg...  Account Portfolio Level 091020240012
Exit
w 102447 Border west Project SE3009 - South Central 102447
% 31-781800 Civic Center Parking Structure Account Portfolio Level 31-7818.00
SR913-1240 Job001 JOB Added by Automation Account Portfolio Level 2411 Test1
NP-OnPremJob Training Job - Maricopa County Mo. TM2924  SE3007 - MEC Industrial 106032
EST-5CH-24-11 Training Job - Maricopa County No. TM2924 Account Portfolio Level EST-5CH-24-11
104035 MM Commerce Flour Loadout Carry Jo SE2013 - T.E. Ibberson 104035
101003 Training Job - Maricopa County No, TM2924 SE4000 - Mining District 101003
31-781800 v2 Richmond Station Parking Structure Account Portfolio Level 31-7818.00
More Jobs... :

1 Create new jobs, open, save, or close opened jobs.

2 Access the library and open the Jobs page. In the Jobs page, you can access the
following options:
» Job Register
e Delete Job
« Compare Jobs
» Connected Analytics
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e

Access templates, snapshots, and archive or restore options.

» Templates - Create job templates.

» Snapshots - Open the Snapshots page where you can create job snapshots
and open the Snapshot Register to access previously created snapshots.

» Archive / Restore - Open the Archive / Restore page where you can access
the following options:

o Archive Job

° Restore job

° Merge Jobs with Archive
o Archive Template

o Restore Template

4 Open the Settings page where you can access the following options:
» General - Customize General, Title Bars, Navigation Bar, Job Startup, and
Language options.
» Decimal Precision - Manage decimal precision for various values in
Estimate.
» Restore Defaults - Click to restore default values for selected settings.

5 Create a new job from scratch, from a template, from an existing job, or by using the
Bid Wizard..
6 View up to 10 recently opened jobs as a list or thumbnail tiles to quickly access

recently opened jobs. You can click the Favorites icon to the left of the job code to
label up to five jobs as favorites. The jobs labeled as favorites show at the top of the
list.

7 Change between the list view or tile view using the List-Tile view icon at the top
right of the section. The source for the thumbnail images in the tiles is from the
estimate project in InEight Platform. The following image shows the tile view.
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Library

Templates

Snapshots

Archive [ Restore

InEight®

InEight Estimate

ESTIMATE

Create a new Job from...
S 1
E3)
Scratch Template Existing Job Bid Wizard o
Open a recent Job | ==|
Code Description Organization Project ID
* 106029 Training Job - Maricopa County No. TM2924 SE2017 - TIC Denver 106029
% 091020240012 Springville 220/56 kv {S) - RUOES 1.5 Emerg...  Account Portfolio Level 09102024 0012
* 102447 Barder west Project SE3009 - South Central 102447
* 31-781800 Civic Center Parking Structure Account Portfolio Level 31-7818.00 @
SR915-1240 Job001 JOB Added by Automation Account Portfolio Level 2411 Test1
NP-OnPremJob Training Jab - Maricopa County No, TM2924 SE3007 - MEC Industrial 106032
EST-5CH-24-11 Training Job - Maricopa County No, TM2924 Account Portfolio Level EST-SCH-24-11
104035 MM Commerce Flour Loadout Carry Jo SE2013 - T.E. Ibberson 104035
101003 Training Job - Maricopa County Mo, TM2924 SE4000 - Mining District 101003
31-7818 00 v2 Richmend Station Parking Structure Account Portfolio Level 31-7818.00

More Jobs...

8 Open the Job Register where you can search and open jobs that do not show in
Open arecent job list.

2.4.1 ARCHIVE / RESTORE

From the Backstage View, you can back up and restore your jobs using the Archive/Restore feature. For

more information, see Archive and Restore Jobs in Estimate Data Management.

2.4.2 SETTINGS

From the Settings in the Backstage view, you can adjust some system settings. For more information,

see System Settings Options.
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Estimate Essentials User Guide 2.5 Load a Job

2.4.3 PROMPT TO SAVE

An important setting to visit in the Tools menu is Prompt to Save. InEight Estimate does not
automatically save your work. Instead, it will prompt you to save as often as you specify in the general
settings.

2.4.4 DECIMAL PRECISION

The Decimal Precision setting is also helpful. This is where you can specify the way your numbers
display in the system. For example, you may want your costs to display to the hundredth decimal place
(2), and your quantities to display as whole numbers with nothing to the right of the decimal (0).

TIP Changing decimal precision does not affect the way your numbers are calculated.

RELEVANT LINKS

System settings options
Archive and restore jobs
Video - Navigating tabs within Estimate

Video - Backstage view

2.5 LOAD A JOB

From the Backstage view, you can load a job by:

e Selecting a job from the Open a recent Job section.

¢ Clicking More Jobs to select from the Job Register.
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¢ Clicking Jobs from the left menu and then clicking Job Register.

InEight®
ESTIMATE

Create a new Job from...

Lorary
Saatch Template Extsting Job Bid Wizard
Templates
Snapshots Open a recent Job
Code Description. ‘Organization Project ID
Archive | Restore
105091-3 Steel Structure Training Job 3 SE3013 - Southwest 105091 2
Settings
SR-TEST12
Bat
S)-Structural Steel Structural Steel 5100000 - PKS Inc. 5J-Project 1
Northview School School 0018 5100000 - PKS Inc TPB30
MLQ-20250627-7 MECT - Foothill ITb to Montdair LRT 5100000 - PKS In¢ estrl
KMP2-25-410-005-2 InEight NOW: Health Faciity - Building Sample Job - Uni. 5100000 -PKS Inc KMP2-251
KMP2-20-T) Training Job - KMP2 5100000 - PKS Inc KMP2-251

There are multiple ways to load a job from the Job Register. For more information, see Manage jobs
from the Job Register.

When you load a job, it loads into the Cost Breakdown Structure Register by default.

= @om - 105091 TRG 0306 - Estimate
File Setup Estimate Quote Price em ) r Tools Integrations Actions
| @rew G copy T3 Toggle Suspended Indent Cost Ttem /.{ A A 4 E CBS Tree Filter Mode:
L3 Delete B Paste Outdent = Subordinate CostItem | G 2 » L] Filter
& Cut Fill Down E% Dependent Cost Item (;EQT\E:Z? ‘; HIEH gﬁ;; CE:\;Z,EE Expand CB5 Tree
Edit Insert View i
Cost Breakdown Structure (CBS) Register @ -
Drag columns here to group Saved views: | Previous View Bpe)
gg:mn Code = Description ?;g;‘gﬁanm :’;‘;:’Jm Uit Cost E‘if;’:é Currency Quote Group
= B 108 20.00  Mile $293,609.18 §5,872,183.61 U.S. Dollar i
Prime Bond 1.00 Lump Sum $47,271.25 §47,271.25 U.S. Dollar
Price % Add-On 1.00 Lump Sum $296,741.22 $296,741.22  U.S. Dollar
Job Financing 1.00 Lump Sum $0.00 %0.00 U.S. Dollar
Indirect Cost Escalation 1.00  Lump Sum $0.00 $0.00 .5 Dollar
Direct Cost Escalation 1.00  Lump Sum $0.00 $0.00 U.5. Dallar
Indirect Cost Add-On 100 Lump Sum $0.00 %0.00 U.S. Dollar
5 Job Management & Equipment 1.00  Lump Sum $157,096.28 $157,096.28 U.S. Dollar
Gl General Expense 1.00  Lump Sum $4,200.00 $4,200.00 U.5. Dollar
Direct Cost Add-On 1.00  Lump Sum $104,958.33 $104,958.33  U.5. Dollar
il Mobilization 1,00 Lump Sum $11,909.51 §11,909.51 | U.5. Dollar
+ 2 Clearing & Grubbing 10,00 Acre $3,918.50 $39,184.97 | U.5. Dollar
E 3 Unclassified Excavation 50,000.00 Cubic Yard $4.68 $233,915.81 | U.5. Dollar o
z ] = 0.00 b $0.00
102 $5,872,183....
As-Entered Currency As-Entered Units Main-T01 105091 TRG 0306
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You can change the default form that opens when you load a job in Backstage view > Settings >
Options > General. In the Job Startup section, select a form from the Start Page drop-down list.

- O:ph'nns General MNavigation Bar
- General
i.. Decimal Predsion () Prompt to Save Every |5 = | Minutes When a record form is dosed, return focus to:
@ Live Register Scrolling © The last form accessed
Q i
@ Align and Match Columns EAlheanithatonensdit
[T Keep Employed Assemblies Collapsed
Job Startup
, Summarize Values in Group Row
- StartPage: | CostBreakdown Struc... -
Showup to |15 5 Detail Rows in Registers without Scroling 5
Title Bars Language
© show Job Code Select a Language: | English (United States) -
(O) Show Job Description
() Show Job Code and Description Visual Style
Bezier Custom Palette -
Restore Defaults... OK Cancel

In the Job Register, you can easily access a job’s properties. For more information, see Open a job’s
properties from the Job Register from Manage jobs from the Job Register.

For more information about job properties, see Job Properties in Project Setup.

RELEVANT LINKS

Job Register

Manage jobs from the Job Register

Job properties

Video - Navigating tabs within Estimate

Video - Backstage view

2.6 COMMON NAVIGATION

Access the common navigation slide-out panel by selecting the main menu located on the top left side
of the Estimate page. This feature provides a common navigation user experience that is shared
amongst all InEight products. The primary intent of this navigation menu is to provide a consistent
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2.6 Common Navigation Estimate Essentials User Guide

InEight product experience, with similar Project Suite graphical interfaces, while working within
multiple InEight products.

Estimate's on-premise software is authenticated by your Windows login credentials, which is shown
below the main menu.

System Integrations
A e
- e
L 23 Equipment

PT Paul Trippi Resources __ . Resource
- i Materials  Aszemblies

INEIGHT S

& Labor

Resources

INEIGHT ONLINE

(i) Explore products

(?) InEight learning and support

& InEightcom

2.6.1 HELP BUBBLES

Help bubbles appear at various times in InEight Estimate, including the first time you open InEight
Estimate. These messages contain important information to clarify key functions in the system.

You can dismiss the message until the next time by closing it with the X in the corner or dismiss it
permanently by clicking the Never offer this help again link.
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, /L

x

Enter up to 10 factors (multipliers) here
to calculate a Factor Composite. The
Factor Composite is displayed on the
Production data block, and 1s multiplied
by the Duration Driven Man-Hours to
calculate the values shown in the
Factored Duration Driven Resources
column.

You can globally customize the titles of

these factors by choosing View from the
main menu, then choosing "Customize.”

Never offer this help again

2.6.2 DATA MAP

2.6 Common Navigation

Found in the Price tab, the Data Map is a great way to view a high level summary of your estimate and
can be accessed at any time during the estimating process. You can see totals of direct costs, indirect

costs, profit, and overall bid price.

DataMap ©Q

TARGET PRICE
$6,522,054

TOTAL COST
$5,869,847

$6,514,916 (99.89%) Current Price
$7,139 (0.11%) Variance (vs. Target Price)
($851) (-0.01%) Changes Register

RELEVANT LINKS

System settings options

Archive and restore jobs
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Indirect Cost Markup

Direct Cost Markup

INDIRECT COST (9.94%)

Business Overhead
W 551%

Job Overhead

W 4.44%

DIRECT COST (80.06%)
Unassigned Direct Cost (Work Plan)
W 0.02%

Assigned Direct Cost (Work Plan)
W 80.04%

$34,118
$618,089
$648,514
$359,257
$289,257
$5,221,333
$1,000

$5,220,333
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Video - Navigating tabs within Estimate

Video - Backstage view

2.7 INEIGHT ESTIMATE LAYOUT

The layout of InEight Estimate is workflow based. You will move from left to right on the tabs as you
enter your data for the project and work on developing your estimate.

2.7.1 SETUP TAB OVERVIEW

Estimate Quote Price System Integrations

®H ¥ B &ir. % a B B

23 Equipment
Job Properties  Foundation  Pay Item &  Bid Wizard | Resources | __ ) Resource CostItem  Standard Reports
- Setup Data = Proposal - iIE Materials  Assemblies | Assemblies  Tables

o Initialize o Resources Assemblies Reports

1 Initialize From the initialize section, you can access the following registers. Job
Properties is where you enter the basic project details. Foundation Setup
Data is where you populate all account codes and validated fields. The
Pay item & Proposal Register provides an alternate structure to distribute
estimated values. Bid Wizard helps automate the process of setting up
estimates by copying information that already exists in other jobs.

2 Resources In the Resources section, Resource Rates opens the Resource Rate
Register, where detail costs for labor, equipment and material is stored.
The Resource Assemblies opens the Resource Assembly Register,
where you create a combination of resources as an assembly and reuse
it as needed in multiple cost items.

3 Assemblies You can create a Cost Item Assembly to automatically estimate different
scopes of work based on input values. Standard tables - allow you to
create tables of reference data that can be accessed in any cost item
assembly.
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4  Reports The Reports section is available from any tab. Depending on the tab you
access it from will bring you to reports specific to that tabs data. Here
you will find reports on resources such as Resources Changes,
Resource Utilization, and Resource Cost Details.

2.7.2 ESTIMATE TAB OVERVIEW

System Integrations

T Account Code Utiization l‘l_l B2 Resource Utiization = [mfm] Jab Finance ] U Direct Markup BASE -
ﬂ %a.. Work Breakdonn Structures - 2. Resource Cost Details m - Z D o P4 Price % addon | f— @) Indirect Markup 3 dimates I'T'I—T;l
gzs:izn::k&gg;\ o Resnljrcss 5 e \fnrlibnnk Sd'\E‘duIe Cash Flow Cér::lﬁéras E] —— I:gscizfsk(ggg';\ i e o Reports
Breakdown Structures Resources o Woa)k 58”5 Indirect Cost Overhead and Profit Alternates Ras
1 Quantity Import and manage quantity takeoff data using the Quantity ltem
Takeoff Sources, Quantity Item, and Quantity ltem Employments registers.

2 Breakdown Access the Cost Breakdown Structure (CBS) Register, Account Code
Structures Utilization Register, and Work Breakdown Structures (WBS) Register.

3 Resources Resource Rate Register is where you create or modify the rate charged
for labor, material and equipment resources. Different views of the
Resource Rate register such as Resource Utilization and Resource
Cost Details are available from the Resources section.

4  Workbook InEight Estimate's integration with Microsoft Excel is a two-way
integration that allows you to update register fields in Estimate with data
contained in an Excel workbook, and update Excel cells with data
contained in a register field in Estimate. This is where you open the
embed excel workbook which is maintained as part of the estimate job
folder and where you preform the sync functions to send values back
and forth.

5 Schedule Access bi-directional integration with Microsoft Project and Oracle
Primavera. The Cash Flow graph displays the projected cash flow of
your project, along with the job financing expense, individual cost
category costs and resource utilization.
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6 Indirect Cost Indirect Cost Items filters the CBS register to display cost items that
contain overhead costs that are not directly associated with any
particular deliverable items. Clicking on % Price Add on or Prime Bond
opens up these individual records.

7  Overhead Price Breakdown Structure (PBS) Register is a visual run-down of the
and Profit costs and profit that make up your Target Price. You can access the
Direct and Indirect Markup records or see totals of direct costs, indirect
costs, profit and overall bid price summarized in a Data Map.

8 Alternates Alternates are used to define alternate scenarios in order to assess the
impact of those scenarios.

9 Reports Run reports on CBS Summary, CBS Details, CBS Outline, CBS
Estimate Summary, CBS Currency Comparison.

2.7.3 QUOTE TAB OVERVIEW

Setup Estimate System Integrations

!IE =} Quote Group Tags @ @ i“= E @

O Minority Setup
Address = Request For Quotes Resources  Cost Items Reports
Book Attachments Quote (RFQ)
Setup Quote Management Quote Comparison & Award Reports

(1) (2 o &
-

1 Setup Quotes are organized using Address book, Quote Group Tags,
Minority Setup and attachments in the Setup section. Address book
stores and maintains all information pertaining to subcontractors,
vendors, architects/engineers, etc. that you work with regularly. The
Minority Setup tab within Job Properties stores information about the
agency that authorizes the status of Minority Enterprises along with
their different types. You can use Quote Group Tags to group together
multiple resources or cost items that will be sent in a single request for
quote package to solicited contractors or vendors..
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T ™

2 Quote Quote Management allows you to access the Requests for Quote
Management (RFQs) register and Quotes. Request for Quotes (RFQs) are
invitations to sellers, requesting that they submit pricing to provide
services, equipment or material based on the line items and resources
included in your estimate. The Quote Register stores all of the quote
responses you receive for that job.

3 Quote The Quote Comparison & Award section allows you to perform
Comparison & comparative analysis across all the quotes you've received. You can
Award view a comparison of submitted pricing by resources or cost items.

4  Reports From the Reports section in Quotes you can run reports on Quote

Summary, Quote Record, Compare & Award, and Minority
Participation.

2.7.4 PRICE TAB OVERVIEW

File Setup Estimate Quote System Integrations

@ v | Lock Cost Ttems to Pay Ttems —— EE%. Direct Markup - PBS Changes BASE M
s E
Bl
[T Pricing ['I-f] Indirect Markup Log PBS Changes J’ Alternates
Pay Item & . . Price Breakdown . Reports
Proposal @ = Competitors Structure (PBS) = DataMap
Pay Items Overhead and Profit Audit Log Alternates Reports

T T S

1 Payltems From the Pay Items section you can lock Cost items to Pay items and
access the Pay item & Proposal register. Under Pricing in Job Properties,
you can set up how the tool calculates profit and spreads pricing to your
pay items. In the Competitors section, you can keep track of companies
that have submitted bids as well as record and track competitor bid
prices.

2  Overhead The Price Breakdown Structure (PBS) Register is a visual run-down of
and Profit the costs and profit that make up your Target Price. You can access the
Direct and Indirect Markup records or see totals of direct costs, indirect
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s [ bsmww

costs, profit and overall bid price summarized in a Data Map.

3 AuditLog You can access the PBS Changes register (which logs any changes that
effect the Target Price) and turn on/off logging PBS changes..

4  Alternates Alternates are used to define alternate scenarios in order to assess the
impact of those scenarios on the total estimate value.

5 Reports From the Reports section in the Price tab, you can generate reports for
Standard Proposal, DOT Proposal, Pay Item Summary, Pay ltem
Currency Comparison, Pay Item Price Breakdown.

2.7.5 SYSTEM TAB OVERVIEW

File Setup Estimate Quote Integrations

. X 2
— 5 Saved Views - (:_?i' Colors = /Yl External Reports ~ a About Estimate
—— -
@ Titles « ﬁ' Output Settings - E, External References ~ ﬁ' Release Motes
Customize Estimate InEight
o Help (@) InBightcom  University
Customize Help

v | g

1 Custom You can customize the titles and colors for different fields. You can export
and import saved Views, Titles, Colors and Output Settings. You can
customize reports generated by Estimate using External reports. External
References allows you to open external programs with Estimate.

2 Help You can access a comprehensive help system from the Help menu. You can
get information about the Estimate Version and all new updates about the
different versions.
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2.7.6 INTEGRATIONS TAB OVERVIEW

N =
File Setup Estimate Quote Price System Developer Tools Integrations Actions
éﬂ é‘ﬂ é‘ﬂ App Logs
Publish Estimate  Publish Cost Items Publish Cost Items o

to @ Mew Project  to Active Project  for Change Management

o olnfight Platformo
T

1 Publish Estimate  Sends job data to InEight Platform Integration. You can continue
to a New Project  using Estimate during the publish and will be notified after the data
has been sent successfully.

2 Publish Cost Sends cost items to the active project.
Items to Active
Project
3  Publish Cost Sends cost items to InEight Platform Integration to import to InEight
Iltems for Change Change.
Management
4  ApplLogs Shows a list of InEight Project Suite application logs that you can

export to Excel.

2.7.7 LIBRARY

Click on the Library icon and the Library opens in its own window.

Users with sufficient security can access master information available in the Library.

TIP The Library is covered in greater detail in 3.1 Library Overview on page 80
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2.7.8 OPEN FORMS

The following steps assume you already opened the Training Job.
STEP BY STEP — OPEN FORMS

1. Click on the Setup tab.
2.

In the Initialize section of the Setup tab, click on the drop-down menu for Job Properties.

3. Select Overview to open the Job Properties form.

Job Properties  Foundaton  Pay!
= Setup Data ~ Pro

oD Owerview
%

LT_,.' Security
E Cowver Sheet
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* Notice that each form opens in its own tab within the active job folder

Estimate Quote Price System Integ

E " E ‘# &, Lab
7" [

= Equ
Job Properties  Foundation  Pay Item & Bid Wizard | Resources __

- SetupData = Proposal - e Mat
Initialize Resol
Job Properties Cost Breakdown Structure (CBS) Register ©

* You can tab between these forms as you are working in InEight Estimate

e Once you are in a register, the Actions and More Actions tabs are available to you. The options

available are contextual to that register

1234 - Estimate

system  Integratons  [EEECEOS
B print @ new  Ghcopy T Teogle Suspended Indent split Link Field CostItem Assembly Resource e W CES Tree Fiter Mode:
R Preview Delete Paste Outdent split by Cost Type nlinkField | = subordinate CostItem | F= Subordinate Assembly Resource Assembly 4 » e Filter
& Export to Excel cut Fil Down Merge Cost Items E-% Dependent Cost Ttem c??\l;izg [re E!iir e Expand CBs Tree
Print Edit Workbook Insert View

1234 - Estimate

_ =
File Setup Estimate Quote Price System Integrations Actions More Actions
&= schedule Selection 4k Swap - 'E‘ Bid Wizard Z Unit / Total Confirmation Add Quote Select in Model {1 Sync Model Quantities
€ Unschedule Selection e Remave ~ Subtotal Calculator O Refresh Benchmarks Frame Selected m Send Selected CBS to Model
om Impart /
=g Caloulate Plug Days C Update + Quantity Checking Roll Up Quantities Update CBS ~
schedule Batch Operations Tools Data Source Model Connector

RELEVANT LINKS

System settings options
Archive and restore jobs
Video - Navigating tabs within Estimate

Video - Backstage view
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2.8 System Settings Options

2.8 SYSTEM SETTINGS OPTIONS

Estimate Essentials User Guide

From the Backstage View, you can access system settings. System settings contain options and settings
that effect the entire InEight Estimate system. These settings include:

¢ General settings (options)

e Title Bars
¢ Navigation Bar

Language

¢ Visual Style

Job Startup

All of the settings under the Options branch are user-level settings.

Integrations

— ws - -
&> Saved Views ﬁ Output Settings

& Tites ~

Customize pay
(] Colors =

ﬁ’o Quantity Item Settings ~

[=)- Options
i--General
i Dedmal Predsion

Restore Defaults. ..

Estimate

T External Reports « Help &) InBight.com

General

[ Prompt to Save Every |5 = | Minutes
@ Live Register Scrolling

@ align and Match Columns

() Keep Employed Assemblies Collapsed
- Summarize Values in Group Row

showup to |15 54 Detsi Rows in Registers without Scrolling

Title Bars

© show Job Code

(©) Show Job Description

(2 Show Job Code and Description

'_‘; External References ~ a About Estimate

@ Release Notes

InEight
University

Navigation Bar

Whena record form is dosed, return focus to:
© The last form accessed
() The form that opened it

Job Startup

Start Page: | Cost Breakdown Struc... -

Language

Select a Language: | English (United States)

Visual Style

Bezier Custom Palette -

OK

Cancel

The following step by step walks you through configuring general settings (options).
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STEP BY STEP — DECIMAL PRECISION

With InEight Estimate open, click on the File tab to go to the Backstage view.
Select Settings.

Select General under Options in the node tree on the left.

To activate Prompt to Save, select the Prompt to Save checkbox.

Select how often you want to be prompted (in minutes).

Select Decimal Precision in the tree on the left.

N o g bk~ w D=

Review the default settings.

TIP Units of Measure will default to English, and Currency will default to U.S. Dollar.

Settings

[=}-Options .
i General Decimal Precision

Cost Summary Predsion 2

Unit Cost Predision 2

Quantity Predsion 2

short Percent Predsion 2

Long Percent Predsion 2

Currency Rate Precision 5

Restore Defaults. .. oK Cancel

2.9 COLUMNS

Within each register, you can move, sort, filter and group your columns to view the information the
way you need to see it.
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2.9.1 MOVE COLUMNS

You can move columns by selecting a column header and using drag-and-drop. If there are columns on
the register that you don’t use, you can hide and unhide them from view, as needed.

STEP BY STEP — MOVE COLUMNS

1. In the CBS, click on the Currency column header and drag the column to the left, dropping it to
the right of the Description column.

2. Hide the Optional Code column by dragging the Optional Code column header down until a black
X appears, then let go.

Optional
Code

Currency
U.5. Dollar
U.5. Dollar PERIME BOMND

U.5. Dollar PICE % ADD-OM
U.5. Dollar FRIAMNCE EXPEMSE
U.5. Dallar RECT COST ES...
U.5. Dollar DIRECT COST ESC...
U.5. Dallar P toRaTN AT 1
U.5. Dollar _.l'::-ll:llsldIE'IHI'ilH'\:'lEl'lEl'lT...
U.5. Dallar GEMER.AL EXPEMSE
U.5. Dollar DIRECT COST ADD...
U.5. Dollar 6410100

U.5. Dollar 2010102

U.5. Dallar 2020183

LS. Daollar 3.1

e The Optional Code is now hidden from view

¢ To unhide a column, right click on any column header and select Column Chooser; a
Customization window appears, which contains all the hidden columns in that register

3. Find the column you want to unhide and drag-and-drop it to the location where you want it to
go.
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Unit Cost

£5,861,800...
£47,069,28
£294,923,52

Total Cost
(Forecast)

£5,361,800,79
£47,069,28
£294,923,52

-

Currency | Optional

Code
U.S. Dollar =
U.5, Dol
.5, Jllar

£0.00
£0.00

Customize

20,00 5. Dollar
20,00 U.5. Dollar

Drag a column from bgifow to place it into the

gister.

Custom Captio

| Default Caption

Optional
Code

Owned Equipment
Biling...

Owned Equipment
Total...

Owned Equipment
Total Cost

Owned Equipment
Unit Cost

Pay Hours
Rules

Fay Item
Assignment

Pay Item
Description

Pay Item
Line Mumber

¢ You can also unhide a column using the Go To Column feature

Optional
Code

Owned Equipment
Billing...

Owned Equipment
Total...

Owned Equipment
Total Cost

Owned Equipment
Unit Cost

Pay Hours
Rules

Fay Item
Assignment

Pay Item
Description

Pay Item
Line Number

4. Right click on a column header and select Go To Column.

5. Click on the drop-down menu and select the column you want to unhide.

Column:

Go To Column

Include columns that are not currently in the view

InEight Inc. | Release 25.7
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6. Click OK.

2.9.2 SORT AND FILTER COLUMNS

You can sort and filter your columns to drill down to specific information.

STEP BY STEP — SORT COLUMNS

You can sort on any column by clicking once on the column header.

1. In the CBS Register, click on the Total Cost (Forecast) column to sort the column in ascending
order (e.g., 1to 10, A to Z).

2. Click the Total Cost (Forecast) column a second time to sort in descending order (e.g.,10to 1, Z
to A).

TIP Use Ctrl-click to unsort a column and reset it to its original state.

STEP BY STEP — FILTER COLUMNS

1. In the CBS, hover over the Unit of Measure column header for the filter icon to appear.
2. Click on the filter icon in the Unit of Measure column to select a filter value.

e From the filter list, you can select any of the values defined for that column or you can use
one of the predefined values (Custom, Blanks, Non blanks).
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Unit of : Total Cost
Measure kel (Forecast)
Values Text Filters
Enter text to search... e
| (Al Month
Acre Pound
Cubic Yard + | Sgquare Feet
+ | Each Square Yard
Linear Feet Ton
+ | Lump Sum
Mile

I Clear Filter Filter Editor Close !
. ama

3. Make your selection, then click Close.

4. To clear the filter, click on the red X at the bottom of the form or click on the filter icon on the
header of the column you filtered and select (All), then click OK.
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2.9.2.1 FILTER EDITOR OVERVIEW

Column filters can be managed on individual columns or for the entire register using the Filter Editor.
The Filter Editor tool lets work with all the column filters for a register view in one place as well as
creating more complex filters through the use of grouping and applying And/Or statements.

When you add a new Group, a new Condition is automatically added to that Group.

With each additional Condition statement, you need to select an operator and a value in order for your
customized filter to take effect on your chosen column. Many new comparison operators have been
added to this version as shown below:

Filter Editor b4

And

I - [WBS: CEAS (Civil Engineering Account Code System]] Begins with <enter a value> €3 I

Is less than

<

% Isless than or equal to
£ Is between

£ Is not between

aflc Contains

s Does not contain

[lec Begins with

4 fe[d Ends with
% Is like
Load Save QK
e Is not like
45,000.00 Ton #b Is any of
400,000.00  Sguare Yard @) Is none of
35,000.00  Ton Is blank
35,000.00  Ton @ Is not blank -

CREATING COMPLEX FILTERS USING THE FILTER EDITOR

You can define filters across any of the columns available in the CBS register. You can also open the
Filter Editor using the button in the column filter drop-down, but regardless of how you access it, the
Filter Editor dialog permits defining a filter for the entire register and not just the selected column.

Page 64 of 402 InEight Inc. | Release 25.7



Estimate Essentials User Guide 2.9 Columns

?‘I’o;oe;asqlianbw T d m‘;:;e Unit Cost 1{;’;1{?5% Subject Cost mect Cost Allocated muon Currency

1.00 \Lump Sum $5,508,579.45  $6,508,579.45 " U.S. Dollar

U.5. Dollar

U.5. Dollar

U.5. Dollar

U.5, Dollar

UM/ Equip-Hour U.5. Dollar

UM/ Hour .S, Dollar

UM/ Man-Hour LS. Dollar

| [se N O O .o

Undefined Biling Adjustment Amount U.S. Dollar

Undefined Billing Adjustment Percent LS. Dolar
Undefined Billing Unit Rate

Undefined Cost Adjustment Amount U5 Doler

Undefined Cost Adjustment Percent .S Dolar

Undefined Total Biling Amount U.S. Dollar

Undefined Total Cost U.S. Dollar

Undefined Unit Cost U.S. Dollar

Unit Cost el Apply U.S, Dollar

35, Unit of Measure ) T U.S. Dollar

Because all the register fields are available, more complex filters can be created by using Grouping and
Or operators. In the following example, a filter has been defined to return all Terminal Cost Items that
either have a cost source of Plug, or exceed $100,000 of Total Cost (Forecast).
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Cost ure [CB5) =]

Drag columns hene to group

Do = oo T O EH s S ey v
=[] riceseadd-on PRICE % ACO-.. 100 Lump Sum $1293561 $31231861 &
- Direct Cost Add-On DIRECT COST .. 100 Lump Sum $110,803,57 $110,803.57 [+#]

+ Job Management & Equipment JOB MAMAGEM ... 100 Lump Sum 5157,096.28 $157,096.28 Detsl
31 42,000.00  Cubic Yard 53,44 §144,552.52 [v] Detad
15,142.50 [+#] Detad
117,018.05 [+] Detsd
b [ Termingl) Ecuss Chedeed © 189,660.73 [v]  oewl
Ugc e 111,905,357 Detai

— ' h
Irrou Cost ruzasc?:::m than 100,000.00 © foensa|  [v]  [oe
$42,000.00 ] Piug
244,383.14 [#] Detsi
%2,862.73 [+#] Detal
518,778.57 [¥] Detal
147,668.50 [+#] Detsl
' §1,500.00 ™
' $3,500.00 [+] Pl
$2,900.00 Py
$2,100.00 [+ Plg
[ [ s | o |l amat TR om e
 Tesm 1m0 umpsm | SLmo0| &80 Pl
| 12510 100 Lump Sum $2,100.00 20000 [v] P
15300 100 Lump Sum $3,300,00 $3,300.00 [+] g
16510 100 Lump Suf $3,400.00 $3,400.00 Pl
1 RAL TR AN ek R 1 AAR AR A L.

z 0.00 z 50.00
54,830, 378.06

» ([Cost Source] EQUAL Fiug' OR: [Total Cost (Forecast)] GREATER THAN 100000) AND [Ts Terminal] EQUAL True

When modifying a filter, the Filter Editor can be invoked by clicking the Edit Filter button located on
the bottom right of the CBS page.
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Cost Breakdown Structure (CBS) Register © -

ape
rmcote = Desaoten ey | v | pcs v / g ccun ot
- = 108 Mile §5,666,162.55 4 .
Prime Bond 7000 Lump Sum $45,861.93 4
Price % Add-On 7000 Lump Sum $284,057.38
Direct Cost Escalation 7000 Lump Sum $13,933.28 E
Direct Cost Add-On 7000 Lump Sum $99,962.10 OVERHEAD
=1 SITEWORK & ROADWAY Each $2,387,025.45 § ORK
+ 12 Clearing & Grubbing 1110 Acre $39,184.97
= 13 Undassified Excavation 1122 Cubic Yard $158,985,21 ATION
+ 132 Embankment 1122.200 Cubic Yard $69,678.93
= 14 Aggregate Base 1120 Ton $692,928.99 £
+ 141 Furnish & Haul Base Material 1120, 100 Ton §519,513.30 4
= L5 Asphalt Concrete Hot Mix Type A 1240 Ton $1,486,222.28 ONCRETE PAVEMEN
+ L51 Furnish & Haul Hot Mix 1240. 100 Ton $1,374,562.54 WCRETE PAVEMEN
=2 WATER & SEWER Each $519,502.60 -
= 0 = $0.00
78 £5,615,073.91

4 L3

STEP BY STEP - FILTER EDITOR

1. In the CBS, hover over the Unit of Measure column header for the filter icon to appear.

. B

®  [Unit of Measure] EQUAL "Cubic Yard' OR [Total Cost (Forecast)] GREATER THAN 10000 OR [Account Code] EQUAL "1127

2. Click the Filter icon in the Unit of Measure column to select a filter value; select the desired
UoM.

3. Select the Filter Editor button, and the Filter Editor data box appears.

» By default, an And statement is created with a Begins with operator and a blank
value.

4. Select your preferred operator and enter in your preferred value.

To add additional And/Or statements, select the word And in the top left corner. A drop-down
appears.
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1 And th <emter a value > )
e Or S
=, Add Condition

= Add Group

# Clear All

Load Save 0K Cancel Apphy

6. Choose which And/Or statement to add and then select the Preferred Operator.
7. Enterin your Preferred Value to complete your additional statement.
8. Click OK.
» Select the X to delete a single statement.
9. Select the And statement in the top left corner to begin clearing all And/Or statements.
10. From the drop-down, select the option Clear All.
11. Once done, select Apply and then click OK.

2.9.3 GROUP COLUMNS

Sometimes you may want to organize your information into groups. Instead of filtering your
information down to one value (e.g., unit of measure = Ton), you can look at your information with a
separate group for each value (e.g., a group for Tons, a group for Cubic Feet, etc.).

STEP BY STEP — GROUP COLUMNS

1. From the CBS register, group the Unit of Measure column by dragging it into the grouping area
(where it says “Drag columns here to group”).
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Cost Breakdown Structure (CBS) Register @

*ees
Position Code

= -
Lesdipion

T —

JOB
Prime Bond
Price % Add-On

Job Financing

L

(T/0) Quantity
1.00
1.00
1.00

1.00

Unit of
Measure

Lump Sum
Lurnp Sum
Lump Sum

Lurnp Sum

2.9 Columns

¢ Notice that the cost items in the register are now grouped together by their units of
measure, and each group of cost items is subtotalled by costs, hours, quantities, etc.

Cost Breakdown Structure (CBS) Register ©

Unitof .
Messure

Unitof -
Measure

Acre
Cubic Yard
Each

LF

Linear Feet
Lump Sum

Mile

o E 8 E e

Month
Pound
Square Feet
Square Yard

E Ton

cBs
Position Code:

Desaiption

Cptional Forecast
Code (T/0) Quantity

Unit Cost.

10.00

117,865.76

59.00

2,083.95

30,248.00

22.00

0.00

2.00

60,000.00

136,300.00

800,000.00

160,000.00

Total Cost
(Forecast)

$39,184.97
$498,571.36
$1,684,854.23
$0.00
$459,303.91
$667,772.98
$0.00
$10,000.00
$44,408.30
$276,594.95
$99,954.78
$2,034,391.05

2. To ungroup, right click in the grouping area and select Clear Grouping

2.9.4 SAVED VIEWS

e The column returns to its original location

TIP

You can group by more than one column to have multiple grouping levels.

Once you have set up a view the way you like it, you can save the view so you won’t have to configure

it again later. InEight Estimate also comes with some pre-built views to help you organize the screen
the way you want to see it.

Views are accessed from the Saved Views menu in the top right portion of a register.

The following steps assume you have made changes to your register view and want to save it for future

use.
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STEP BY STEP — CREATE A SAVED VIEW

1. Inthe CBS register, click on the Saved Views drop-down menu and the Save disc icon appears.

Saved views: | Previous View - -

Account Code View

Alternates View

Benchmark View

Billing Rates View

Budget Comparison View

CBS Cost View

CBS Labels, Tags, Assignments View

CBS Production View

CBS Simple View

CBS Work Rules View L

2. Click on the Save disc icon.

¢ The Save Current View window appears

)

=) Save Current View

Type a name for the current view. All filters, sorts,
groups, and column settings will be saved under this
name so that you can recall them later while in this
register.

View name: |
[7] save as Locked Corporate View

Include this view in the Saved Views section
of the report control

[ox J[ cone ]

3. Enter the View Name, then select OK.

e The new view displays in the drop-down menu

TIP Saved views are user-specific; you will only see your own saved views when you are
logged in.

2.9.5 SUBTOTAL CALCULATOR

You can select multiple cost items and use the Subtotal Calculator to summarize and display Unit Cost,
Man-Hours/Unit and Units/Man-Hour. Highlight a cost item in the CBS and right click on a Total Cost

Page 70 of 402 InEight Inc. | Release 25.7



Estimate Essentials User Guide

2.9 Columns

column (e.g., Total Cost (Forecast), Labor Total Cost, Owned Equipment Total Cost, etc.). Select

Subtotal Calculator from the right click menu, and enter the number of units to use in your calculation.

0D FTOPETDES  rOUNO&UoN  Fay LTem &
- Setup Data ~ Proposal
Initialize

oig vwizara HESoUrces

- £5R Materials

Resou

Cost Breakdown Structure (CBS) Register ©

Jrag columns here to group
+ 11 et TiON £11,909 _
+ 1.2 Clearing & Grubbing $19,592
2 13 Undassified Excavation §85,36(
+

. +
=

rces

& 5 b

17 @O0

fl i

]
a

Open
New

Delete
Cut
Copy

Da:te_/_

Inser ost ltem Assembly

Insert Cost ltem Assembly as Subordi

Split

Split by Cost Type
Merge Cost ltems
Insert Resource

Insert Resource Assembly
Toggle Suspended
ost Allocation ltem

GoTo(

Schedule Selection
Unschedule Selection

Calculate Plug Days...

Subtotal Calculator

] Total Cost (Forecast) $85,360.07 $97,567
{ Units: 1.00 §73, 46(
r

4 Unit Cost: $85,360.07 24 10¢

q 550,528
Man-Hours (Total) 1000.54

4 $64,306
Man-Hours / Unit: 1000.54 ‘ .
Units / Man-Hour: 0.00 £05,7

L]
As-Entered Currency As-EnteredUnits  Training Job

Roll Up Quantities
Add Quote...

2.9.6 REGISTER RUNNING TOTALS

You can select multiple rows in a register and see the sum total amount at the bottom of the register.

For example, you can hold down the CTRL key and multi-select cost items 2.1.1, 2.2.1, and 2.3.2 in the
CBS register, you can see the sum of the three selected cost items toward the bottom row of the

register.
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= 3 = 16,024.00 I 529977988 ¥ 51367648 T s1a,17a.40 3 s0.00 = 50.00 T $258,980.00 3 so.00

Estimate calculates subtotals for quantities when the UOMSs match. Superior cost items are not
included in the subtotals to avoid any double counting in the subtotal.

It is not necessary to export data to Microsoft Excel and run separate calculations to better understand
costs of multiple items. The sigma symbol shows in the subtotaled row to indicate it is the total of the
selected rows.

RELEVANT LINKS

Video - Working with registers

2.10 FIND FEATURE

The Find feature lets you search across all columns in the register with a single operation. The
matching results are then highlighted in yellow. A scroll bar annotation is provided to indicate the rows
in the grid containing matches. This lets you easily navigate to the search results in the register.

The Find feature also includes the flexibility to perform more precise searches using various syntax in
the search bar. The Find search bar shows the currently selected and total number of search results.

Meyg= If you type in two words, such as total cost, the grid considers them as individual
conditions and selects records that contain either total or cost.

+ To find records that contain both search terms
like total cost, type + before the second word.
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For example: total +cost.

- Type - to exclude records that contain a
specific word, for example: total-cost. You
can combine different operators. Use + and -
to select records that contain both pay and
item, excluding records that contain
assignment. For example: pay +item -
assignment.

"quotes” To search for a string that contains a space
character, you need to enclose this string in
guotation marks. For example: "total cost".

. To search against a specific column, type the
first letters of the column's display name plus
a colon character. For example: optional:
unassigned. Now the grid displays records
containing unassigned in the optional code
column.

If you add another column-specific condition, the grid joins them using the + logical operator. Then the
record shows the result that matches both options. The same happens when you join a column-specific
condition with the one applied to all columns. An example of this search criteria looks like this:
optional: unassigned +"pay item".

STEP BY STEP — FIND FEATURE

1. From the Cost Breakdown Structure (CBS) Register, bring up the Find feature using CTRL+F.
2. Inthe search bar, type in Materials.

3. When all the searches are highlighted in yellow, use the up or down arrows to the right of the
search bar to navigate to the next search result in the register.

InEight Inc. | Release 25.7 Page 73 of 402



2.11 Keyboard Shortcuts

Estimate Essentials User Guide

Drag columns here to group % | material 113 @ v
gg:tion Code — DScrtiol gopéjznal ?;ggaqsﬁanﬁty I'H'Igi.:sojre Lrat ot ?;féfaﬂ:tg Subjef
Indirect Cost Add-On INDIRECT COST ADD-ON 100 Lump Sum £0.00 £0.00 g
P Job Management & Equipment JOB MAMAGEMENT & EQUIPMENT 1.00  Lump Sum £157,096.28 £157,096.28
P General Expense GEMERAL EXPENSE 1.00  Lump Sum £4,200.00 £4,200.00
Direct Cost Add-On DIRECT COST ADD-ON 1.00  Lump Sum £98,633.23 £98,633.23
+ 1 Mobilization 5410100 1.00  Lump Sum $11,909.51 $11,908.51
+ 2 Clearing & Grubbing 2010102 10,00 Acre £3,918.50 $39,184.97
2 3 Unclassified Excavation 2020183 50,000.00 Cubic Yard £4.68 £233,915.81
+ 3.1 Excavation 31 50,000.00 Cubic Yard $3.00 $149,922.83
+ 3.2 Embankment 3.2 50,000.00 Cubic Yard $1.68 $33,992.94
3035912 45,000.00 Ton §15.40 $592,928.99

a1

$519,513.30

Finegrade Subgrade 4,2 400,000.00  Square Yard 0,19 £75,848.36
= a3 Install Aggregate Base 4.3 45,000.00  Ton §2.17 £97,567.33
+ 431 Place Aggregate Base 4.3.1 45,000.00  Ton 5$1.63 $73,460.92
+ 432 Blue Top Aggregate Base 4,3.2 400,000.00  Square Yard £0.06 £24,106.42
= 5 Asphalt Concrete Hot Mix Type A 303 4253 35,000.00 Ton $42.62  §1,491,580.59

4. To add the Find feature to the register functions header, select the Options icon to the far
right of the search bar. Then select Always Expanded.

5. To search in a specific column only, select the Options icon to the far right of the search
bar. Then select Search in Selected Column Only. Search a specific term in your
selected column.

6. To close the Find functionality, click the Close icon to the left of the search bar. You can
also hold down the Shift key and then select the F3 key to use this feature.

e = A drop-down can be used to see a list of previous searches.

2.11 KEYBOARD SHORTCUTS
2.11.1 NAVIGATING IN A REGISTER

I

Arrow keys Move one cell up, down, left, or right
Tab Move to the next cell in the same row
SHIFT+Tab Move to the previous cell in the same row
Home Move to the beginning of the cell
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| Pes |

End Move to the end of the cell
Page Down Move to the last row in the register
ALT+Down Arrow Shows the contents of drop-down list choices for applicable fields
Numpad * Expands the subordinate leaves of a tree structure for the currently

highlighted branch

Numpad + key Expands the currently highlighted section to display subordinate
sections
Numpad - key Collapses the currently highlighted section to remove the display

of subordinate sections

CTRL+Spacebar Selects and Deselects a row
CTRL+Tab Toggles the display of open windows
ALT Activates form menus
ALT+F4 Closes active form
CTRL+G Opens the Go To Column navigator

2.11.2 NAVIGATING IN A RECORD

e

Left and right arrow keys Move one character left or right in an editable field

TAB Move to the next editable field in the record
SHIFT+TAB Move to the previous editable field in the record
Home Move to the beginning of the field
End Move to the end of the field
ALT+Down Arrow Shows the contents of drop-down list choices for applicable fields
F4 Shows the contents of drop-down list choices for applicable fields
CTRL+Spacebar Selects and deselects a row
CTRL+TAB Toggles the display of open windows
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e

ALT Activates form menus
ALT+F4 Closes active form
CTRL+G Opens the Go To Column navigator

2.11.3 MENU AND KEYSTROKE COMMANDS

All forms have their own set of commands specific to the form. Commands for a form show in the
ribbon on contextual tabs (Actions and More Actions) when it is open and the form is active. Click a
command on the tab to order it. Some routine commands can be ordered using the standard Windows
keystroke combinations (e.g., Ctrl+C, Ctrl+V) or right-click with the mouse when the field is selected.

2.11.4 FUNCTION KEYS IN ESTIMATE

F1 Open to the Help
F2 (grid) Edit cell value: Enter edit mode for cells that are editable on the grid
F2 (tree list) Edit cell value: Enter edit mode for cells that are editable on the tree
list
F3 Find next: Finds the next value based on the search criteria
F4 (grid) Show selection register or options in the drop down
F5 Refresh, wherever available
F5 Collapse subordinate Items
F6 Expand subordinate Items

Mejg=n In the Account Code Utilization Register, F5 can either refresh or collapse subordinates
based on whether an account code is selected.
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Lesson 2 Review

LESSON 2 REVIEW

1. The is a great way to get a summary view of your bid. You can see totals of
direct costs, indirect costs, profit and the overall bid price.
a. Job Folder

b. Data Map
C. System tab
d

. Resource Rate Register

2. You can group by more than one column to have multiple grouping levels.

1. True

2. False

3. Display settings for Units of Measure, Currency, and Colors can be adjusted from the
tab.

Setup

T o

Estimate

o

System
d. Help

LESSON 2 SUMMARY

As a result of this lesson, you can:

* Navigate the InEight Estimate system interface
¢ Navigate system settings

¢ Manage columns in InEight Estimate registers
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LESSON 3 — LIBRARY SETUP

LESSON DURATION: 60 MINUTES
LESSON OBJECTIVES

After completing this lesson, you will be able to use the following forms and explain their purpose:

e Library Job Properties
e Library Foundation Setup Data Register
e Library Resource Rate Register

e Library Assembly Register

LESSON TOPICS
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3.1 LIBRARY OVERVIEW

The Library is where you set up and maintain master information that imports into your projects,
including resource rates, tags, units of measure, cost item assemblies, and master breakdown
structures. It is also where security roles and permissions are configured.

You access the Library from the Backstage view in Estimate. Click on the Library link to open.

InEight®
ESTIMATE

Open a recent Job

- -

Jobs

More...

. Training Job
Library Job sC Job A Training Job -
Maricopa County...
Templates
Snapshots
Create a new Job from...

Archive | Restore
Settings + ] I_.|:I- I

[(H & &=

Scratch Template Existing Job Bid Wizard

You can also access the Library by clicking on the Library icon, when on the InEight Estimate landing
page.

Training Job - Estimate

System Actions Mare Actions
Labor m‘ ﬁ-’ 1 @ | @
Equipment ‘

) Resource CostItem  Standard Reports
Materials  Assemblies | Assemblies  Tables

BESOUFCES Assemblies Reports =
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When the Library opens, you see ribbons available under the main menu tabs. Each Menu tab has
unique sections which hold the necessary forms. In this lesson you will learn about each tab and their
components.

3.1.1 LIBRARY TABS

The Library has four tabs which organizes the forms under sections. The tabs are:
e Setup
e Estimate
e System
¢ Integrations

The Actions and More Actions tabs appear when you open a register and contain functions for the
register you have active. .

Estimate System Integrations Actions More Actions

3.1.1.1 SETUP TAB

Overview - Setup Tab

T ™

1 Job The job properties maintained in the library will serve as the default
Properties settings for any new estimate that is created from scratch. When
creating a new job it will inherit all the job properties set in the master
library.
2 Foundation A master set of account codes, tags, and units of measure. When a

Setup Data new folder is created, the master set is automatically copied from the
Library to the new folder.

3 Address Book Used to store and maintain all information pertaining to the companies
with whom you work and contact regularly (subcontractors, vendors,
architects, etc.).

4 Trench Stores and maintains common trench configurations that are used from
Calculator project to project.
5 Shift Rate Allows you to set up shift rate configurations that you can access at the
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10

11

12

13

Calculator

Resources

Most Used
Resources

Resource
Assemblies

Cost Iltem
Assemblies

Standard
Tables

User Roles

Access
Control

Reports
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Overview - Setup Tab (continued)

T ™

project level.

Opens the Library Resource Rate Register where you can create and
edit all resources and resource cost details available for import into
your projects.

For quick access to the Labor, Equipment and Materials tabs of the
Master Resource Rate Register.

Takes you to the Library Resource Assembly Register where you can
set up resource assemblies to import into individual projects.

Cost Item Assemblies are predictive models to quickly and accurately
estimate elements of a job that can be repetitive in nature on the job or
from job to job.

The Standard Tables are used to create and/or list job-level table data
that is accessible by any of the Cost Item Assemblies that exist in a job.
The Standard Table Record allows the user to create and or modify a
Table record. The Standard Table Register lists all the job level tables
created / available in the project.

Opens the Register where you assign users to a role which can include
the forms, tabs and menu commands to which each role has access.
The user names that are used when setting up your User Profiles come
from Active Directory, and they are the user names that each user uses
when logging onto his/her personal computer.

Allows you to customize your system permissions by restricting
destinations or commands that only designated roles should have
access to.

Opens the Reports window, where you can access all system reports
and configure the default report settings.
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Library - Estimate

: 3o oecprros O susoe 7 9 11
B 2 2 W @ & 5 % a B @ 4 [

22 Equipment
Job Properties  Foundation — Address  Trench shift Rate | Resources __ ) Resource CostItem  Standard User Roles  Access Reports
- Setup Data ~ Book  Caloulator Calculator - =X Materials  Assemblies | Assemblies  Tables Control

o Master Initialization o o Master Resources o Master Assemblies Roles and Permissions Reports

3.1.1.2 ESTIMATE TAB

Overview - Estimate Tab

T T S

1 Cost Opens the Library Cost Break Structure register, where you can define the
Breakdown CBS that will automatically import when a new project is created.
Structure
(CBS)

2 Account Used to roll estimate line items into an account code hierarchy and
Code benchmark against historical projects in a way that is consistent across

Utilization projects.

3 Work Opens the Library Work Breakdown Structure register, where you can
Breakdown define additional Work Breakdown Structures that will automatically import
Structures when a new project is created.

4 Master Opens the master Microsoft Excel template which will be embed into each
Workbook new estimate job folder. The cells in the embed excel workbook can be
linked to send information to or from InEight Estimate Fields.

5 Indirect Cost Takes you to the Library Cost Breakdown Structure Register where you
ltems can edit and define indirect cost items.

6 Job Finance Takes you to the Library Cost Breakdown Structure Register where you
can edit the Job Financing cost item.

7 Price % Add Takes you to the Price % Add On record, where you can define the price %
On add to be included in the Library CBS.

8 Prime Bond Opens to the Library Prime Bond record where you can define the bond
tables that will import automatically when a new project is created.
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Overview - Estimate Tab (continued)

T T S

9 Reports Opens the Reports window, where you can access all system reports and
configure their report settings.

— = - Library - Estimate

File Setup System Integrations
ﬁ Lam Account Code Utilization 2 m a0 Job Finance o | @

& Work Breakdown Structures % Price % Add On

Cost Breakdown Master Indirect ) Reports
Structure (CBS) Workbook * | CostItems [5%] Prime Bond
Master Breakdown Structures Workbook Master Indirect Cost Reports

3.1.1.3 SYSTEM TAB

Overview - System Tab

R

1 Customize Window to customize the field titles that are displayed throughout
various screens in the system, including all cost category titles,
user-defined Tags, and more.

2 Saved Views Allows you to save your views onto a disk or load from a disk.

3 Titles Allows you to save titles onto a disk or load from a disk.

4 Colors Allows you to save your colors onto a disk or load from a disk.

5 Output Allows you to save your output settings onto a disk or load from a
Settings disk.

6 Quantity Item Save your mapped quantity item source settings to your computer.
Settings You can then load the saved mapped settings into your Quantity

Item Sources Register.
7 External Menu to not only generate reports created by Estimate, but also to

Reports open programs, folders, documents, reports, or Internet resources
with the associated program.
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Overview - System Tab (continued)

=

8 External Allows you to open programs, folders, documents, reports, or
References Internet resources with the associated program.

9 Help Section  Offers you links to Estimate’s general Help menu, information
about Estimate (i.e., version number, system information, tech
support, etc.), What's New in the new version, and InEight’s
external website.

Developer Tools Integrations

s - - ~ -
_- & Saved Views 'n Qutput Settings Ly External References ® e About Estimate

@ Titleg + ﬁ’g Quantity Item Settings ~ @' Release Motes
Customize . Estimate InEight
@ Colors = ("4 External Reports = Help @ InEight.com University

Customize Help

EXTERNAL REPORTS

The External Reports menu lets you generate reports created by Estimate, and also lets you open
program files, folders, documents, or other internet resources.

System

External Reports -

External References -

=
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Each menu item can be added to the External Reports menu. Upon selecting one of the menu items,
the associated program, file, folder document or URL will open, as defined by the command entered in
the Open column.

Uy External Reports ~ @ (4]
InEight Folder '

Estimate Open Support Tickets

Integrations

Customize

Customize Menu Items
The External Reports menu allows you to not only generate reports created by Estimate, but it also
allows you to open programs, folders, documents, reports, or Internet resources with the associated
_ program. !
Each menu item that you add here will be added to the External Reports menu in Estimate. From there,
when you select one of these menu items, the associated Windows program will open the designated
program, folder, document, report, or Internet resource defined by the command. 5';
it
For additional help using this feature, click on the Help button. 14
r
Menu Order = Menu Text Open 9
2 Estimate Open S... https:/fineight.com/fhelp-support/ 109
3 Integrations https: /fineight.com/integrations/ L9
3.9
3,1
3,0
1,2
3,7
- 3,1
Add Edit Delete 0K Cancel Help
———— — — e

To add a new menu text, first select the Add button and enter in a name in the Menu Text field, then
type in the location of the new Menu text under the Open field.
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The External Reports menu allows you to not only generate reports created by Estimate, but it also
| allows you to open programs, folders, documents, reports, or Internet resources with the associated

| program.

Each m MNew Menu Item
when y

' proara mMeny Text:

! For adi Type the name of a program, folder, document, report, or Internet resource and
Windows will open it for you. If you do not know the command, dick the Browse button

= and select the file that you would like to open.
M

] :
s

Browse Cancel

Edit Delete 0K Cancel Help

TIP Customized Job Folder Tags match the view of the fields in the Job Properties form.

Esomate
T @ regrtan

Customize Help

g

IIIIIIIIIiiW
HEIBIEIEEEE E
A
»

serTag 4: [Tag 4

ser Tag 0

u
u
u
u
UserTags:
u
UserTag 7:
UserTag:
u

ser Tag 50 ground

6 & 0 o~

ser Tag 10: [Tag 10 Tag 22 @ a | a [mw -
Other expenses et

Subcontrat 0.0

Adto 000

B0 A=A Qi « » o2 |E aB

serTag 11: [Tag 11

iiliiiiiiiii

serTag 12: [Tag 12
b Folde Tam

Restore Job Folder Tag Tites. Fidd value Descrigion

Restore Al Customized Values,
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3.1.1.4 INTEGRATIONS

Overview - Integrations Tab

I -

1 Publish Estimate to Lets you publish an estimate job to a new project. This
a New Project requires the installation of the data provider plug-in.

2 Publish Cost ltems  Lets you publish cost items to an active project. This
to Active Project requires the installation of the data provider plug-in.

3 App Logs Lets you open the Estimate application logs in Project

Suite, view log details, and export to Excel.

Library - Estimate

Estimate System Integrations

App Logs o

Publish Estimate  Publish Cost Items
to a Mew Project 1o Active Project

InEight Platform

APP LOGS

The InEight Project Suite App Log lets you drill down to the Detail level which helps you find, analyze
and solve application errors.
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[ Export to excel
h o

Level Domain Area Message Route Correlati

Detail Error HDDesign Design & ge -> Publish NoMessag 0b1C7752-578F-4e1 2-b02b-ced8fadd14
Detalls  Ermor HDDesign Design £ ge -» Publish NoMessag subscriptions exist thatr 94fdc020-36h9-4636-207¢-08bf451262
Detail. & HDDesign Design & ge -> Publish NoMessag 12cac03b-T6ea-4808-9330-3d57bab3l
Detalls  Ermor HDDesign Design E ge -> Publish NoMessagy subscriptions exist thatr 205befab-fad1-428b-bcd-9770e450be
Detail. E HDDesign Design 3 ge -> Publish NoMessag 2c9a0ea?-eB98-4512-07h8-57a194732
Detalls  Error HDDesign Design E ge -+ Publish NoMessag subscriptions exist thatr 244b84e1-f82b-4017-894d-0d 5851031
Detslls  Enor HDDesign Design £ ge -> Publish NoMessag subscriptions exist thatr 30d60546-2581-421d-2416-2341 befde
Detslls & HDDesign Design & ge -> Publish NoMessag 5d9f3e77-f3d8-417e-ab07-a4bf51210e36
Detalls  Ermor HDDesign Design £ ge -» Publish NoMessag subscriptions exist thatr 43263592-4004-4040-b54-f64702650ff0
Detail. & HDDesign Design & ge -> Publish NoMessag scriptions exist that match top Cf6f4150-Geec-4fB2-boc7-14d2df91770c

InEight Project Suite App Logs - #42329000

Level

Error
TMestamp: - 5073-11-2811:2118 -0700  [Received: 2023-11-28 112118 0700]
Domain: HDDesign
Area Design
Correlationld: o1 17762-578f-4e12-b02b- cod8fadd1 46d [rowse chan |
Expires 2023-12-13 112118 -0700
Machine: 41 sdwkoooim
Message
EntityChange -> Publish NoMessageTargetsException
InEight.Platform.Messaging.NoMessageTargetsException

No ESB subscriptions exist that match topic=DesignCostitem, workType=EntityChange, sourceDomain=Dg,

at InEight.Platform.Messaging. ESBPublisher.<Publi g >d__101.Movel
-~ End of stack trace from previous location where exception was thrown ---

at System.Runtime.CompilerServices.TaskAuaiter. ThrowForNonSuccess(Task task)

at System.Runtime.CompilerServices.TaskAwaiter.HandleNonSuccessAndDebuggerilotific

at System.Runtime.CompilerServices.TaskAwaiter.ValidateEnd (Task task)

at InEight.Design.Common.Businesslogic.Services.EntityChangeService.<Publish>d_ 3"\ ice.cs:line 81

3.2 LIBRARY JOB PROPERTIES

The Library Job Properties form serves as a template for new jobs. Some of the tabs on the Library Job
Properties form hold basic settings that will require a default selection which will apply to all new jobs
created from scratch. Time can be saved when utilizing Library Job Properties, because the data and
settings you fill out will be automatically imported into a new job. Once imported, these settings can
be changed at the job level if necessary.

It may be helpful to complete the following tabs / fields at the Library level:

e Overview Tab Notes Field: Filling out the Notes section at the Library level would be helpful for
any instructions or reminders that you want to display on all projects’ Job Properties form. For
example, “Always double check currency exchange rates”

¢ Cost Basis Tab: Shift arrangements may or may not be standard across all projects, as well as
wage rates and scales. The cost basis default rules should be established within the library.

e Fuel Cost Tab: Entering a default fuel cost here will factor with the utilization of your equipment
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to be included in your equipment rates

Library - Estimate

Estimate System Integrations
AT o
= Y | A T L A ebor e
= T BT RS 22
#2 Equipment
JobPropertes  Foundation  Address Trench  ShiftRate | Resources __ Resource | Costltem Standard User Roles  Access Reports
- SetupData ~ Book Calculator  Calculator - 5 Materials Assemblies Assemblies  Tables Control

Master Initialization Master Resources Master Assemblies Roles and Permissions Reports

Job Properties ©

|overw=w | CoverSheet | CostBasis | Mnority Setup | Fuel Cost | Job FolderTogs | Pricng | Scheduie | Cash Fow | EqupmentMaintenance | Bendmarkng | Altemates

Code: Library Status: {Bidding ~| organization:

Description:

Notes:

Last Saved: 11/28/2023 9:32:00 AM
Job createdby:  Sarita

Source Job:

RELEVANT LINKS

System settings options
Archive and restore jobs
Video - Library job properties

Video - Backstage view

3.3 LIBRARY ADDRESS BOOK

Estimate's vendor and contact information in the address book register integrate with InEight
Platform's vendor and contact master data libraries.

Cancel

Vendors and contacts are created and maintained in Platform's master data library as a single source

repository of vendor and contact data.
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X Master data libraries /

Vendors

[} Name T Alternate name
0010118762 112391 ] Sun Star Shuttle
(] 0010105600 1127571 B.C Ltd Sparrow Excavation and Fencing
0O 0010069102 112792 Canada In DBA AMJ Campbell Van Lines
O 0010106779 1 4 Al ‘wolution Metal Works
0010097951 1135391 Ontarie Ltd DBA Orleans Autopro
O | oowon14422 1138357 Alberta Ltd Young Contracting
O | 0010111084 14 T Barcelo Flame Grilled Chicken
(] 0010092209 1165292 BC Ltd DBA Hydro Tech
O | 0010006725 1169577 Alberta Lid, DBA A-1 Portables
0010119746 11754491 Canada Ltd Synstone
0010102352 1189589 AB Lid Fire-Alert SE Edmonton
(] 0010118867 1190475 BCLTD Vancouver Island Forest & Marine

VENDORS

Zom

Zom

zom

zoon

Zom

Zom

om

Zom

zom

Zoon

Zom

Zom

3.3 Library Address Book

VENDOR TYPES

micops

\

.llooet

elta

¥

ans

anoka

~

Jurnaby
“rnaby
rose
itford
dmonton

Juncan

Library - Estimate

L L =] L=
B rreven 12] >3
Vendorsand  Vendrsand  Contacts
& Eportoxel | Contacts  Defouit Guotes
Prnt Lavouts rdit
Address Book Register @
Verder I erdor Hame = VendorToe
Q010037554 1 Aliance Geomatics LLC i
+ QNP -Vendor? 1_NP - Vendar2 1P Verdor
+ LM -Veol L Vendorl 19 Verdor
+ LMool L Vendorl 1.1 Verdor
Qni0sEse 10 Engineered Matesials LLC o1
0 I009RF 10K Engineer ed Materials LLC 001
10119449 11032119 Canada Inc 001
footes 1105500 Ontario Lid oa Fire Alert o1
IIATS  LORISBELTD 2001
QUIOOSTEZ; 11083005 Canadainc 003
9010033404 111008 Canada inc. 02
QIOIISST 1112004 Ontario Tnc o1
ANO1IETE2 1123510 B.C. Lid 001

The vendor and contact data structure shows a new hierarchy where multiple contacts can be assigned

to one vendor.

Address Book Register ©

Tax ID Tax Jurisdiction

000147200

Wendor ID First Name Last Mame Compary = Address Address 2
=P > Q0I0WETTS | Frank Matty Aberta
-— 00I0I06778  Tom Cross Aberta Ltd

- Merge vendirs

e W 8 2
» PR © i
Expand | Fiter  Caar Vi Vendors  View Contacts
Coloome = - Fiter
Workbook view InEight Platform
TaxlD  Taxdrsdctn  ddesst Mbemz ol cty State
461554451 4803300400 12614 120th Ave BE Urited States Of America Belewe Washngton
12345 b St Street United States Of America Scottsdale eizona
amssz1y 151813100 1162 Mancheser Ave United States OF America Wabash ndana
aass8713 1515913100 1162 Mancheses Ave United States Of America Wabash Tndona
731000852 7001509700 300 Greenbank Road Suite 12 Canada Ottawa Ontano
BIBBZ1154 001520100 1-890 Taylor Creek Br Canada Orlears. Ontaro
TaTIzens  Ponnuzan 1570 Okl Richter Poss Road Canada Gaayoos Brish Colu
a6SU8E 7001506500 PRIMARYAkress PRIMARYAD..  [nda PRIMARTAGHess!  Tomd Nack
551542 MOLS65130 6366 Mceewen Or -1 Canada Greely Ontano
BUEA30377  P001568530 5243 Robert Hogan Lane. Canada Seeley's Bay Ontano
FOIR0B5 000301500 1016 Quass Roost Crt Canada Kanmoops. Britsh Colu

/

Address 1/

7

Country |
Region

City

Country /
Region

Primary Email

Frankmatty @gmail com

Tomdross ggmail.com

3.3.1 PRE-EXISTING ESTIMATE DATA

Upon upgrading to version 23.6, address book records show a combined list of both pre-existing

Estimate Address Book records and Platform vendors and contacts. Pre-existing Estimate Address Book

records are still editable, but Platform records are not. The pre-existing disconnected vendors and
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contacts show a red glyph to the left of the Vendor ID column which shows that these records are
disconnected from Platform.

Address Book Register ©

VendorID = Vendor Mame
o+
/j Alpha
= Al.Ven1
Disconnected from
/| InEight Platform Ed-Sub2
;a’ + Example Vendor 4 DBE

The existing contact records also have a vendor record associated with it. New vendors and contacts
must be added via Platform, and changes to any Platform originated records must be modified in
Platform. This promotes the use of Platform as the single source of creation and maintenance for
vendor master data.

3.3.2 ESTIMATE SPECIFIC DATA

Certain vendor affiliated qualification information required for estimating purposes such as licensed,
bonded and insured data, or minority participation, is maintained directly in Estimate only rather than
in Platform.

There can be other Estimate vendor and contact data that only exist in Estimate and not in Platform,
such as License, Bond, Insurance and Minority Certifications, and Default Quotes.
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Address Book Register Vendor Record ©
Vendor Details
Vendor ID: 1_NP - Vendor2
Vendor Name: » 1_NP=Vendor2
Wendor Type: 1_NPVendor
Tax ID: 12345
Tax Jurisdiction: abc
Address 1: S0th Street
Address 2:
Country / Region: LUnited States Of America
City: Scottsdale
Srate: Arizona
Postal f Zip Code: 85258
Phone Number: 99999999
Fax Number: 963258741
Web Site URL:

Rafaranscs Mambass

L ]

Contacts Motes
B Licensed

Licensor:
Class:

Identification:

=] Bonded

Company:

Agent:

Phone:

Cost per 1,000: |

£ nsured

Company:

Agent:

License f Bond [ Insurance

Minority Certifications

Default Quotes

[1eff Lewis

A

GDIMNDGE3

Owens Inc

Phil Jones

Evergresn Insurance)

3.3.3 ADDRESS BOOK LAYOUTS

3.3 Library Address Book

You can choose between three address book page arrangements, vendors and contacts, vendors and

default quotes, and contacts.

Developer Tooks Integrations

o L

:E [ open P Down ik Feld e W W LE‘@ .|§|<E>
B previen [ . wikped | ™ PR
& Freview clete Unlink Field
Vendorsand  Vendarsand  Contacts Expand |  Filter  Clear  View Vendars  View Contacts
@ Eport toBxcel | Contacts  Default Quotes By Copy Collapse * = Filter
Print Layouts Edit Workbook View InEight Platform

Address Book Register ©

3.3.3.1 VENDORS AND CONTACTS

Vendors and Contacts are arranged where the vendor is the primary record in the register, and the

contacts associated with the vendor are shown as secondary detail records.
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File setup Estmate System Integrations
= 1
=, Preview ' ! Delete
. Vendorsand Vendorsand  Contacts
& ExportioExcel | Contacts  Default Quotes 5B Copy
Print Layouts

Address Book Register | ©

Dirag columns here to group

= |=— 0010106779 | 1128354 Aberta Ltd

Vendor ID First Mame Last Mame
> 0010106779  Frank Matty
0010106779  Tom Cross

3.3.3.2 VENDORS AND DEFAULT QUOTES

Vendors and default quotes are arranged where the vendor is the primary record in the register, and
the default quote group assignments for the vendor are shown as secondary detail records.
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3.3 Library Address Book

File Setup Estmate System Integrations

= Print z T |

8 RN

'ﬁ Preview ! !
Vendors and Vendorsand  Contacts

@) ExporttoExcel | Contacts  Default Quotes

Print Layouts
Address Book Register ©

Drag columns here to group

Vendor ID Vendor Name
0010087554 1 Aliance Geomatics LLC
> | 1_NP - Vendor2
Resource Resource
Code Description

= Asphalt Materials

3.3.3.3 CONTACTS

[ open
Delets

B8 Copy

Contacts are arranged where the contacts are shown in a flat list and are not secondary detail records
under the Vendor. This layout can be used to search more easily for contacts regardless of their vendor

assignment.

SEp Esbmate SySiem Integrabons
'E" Print @E u_?l;h HE Delete
=8 Preview ' | Copy
) Vendorsand Vendorsand — Contacts -
Ef EporttoExcel | Contacts  Default Quotes Fill Dow
Print Layouts Edit
Address Book Register ©
rag columns here to group
First Name Last Mame Company
Madeesha Karunanayaka A
Joe Langmore You.Inc
TestUser 103 8gmal.c... Testlser 103@gm...  TestUser 103@&gmad. com
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3.3.4 VIEW VENDORS AND CONTACTS IN INEIGHT
PLATFORM

Select View Vendors or View Contacts to open a new InEight Platform master data vendors and
contacts browser.

= G  Master data libraries / Vendors

Vendor >  Editwendor VENDOR DETAILS USERS CONTACTS

Vendor details

.1 * Name

0010010622 Smith and Constructics|
Vendor tax ID Wendor tax jurisdiction
120998677 7001910900

Available - Canadian Dollar

3.3.5 VENDOR AND CONTACT CREATION

You can quickly create ad hoc vendors and contacts via the Quote Register and Record forms.

After you receive vendor quotes and you are ready to enter quote information, it can be an optimal
moment to create new vendors and contacts if they are not currently in the Address Book. Creating
vendors and contacts on the fly while the vendor quote information is readily available, and then
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entering the quote information is more expedient than leaving the quote to create the vendor and
contact in Platform. This is especially useful when you have multiple new vendor quotes.

You can create vendors and contacts on the fly in both the Quote Register > Address Book Register
Library and directly from the Quote record.

Quote Register

Quote Register ©  Quote Record

Drag columns here to group

Desaription &= ELT& Vendor Vendar Name Contact $;;5" ?:t:de'd
£ Asphalt Materials Received Lewis Concrete - AAL Lewis Concrete <Ad-Hoc Contact> $1,115,575... s
Ve comsraons BN -5t S s [0
J#  Guard Rai Items Invalid SUB4 iz suB4 SLB4 -- Harry Belefony £0.00 -

new J-11 Received 51-5--51-5
Address Book Register - Library
g Pipe Materials Received Ven10
/& Pipe Materials Received  Example Vendor 4D8i  Actons
Jo s Received  Example Prime Contra L@@ L[E(l_} Qv /J, W W \'I%ED ! _AC
/2. SinHtems [l Barple sub #3908 &R Cony . | I ]
Sign Items Incomplete  [Enter Vendor Name] Vendorsand  Vendors and Expand [  Filter  Clear View Vendors  View Cont
Contacts  Default Quotes Colapse - - Filter
Ja Site work Recefved | Civilworks Inc. —Ven
Layouts Edit View InEight Platform
test Received | [Enter Vendor Name] TIEVT TEST
* 999099 Robert Roberts z002

(]

=

2=
=
=

Lewis Concrete

Quote Record

Quote Register Quote Record ©
Header

Description: | Asphalt Materials

vendor: | <Ad-Hog Vendor >

=l

=

Contact: | <Ad-Hoc Contact>

Primary Email: |

External Ref.: |

For example, when you are in a quote record and need to quickly create a new vendor because the
vendor you received a quote from does not yet exist, you can select the Vendor Quick Add button, and
then enter in the vendor details in the Vendor Record — Library form.
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Quote Record O
Header

Vendor Details:

Desoription: | Sete work o

Wendor ID: = V187

Vendor: | cAd-Hae Vendar > ‘r" Wendor Name: ®= (Leéwis Concrete ]

Contact: | <Ad-Hoc Contact> Y] vendar Typa: Z004 -
Primary Email: | | Tax ID:
Extarnal Ref.: | Tax Jurisdiction: |

Resources | Cost ltems

Package =

Package = Code & RFQID
B P1(DemoExav,Grading)

0 P2 (Assisted Parking Lot)

o P3 (Paving)

Quaote Group

Address 1= ,W
Address 2: ]

Country { Region: Urited States Of America =
Cty:  [Phoemx |

State: | Arizana -
Postal [Zip Code:  [B5256 ]
Phone Number: 480 555 2656

Fax Mumber:

Web Site URL:

Reference Number:
Quote

Canmency: .5, Dollar -

DoMetUse: [

Estimate Essentials User Guide

Vendor Record - Library

oK 3 Mext >

You can also add additional qualification information in the License/Bond/Insurance and Minority

Certifications tabs.
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Vendor Record - Library

—

Vermdor On:talk Contacts | Notes

Vendor 1D: = [W187

Vendor Hame: = [Lewis Cancrete [T
vendor Type: | 2004 - Licensor: [John Lewis
Twxi0: | Class: [Ganeral Engineering
Tax Junisdiction: | ] Tdentification: :EOE 333055
Address 1 125 Magle Ave
s =] Bonded
Cowntry | Region: Urited States OF Amenica = Company: :’“"JE'\' Bonding
city: | Phagnix 1 Agent: :J'"" Smith |
R T Phone: |80 555 6582
Postal [ Zip Code: (45256 Costper Lo00: | 5309 Contacts | Motes | Licsrse [Bond | Irurance Diefault Quotes
Fhong Mumber: | 430 555 2656 [ Insured Mame  Awthority and Certification Number
Faxmumber: [ ] ) Hoee  [awsirss
webstsr: [ | Company: [Bribrict Omee |
Agent; |Tom Janes
Reference Mumber: L 1 - [ wse
Phong: | 480 568 6584
Quate Other Manority Cemifications:
Corency: | U5, Dollsr B A OBEL | CL036746
Do Motuse: [ [ oeez
[ oses
[ oBEs
[ oBEs
Qons
[ oeezr

Certification Comments:

The additional qualification information is added and maintained in Estimate and cannot
be added to the vendor record when creating vendors directly in Platform.

After the vendor is created, it is included in the Library Address Book and can be chosen as a vendor to
be used on a quote.
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@ - Address Book Register - Library
Actions
Drag columns here to group % | Enter text to search... 1 8 4
Vendor ID = Vendor Name Vendar Type Address 1 Cauntry / Tax ID LT
= Region Jurisd..
wi212-a tst =
N
2 @ewd
+ V201 MAINT. 2004 Add1 Albania T.303 -
+ VA3 J&8a
Vendor 1 wvendar 1 VT1
LY SR . ¥ Pp——" [T R R . e LT e
4 3

If you have a new contact to add, you can select the Contact Quick Add button, and then enter the
contact information.

Quote Record © Contact Record - Library

Header z

Contact Details

Description: | Site work |
First Mame: = |Robert Address 12 ||.25 Maple Ave |

Last Name: = |Cantor Address2: |

Vendor: | Lewis Concrete == V187 O i

i il :
Contact: | <Ad-#Hoc Contact™ o o/ Company: * |Lewis Concrete | Country/Region: | United States OF America

Primary Email: # |reantor@lewiscancrete.com State: | Arirana

Primary Email: |
Extarnal Raf.s | Contact Type: | Estmate Contact City: |Phoeno-< |
Department: | PostaljzipCode: [ss256 |
Resources | Cost Items
— Position: |Contracter | Fax Number: | |+
Package = Title: [5r. Contractord | Office Number: [480 555 2658 I
Language Freference: Maobile Number: |480 555 G887 |
P = Code & RFQID te 5a
adage B = Q Quote Group - ity
@ P1(Demo,Exav,Grading) Vendor ID: 187 Last Changed By: | Paul Trippi
B P2 (Assisted Parking Lot) Varlar: | Lenls Coneie =V iR B Last Changed On: | 12/29/2023 11:50:42 AM
B P3 (Paving) Do Not Use:

Cancel New... < Prav Next >

After the contact is created, it becomes associated with the newly created vendor in the Library
Address Book.
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Address Book Register - Library

Actions
Drag columns here to group x | Enter text to search... | | 1’:}
vendorID &= Vendor Name Vendor Type Address 1 Country / Tax ID Tax
- Region Jurisd..

f Lewis Concrete 125 Maple Ave United States Of America
Company = | Address 1 Address 2 City
= V187 Robert Cantor Lewis Concrete 125 Maple Ave Phoenix Ari
P >
»

The vendor and contact information are stored in Platform where it can be easily accessed by selecting
one of the vendor ID links in the Library Address Book. The vendor can also be used by other Platform

applications.

Address Book Register - Library

vendor 3 Edd vendor VENDOR DETAILS USERS CONTACTS

Vendor details

o -

18 Lewis Concrets

e ndor

z008

endar tax 10 vendor dictio
St Oefault cumency
dvailable
Dieéault payment terms Default mooterms

Default incoterms locaticn

Addresses | ve 3 Pt vendor VENDOR DETAILS USERS CONTACTS

Country / Region

Ful name Frinosy cmad Contoct type Office number

] | Rabert Cantter Name23@Examphe com Edtimate Centast 480555 2658

NN
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3.3.6 MERGE AND UPLOAD CONTACTS AND VENDORS
INTO PLATFORM

You can manage and retain all vendor information in the Estimate Address Book that are not linked
(disconnected) with Platform, including contacts and companies that are referenced in multiple
estimates, quotes and RFQs.

Disconnected Vendors and Contacts can be merged with existing Platform vendors and contacts, or
they can be uploaded to create new Platform vendors and contacts by navigating to the Library > Setup
> Address Book. You can also upload new Estimate vendors and contacts into Platform's master data
repository.

Estimate's process of uploading contacts and vendors into Platform's master data library (as a means
for all InEight products to access as a source system of contact and vendor data) not only lets you send
this information to Platform, but it provides you with a mechanism to clean up and simplify existing
Estimate Address Book data. For example, your current Estimate Address Book might contain many
duplicate contacts containing the same first and last name, but with different addresses, emails, or
mobile numbers. Merging these records helps administer customer data better so that you can
eventually only maintain a single contact or vendor that has the most up to date and most accurate
information.

Address Book Register ©

Vendor ID Company = Vendor Address 1
Z Phoenix Contractors Example Vendor 1888 100 Tenth Street
Z Phoenix Contractors Example Vendor 1666 100 Tenth Street
Z Phoenix Contractors Example Vendor 5551 100 Tenth Street
Z Phoenix Contractors Example Vendor 222 100 Tenth Street

3.3.6.4 DISCONNECTED CONTACTS AND VENDORS

Pre-existing Estimate vendors and contacts that are disconnected from Platform show a red glyph to
the left of the Vendor ID column, and only exist in Estimate at this time. To only show the disconnected
records, click the column filter in the Vendor ID column, and then select (Blanks). You can either delete
the disconnected records or choose to merge or upload them into Platform.

Showing only the disconnected vendors or contacts helps you see the vendors and contacts that are
not connected with Platform.
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Address Book Register ©

, First Last
Vendor ID Y Name Name Com
B | values  TextFiters Phoe
Iy
4 Phoe
o Enter text to searc el
J Phoe
r m | (Al -
)4 (Al / Phoe
Z v | (Blanks) PC5
y Example Prime Contractor 13 PC3
4]
Example Sub #14 DBE
new
Example Sub #24 DBE
jose
Example Sub #8
InEi¢
Example Vendor 123 =
InEL
InEic
Clear Filter Filter Editor Close )
InEic
Sasi Test3 18D

Jlelg= All new library address book records must be created in Platform.

Vendor and contact ID's that show a blank do not currently have an associated Platform vendor
association, as these vendors were originally created in Estimate. These vendors have not been merged
into Platform, and therefore have no association with the vendor master data that resides in Platform.

. = = | A 1 Dow . -
E!! Print Lq@ L|__§|:} i L| Open Fill Down Link Field 4{ Y w ]l%
F.i( Preview ! ! e Delete ‘!1 Merge Vendors UnLink Field =

Vendorsand  Vendorsand — Contacts Expand f Filter  Clear View Venc
@]ﬂ Export to Excel Contacts  Default Quotes % Capy Collapse = - Filter

Print Layouts Edit Workbook View
Address Book Register ©
Drag columns here to group
Vendor ID Y Vendor Name = Vendor Type Tax ID Tax Jurisdiction Addresz 1 Address 2
wample Sub #34 DBE 900 First Street Suite 9000 -
First Last = "
‘endor ID Name Name Company =  Address 1 Address 2 City
2]’ Larry Jack Example Sub #34 DBE 900 First Str... Hometown

INACTIVE CONTACTS AND VENDORS

You can mark a vendor as Do Not Use in a contact record, which indicates the status of the contacts
associated vendor, and can only be set in Estimate when vendors are disconnected from Platform. The
record changes to red to signify it is inactive and cannot be used, but is not deleted from the system.
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Address Book Register Contact Record Vendor Record ©
Vendor Detais " | Contacts | Notes
Vendor ID: 490917301947

Drag columns here to g

Vendor Name: * |51st State

First Name
Vendor Type: 2002
Tax ID: 13
Tax Jurisdiction: Sth Level
st i | [ Ly
reter.
Quote Address Book Register Contact Record ©
Currency: U.5. Dollar
/ Contact Details
DENSERRS First Name: Tony Address 1: 300 Third Street
Last Name: LM Address 2: 300 Third Street

Title: jrtL Office Number: off-1
Language Preference: | English Mobile Number: mob-1
Vendor Security
Vendor ID: VID-008 Last Changed By: |InEight Service Account
Vendor: | DesinbConeult=) 8] Last Changed On: |8/2/2025 1:56:09 PM
Do Not Use: ,

To change the Do Not Use status, select the Vendor ID Platform link for the vendor record in Estimate.
In Platform, the Do Not Use flag can be maintained by selecting the Status field in Master Data Libraries
> Vendors, and automatically integrates with Estimate.

2 Master data libraries / Vendors

Vendor >  Editvendor VENDOR DETAILS USERS CONTACTS
Status Default currency
Available v Select one v
Q
| Default incoterms
Available Default incoterms v
Unavailable

Default incoterms location

Addresses PRIMARY REMIT TO ADDITIONAL
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STEP BY STEP — MERGE ESTIMATE VENDORS TO PLATFORM

1. Choose one connected and disconnected vendor, then select Merge Vendors with Platform.

= = f— | '

& Print qu@ 1'9 E] |'_, Open il Dowr & Link Fields e Y v \_E@ ;_ﬂ@ & Merge Vendors with Platform

R Preview ' t= | Merge Vendors nLink Field 2 2 & Upload Vendors to Platform
- 'endors and Vendors and Contacts Expand / Filter Clear View Vendors View Contacts

& Export to Excel i Default Quotes % Copy Colapse ~  ~  Fiter

Print Layouts Edit Workbook View InEight Platform

Address Book Register ©

Postal / Phone
Vendor ID Vendor Name = Address 1 City State Zip Code e Address 2 Vendor Type Tax 1

- e - T

» Note that the connected Estimate vendor previously exists in Platform, prior to the
merge of the two vendor records.

2. Select Merge.

The displayed vendors will be merged to the selected primary vendor.
Saved views:

Postal f Phone Fax Web St URL

Zip Code Number Number rency Boliottee

Primary Vendor ID = Vendor Name =  Vendor Type Address 1 Address 2 CGity

v Ven34 Ven34 700 Seventh... 700 Seventh.. Hometown 889500 111-1314... | 222-1342.. CND Dollar
Ven36 700 Seventh. . Hometown 889500 111-131-4... | 222-134-2. CND Dollar

» Notice that the primary vendor is checked, as this record already exists in Platform.

» Other records where the Primary field is not checked are records to be merged into
the primary record.

 Fields in yellow for the non-primary records are deltas. These deltas will not be
merged, and differences will be lost once they are merged, as the data that exists in
Platform takes precedence. If you want any of the disconnected data to exist in
Platform, you need to manually change the data in Platform. The advantage for this
is to allow for the disconnected Estimate vendors to become associated with an
already existing Platform vendor, which lets the contact to still be keyed in areas it
was used in Estimate, such as in Quotes and RFQs.

3. Select Yes in the Attention dialogue box to acknowledge that the attributes of the primary
contact will exist.
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Attention

The attnbutes of the pnmary vendor will persist and the default

quotes for the other vendors will be removed. This operation will
save the Library.

Are you sure you want to continue?

Yes No

STEP BY STEP — UPLOAD ESTIMATE VENDORS TO PLATFORM

1. Choose a disconnected vendor with an associated contact, and then select Upload Vendors to

Platform.
E! Print LEl Lﬁ I L@ !LEl \_r} Merge Vendors with Platform
'%_ Preview :@ Q IE @ ® ‘_r'-j’" Upload Vendors to Platform

Vendorsand  Vendorsand  Contacts | View Vendors  View Contacts
@ ExporttoExcel | Contacts  Defeult Quotes

Print Layouts InEight Platform -

Address Book Register ©

Drag columns here to group Saved views: Previous View - | p

Vendor Y | Vendor Name = :ndor Type Country / City State Eustll Rhane

D = i Region Zip Code Mumber
g Example Sub 98 Hometown AZ 839050 111-123-120 +
Z Example Sub 77 United States OF America Hometown Arizona 839030 111-232-34;
g ample Vendor 123 _. United States Of America Hometown 839060

Wendar 1D First Mame Last Mam State P.DStal / Comny / Primary Email Catact
Zip Code Region Type
¥ Pat Roberts Az 839060

Pl

2. Click the + symbol to the left of the Vendor ID to expand all the records. Select Upload to sync
the vendor shown with the contact in this window to Platform.

¢ The preview dialog box opens.

3. Select Yes in the Attention dialogue box to confirm that the vendor will be uploaded to Platform
and synchronized back to the Estimate Address Book library.
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FusLal § Lounuy § gL L«

City State S B
Attention

Yendors will be uploaded to Platform and synchronized back to
Estimate. This operation will save the Library.

Are you sure you want to continue?

es Mo

STEP BY STEP — MERGE CONTACTS TO PLATFORM

1. Choose one connected and one disconnected contact, and then select Merge Contacts with

) . = | 2 e ) | = -
Eh Print ]‘Q@ LDQ IE [4 open 3 LinkFields '= B :lgl@ (& Merge Contacts with Platform
'%' Preview ! ! Dl UnLink Field 3';‘ Upload Contacts to Platform
Vendors and  Vendors and Contacts Expand [ Clear Wiew Vendors  View Contacts
& Export to Excel Contacts  Default Quotes Bg Copy Collapse Filter
Print Layouts / Workbook View InEight Platform

Address Book Register ©

Saved views: [

Drag columns here to group

OFirstStr... | 343 Plum st United States OF America
p
‘ 300 First 5tr... | 900 First StreetSu... | United States OF America

¢ Prior to the merge, note that the connected Estimate contact previously exists in Platform,
prior to the merge of the two contact records.

0A-T01-238 @ J:‘L

= @  Master data libraries / Contacts

CONTACTS CONTACT TYPES
® 4 v B o a
Full name T Primary email / Mobile number City Created on Address 1 Is User Al
month/day/ All
O Larry Jack tc@yahoo.com / 111-565-8958 Hometown 09/15/2023 01:07:50 PM 900 First Street Suite 9000 false ot

2. Select Merge.
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The displayed contacts will be merged to the selected primary contact.
Saved views: | Previous V

y First Last , Contact " Country / < . Postal / Mobile Office f
Primary Tame Nesme Company =  Primary Email Type = Address 1 Address 2 Region State City 7 Code Nomber Number i

Larry Jack

tc@yahoo.com  Estimate Cont.. 900 First Stree. 900 First Str United State Arizona Hometown 889009 111-5658 111-332-4.

pt@sub.com 900 First Stree... 343 Plum st United State... Alaska Hometown 835009 111-3324... |

Cancel

¢ Notice that the primary contact is checked, as this record already exists in Platform.

e Other records where the Primary field is not checked are records to merge into the
primary record.

¢ Fields in yellow for the non-primary records are deltas. These deltas will not be merged,
and differences will be lost after they are merged, as the data that exists in Platform takes
precedence. If you want any of the disconnected data to exist in Platform, you need to
manually change the data in Platform. The advantage for this is to allow for the
disconnected Estimate contact to become associated with an already existing Platform
contact, which lets the contact to still be keyed in areas it was used in Estimate, such as in
Quotes and RFQs.

3. Select Yes in the Attention dialogue box to acknowledge that the attributes of the primary
contact will exist.

Attention

The attributes of the primary contact will persist. This operation will
save the Librany.

HAre you sure you want to continue?

Yes Mo

¢ A message shows it was successful, and the entry is created in Platform.
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Attention x

Successfully merged contacts with primary contact.

) Master data libraries / Contacts

CONTACTS CONTACT TYPE.
® 4 O B o Q
Full name 7 Company Primary email Address 1 Address 2 / Created on D
larry jack month/day/year
O LayJack Example Sub #4 DBE te@yahoo.com 900 First Street Suite 9000 900 First Street Suite en/ retown 09/15/2023 01:07:50 PM

STEP BY STEP — UPLOAD CONTACTS TO PLATFORM

1. Choose a disconnected contact, and then select Upload Contacts to Platform.

=h print LFII@ ]‘[(13 iﬁ ) L@@ 3 _;@ % Merge Contacts with Platform

R, Preview Upload Contacts to Platform
Vendorsand Vendorsand  Contacts = View Vendors  View Contacts
& BxporttwExcel | Contacts  Default Quotes !

Print Layouts InEight Platform
Address Book Register ©

olumns here to group / Saved views: | Previous Vie -]

X N Country / Postal /
Vendor ID Y | First Name LastName = Address 1 Address 2 Region State City Zip Coch

2. Select Upload to send the contact shown in this window to Platform.

e The purpose of the preview dialog is to let you see what will be created in Platform, and to
correct any issues before completing the operation.

The displayed contacts will be uploaded to Platform. /
Drag columns here to group Saved views: | Previous Vie -

. / Postal / Contact Language Mobile Offis
First Name Last Name Company = Primary Email Zip Code Type Preference Number Num
Keesha Blank SUBS 2@gmail.com / 889007 000 111
« >

¢

3. Select Yes in the Attention dialogue box to upload the contact to Platform, synchronize back to
Estimate, and save to the library.
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Attention

Are you sure you want to continue?

Yes

Contacts will be uploaded to Plattorm and synchronized back to
Estimate. This operation will save the Library.

No

Attention x

Successfully uploaded contacts to Platform,

@ E ® & Pomoteuser

Full name T Primary email

Keesha Blank 2@qgmail.com

Office number

111-222-3232

Mobile number

CONTACT TYPES

4
/
’

Estimate Essentials User Guide

A message shows it was successful, and the entry is created in Platform.

QA-TO1-23.8

B @ Q
Created on il
month/day/year

09/14/2023 01:26:22 PM
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STEP BY STEP — CREATE VENDORS AND CONTACTS VIA QUOTE

RECORD

1. Navigate to the Quote register and open an existing quote.

Quote Register @

Drag columns here to group

Quote

Description = Status Vendor Vendor Name Contact
hephel Meterics [ 1 [rer——— levis Conaete | <ad e Contact> |
[% gpen
/. Guard Rail Items - SUB4 SUB4 — Harry Belefony |
new J-11 Received vendor-Nada — V206 e Bew <Ad-Hoc Contact>
A Fipe Materials Received Adams Concrete -- Ven 9 Delete <Ad-Hoc Contact>
A Pipe Materials Received Example Vendor 4 DBE < Cut Example Vendor 4 DBE — Leste...
A sa Incomplete  Jose Luis Maldonado — % Copy Example Prime Contractor 211 ...
/v, Sign Ttems - Example Sub %34 DBE Basie Example Sub %34 DBE — Larry .. |
Sign Ttems - 0703172 BC Ltd — 0010 FUE <Ad-Hoc Contact> |
ﬁ Site work Received Lewis Concrete — V187 | 5 Link this field to Excel Lewis Concrete -- Robert Cantor
test Received [Enter Vendor Name] — | =5 UnLink from Excel =<Ad-Hoc Contact>
. C Refresh

2. Click the Vendor Quick Add icon in the Quote Record register.

Quote Register Quote Record ©

Header

Description: | eWEga =T Rte==

Vendaor: LmEntrEmsm...E'lil !

Contact: | <Ad-Hoc Conta... @ [

Primary Email: | |

External Ref.: |

3. Inthe Vendor Record - Library window, enter a new Vendor ID and Vendor Name. Under the
Vendor Name field, enter in the other non-required information such as the Address and Phone
Number.
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Vendor Details

Vendor ID: *
Vendor Name: =

Vendor Type:

Tax ID:

Tax Jurisdiction:

Address 1:

Address 2:

Country { Region:

City:

State:

Postal /Zip Code:

Phone Number:

Fax Number:

Web Site URL:

Reference Number:

Quote
Currency:

Do NotUse:

Ven7869
Adams Concrete

2002 -

1029 King 5t

Il

United States Of America =

Scottsdale

Arizona -

85258

480 555 6987

ABL-3947

i

U.5. Dollar -

O

Contacts

Notes:

Vendor Record - Library

Notes

Tag 1:
Tag 2:

Tag 3:

License { Bond / Insurance

Minarity Certifications

Last Changed By:

Last Changed On:

Estimate Essentials User Guide

Default Quotes

Paul

1/24/2024 2:11:43 PM

Cancel

< Prey Next =

4. On the right side of the window, enter any relevant information in the tabs, such as vendor
notes and license, bond and insurance information, and then click OK.

License f Band / Insurance

Concrete

Contacts Motes
Tag 1:
Tag 2:
Tag 3:
Notes:

o -
o -

Minarity Certifications

Last Changed By:

Last Changed On:

Faul

Default Quotes

1/24/2024 2:17:05 PM

- Use this vendor for project work in the Phoenix metro area.

- Reference number must be induded on the work invoice upon project completion. |

=)
S

Cancel

New...

< Prev

MNext =

The new vendor is now added to the Estimate Address Book Register - Library.
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Address Book Register - Library

Actions

by & S 4 TR @ £
1
i % Copy » Qo
Vendors and  Vendors and Expand / Filter  Clear View Vendors  View Contacts
Contacts Default Quotes Collapse = - Filter
Layouts Edit View InEight Platform -
Drag columns here to group x | Enter text to search... |
VendorID = Wendor Name Vendor Type Address 1 E:;?o:y / City State I|
Ven7a63 Adams Concrete 2002 1029 King 5t United States OFf America Scottedale Arizona o |
VEN202 wen 202 1 b
VEN202 ven 202 Quote Record @ saga -
+ Ven o7 Civilworks Inc. Header j Arizon
+ y300 Vendor 300 Description: | TREIIEREER e $246,720.00
$12,336.00
+ vz Qzv3

Vendor: || Adams Concret... @ {z]| Vendor Name: Adams Concrete (
Contact: | <AdHoc Conta... @ {2/ First Name: $0.00

External Ref.: |

$250,056.00
Resources Cost Items b3
Drag columns here to group Saved views: Previaus View
. - 2 No

Code = Quote Group = Description split
f# WPP10 Pipe Materials Pipe 10" PVC SDR21

MPP24 Pipe Materials Pipe 24" PVC SDR35
& MPR 36 Fipe Materials Pipe RCP 36 In
.

NN

< Prev Mext >

The following steps help to confirm that the vendor was created correctly, and that it can
be used to update or maintain the vendor after it has already been created, including steps
to create a new contact on the fly.
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5. Click the new Vendor ID in the Estimate Address Book Register - Library.

By B o= s

|
| Rcopy | 7
Vendorsand  Vendors and Expar
Contacts Default Quotes Collaps=
Layouts Edit
Drag columns here to group
Vendor ID = Vendor Mame
Ven7369 Adams Concrete

The new vendor opens in Project Suite > Master data libraries > Vendors.
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Master data libraries / Vendors

Vendor >  Editvendor VENDOR DETAILS USERS CONTACTS
Vendor details
*1D * Name
Ven7869 Adams Concrete
Alternate name Vendor type
7002
Vendor tax 1D Vendor tax jurisdiction
Status Default currency
Available v Select one
Default payment terms Default incoterms

Default payment terms v Default incoterms

Default incoterms location

AddrESSeS PRIMARY REMIT TO ADDITIONAL

Country / Region Address 1
6. Click the Contact Quick Add icon in the Quote Record register.

Quote Register Quote Record ©

Header

Description: | Pipe Materials

Vendor: | Adams Concrete -- Ven 7865 i

]
_ :
Contact: | <Ad-Hoc Contact> |§ﬂ' 2]

Primary Email:

External Ref.:

7. In the Contact Record - Library window, enter the First Name, Last Name, Company, and
Primary Email. Under the Primary Email field, enter in the other non-required information such
as the Address and Phone Number, and then click OK.
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IZl Contact Record - Library — [m] *

Contact Details

First Name: * |Tom Address 1: |123 Maple Dr |

Last Name: * |I'~‘1cHenr5-I Address 2: | |

Company: * |Vendor 1 Country/Region: | United States Of America

Primary Email: * |Narne25@!Enamp|e.com State: | Arizona
Contact Type: | Estimate Contact City: |Scott5da|e |
Department: |E5tirnating | Postal/Zip Code: |85259 |
Position: |E5timator | Fax Number: | |
Title: |Lead Estimator | Office Mumber: | |
Language Preference: Mobile Number: |480 555 3553 |
Vendor Security
Vendor ID: Wend 1 Last Changed By: | Paul Trippi

Vendor: | Vendor 1--Vend 1 2] Last Changed On: |1/25/2024 9:11:43 AM

Do NotUse:

Cancel Mew... < Prev Mext =

The new contact is now added to the Estimate Address Book Register - Library.
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TR

& copy |
Vendors and  Vendors and Expand / Filter ~ Clear View Vendors  View Contacts
Contacts Default Quotes Collapse ~ - Filter
Layouts Edit View InEight Platform -
Drag columns here to group Saved views: | Previou - Enter text to search...
WendorID = Vendar Name Vendor Type Address 1 Country / City State ‘|

Region

m 1029 King S5t United States Of America

3.3 Library Address Book

a
Vendor ID First Name | st Name. Comnan =  Address Address 9 City ta
Quote Record @ \ =
-+ | ¥en785% Tom
Header
.
Description: | Pipe Materials §246,720.00
£12,336.00
Wendor: | Adams Concrete -- Ven7869 @ [z| VendorName: Adams Concrete i
Cantact: | Adams Concrete — Tom Henrys [ §E First Name: £0.00
Primary Email: Last Name: |
External Ref.: I $259,056.00
Resources Cost Items ( x
Drag columns here to group
Code = Quote Group = Description g;l‘t Free Awarded Dr
A MPP 10 i  Pipe Materials Pipe 10" PVC SDR21 o
MPP24 Fipe Materials Pipe 24" PVC SDR35 o
& MPR3& Pipe Materials Pipe RCP 38 In V¥
- [l ] ]
«
< Prev Next >

8. Click the new contact Vendor ID in the Estimate Address Book Register - Library.
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& = copy | Sy W W
2] A P B
Vendors and Contacts Expand Filter  Cle
Contacts Collapse - - Filt
Layouts Edit View

Drag columns here to group Save
Vendor ID = Vendor Name Vendor Type

= i— Ven7859 . Adams Concrete 002
Vendor ID First Name Last Name

= | Ven7869 Tom Henrys

The vendor opens in Project Suite > Master data libraries > Vendors, and includes the new
contact.

Vendor > Editvendor VENDOR DETAILS UseRs conTaACTS
Vendor details
‘o “Name
Ven7869 Adams Concrate

e 777—/_\" - \_/—\' — 77\_/_\"' — -

Addresses PRIMARY REMITTO ADDITIONAL
Countty Region Vendor > Editvendor VENDOR DETAILS USERS. CONTACTS
? Full name. Primary email Gontact type Office number Mobile number Gity
O | TomHenrys Tomhenry@adamsconcrete com Estimate Contact 480 5552387 Scottsdale

RELEVANT LINKS
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System settings options
Archive and restore jobs
Video - Migrating your Estimate address book

Video - Library job properties

3.4 LIBRARY JOB PROPERTIES PRICING
3.4.1 JOB PROPERTIES OVERVIEW

In Job Properties Overview > Pricing, there are balanced price and markup options in the bid pricing
area which lets you categorize costs, markup various costs in an estimate, and distribute that markup
throughout the bid which establishes balanced bid prices.

Job Properties ©
Cverview Security Cover Sheet Cost Basis Minority Setup Fuel Cor Pricing

Balanced Price Options
Calculate Balanced Pay Item Prices using:

(® Cost Amount
(O Billing Amount

Distribute Unassigned Cost/Billing Amount by:

(®) Individual Categories
(O Top levelCategories
(O Total Cost/Billing amount
Markup Options
Markup Pay Item by:

(® Using Weighted Distribution

O Keeping Markupwith Assigned Costs

Categorize Business Overhead as:

O Indirect Cost
(® Markup

Calculate Proposal Recap Forecast Markup using:

(® Unit Markup (current) x Forecast (T/0) Quantity
() Forecast Price - Total Cost/Billing
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3.4.2 BALANCED PRICE OPTIONS

This option determines if a pay item will use the cost or billing amount values of the assigned cost
items as the basis for determining a balanced bid price. This also determines if the AutoPrice command
will use the cost or billing amount values.

3.4.2.1 CALCULATE BALANCED PAY ITEM PRICES USING
COST AMOUNT:

Balanced Price Options
Calculate Balanced Pay Item Prices using:

(®) Cost Amount
() Billing Amount

Price Breakdown Structure @

Description Assigned Unassigned | Total :‘;gﬁ ;‘;]fm ?xﬂ LB’;‘;‘;W“ ;1::; ?‘;rgﬁ ﬁ;t

v A TargetPrice £5,040,796.20 £1,222,999.47 100.00 €5,164,30.. §L,123,41. $5,288,21. 100.00
v [ Markup $0.00  $896,159.52  $896,159.52 1431 $0.00 $755,068.85 $755,068.85 12.01

v A\ TargetProfit $594,133.61 459413361  9.99 1L13 $0.00 $447,511.92 $447,511.92 7.12 8.00

|, Indirect Cost Markup §14,73068  $14730.68  0.24 5.00 $0.00  $27,331.76 27,3307 0.43 8.00

Direct Cost Markup $579,4294  $573,W29%  9.25 e $0.00  $420,180.16  $420,180.16 6.68 8.00
v A Business Overhead $0.00  $302,02590  $302025.90 482 $0.00 $307,556.93 $307,556.93 4.89
BB Price % Add-On $0.00 $281,870.81  $281B870.81  4.50 $0.00 $281,870.81 $281,870.81 4.48
88 JobFinancng $0.00 $5,762.53 8576253 0.09 $0.00 8575253  $5,762.53 0.09
BB Indirect Cost Escalation £0.00 $2,13L11 £2,131.11 003 $0.00  §2,983.55  $2,983.55 0.05
55 Drect Cost Escalation $0.00 §12,26146  $12,261.46 020 $0.00  $16,990.05  $15,990.05 0.27
i Business Overhead tems £0.00 £0.00 .00  0.00 £0.00 £0.00 £0.00 0.00
~ Ak TotalCost $5,040,796.20 |  $326,839.95 $5,367,636.15  85.69 $5,16480... $368,342.37 $553314. §7.99
v A IndrectCost $0.00| $325839.95 432583995 520 $0.00 $367,392.37 $367,342.37 5.84
» 4 JobOverhead §0.00 | $325,839.55 $325839.85 520 $0.00 $367,342.37 $367,342.37 5.84
B2 Prime Bond §0.00| $45618.98  $45618.98 0.73 S0.00  $45,618.98  §45,618.98 0.73
BB indrect Cost Add-On $0.00 $5,734.95 3573495 0.09 S0.00  $5,690.%  $5,64.% 0.11
BB Direct Cost Add-0n §0.00| §99,189.74  §99,189.74 158 $0.00 $103,316.14 $103,316.14 164
&% Job Overhead Items $0.00 | $175,296.28  $175296.28  2.80 $0.00 $211,766.79 $211,766.79 3.37
v 4 DirectCost $5,040,796.20 $1,000.00 $5041,796.20  80.49 §5,164,80..  $1,000,00 $5,16580.. 82.15
oL DiectCost Items £5,040,796.20 £1,000.00 $5041,796.20 80.49 €5,164,80..  $1,000.00 $5,165,0... 82.15
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3.4.2.2 CALCULATE BALANCED PAY ITEM PRICES USING
BILLING AMOUNT:

Balanced Price Options

Calculate Balanced Pay Item Prices using:

(O Cost Amount
(@) Billing Amount

Price Breakdown Structure  ©

—— P —— Tota ::;[ *af W Unassigned  Total %of %af

Eiling Biing Target

.v‘_immsmE

v M TargetPrice $5,040,796.20 §1,222,999.47 $6,263,795.67 100.00 $5,164,80.. $1,123,41.| #6,288,21 | 100.00
w 5 Markap £0.00 S506,159.52 $896,159.52 1431 $0.00 S755,068.85 S$755,068.85 1201
w [\ TargetProfit §594,13261  §594,13361 9.9 1113 $0.00 $H7,511.92 §447,511.92 7.12 8.00
Y, Indrect Cost Markup $14,730.63 $14,730.63 0.24 5.00 £0.00 $27,331.7% $27,331.7% 0.43 B8.00
\, Direct Cest Markup £579,402.94 £579,402.94 9.25 1149 0,00 $420,180.16 &420,180.16 6.68 B.0D
w = Businest Owerhesd £0.00 £302,025.90 §302,025.50 482 #0000 $307,556.93 §307,.556.93 469
HE price % Add-On $0.00  §2818M.81 SMLEMEL 450 $0.00 $281870.81 528187081 4.4
BB 3ob Finandng .00 $5,7%62.53 §5,762.53  0.09 $0.00  $5,762.53  $5,762.53 0.09
EE Indrect Cost Escalation £0.00 £2,131.11 $2,131.11 0.03 £0.00 $£2,383.55 $2,983.55 0.05
95 Direct Cost Escalation €000 $12,26146  $1226146 020 .00 $16,540.05  $16,840.05 0.27
S Business Overhead ltems $0.00 $0.00 $0.00 0.0 $0.00 $0.00 $0.00 0.00
~ Ak Total Cost §5,040,796,20  $326,339.95 $5,367,63%.15 8569 §5,164,90... | $368,342.37  $5,533,14. a7.59
» & Indirect Cost £0.00 $325,839.95 £325,639.55 5.2 $0.00 | 8357,342.37 8367,342.37 5.64
v = Job Overhead £0.00 £325,839.95 £325,6839.95 5.20 S0.00 | $367,342.37 $367,.342.37 5.64
05 Prime Bond $0.00 $4561858  $45618.58 073 $0.00 | $45,60B.58  $45,618.98 0.73
B2 Indrect Cost Add-On $0.00 §5,734.95 $5,734.95  0.09 $0.00 | 5559095  $5,540.46 0.11
Eg Dwect Cost Add-On £0.00 £39,189. 74 $99,1539.74 L5 $0.00 | $103,316.14 $103,316.14 LE4
.'J Job Overhaad [tems £0.00 £175,296.28 £175,296.28 ZED £0.00 | £211,766.79 $211,766.79 337
~ gm Direct Cost £5,040,796. 20 §1,000.00 $5,041,796.20 &0.99 §5,164,80._.. %$1,000.00 $5,165,80.. aLi5
f4 Diect Cost Items §5,040,796,20 $1,000.00 $5,041,796.20  80.9 §5,16480.. | $.,000.00 $5,165,80 8215
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3.4.2.3 DISTRIBUTION OF UNASSIGNED COSTS/BILLING
AMOUNT BY INDIVIDUAL CATEGORIES

Distribute Unassigned Cost/Billing Amount by:

(@) Individual Categories
() Top level Categories
(O Total Cost/Billing amount

Any costs in the estimate not assigned to a pay item needs to be proportionally spread back to all pay
items to determine a balanced bid price. This option lets the user choose the basis for calculating the
weighted distribution of any unassigned costs plus markup.

¢ Individual Categories - this option uses each individual cost categories as the basis for
establishing the weighted distribution amounts.

Labor
‘ Gross Wages Taxes Fringes =
Payitem |Description Total Cost cost|  weight| Distribution cost| weight| Cost| Weight] Di -] Price
6410100  Mobilization 513,106 51,763 0.9% $949 $588  0.9% 5290 5294 0.9% $145
2010102  Clearing & Grubbing 541,246 59,994 5.0% 35,379 §3,331  5.0% 51,643 51,666  5.0% sn
2020183 Unclassified Excavation 90,455 | 520,923 10.4% 511,260 $6,974  10.4% $3,491 $3,487  10.4% $1,720
3035912 Aggregate Base SB46,910 | $68,717 34.2% 536,981 522,906 34.2% 511,300 $11453  34.2% 55,650
3034263 Asphalt Concrete Hot Mix Type A | 51,756,602 585,169 42.4% 545,835 $28,390 424% $14,005 514,195  42.4% $7,003
413(B) 0454 36 Inch RCP Culvert Class Il $73,220 | $14,114 7.0% 57,596 54,705 7.0% $2,321 $2,352  T.0% 51,160
Total Direct Costs 2,621,839  $200,681 108,000 566,894 533,000 533,447 16,500 .. 52,966,839
Unassigned Cost $300,000 550,000 530,000 $15,000
Markup $45,000  $18,000 | $3,000 | $1,500 |
Total Distribution $345,000 S108,000 533,000 516,500

Target Price 52,966,839
e Top Level Cost Categories - This option uses the ten top level cost categories (labor, owned

equipment, rented equipment, supplies, materials, etc.) as the basis for establishing the
weighted distribution amounts.
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Labor Owned Equig lanced|
Pay Item ||: iption Total Cost| Cost|  Weight] Distribution l'.‘:st|We_IBLt|DIshibutinn Cost| Weight| Distribution Price
6410100  Mobilization 513,106 52,939 0.9% 51,582 59,642 21% $2,332 S0 0.0% 50 517,020
2010102  Clearing & Grubbing $41,346 $16,657 5.0% 48,964 $23,587  5.2% 45,705 0 0.0% S0 456,015
2020183  Undlassified Excavation $90,455 534,872 10.4% 518,767 $55,583  12.2% 513,443 50 0.0% S0 $122,665
3035912  Aggregate Base $646,910 [ $114,528 34.2% $61,635 £118,815 26.1% 528,736 354,728 22.6% 512,431 $749,712
3034263 Asphalt Concrete Hot Mix Type A | 51,756,802 141,949 42.4% 576,392 $235,310 51.7% 556,911 51,316,700  75.4% $41,465 | 51,931,570
413(B) 0464 36 Inch RCP Culvert Class 1l 573,220 523,524 7.0% 512,660 511,877 2.6% 52,873 535,078 2.0% 51,105 589,857
Total Direct Costs $2,621,839 5334469 $180,000 $454,814 $110,000 $1,746,506 455,000  $2,966,839
Unassigned Cost $300,000  $150,000 | $100,000 | 450,000
Markup 545,000 $30,000 510,000 55,000
Total Distribution 5345000  $180,000 $110,000 $55,000
Target Price 52,966,839
e Total Cost[/Billing Amount] - This option uses Total Cost as the basis for establishing the
weighted distribution amounts.
Balanced
Pay Item  |Description Total Cost Weight| Distribution Price
G641 0100 Mobilization 13,106 0.5% 51,725 $14.831
2010102  Clearing & Grubbing 41,345 1.5% 55,441 A, TE7
202 0183 Unclassified Excavation 490,455 3.5% 511,903 $102,358
3035912  Aggregate Base $646,910 24.7% 585,125 5732,035
3034263  Asphalt Concrete Hot Mix Type & | 51,756,802 67.0%  5231,172 | 51,987,974
413(B) 0464 36 Inch RCP Culvert Class Il 573,220 2.8% £9,633 582,855
Total Direct Costs 52,621,839 5345,000 52,966,339
Unassigned Cost $300,000
Markup 545,000
Total Distribution 5345,000
Target Price 52,966,839
Markup Pay Item by:
(®) Using Weighted Distribution
() Keeping Markup with Assigned Costs
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This option determines how markup is applied to pay items when establishing a balanced bid price.

¢ Using Weighted Distribution. Marking up Pay Items using weighted distribution takes the total
markup and proportionally spreads the amount using the chosen weighted distribution method.

Total Cost Balanced
Pay Item  |Description lahor| Equlpmenl:| Material| Total| Weight| Distribution Price
2010102  Clearing & Grubbing 514,000 524,000 S0 538,000 4.0% 54,556 542,556
2020183  Unclassified Excavation 462,000 $172,000 50 5234000 | 24.8% 428,055 4262,055
3035912  Aggregate Base 5112,000  $157,000 $404,000  $673,000 | 71.2% $80,689 §753,689
Total Direct Costs $188,000  $353,000 5404,000  5945,000 $113,300 51,058,300
Markup
Markup Percent 20% 10% 10%
Markup Amount 537,600 535,300 540,400  5113,300
$1,058,300

Target Price

¢ Keeping Markup rates to Assigned Costs. This option uses the cost category amounts of all
assigned cost items and calculates the markup by applying markup percentages as defined in the
direct and indirect cost markup records. Excluding cost items from the dependency tab of the
markup record precludes the application of that markup percentage to the assigned costs on

that pay item.

Labor Equipment Material Total
Pay Item |Description Cost]| Markup]  Price] Cost|  Markup] Price Cost| Markup]  Price Cost| Markup] Price
2010102 Clearing & Grubbing $14,000 52,800 $16,800 | 524,000 $2,400 526,400 50 50 50| $38,000 55200  $43,200
2020183 Unclassified Excavation | 562,000 512,400 574,400 | $172,000 517,200  5189,200 50 50 50 |5234,000 529,600  5263,600
3035912 Aggregate Base $112,000 522400 5134400 | $157,000 515700 $172,700 | 5404,000 540,400 $444,400 |5673,000 578,500 5751500
Total Direct Costs $188,000 537,600 $225,600  $353,000 535,300  $388,300 S5404,000 40,400 $444,400 5945000 $113,300 $1,058,300

Marku, p Perce ntages

Labor 20%
Equipment 10%
Material 10%
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3.4.2.5 CATEGORIZE BUSINESS OVERHEAD AS INDIRECT
COST

Categorize Business Overhead as:

(® Indirect Cost
() Markup

This option controls where cost Items with a cost segment of business overhead appear in the PBS.

¢ Indirect Cost - Business Overhead is included as a subcategory of indirect costs in the PBS.

Job Properties Pay Item & Proposal Register Price Breakdown Structure ©  Cost Breakdown Structure (C
Description Assigned Unassigned | Total ?:T"gzt ?Lbo;ct
- ‘ Target Price £5,263,201.67 %51,259,783.56 86,523,075.24 100.00
w . Markup £0.00 £638,732.42 £638,732.42 .79
» [\ TargetProfit £638,732.42 £638,732.42 9.79 11.52
v J& Total Cost $5,263,291.67  $621,05L14 $5,884,342.81 90.21
v ®  Indirect Cost £0.00 £620,051, 14 $620,051.14 9.51
» = Business Overhead $0.00 £340,453.7%6 £340,453.76 5.22
» = JobOwverhead $0.00 $279,597.38 £279,557.38 4.29
~ g Direct Cost §5,263,291.67 $1,000.00 $5,264,291.67 80.70
E.i Direct Cost Items 55,263, 291.67 $1,000.00 $5,264,291.67 80,70
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e Markup - Business Overhead is included as a subcategory of Markup in the PBS.

Job Properties Pay Item & Proposal Register Price Breakdown Structure @  Cost Breakdown Structure (C
Description Assigned Unassigned Total ::;L ;:t?;ct
v ‘ Target Price £5,263,291.67 §1,259,783.36 $6,523,075.24 100.00
v % Markup £0.00 §979,186.18 $979,186.18 15.01
» |\ TargetProfit $638,732.42 $638,732.42 9.79 11.52
» * Business Overhead $0.00  $340,453.76  §340,453.75 5.22
+ jk Total Cost $5,263,291.57 $280,597.38 §5,543,889.05 B4.99
w &  Indirect Cost £0.00 $279,597.38 $279,597.38 4.29
» =~ Job Overhead $0.00 $279,597.38 $279,557.38 4.29
v s Direct Cost §5,263,291.67 $1,000.00 $5,264,291.67 80.70
i". Direct Cost [tems $5,263,291.67 $1,000.00 $5,264,291.67 B80.70

3.4.2.6 CALCULATE PROPOSAL RECAP FORECAST MARKUP

Calculate Proposal Recap Forecast Markup using:

(@ Unit Markup (current) x Forecast (T/0) Quantity
(O Forecast Price - Total Cost/Billing

This option determines how the Markup is determined in the Forecast column of the Proposal Recap
data block on the Pay Item & Proposal form.

e Unit Markup (current) x Forecast (T/O) Quantity - The Forecast Markup amount is determined
as the sum of each Pay Items Unit Markup (current) multiplied by the Pay Items Forecast (T/O)
Quantity.
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Proposal Recap - Training Job b ‘
Current Target Forecast Variance |
Price: | §6,455,450.00 $6,523,075.24 | §6,462,850.00 | $67,625.24 | ADD
Markup: §571,107.19 §638,732.42 | §631,560.32 §7,172.10 | ADD
Margin%: 8.85 9.79 9.77 £1,413.30 ADD
Job Properties Pay Item & Proposal Regh (-] Structure Cost Breakdown Structure (CBS) Register
Drag columns here o group Saved views: | Previous View - ,D
Position Pay Item Destription | Forecast (T/0) .Lh'tqf Uinit Price: Total Price LUirit Mariup Total Markup LH
Code = HNumber Quantity Measure: [current) {oumnent) {ourrent) founment) ﬂ:\a
1.00 fJlump Sum $388,800.00 $385,800,00 $370,556.05 $370,595.05
10.00 facre $6,120.00 $51,200.00 $1,007.30 $10,072.57
50,000.00 |Cubse Yard 43.50 $425,000.00 £3.04 $151,509.18
10 Trich PVC Faree Main (SDR21) 12,000.00 [Linear Fest $28.00 $336,000.00 5146 $17,550.62
24 Inch PVC Grawity Sewer (SDR3S) 3,000.00 fLinear Feet $64.00 $192,000.00 £7.46 $22,394.31
4 Faot iameter Marhole 16.00 [Each §4,500.00 $72,000.00 $445.18 §7,170.89
Structural Excavation & Backfil 800.00 | Cubic Yard §30,00 $24,000.00 §5.25 $4,201.04
Stesl Renfarcement 30,000.00 fPound 51.60 $43,000.00 (§0.01) ($363.37M
Retaining Wal 550.00 |Cubic Yard $535.00 $454,750.00 $60.79 £51,669.32
{Paint Existing Steel Bridoe Structure .00 JLuwo Sum $100,000.00 $100,009.00 $10,915.94 $10,918.54
Presess Equipment 1.00 [Each $1,920,500.00  $1,920,500.00 $170,356.68 $170,356.68
Remeval of Underground Storage Tanks 200 [Each $12,500.00 $25,000.00 $1,57L.46 £3,142.91
ispersal of Contamnated Sol 500,00 |Cubsce Yard $25.00 $20,000.00 £2.25 $1,602.45
Toll Booth L0 [Each $30,000.00 §20,000.00 $2,169.15 $2,169.15
‘Guardrad Type 2 1,000.00 Linear Fest $24.00 §24,000.00 (52.06) (§2,059.54)
Guardrai Type 34 200,00 |Linear Feet $31.00 £6,200.00 (s2.68) (6332.14)
Type: 4 Signs 1,000.00 |Square Fest §13.00 £13,000.00 ($1.12) (81,115.779)
Realignment of Water Line 100 |Each £7,000.00 $7,000.00 $7,000.00 $7,000.00
5
2 $6,455,450.00 §571,107.19

» Forecast Price Total Price - Total Cost/Billing. The markup amount is determined by subtracting
the sum of the total jobs cost based on forecast (T/O) quantities from the forecast bid price,
which is the sum of all pay item current unit prices multiplied by the pay items forecast (T/O

guantity).
‘ Proposal Recap - Training Job x
Currant Target Forecast Variance
| Price: | $6,455450.00 | $6,523,07524 | $6,46285000  $67,625.24  ADD
Markup: £571,107.19 £638,732.42 £627,743.91 ! ADD
Margin¥e: 8.85 9.79 £5,643.97 ADD

InEight Inc. | Release 25.7

Page 127 of 402



3.4 Library Job Properties Pricing

Estimate Essentials User Guide

Job Properties Pay Item & Proposal Regis @ Pric ke Cost ek (CBS) Register
T —— e T —
Position - Pay Item Descript Forecast {T/0) Unit of Unit Price Total Price Unit Markup Total Markup un
Code Quantity [Measure (urrent) (ourrent) (current) (ourrent) b2
$3865,800.00 $385,800.00 $370,596.05 $370,596.05 I
$6,120.00 $61,200.00 $1,007.30 $10,072.97
$8.50 $425,000.00 $3.04 $151,909. 18
. we ssnm
| Gmnssisy
100 Inch PVC Force Main (SDR21) $28.00 $336,000.00 $1.45 $17,550.62
24 Inch PVC Gravity Sewer (SDR35) 3,000.00 |Linear Feet $64.00 $152,000.00 §7.45 §22,394.31
4Foat Diameter Manhole 16.00 |Each £4,500.00 £72,000.00 448,18 §7,170.88
Structural Excavation & Badkdfil 800.00 | Cubic Yard £30.00 £24,000.00 $5.25 4,201.04
Steal Reinforcement 30,000.00 |Pound £180 £48,000.00 (£0.01) (6363.37)
Retaning Wal 850,00 | Cubic Yard $535.00 £454,750.00 £60.79 £51,660.32
[Paint Existing Steed Bridge Structure 1.00 fLump Sum $100,000.00 $100,000.00 $10,318.94 £10,918.94
Process Equipment 1.00 |Each $1,920,500.00| $1,920,500.00  $170,356.63 $170,356.63
Remaval of Underground Storage Tanks 2.00 |Exh $12,500.00 $25,000.00 $1,571.46 $3,142.81
Disposal of Contaminated Soi 800.00 1ouhc Yard $25.00 $20,000.00 §2.25 §1,802.45
Tell Baoth 1.00 |Esch $30,000.00 $30,000.00 $2,169.15 $2,169.15
Guardrail Type 2 1,000.00 |Linear Feet $24.00 $24,000.00 ($2.08) (42,055.88)
Guardrail Type 34 20000 [Linear Feet $31.00 $6,200.00 ($2.66) ($532.149)
Type 4 Signs 1,000.00 |Square Feet $13.00 $13,000.00 (51.12) (51,115.77)
Realignment of Water Line 100 |Each $7,000.00 $7,000.00 $7,000.00 $7,000.00
>
21 $6| 462‘ 850.00 $6,455,450.00 $571,107.19
- »
Job Properties Pay Item & Proposal Register Price Breakdown Structure Cost Str (CBS) Register ©

Drag columns here to group

PRIME BOND 1.00
PRICE % ADD-... 1.00
FINANCE EXPE... 1.00
INDIRECT COS... 1.00
DIRECT COST ... 100
INDIRECT COS... 1.00
JOB MANAGEM... 100
GEMERAL EXPE... 1.00
DIRECT COST ... 1.00
6410100 100
2010102 10.00
2020183 50,000.00
31 50,000.00
3.2 50,000.00
3035912 45,000.00
4.1 45,000.00
42 400,000.00
43 45,000.00
431 45,000.00
43.2 400,000.00
303 4263 35,000.00
5.1 35,000.00

Lump Sum $46,915,38 $46,915.38
Lump Sum $293,538.39 $293,538.39
Lump Sum $0.00 $0.00
Lump Sum $0.00 $0.00
Lump Sum $0.00 £0.00
Lump Sum £0.00 £0.00
Lump Sum $157,096.28 $157,096.28
Lump Sum $4,200.00 $4,200.00
Lump Sum $104,301.10 $104,301.10
Lump Sum $11,909,51 $11,909.51
Acre $3,918.50 $39,184.97
Cubic Yard $4.68 $233,915.81
Cubic Yard $3.00 §149,922.88
Cubic Yard $1.68 £83,992.94
Ton $15.40 $692,928.99
Ton $11.54 $519,513.30
Square Yard 0,19 §75,848.36
Ton s2.17 $97,567.33
Ton $1.63 $73,480.92
Square Yard $0.06 £24,106.42
Ton $42.62  $1,491,580.59
Ton

§39.27,
I $5,835,106.09 |
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3.5 LIBRARY FOUNDATION SETUP DATA

Foundation Setup Data is where all drop-down options within Estimate fields are stored. These can
serve as category labels, alternate structures or validated tag fields. The different validated fields are
organized into tabs on this form.

Library - Estimate

Estimate Execution System Integrations Actions

b 2 [2] B @ & 2> M al B @& Th B

2 Equipment

JobProperties  Foundation — Address  Trench  ShiftRate | Resource | __ . Resource CostItem  Standard User Roles  Access Reports
- Setup Data = Book Caloulator  Calculator | Rates ~ = Materials Assemblies | Assemblies  Tables Control
Master Initialization Master Resources Master Assemblies Roles and Permissions Reports -
Job Properties Foundation Setup Data Register @ =
I Account Codes | Tags | Work Breakdown Structures | Quote Group Tags | Units of Measure | Currendes | Resource [ Assembly Files | Geographic Areas | Wage Zones | Orge L3 I

Drag columns here to group

Saved views: | Standard View - |

et AL seopn f I Gmen | AROSY gy | AeQmiy sk
= 1001.345 Remove insulation Each .S, Dollar 0.00 -
1010 Environmental Work Lump Sum U.5. Dollar 1.00
1019.234 Remove heater piping Each U.5. Dollar 1.00
1020 Mobilization Each U.5. Dollar 100

You should be aware of these category labels:

Category Labels

Name Definition

Account These codes will be set up on the back end and will help you compare your
Codes cost and production rates to similar cost items in past projects.

Tags Some tags are already set up for you. Additional tags can be created and used

to group and filter your items.

Work Use this format when you need to have multiple variations and summary

Breakdown reports of an estimate. WBS retains the same relationships between items as

Structures in the original estimate and only changes the view and how items are arranged
in hierarchy.

Units of These are standardized to relate to one another by a conversion factor. If you

Measure need to create a new unit of measure, you will need to reference it to a base

unit of measure and can include a conversion factor to allow you to convert
back and forth between English and Metric.

Currencies The default currency is set to U.S. Dollar, but you can also enter the exchange
rate for other currencies (such as Canadian) so you can estimate with
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Category Labels

whatever currency you need. Multiple currencies can be used in the same
project. The system base currency can be changed from USD in the
backstage view settings, but is a global change for the entire estimate
environment.

Currency - Exchange Currency Paositive Currency Megative Currency Decimal
Mame = Rate Symbaol Format Format Symbaol
CND Dollar 100000 5 511 (51.1) Period ()

When you create a new job folder, all category labels defined in the Library Foundation Setup Data
Register will be copied to the new job folder automatically.

RELEVANT LINKS

System settings options
Archive and restore jobs
Video - Library foundation setup data

Video - Migrating your Estimate address book

3.6 RESOURCES

InEight Estimate refers to labor, equipment and material items as Resources. You will use these
resources as the basic building blocks used to detail the costs in your estimates.

InEight Estimate organizes resources into seven types:

Resources

Name Description

Labor The human resources that perform direct or indirect work. Direct labor is
typically classified by trade (e.g., pipefitters, electricians, iron workers) and
title (e.g., foreman, journeyman, laborer).

Construction Owned construction equipment.
Equipment
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Resources

Rented Construction equipment rented from a third party.

Construction

Equipment

Installed Materials that will remain installed on site after the project is completed, (e.g.,
Materials concrete, piping, aggregate).

Installed Equipment that will remain installed on site after the project is completed,
Equipment (e.g., boilers, heat exchangers, vessels, cooling towers).

Supplies Expendable items that will not be permanently installed (e.g., small tools,

consumables).

Unique Resources that are of a “unique” nature and do not fit well into the other types
(e.g., dump fees, hauling charges and equipment rented by the month).

After creating a new job folder, you can import a filtered set of resources from the Library into the new
project. This is done on the Cost Basis tab of the Job Properties form.

In the following section, you will learn more about the resources stored in your Library in the Library
Resource Rate Register.

3.6.1 LIBRARY RESOURCES REGISTER

To open the Library Resources Register, select Labor from the Master Resources ribbon.

System Developer Tools Integrations Actions
] & A a
B 2 @ H &8 2] 32 A\ @1 @
as as
L ! 22 Equipment
Job Properties  Foundation — Address  Trench shift Rate | Resources __ . Resource CostItem  Standard User Roles  Access Reports
- Setup Data ~ Book  Caloulator Calculator - i Materials  Assemblies | Assemblies  Tables Contral
Master Initialization Master Resources Master Assemblies Roles and Permissions Reports

OVERVIEW - LIBRARY RESOURCE RATE REGISTER

o [ Emmww

1 Tabs There are tabs along the top of the form for each of the seven resource
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vwe [ emeew

types, in addition to an Alltab that holds the resources of all types.
» Notice that you are on the Labor Tab

2 Resource Each record (or row in the register) represents a single resource.
Code

3 Description  The Description provides more detail about the resource.

4 Resource This is the resource cost per unit.

Rate per
Unit

5 Utilization Tells you how many units of that resource are being used in the job.
Count

6 Unit of Each resource is defined with a Unit of Measure.
Measure

7 Register This register includes columns for the resource attribute categories so you

can filter and group your resources.
Cost Breakdown Structure (CBS) Register Job Properties Resource Rate Register @ =

All Labor Construction Equipment | Rented Construction Equipment | Installed Material Installed Equipment | Supplies | Unique I

to group 9 e e Find: EG Saved views: e'ous View -

Resource _ Description Unit Cost Unit Cost Unit Cost. Utilization Linit of Resource File Wage Organizational
Code (Scale 1) (Scale Z) (Scale 3) Count Measure Description Zone Category
= |+ Lct Carpenter Apprentice £27.48 541,22 £54.96 534,37 fHour Standard Labor Rate...  Wage Zone A Carpenter -
+ LC2 Carpenter Journey... §28.92 $43.38 $57.84 1,188.73 fHour Standard Labar Rate...  Wage Zone A Carpenter
+ LC3 Carpenter Foreman $31.47 $47.20 $52.94 594,37 fHour Standard Labor Rate... = Wage Zone A Carpenter
+ LF1 Finisher Apprentice £26.80 £40.20 £53.60 0.00 §Hour Standard Labor Rate...  Wage Zone A Finisher - Concrete
+ LF2 Finisher &£28.07 £42.10 456,13 534,37 fHour Standard Labor Rate...  Wage Zone A Finisher - Concrete
+ LF3 Finisher Foreman §32.32 $48.48 554,64 0,00 §Hour Standard Labor Rate...  Wage Zone A Finisher - Concrete |
25 27,257.30

SOURCE JOB AND SOURCE SYSTEM NAME FIELDS
The Source Job field provides visibility into the jobs from which the data may have originated from.

The Source System Name helps to see the source of the data when integrating with other systems.
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Resource Type Ezzueurce Source Job gisgfn =
Mame
+ Construction Equipment Rate EMTE Library System
+  Installed Material Rate MDIRTE Library System
+ Construction Equipment Rate ETDT Library System
+ Supply Rate SFM Library System
+ Supply Rate SFH Library System
+ Installed Material Rate MPDI16 Library System

TIP Resource rate add and search tips:

e You cannot add new resources on the All tab.

» You can search for resources in the Resource Rate Register using the ‘Find’ field.

Next you will take a look at the different types of resources and how they differ when we drill into
resource rate records from each category.

3.6.2 LABOR RESOURCES

Looking at your Labor resources more closely, you will see all the Resource Codes for the Labor
resources begin with an L. This is a best practice for naming and organizing your resources, but you can
also use another organizational method of your choice.

3.6.3 RESOURCE RATE RECORD

If you need to add cost to a resource, adjust a rate, or just view a more detailed breakdown, you can
open the resource’s rate record. From the Library Resource Rate Register, double click on the row
header for the resource you need to view in greater detail.
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Double click on the
row header to open

resource rate record Resource File Unit of Productivity
Description Measure Factor
Carpenter Apprentice | Standard Labor Rate...
+ LC1 Carpenter Apprentice  Standard Labor Rate...  Hour 1.00
+ LC2 Carpenter Journey... Standard Labor Rate...  Hour 1.00
+ LC2 Carpenter Journey... Standard Labor Rate...  Hour 1.00
+ LC3 Carpenter Foreman Standard Labor Rate...  Hour 1.00

OVERVIEW - RESOURCE RATE RECORD

I ™

1 Record The record references the resource you are editing.

2 Charge Rate The Charge Rate tab is the tab the record defaults to and is where you
define the cost of the resource.

3 Scale Buttons The Scale buttons only show up on labor resources. They are used for
defining regular time, overtime and double time rates for the resource.

4 Cost The Cost Category Breakdown is where you enter the costs for the
Category resource. The categories will depend on what type of resource it is (e.g.,
Breakdown equipment resources will have equipment cost categories and materials

will have material cost categories).

5 Special The right side of the record will have additional options to help you define
Instructions/ the rate. These options change depending on what type of resource it is.
Base Wage
Factors
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Resource Rate Register Labor Rate Record @

ICode: * e Description: |Carpenter Apprentice p

Setup ﬁ,ChargE Rate 2 g Rate
I Scale1 | Scale2 | Scale3 | Al Scales Ie

Cost Category Breakdown Amount «3 Percent | Is Taxed Is Insured
- i I
w  Labor Varies
Labor Base Varies
~ | Labor Burden Varies
» | Labor Fringes Varies
» | Labor Insurance Varies o
»  Labor Taxes Varies
Undefined Laber E... 50.00 €« 0.00
Undefined Labor 0,00 « 0.00
»  Materials £0.00
Undefined 0,00

Special Instructions i

Usethe Materials cost categoryto add additional labor cost
formaterials and supplies.

Worker's Comp values forthis resource can be adjusted
automatically when this resourceis employed in ajob,
based an the geographiclocation of the work, and the
Worker's Comp Override listed on the Cost Item on which
the resource is employed.

Standard Worker's Comp Overrides can be defined in the
Library's Foundation Setup Data Register.

Base Wage Factors for Overtime

Use Base Wage Factors for Scales 2 and 3

Scale 2 Factor: x Base Wage
Scale 3 Factor: x Base Wage

This option multiplies the Scale 1 base wage by the factors
entered here to automatically calculate the base wage for
Scales 2 and 3.

3.6 Resources

T T S

6 Setup

There is also a Setup tab where you can define the resource’s attributes, plus

other settings. These attributes are used for filtering which resource rates to

load into a new estimate.

7 Cost
Driver

8 Default
Quantity

are driven by time.

[§§rarce Rate | Biling Rate
\

Resource File: | Standard Labor Rate File -
Geographic Area: | Southwest -
Wage Zone: | Wage Zone A -

0Org. Category: | Carpenter -
Account Code: =
ICﬂstDriver: CI Duration -1
Cost Curve: | Employed Cost Item -

Tag 1: | Nen Union -

Tag 2: | Hourly -

Tag 3: -

Productivity Factor:

[Default Quantity: | 1.00 Ie

Currency: | U.S. Dollar -

InEight Inc. | Release 25.7

Labor resources default Cost Driver is Cl Duration which means their costs

The Default Quantity is typically set to 1 for most cases if you are bringing in
the resource you are using at least one.
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The following steps walk you through how to create a new labor resource.

STEP BY STEP — CREATE A LABOR RESOURCE

1. From the Library landing page, on the Setup tab, click on Resource Rates from the Master
Resources section.

al B & TH | B

- Resource Costltem  Standard UserRoles  Access Reports
terisls  Assemblies | Assemblies  Tables Control

qui

Master Assemblies | Roles and Permissions | Reports

¢ The Library Resource Rate Register opens

2. Select the Labor tab.

w

Right click on any row header and select New.
¢ A new Labor Rate Record displays

In the Code field, type L + [your initials].

Press the Tab key.

Fill in the Description field.

N o g k&

Click on the resource’s Setup tab and select Standard Labor Rate File from the Resource File
drop-down list.

8. Select a location for the Geographic Area.
9. Select Wage Zone A for Wage Zone.
10. Select a labor type for the Organizational Category.
11. For Tag 1, select a code.
12. For Tag 2, select a code.
13. On the Charge Rate tab, enter a dollar value for your Labor Base.

14. Expand Labor Burden and under Labor Fringes, type in a dollar value for Pension and
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Subsistence.

Resource Rate Register Labor Rate Record ©

Code: * |LMECHINEIGHT | Description: |Mechanic - Heavy Duty

Setup ﬁ, Charge Rate Billing Rate

Scale 1 Scale 2 Scale 3 all Scales

Cost Category Breakdown Amount &> Percent
» Total £57.00
w Labor &57.00
Labor Base £52.00
w  Labor Burden £5.00
w Labor Fringes £5.00

Travel £0.00 €« 0.00

Premium 50,00 < 0.00

Holiday 20,00 €« 0.00

Savings S0.00 <« 0.00

| Pension $3.00 | € 577

Vacation £0.00 <« 0,00

| Subsistence $2.00 | = 3.85

Health & Welfare £0.00 « 0.00

15. Define an overtime and double-time rate for the resource. Select the checkbox for Use Base
Wage Factors for Scales 2 and 3.

16. Set the Scale 2 Factor to 1.50 x Base Wage and Scale 3 Factor to 2.00 x Base Wage.

Base Wage Factors for Overtime

|| Use Base Wage Factors for Scales 2 and 3
Scale 2 Factor: 150 x Base \Wage

Scale 3 Factor: 200 x Base'Wage

This option multiplies the Scale 1 base wage by
the factors entered here to automatically calculate
the base wage for Scales 2 and 3.
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17. Click OK, to close the record.

Estimate Essentials User Guide

3.6.4 CONSTRUCTION EQUIPMENT RESOURCES

¢ Similar to Labor Resources, Construction Equipment Resources are also duration driven

resources by default

¢ They contain cost categories for ownership and operation costs

Resource Rate Register ©

Al

Resource _

Labor | Construction Equipment

& to group

Rente:

sy Description
-+ EAPAV Asphalt Paver
+ EARL Asphalt Roller
+ ECOMP1 Compactor Smooth D...
+ ECOMP2 Compactor Sheeps F...
+ ECRII0 Crane 110 Ton
+ ECRST Boom Truck 15Ton
+ ECRHC Hydraulic Crane 25 Ton
+ ED& Dozer D6
+ ED8 Dozer D&
+ EG14G Grader 146
+ EGI60H Grader 160H

d Construction Equipment

Resource File
Description

Standard Equipment Rate.

Standard Equipment Rate...
Standard Equipment Rate...
Standard Equipment Rate...
Standard Equipment Rate...
Standard Equipment Rate...
Standard Equipment Rate...
Standard Equipment Rate. ..
Standard Equipment Rate. ..
Standard Equipment Rate. ..
Standard Equipment Rate. ..

Installed Materizl | Installed Equipment

Unit of Productivity
Measure Factor

Hour
Hour
Hour
Hour
Hour
Hour
Hour
Hour
Hour
Hour

Hour

1.00
1.00
1.00
1.00
1.00
1.00
1.00
1.00
1.00
1.00
1.00

Supplies

1.00
1.00
1.00
1.00
1.00
1.00
1.00
1.00
1.00
1.00
1.00

Find:

Unit Cost
(Scale 1)

§53.40
$21.00
§7.00
$28.00
$196.00
$28.00
$84.00
$84.00
$140.00
$35.00
$31.00

Saved views: | Previous View

Currency

U.S. Dollar
U.S. Dollar
U.S. Dollar
U.S. Dollar
U.S. Dollar
U.S. Dallar
U.5. Dollar
U.5. Dollar
U.5. Dollar
U.5. Dollar
U.5. Dollar

These resources are the fleet of construction equipment that you own.

Utlization
Count

3.6.5 RENTED EQUIPMENT RESOURCES

These resources represent the construction equipment that you rent.

0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00

Organizational Geograph
Category

Asphalt B
Asphalt

Compactor

Compactor

Crane

Crane

Crane

Dozer

Dozer

Grader

Grader

¢ Rented Equipment Resources are also duration driven resources by default

» Contain cost categories for rental and operation cost as well as additional fees

¢ On the Rental Construction Equipment Record, you will notice a new tab named Quote

¢ Quotes will be discussed in detail in Lesson 8 — Quote Management

¢ You will also note the Tax section. You can check the box to Apply Standard Tax, which pulls the

Sales Tax percentage defined on the Cost Basis tab in Job Properties, or you can manually specify

a unique sales tax rate

Tax
Apply Standard Tax
Unique Sales Tax Rate:

000 %
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STEP BY STEP — CREATE A RENTAL EQUIPMENT RESOURCE

1. Open the Library Resource Rates Register.
2. Select the Rented Construction Equipment tab.

3. Right click on any row header and choose New; a new Installed Rented Equipment Rate Record
displays.

4. In the Code field, type RECR + [your initials], then press Tab.
5. In the Description field, type Crane 110 Ton.

6. Click on the resource’s Setup tab and select Standard Rental Rate File from the Resource File
drop-down list.

7. Select a resource from the Organizational Category drop-down list.

Code: ® |RECR110 Description: |Crane 110 Ton

Setup ﬁ, Charge Rate |:_| Quote Biling Rate

Resource File: | Standard Rental Rate File - User Defined 1: |
Geographic Area: - User Defined 2: [
Wage Zone: - User Defined 3: [

Org. Category: | Crane - User Defined 4: [
Account Code: o User Defined 5: |

T amd Diriirars [ S n TETEN AN - llmmr Miafimad £ |:

8. Move back to the Charge Rate tab to follow the step by step on the next page.

3.6.6 EQUIPMENT CONSUMPTION RATES

The Construction Equipment and Rented Construction Equipment Resource Rate Records include
consumption rates that will factor with the fuel cost you define on the Library Job Properties > Fuel
Cost tab to give a fuel cost for your equipment rate.
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Job Properties Construction Equipment Rate Record © -

Code: ® |EAPAYV Description: |Asphalt Paver

Setup ﬂ, Charge Rate Billing Rate

Fuel

Cost Category Breakdown Amount
v Total £199,00 N Fuel Type Consumption Rate
~ Owned Equipment £199.00 Gasoline - 12.00| Gallon/Hour
»  OE Ownership £0.00 - N
« OEO t 199.00 :
peraton $ Consumption Rate factared
OE Repair Parts £0.00 . . .
Spalr Far with cost per liter gives you a
OE Repair Labor 50,00 fuel cost
I OF Fuel $144.00 I 0 RUTo et cany careolate Maintenance Labar
OE Lube £0.00 Man-Hours for this resaurce

The below figure shows where consumption rates are defined on the Construction Equipment
Resource Rate Record.

3.6.7 NON-HOURLY RATE CALCULATOR

For owned and rented construction equipment, the rate entered must be hourly. If your rate is weekly
or monthly, you can use the Non-Hourly Rate Calculator on the Construction Equipment Resource
Record to come up with the hourly rate.

STEP BY STEP — NON-HOURLY RATE CALCULATOR

1. Refer back to your last entry's rate amount. Under Non-Hourly Period Charge Rates on the right,
check the Calculate Non-Hourly Period Charge Rates checkbox.

On the resulting prompt, click OK.
In the Period field, select Weekly.

In the Amount Per Period field, type in a number value.

a & 0N

Type in a number of hours in the Hours Per Period field.
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Non-Hourly Period Charge Rates
V| Calculate Non-Hourly Period Charge Rates for
RE Rental
Period: ‘WEeldy l 'J
Amount Per Period: $4,000.00
Hours Per Period: 20.00
Code: * |RECR110 Description: (Crane 110 Ton

Setup ﬁ, Charge Rate |:_| Quote Billing Rate

Cost Category Breakdown Amount
v Total £200.00
» Rented Equipment £200.00
» Fees £0.00
Undefined £0.00

6. Click OK to close the record.

3.6.8 INSTALLED MATERIALS, INSTALLED EQUIPMENT
& SUPPLIES RESOURCES

e Comparing the Installed Material & Equipment resources to those covered so far, you will note
that the unit of measure is not Hour for materials, but it is specific to the kind of material. It is a
guantity-driven resource, as opposed to duration-driven like your labor and equipment
resources

e You will also note the tax field can pull your standard tax settings from the Cost Basis tab in Job
Properties, or a unique sales tax rate can be manually entered in each record

e On record for these resource types, you will notice a new tab named Quote. This tab shows up
here because you may have to shop around and get quotes for these resources

e Quotes will be discussed in detail in Lesson 8 — Quote Management
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¢ In the Setup tab you will see a field named Waste % Add-on. Here you can account for
approximate waste percentages

e Cost categories will differ on each type of resource record

Job Properties Resource Rate Register ©

All Labor Construction Equipment | Rented Construction Equipment | Installed Material Installed Equipment | Supplies

Drag columns here to group

Resource - - IUnit Cost Utilization Unit of Resource File
Code = SETIEIL (Scale 1) Count Measure Description

= Asphalt Mix (Finish) £32.50 0.00 Ton Standard Material Rate. ..
---+ MAC Asphalt Cement £195.00 0.00  Ton Standard Material Rate...
+ MACA1-1/2 Coarse Aggregate 1-1/2 In £9.10 0.00 Ton Standard Material Rate...
+ MAFA Fine Aggregate £7.80 0.00  Ton Standard Material Rate. ..
+ MAHALL Agagregate Haul Quarry to P... £2.60 0.00 Ton Standard Material Rate. ..
+ MAIAZ/4 Intermediate Aggregate 3/4... £10.40 0.00 Ton Standard Material Rate...
+ MASAMD Sand $7.80 0.00 Ton Standard Material Rate...
+ MATK Tack £1.30 0,00 Gallon Standard Material Rate. ..
+ MEBR Aggregate Base Rock £3.45 0.00 Ton Standard Material Rate...
+ MC2000 Concrete 4000 PSI §110,50 0,00 Cubic Yard Standard Material Rate...
+ MC3500 Concrete 3500 PSI £104.00 0,00 Cubic Yard Standard Material Rate. ..
+ MDIRTA Dirt Class & $1.30 0.00  Cubic Yard Standard Material Rate. ..
+

MDIRTE Dirt Class B 5,50 0.00  Ton Standard Material Rate. ..

Above is an example of the Installed Material tab in the Library Resource Rate Register.

The following steps walk you through how to create a new material resource in InEight Estimate.

STEP BY STEP — CREATE AN INSTALLED MATERIAL RESOURCE

1. Select Resource Rates from the Library landing page.
¢ The Resource Rate Register displays

2. Select the Installed Material tab.

w

Right click on any row header and select New from the drop-down menu.
¢ A new Installed Material Rate Record displays

In the Code field, type MGBP + [your initials], then press Tab.

In the Description field, type Brick Pavers.

Select a unit of measure from the Unit of Measure drop-down list.

N o g &

On the resource’s Setup tab, under Resource File select Standard Material Rate File.
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8. On the Charge Rate tab, expand Materials and enter a number valuein the Installed Materials
Amount field.

Code: * |MGBPPB Description: |Brick Pavers

Setup ﬁ, Charge Rate |_,_,_| Quote Billing Rate

Cost Category Breakdown Amount
» Total
Installed Materials
Lindefined Materials
»  Fees

I lemid =R i A AT

9. Click OK to finish adding this resource.

3.6.9 UNIQUE RESOURCES

The Unique resource type is a catch-all and can be used for anything from dump fees and security to
creating subcontractors as a resource.

¢ The Unique resources are the only resources that have all cost categories available, as well as all
units of measure

¢ You will also note the tax field which can pull your standard tax settings from the Cost Basis tab
in Job Properties, or a unique sales tax rate can be manually entered in each record

¢ Quotes will be discussed in detail in Lesson 8 — Quote Management

RELEVANT LINKS
Video - Create a labor resource

Video - Create owned and rented equipment resources

InEight Inc. | Release 25.7 Page 143 of 402


https://learn.ineight.com/Estimate/Content/Categories/VideoStartPage.htm?wchannelid=wlkiph4dhe&wmediaid=sjowkxo1f9
https://learn.ineight.com/Estimate/Content/Categories/VideoStartPage.htm?wchannelid=wlkiph4dhe&wmediaid=qfkiggy4t5

3.7 Resource Assemblies Estimate Essentials User Guide

Video - Material and supplies resources

Video - Create a unique resource

3.7 RESOURCE ASSEMBLIES

A Resource Assembly is a group of resources. You can create an assembly once and then reuse it as
needed in multiple cost items whenever the same combination of resources is needed.

Library - Estimate

Estimate Execution System Integrations Actions

B (2 EH 8 Lo |24 8B @ B

Job Properties  Foundation  Address  Trench shiftRate | Resource __ ) Resource CostItem  Standard User Roles  Access Reports
- Setup Data ~ Book  Calculator  Caleulator Rates ~ i Materials Assemblies Assemblies  Tables Control
Master Initialization Master Resources Master Assemhlilg_s Roles and Permissions Reports

The most common use for an assembly is to group labor resources into crews (e.g., Pipe Crew,
Concrete Crew); however, any resource (equipment, materials, etc.) may be grouped into an assembly.
Utilizing assemblies allows you to estimate faster, since you can add and manage an entire group of
resources at once.

You can create assemblies in the Library and import them into job folders the same way you import
resources.

3.7.1 LIBRARY RESOURCE ASSEMBLY REGISTER

To open the Library Resource Assembly Register, select the Library icon, then select Resource
Assemblies from the Master Resources section of the Setup tab.

OVERVIEW - LIBRARY RESOURCE ASSEMBLY REGISTER

1 Each row in the register represents a single resource assembly and is defined with
an Assembly Code and Assembly Description.

2 Each assembly can be expanded by clicking the plus [/ icon next to its Assembly
Code.
3 Expanding an assembly reveals the list of resources that make up that assembly.
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» Best practice for creating Assembly codes is to use C for Crew Assemblies, M
for Material Assemblies, etc., however you can have labor, equipment, and
materials in the same assembly

Resource Assembly Register @ -
Drag columns here to group Find: Saved views:
de = | Desaipton - Quanoty  potof o umtcost  TowslCost  Cureny | Jrenimtonel  Cegraphc  flege ten
> Standard Assembly... 1.00 | Hour $330.38 $330.38 . *
ot = EC despton Qunity ST ot ey B e
> 1/1c2 Carpenter Journeyman 2.00 | Each $23.92  U.S5. Dollar CIDura...  Standard Labor Rate File Carpenter Southwest | Wage Zon...
2 LF2 Finisher 1.00  Each $28.07 U.S. Dollar CIDura... = Standard Labor Rate File Finisher - Conc...  Southwest = Wage Zon...
3 w1 Iron Worker 1.00 | Each £35.55  U.S. Dollar CIDura...  Standard Labor Rate File Tron Worker Southwest | Wage Zon...
e 4 L2 Laborer 1.00  Each $26.37 U.S. Dollar CIDura... = Standard Labor Rate File Laborer Southwest  Wage Zon...
5 ECRHC Hydraulic Crane 25 Ton 1.00 | Each £84.00 U.S. Dollar CIDura...  Standard EquipmentRate... Crane
6 LC1 Carpenter Apprentice 1.00 Each $27.48 U.S. Dollar CIDura... Standard Labor Rate File Carpenter Southwest ~ Wage Zon...
7102 Operator Class 2 1.00 | Each £30.21 U.S. Dollar CIDura...  Standard Labor Rate File Operator Southwest | Wage Zon...
8 ETFT Flatbed Truck 1.00 Each $7.00 U.5. Dollar CIDura... Standard EquipmentRate... Trude
a 9 1C3 Carpenter Foreman 1.00 Each $33.87 U.5.Dollar  CIDura...  Standard Labor Rate File Carpenter Southwest | Wage Zon...
CGRADE Grading Crew Standard Assembly... 1.00 Hour $175.06 $175.06  U.S. Dollar Earthwork
|+ cmamT Equipment Maintenance Standard Assembly... 100 Each $58.00 $58.00 U5, Dollar Mechanic | %
+ CPAVE Pavina Crew Standard Assemblv... 1.00  Hour £346.04 £346.04  U.S. Dollar Asphalt

3.7.2 RESOURCE ASSEMBLY RECORD

To open an existing Resource Assembly Record, right click on the row header of an assembly (row) on
the Resource Assembly Register and select Open.

OVERVIEW - RESOURCE ASSEMBLY RECORD

T T S

1 Assembly Each assembly is defined with an assembly Code and an assembly
Code and Description.

Description

2 Quantity Each assembly has a quantity and unit of measure. The defaultis 1 EA.
and Unitof  For crew assemblies with all hourly duration driven resources, it is a best
Measure practice to change the Qty to Hour, so that when used on a cost item, it

will show you the assembly’s unit cost per hour.

3 Assembly The rows in the Assembly Details register represent the resources that
Details make up the resource assembly.

4 Notes An area where the estimators make notes for records related to the
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[vwe [ emeew

resource assemblies for work orders which is commonly performed by a
type of crew.

Resource Assembly Register Resource Assembly Record @ -

" 1
|Cude: Cccone Description: [Concrete Crew | | a0
Resource File: | Standard Assembly File = | Tag1: | - uM:
Geagraphic Area: | - Tag2: | - Unit Cost: $330.38
Wage Zone: ‘ - ‘ Tag 3: | - ‘ Currency: | U.S. Dollar -

Org. Ctegary: Mon Gourt: 500 a Last Changed sy:

Equip Count: 2.00 Last Changed On:

Notes:

Cost Summary | Assembly Details,
Drag columns here to group Find: | [Search For...] Saved views:

W ot S ooy SR mew e G SRR Gunrd | ceogprc | o
= 1 Lc2 Carpenter Journgy... 2,00 Each $28,92 U.5. Dollar €I Duration Standard Labor Rate File Carpenter Southwest Wage Z
2/ 1F2 Finisher 1.00 Each $28.07 U.S. Dollar CI Duration Standard Labor Rate File Finisher - Concrete Sou%est Wage 2
3 w1 Tron Worker 1.00 Each $35.55  ULS. Dollar CI Duration Standard Labor Rate File Tron Worker Southwest Wage Z
FRETE! == A00 oo $2637 112 Dol £lDucal tanclacd | ohos Dot I Lok thact m

3.7.2.1 PRODUCTIVITY RATE INDICATOR IN THE CBS
REGISTER

The Productivity Indicator shows the field that contains the as-entered value and is driving the
estimate for that cost item. This appears as an arrow aligned to the left of the cell as shown below.

Crmecricton ?S'Lb-., i.::-u L Comt ;f:ﬂl::.".lé Currancy '.-‘.:.::ur- drroen] x.b.rl&r\- drreen]

oa 00 e B MDY A S5 BT LS. Dol 5. rFLS 15
Friene B L0 L S [ 310N 4 NN LS, Doder

Frice o Aud O L0 Luep fum 25,515 71 IS5 TE LS, Dolsr

Bob Fmancing L0 lueg fum [ =l W00 LS. Doller

Andirect Coal Ewcalation 100  Lump Sum [ k] LR TR .

Dt Coall [acalation L0 Lo Sum { =L ] B000 LS. Dol

Inadirect Coat Add T L0 Lueg Sum [ =Ll H20 S Dolw

Bob Manspesmest B | quigment L0 Lump fum HIST.0 1 BLST.05%. I8 LL5. Doler L= 0.0m
General | aprose 100 L Sum 4, 200.00 #4,200.00 (L5, Dol 000 .00

L TR LT

Unclasasfied Uncavatios $,000.00  Cubs: Fard BRI BIEMOA0 15, Dol AT 000
Excavaton $0,000.80  Cubse Fard B66 EILE0080 (LS. Dol 100 000
[arerem— $,000.80  Cubse Fard $LI3 ETRAMLED LS, Dol AT .60

Being able to see productivity drivers on the CBS register makes it easier to review and modify the
estimate as a whole while reducing the potential to accidentally overwrite a manually entered data.

Follow the step by step below to create a Resource Assembly.
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STEP BY STEP — CREATE A RESOURCE ASSEMBLY

1. From the Library landing page, under the Master Resources section of the Setup tab, select
Resource Assemblies.

¢ The Resource Assembly Register is shown.
2. Right click on any row header and select New from the drop-down menu.
¢ A new Resource Assembly Record is shown.
In the Code field, type CEXC + [your initials] as the unique code for the assembly.
4. Add a description in the Description field.

In the Assembly Details register at the bottom of the screen, click in the Resource Code column
in the first blank row, and then select the Resource icon that appears in the cell.

6. On the Labor tab of the resulting register, select the resource with the Description: LL2Laborer
and click OK to add this resource to the assembly.

7. Add two additional resources.

TIP You can use the Ctrl and Shift keys to select multiple resources at once.

8. Click OK to save and close the new assembly.

Resource Assembly Register ©

Drag columns here to group

Code = b Ei?es %Lérgnje'ipﬁun Ly rI:I"II:.:sD:rE l
+ CCOMC Concrete Crew Standard Assembly... 1.00  Hour

= ( | Excavation Assembly _I
+ CGRADE Grading Crew Standard Assembly... 1.00  Hour
+ CMAINT Equipment Maintenance Standard Assembly... 1.00 Each

RELEVANT LINKS

Video - Resource assemblies
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EXERCISE 3.1 — CREATE RESOURCES & RESOURCE ASSEMBLIES

In this exercise, you will practice creating resources and assemblies in the InEight Estimate Library. In
the Library Resource Rate Register, create resources with the following variables:

Labor Resource

Resource Code LSFA Wage Zone Wage Zone A
Resource Field Organizational Supervision
Description Administrator Category

Geographic Area Southwest Scale 1 Labor Base $33.45

Scale 1 Premium 2 percent Scale 1 Subsistence $0.47
Resource File Standard Labor Rate File

Select the checkbox for Use Base Wage Factors for Scales 2 and 3.
Scale 2 Factor: 1.50 x Base Wage. Scale 3 Factor: 2.00 x Base Wage.

Rented Construction Equipment Resources

Rented Construction Equipment Resource

Resource Code  RPW3000 RE Rental Amount $3.40
Resource Pressure Washer 3000  Organizational Clean & Inspect
Description PSI Category

Resource File Standard Rental Rate File

Installed Material Resource

Resource Code @ MCCB Installed Materials Amount $300.00
Resource Pre-Cast Concrete Organizational Category Concrete
Description Catch Basin

Resource File Standard Material Rate File

Unit of Measure Each

Uncheck the box for Apply Standard Tax and enter a Unique Sales Tax Rate: 6%
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In the Library Resource Assembly Rate Register, create resource

assemblies with the following codes, descriptions, and resources.

Assembly #1
Assembly Code CBRIDGE
Assembly Description Bridge Crew
Resource File Standard Assembly File
Unit of Measure Hour

Select Wage Zone A Labor Resources for this Assembly.

Resources on Assembly Resource Description Resource Quantity
LC3 Carpenter Foreman 1

LL2 Laborer 2

LF2 Finisher 1

LC2 Carpenter Journeyman 2

Assembly #2

Assembly Code CRIPRAP

Assembly Description Rip Rap Replacement Crew

Resource File Standard Assembly File

Unite of Measure Hour

Select Wage Zone A Labor Resources for this Assembly.

Resources on Assembly Resource Description Resource Quantity
LT2 Teamster Foreman 5

LO3 Operator Class 3 1

LL2 Laborer 2

EX510 Backhoe JD 510 1

ETPU Pickup 1

EL950 Loader 950 1
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You should end up with similar results:

Resource - Resource File Organizational Geographic Wage - Unit of
Code =7 Description Category Area Zone Desch Measure
— LSFA Standard Labor Rate File  Supervision Southwest Field Administrator Hour
Scale = Total Labor Labor Base  Labor Burden  Labor Fringes
> 1 3392 §33.92 $33.45 £0.47 £0.47
2 £50.18 £50.18 £50.18 £0.00 £0.00
3 §66.90 $66.90 £66.90 £0.00 £0.00
Resource , [ —— — Resource File Unitof [ UnitCost [~ — Organizational
Code L Desaription Description E Measure (Scale 1) Currency Category
[Z]RPW3000 | Pressure Washer 3000 PSI Standard Rental Rate File |Hour $3.40 U.5. Dollar | Clean & Inspect
Total Rented Equipment RE Rental RERentExpense RE Overhead RE Finance Expense RE Insurance RELicense R{
» $3.40 $3.40 §3.40 $0.00 $0.00 $0.00 $0.00 $0.00

Resource ; Descriti Resource File Unit of Unit Cost o QOrganizational
Code escription Description Measure {Scale 1) urrency Category
[=] McCB Pre-Cast Concrete Catch Basin |standard Material Rate File | Each | $318.00 | U.5. Dollar |Cor1crehe

Total Materials  Installed Materials  Undefined Materials Fees  Sales Taxes  Undefined Fees  Undefined  Biling Rate E.:!I:E

b $318.00 $300.00| $0.00| $300.00| $18.00| $18.00| s0.00) 000 s318.00]

Find: |[Search For...] [E] Saved views: | Previous View E
Resource = Unit of - Organizational Geographic W
File Description E' Quantity |~ | peagye | v/ UnitCost |~ | Total Cost |~ | Currency | - Catagory “l Area =1 Zof
Standard Assembly File 1.00 | Hour $170.11 $170.11 U.S. Dollar
Row , Resource — Unit of = Cost Resource Organizational Geographic Wage
MNumber " Code Desaiption Quantity Measure UnitCost Currency Driver File Desciption Category Area Zone
» 1/LC2 Carpenter Journeyman 2.00|Each $28.92|U.S. Dolar CI Duration | Standard Labor Rate File Carpenter Southwest  Wage Zone A
‘ 2/LC3 Carpenter Foreman 1.00 | Each $31.47|U.S. Dollar CI Duration | Standard Labor Rate File Carpenter Southwest |Wage Zone A
‘ 3|LF2 Finisher 1.00|Each $28.07|U.S. Dollar | CI Duration | Standard Labor Rate File Finisher - Concrete | Southwest | Wage Zone A
‘ 4/LL2 Laborer 2.00 Each $26.37|U.5. Dollar CI Duration | Standard Labor Rate File Laborer Southwest |Wage Zone A
Code = Y  Description :f:;‘;’:;pmn Quantity a’;‘;s“lfm Urit Cost Total Cost Currency S;%:S;EYW”E‘ gf:agmph‘( \anng:
— CRIFRAP Rip Rap Replacement Craw Standard Assembly. . 100 Hour $152.89 §152.89 U.S. Dolar
Qi VR Unbcost e S, B o [Eerns
+ 1 w2 Laborer 2.00 Each $26.37 U.S. Dollar CI Duration Standard Labor Rate File Laborer Southwest ~ Wage Zon...
2 Lo3 Operator Class 3 1.00 Each $30.62 U.S. Dollar CI Duration Standard Labor Rate File Operator Southwest ~ Wage Zon...
3 112 Teamster Foreman 0.50 Each $32.32 U.S. Dollar CI Duration Standard Labar Rate File Truck Driver - Teamster = Southwest ~ Wage Zon...
4 FEL950 Loader 950 1.00 Each $14.18  U.S. Dollar CI Duration Standard Equipment Rate...  Loader
5 ETPU Pidaup 1.00 Each $4.20 U.S.Dolar  CIDuraton  Standard EquipmentRate... Truck
6 EX510 Backhoe 1D 510 100 Each $35.00 U.5. Dollar CI Duration Standard Equipment Rate...  Excavator

Congratulations, you have completed this exercise!

3.8 IMPORTING RESOURCES

The following procedures inform you how to setup resources in InEight Estimate from an excel sheet.
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Al 2 Use of this lesson will draw from other sections of InEight Estimating Manual. Basic
understanding of the Sort, Group, Filter, Excel integration functionality in InEight Estimate
is required.

3.8.1 OPEN RESOURCE RATE REGISTER

You can create resources within the Resource Rate Register. This is the location to build out the

structure of those resources.

STEP BY STEP — OPENING THE LABOR TAB

1. Open the Job Folder or Library that you’re going to be working in.

2. From the Ribbon, select the Setup tab.

3. Under the Resources section, select Resource Rates. The Resource Rate Register opens.
4

. Select the tab you want to add resources to.

Estimate Quote Price Execution System
= Print O rew Copy Link Field /{ Y W Tz Resource Utilization ‘;ﬁ
"1 Preview Delete E Paste niink Fiel ” E Resource Cost Details —
_ Expand/  Filter  Clear Copy Job Re
& Export to Excel Cut Fill Dowr Colapse »  ~ Filter to Libez
Print Edit Workbook View
Job Properties Resource Rate Register ©

Al Corslruclinn Equipment | Rented Construction Equipment | Installed Material | Installed Equipment Supphes Unigue

Unit of Productivity Default ‘Waste % Unit Cost Unit Cast
Measure Factor Quantity Add-on (Scale 1) (Scale 2)

Resource

Code Desaiption =

The layout of this register and excel file is up to the organization and the decisions that are made
during the detail design phase. A basic excel file will be provided to your organization as a starting
point to work from. If that can’t be located, you can easily build one utilizing the views within InEight
Estimate.

3.8.1.1 CREATING A LABOR SAVED VIEW - RESOURCE RATE
REGISTER

You can create a view to mirror both the register and excel sheets to easily bring information back and
forth from the two applications.
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Example of columns:

e User Defined 1

* Resource Code

» Description

» Resource File Description - Validated field
» Geographic Area - Validated field

» Wage Zone - Validated field

» Organizational Category - Validated field
e Tag 1 - Validated field

e Tag 2 - Validated field

e Currency - Validated field

» Default Quantity

» Use Base Wage Factors - Scale Factors
» Scale Factor 2 - Scale Factors

e Scale Factor 3 - Scale Factors

e =0 For more information on Validated Tags field, see Validated Tags topic. Scale Factors
aren’t required if you are manually applying rates to each cost category scale.

The view should appear as shown below with User Defined 1 in the first column. This field is used for
sorting and arranging data accurately moving between Estimate and Excel. You are not limited to UDF
1 and can choose to utilize a field of their choice for sorting.

JobProperties  Foundabion  Rayliem
- Setup Data =
Initialize

Cost Breakdown Structure (CBS) Register

3.8.2 SETTING UP THE EXCEL FILE

Go to the Excel sheet and make sure the information in the columns shown in the screenshot are filled
out. Basic concepts to keep in mind regarding the excel file:

Page 152 of 402 InEight Inc. | Release 25.7



Estimate Essentials User Guide 3.8 Importing Resources

Sort Code - This column needs to have a high sequential number such as 10000. This is very important
to assign as it will help us authenticate all the labor rates.

Resource Code - A unique Naming convention to be assigned to every labor resource. In this example
we have all labor resource starting with a L followed by the letters that represent the resource
description.

Labor Base - The base wage of the labor resource is entered here. Estimate does not allow $ sign to be
pasted, which is why the cells for the Base column are formatted to Number.

ks - £
A [ € o 3 E G H i i 3 L W " o 3

1 Hequirea

2 | Validated Field

3 | Not Required

F

5 Rescurce Cost Desails Regisy

& UDFL Resowce Code - Description Camescy - | Defauh Quanticy - |Use Base Wage Facters | - | *Scale Factoe 2~ | “Scale factor 3~ [Tatal | - [Laber Base -Tte

7 10000 L2 Carperer Joumeyman Standsrd Labar Aate File  Co 5 Datlar 1 TRUE 200f s21 2w

) 10061 LsuP ! 1 Tew 150 200f s2050 210

b 10052 LSUW ore Stanciard Labor Rate File on Union Howty U5 Dotlar 1 TeUE 150 z00f 5308 10

" 210003 LSLK Forer ol Stancand Laber Rate File Nee Unicn Howty U5 Dollar 1 TRUE 150 200 5319 %10

" 10004 LSUBM Foreman Boilermaker  Standard Labor Rate File Non Unicn Howly  US. Dollar 1 TRUE 150 2000 5329 2610

RH 10005 LPFL Lead Pipe Fabricator  Standard Labor Rate File Non Union Howly  US. Dollar 1 TRUE 150 200f 53390 nm

n 10006 LPF2 Journeyman Pipefitter  Standard Labor Rate File Non Union Howdy  US Dollar 1 TRUE 150 200[ s34 31

L] 10007 LPFY Pipefitter A Standiard Labor Rate File ey US Dallar 1 TRuL 1%0 2o0] s1s9) 210

18 10008 LPF4 Pipetitter 8 Seandard Labor Bate Fila G U, Dotlar 1 TeuE 150 200 s34 10

1 10000 LB Lend Boitermater Seandard Labor Rate File G us, Detlar 1 TuE 150 200f s37.83 510
us. Dot 1 TRUE 150 z00f 53889 a1

7 20030 LEMZ Journgyman Boilermake Standard Labor Rate File  Ca

3.8.2.2 CREATING THE RESOURCE

Follow this procedure once you have information filled out in excel.

STEP BY STEP — CREATING THE RESOURCE

1. Open the excel file.

2. Sort the sheet by sequential number in the Sort Code field.
3. Highlight the cells you want to bring into the estimate.
4

Copy the cells using right click and selecting Copy from the context menu.

A ] 4 o E F & H [} [ £ L M N -} P
1 [Required
2 Valioated Field
3 Mot Required
4 Column Headers may difter based on Design Decision liem 267
5 Rescurce Rave Register Aescurce Cost Details Regis
& csariecion Cranizarionsl [ - oz - oo TS S - - -N
7] Te0 2210
3 File 150 230
E 150 2410
1 150 21
1 150 2610
4 Lead Pipe Fabricator  Standard Laber Rate file 150 2710
1 10008 LPP2 pe Rate file  Carpenter Southwest Wage Zone A NonUnion Hourly | US. Dollar TRUE 150 2w
1 10007 LPFS Pigefitter & Standard Lator Rate File  Carpenter Southwest Wage Zone A NonUnion Hourly U Dollar TRUE 150 210
1 10008 LF& Pipefitter & Standard Labor Rate File  Carpenter Southwest WageTone A Non Union Hourly U5 Dollsc TRUE 150 5010
1 Lead Boilermaker Standard Labor Rate File  Carpenter TAUE 150 5110
1 Jou n Boilermake Standard Lator Rare File  Carpe: TRUE 130 5240
1

5. Open Estimate to the Resource Rate Register.
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6. Select the User Defined 1 column in the Labor tab of the Resource Rate Register.

i Extirate Qe Pric a Syshe Actons
B ¥ B O &L n a B
. [ - £ ' ll
kbfroperties  Foundafion  Payltem B BdWied | Resource Besource | Jostler  Stenderd Reports
= Catup Dane = Prapedal Pt = S Maberisls Adirmished  Busemises Tables
Inatia e Hesnaroes Assemibhes Beports

Cost Breakdown Strecture (CB5) Register rﬂcmmemnw nlmmmm

.lll:mmmmnt Feented Constiucsen Equoment | [rstaled Maberial | Instaled Equpment | Supphes | Uinigur

Liser Rresource Fie Or ganizutonal Gesgra
Defired 1 Code Dawcription TesToben ] Ares

7. Right click the empty cell and select Paste from the context menu. A pop up will appear asking
Are you sure you want to insert the selected values?

Select Yes to confirm inserting the selected values.

The cells you copied from the excel sheet are now copied into the Resource Rate Register. The
Sort code data is pasted in the User defined 1 column. Resource Code & Resource description
data is pasted as well.

Demo - Estimate

& B aAir. WM a8 B

2 Equpment
MbPropertes  Foudston  PayDemB  Bd Wiwd e Ressrce | Costltem  Strdad | Aevorts
- SetpData = Propossl Rates - HEMibeish  Assembles | Assembles Tables
Initiakze Resources Assembles Reports
Corst Breakdow Structure (CAS) Register Resource Rate fegistes O Ressurce Cast Details Regiter

=) | [ [

Drag ere 1o Find: | [SearchFer...] Saved views: | RE_Resource Labor Uplosd Wi =
-0 g - BE | Gawd gt M i i o ol -
1+ o [z Carpenter Jourey. | StandardLabor Rats Fie. Carpenter Sousfewest  WogeZweA Honlmon Houly LS. Dolar .00 ] 000 .00
+ 10001 T LsuPE Foreman Ppe Standard Labor Rate e Carpenter Soutwest Wage Jore A Non Union  Mourly LS. Dolar 100 < 0.00 0.0
+ 10002 Lsutw Foreman fron Standard Labor Rate Ple Carpanter Soutwest WegeZore A MonLnin  Hourly .S, Dolar 100 < 0.00 000
+ 10003 L Foreman Ol Standard Labor Rate Fle Carpriter Soutest Wage Tore A Non Lnion  Hourly LS. Dolar 1.00 o 0.00 L
+ U004 LSuEM Foreman Bodermaker | Standard Labor Rats File Cargeniter Soutwest Wage Jorw A N Loy Henrly LS. Dolar .00 o 0.00 LR
+ 10005 LPFL Lead Pipe Fabricator Standard Labor Rate Fle Carpenter Soufwest Wage Tore A Non Lnion  Howurly LS. Dolar 100 4 0.00 000
+ 10006 [l Journeyman Ppefitter | Standand Labor Rate Fle: Carpenter Soutwest Wage Tore & Non Lnion  Mourly .5, Dolar L00 L 0.0 0.00
+woor Py Fpefiter & Siandard Labor Rate Fle Carpenter SouTTVESt Wegelore A Nonlnmn  roury 15, Dolar 100 o 000 000
+ 008 =" Fpmfitter B Stancard Labor Rate Fie Cargenter Soufwest  WegeZuowA  Mealmon rouly  US Dol 200 v 000 000
+ W 181 Lead Bodermakier Standard Labor Rate Fle Canpenter Soutwest WageZore A NonLnion  Hourly LS. Dolar 100 Bl 0.00 000
D T e e P o sy Py ooy pres Wk | aam

Page 154 of 402 InEight Inc. | Release 25.7



Estimate Essentials User Guide 3.8 Importing Resources

10. For Make sure the sorting is on User Defined 1 column. This allows us to see the
information being sorted similar to our data in excel file. Base Wage Factors need
to be flagged to turn on with the check box. Your first copy and paste should have
activated them. You need to copy and paste again in order to apply the factors.

Resource Cost [

tors - *Seale Factor2 - *Scals Factor & .Frunl - |Labor
1.50/ 52892
1.50 200) 51992
1.50 200] 53052
1.50 100j 53192
1.50 2000 53292
1.50 2004 53392
1530 2000 53492
1.50 200j 535.92
1.50 2001 53692
1.50 2009 53792
1.50 200 53802
Cost Breakdown Structure (CBS) Regster Hesowrce Rate Register ©  Resource Cost Details Register
Al | Lo | Constucson Equpment | Remted Corstruction Equpment | Instaled Materisl | IrstaledEquement | Supples | Urioue
Find: | [Search For....)
e am:r o Reesource Fie g;mu_w.u Geogra o Togi Tag 2 Defadt “”w”"" Scale 2 Scale 3
Diescripiten hegary Beea Zone: Quan bl Factor Factor
= [+ wom Han L L5
+ 1001 Laer Fereman Ppe Stondard Labor Rate Pl ! Soubwest  WogeZoneA  MenUmon Mowly U5 Dolar Lo + L% 200
+ 0oz e Fareman fron Standard Labor Rate Fie Carperiter Soutwest Woge Tt & Honlnion  Hourly .5, Dollar L0 < L% 200
100 L5 Feremnan Civi Staniard Laber Riate Fie Carperiter Soutweil Wage oA Nonlion  Houdy U.5. Dol L0 ] 150 200
+ 10004 LsuBM Fereman Bodermaker  Standard Labar Rate Fie Carperier Soutwest Woge Tone A Nonlmion  Howly | ULS. Dol L0 ’ 150 2100
+ po00s LPFL Lead Ppe Fabrcatr  Standard Lshar Ruate Fie Carperiier Soutwest  WapeZoned  Nonlmion Mowly LS. Dolar L < 150 200
+ 10006 LPF2 Joureyman Ppeftter | Standard Lshor ste Pl Carperiter Soutwest  WaspeZoneA  Nonlmon Mouy LS. Dolar L < L% 200
+ ooy LpF3 Poitier & Stancard Labar Rate Pl Carperiter Sostwest  WogeZoned  Menlikon Howdy LS Dol L% ) L% 200
) LPFa Prpsefitser B Standard Laber Rate Fie Carpiriter St Wage ot A Nenlimsn  Hawrly U Dol Lo < L8 o
+ 00 LB Lead Bodermaker Standard Laber Ruate Fis Carperier Soutwest Wage oA Nonleion  Howly | U5, Dolar 100 / L% 200
+ 0w LBMZ Joureyman Bolerm... | Standard Labor Rate Fie Carperier Soutwest  WapeZoneA  NonUmon Howly U5, Dol Lo + L% 200
.

3.8.2.3 RESOURCE COST DETAILS

Labor resources are now in the system a user can apply rates to those resources.

STEP BY STEP — RESOURCE COST DETAIL

1. From the Ribbon, select the Actions tab.

2. Under the View section, select the Resource Cost Details option. The Resource Cost Details
Register opens.

Mo =0 Create a view to mirror the accompanying excel sheet or create one to bring in the
associated resource cost in the details register.

4. From the Saved views drop down, select the Labor view to filter down to only labor resources.
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5. Right click a column header and select Column Chooser.

6. Drag and drop the columns into the view identified below.

Sce s T |Tod  lsber  LborBme  LsborBuden Labecfges Tl Promm  odey Sowgs s Vet fa)caaieg poororicee  Undefined Fringe indefed Fringet Undefine

=+ | 1 .00 $0.00 $0.00 .00 $0.00 $0.00 Z1 Sort Descending .00

o L s .00 0,00 0.0 L) .00 Clear &ll Sorting

Orieg 8 colema from Belaw o place it into the
register.

-
LT oo [ Caten Goan | nefmcannin s ]

Hide This Column 0.0 Adustment
Alorwance

0.0 000 .00 0.0 000 .00
wFL 1 e .00 0.00 0.0 000 0.00

PP 1 s .00 0,00 .00 sa00 .00
LFF4 (R ] s 000 .00 ) .00
ET ] 000 .00 00 000 .00
Lsuc 1 wm 0.0 00 0w 000 00

e 1w .00 .00 0.00 000 .00 .00 .00 .0 .00 .00

Example of columns — The level of detail and utilization of specific cost categories is a decision for each
organization:

» User Defined 1 - Non editable fields from resource rates register

» Resource Code - Non editable fields from resource rates register

» Description - Non editable fields from resource rates register

» Resource File Description - Non editable fields from resource rates register
» Geographic Area - Non editable fields from resource rates register

» Wage Zone - Non editable fields from resource rates register

» Organizational Category - Non editable fields from resource rates register
» Scale - Non editable fields from resource rates register

e Labor Base

e Travel

e Premium

» Holiday

e Savings

» Pension

e Vacation

» Subsistence

» Health & Welfare
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e Apprenticeship

e Undefined Fringe 1

» Undefined Fringe 2

» Undefined Labor Fringes
e Bodily Injury & Property Damage
* Workers Compensation
» Undefined Insurance1

» Undefined Insurance2

» Undefined Labor Insurance
* FICA

« FUTA

o SUTA

» Undefined Tax1

» Undefined Labor Taxes
» Undefined Labor Burden
» Undefined Labor

e Construction Supplies

e Undefined Materials

e Undefined

 Billing Rate

« Billing Rate Markup
 Billing Rate Markup %

3.8.3 FILTER/SORT/PASTE - RESOURCE COST
DETAILS REGISTER

The Labor upload view brings in the columns required to enter Labor base, burdens etc. Every Labor
resource has three rows created with Scales 1,2,3. The Scale Column is used to setup Straight time,
Over time, Double time.
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—

Cost Breakdown Structure (CBS) Register Resource Rate Register Resource Cost Details Register 1

Drag columns here to group

Ezzzurce E Scale = otal Labor Labor Base Labor Burden Labor Fringes Travel

LBM1 $0.00 §0.00 $0.00 $0.00 $0.00 0
LEM1 £0.00 €0.00 £0.00 €0.00 €0.00 €0
LBM1 $0.00 $0.00 $0.00 $0.00 $0.00 S0
LBM2 $0.00 $0.00 $0.00 $0.00 $0.00 s0

STEP BY STEP — FILTER RESOURCE COST DETAIL REGISTER

1. From the Scale column header, click the filter icon..

2. Set the From and To values to 1.

Cost Breakdown Structure (UBS) Register Resource Rate Register [ Resource Cost Details Register © I Labor Rate Record

Crag columns here to group
0 Pc'z‘:”’“ L Description g:;’;fo:"e g?;::.MI ﬁ“‘"‘ i sale = T ||Total Labar Base Travel Pren

= 10009 ,_Lm;n Standard Labor Rate Fie Carpenter Southwest Wage Zone A | e $0.00
10010 LBM2 Standard Labor Rate Fie Carpenter Southwest \Wage Zone A $0.00
10000 Lc2 Standard Labor Rate Fie Carpenter Southwest ‘Wage Zone A From | 1 RN q $0.00
10005 LPF1L Standard Labor Rate Fie Carpenter Southwest \Wage Zone A $0.00
10006 LPF2 Standard Labor Rate Fie Carpenter Southwest \Wage Zone A . £0.00
10007 LPF3 Standard Labor Rate Fie Carpenter Southwest \Wage Zone A $0.00
10008 LPF4 Standard Labor Rate Fie Carpenter Southwest \Wage Zone A $0.00
10004 LSUBM Standard Labor Rate Fie Carpenter Southwest \Wage Zone A $0.00
10003 Lsuc Standard Labor Rate Fie Carpenter Southwest \Wage Zone A $0.00
10002 LSUIW Foreman Iron Standard Labor Rate Fie Carpenter Southwest \Wage Zone A $0.00
10001 LSUPF Foreman Pipe Standard Labor Rate Fie Carpenter Southwest \Wage Zone A $0.00

Clear Filter Cugtom Close:

3. Back on the excel spreadsheet, highlight the base rates to bring in.

4. Right click and select Copy in the context menu.
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vio = £

A [ [4 M (] ] 3 ] 3 5 T {1 v w T z
1 Required
2 Valisted Field ——>
3 |Not Reguired |
4
5 Resource Aave Register Resource Cost Details Register
6 User Defieed | Resource Code  ~ Description L™ *Seale Facwr 2 | *Scale Factor 3|~ JTotad | = fLabor Base [~ [Travel |~ Premium ~ Holiday * 'Savings * |Pensicn ~ [Vacation * 'Subsistence = | Health & Welfare = | Apprenticeship| ~ | Undefined Fringe 1~ | U
7 10000 LC2 Carperter laurmeyman 150 20f s2e.00] 210 [ a0 02 0w 066 000 6 0.00 000
s 10001 LSUPF fareman Fipe 150 200] s2950) 210 o0 a0z om 066 0 000 06s 0.00 000
9 10002 LSUIW Foreman Iron 150 200f s30.90} .10 (1 a0 o om 066 [T am 0 0.00 om
10 10003 LSUC Fareman Civi 150 200f s3ns2) 25.10 000 a0 0w 0w 066 044 200 066 0.00 00
n 10004 LsLEM fareman Boilermaker 150 200] sa2sf 2610 o0 a0 om 066 0 000 06s 0.00 00
2 10005 L5F1 Lead Pipe Fabricator 150 200f s3350) 7.0 (1 00 o:  o0m 086 048 200 085 0.00 00
13 10006 LFF2 loumeyman Pipefimer 150 200f 53452 28.10 000 a0 0w 0w 0566 044 200 066 0.00 000
14 10007 LFFY Fipefitter & 150 200f sassf 2410 0.00 o 02 om 066 044 000 066 0.00 000
15 10008 152 Pipefimer 8 150 200f 535504 30.10 13 00 o: 0w 056 0 am 085 0.00 oo
16 10009 LML Lead Boilermaker 150 200f 537924 3110 000 a0 om0 066 044 200 066 0.00 00
17 10010 LAM2 Joumeyman Bailermaker 150 200f same] 3210 0.00 a00 03 om 066 .44 000 066 0.00 0.00
1
18

5. Go to Estimate. Right click and select Paste from the context menu.

Cost Breakudown Structure (CBS) Register Resource Rate Register _

£0.00
woax T Foreman O Stantard Laber Fuste Fie Carpenter Sauttwest Wage Zone A LT
w008 wsiem Foreman Bolermaker Stanard Labor Fuste Fie Carpenter Soutbwest Wage Zone & 1 e
105005 1Fr1 Lead Pipe Pabricator Standard Labor Ruate Pl Carpenter Soutwest Wage Zone & 1 0.00
12004 w2 Jourreyman Pioefitter Standord Labar Rate Fie Carpenter Soutwest Wage Zone & 1w
woar wF3 Poafitter & Standard Laber Rate Fie Carpenter Sotwest Wage Tone A 1 0.00
o wF Ppetater 8 Stantard Laber Ruste Fie Carpentar Satwest Wage Zone A 1 e
w0 e Lead Bodermaker Standard Laber Rate Fie Carpenter Sautwest Wage Zone A 1w .00 .00
wow e Jourmeyman Bodsmsker Stanard Labor Fuste Fle Carpenter Soutbwest Wage Zone & 1 @ .00 .00

0.0
0.00

0.0 .00 0.0
0.0 .00 0.0
.00 .00 .00
000 .00 .00
0.00 .00 0.00
0.00 .00 0.00
0.0 .00 0.0
0.00 .00 .00

6. You will be prompted with a Are you sure you want to insert these values? message as before.

Select Yes to continue.

3.8.4 MANUAL SET-UP OF SCALES 2 & 3 - OPTIONAL

If the organization wants to have more in-depth cost details for each scale rather than using scale

factors the same procedure will be utilized to copy Labor burden, fringes, and other add-ons to setup

Scale 2 & Scale 3.

e = For Base Wage Factor Columns will not be active if your organization is using method 2.
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3.8.4.4 RESOURCE RATE REGISTER

Canst - R Labor Rate Recand
A | Labor Rented C; Supphes | Liique.
Find: | [Search For...] —|  Sawed weews: | Prewiow
Rescarce Resource File Unitof Preductvity Defait Waste % Uit Cost Uit Cost Uit Coat Lise Bade Wage
Code L= Lt Desargton Measre Factor Quariaty addon (5cae 1) Gaed  Gaen UMY fracne
+ M1 Labor Rate Lead Bolermaker Standard Labor Rate Fle Hour L0 Lo0 $37.50 4565 $62.20 LS. Dolar
+ Mz Labor Rate Journeyran Bodermakoe Standard Labor Rate Ple Hour L00 L0 3050 RS $64.20 U5, Dolar
+ 2 Laber Rinte Carpentes Joureyman Standard Labor Siate Fie Hour 100 100 s2850 L8 4420 LS. Doler
+ wRl Labor Rate Lead P Falricater Standard Labor Riate Fie Hour 100 120 3250 s0ss $5420 LS. Dol
+ PF2 Laber Rate Jeurneyran Poefitter Standard Laber Rate Fie Hewr 1.00 100 $A215 $56.20 LS. Dolar
+ FF3 Laber Rate Ppefitter & Standard Labor Rate Fie Hour 100 100 $A3ES 458.20 LS. Dolar
+ PF4 Labor Rate Poefitter B Standard Labor Rate Fle Hour L00 Lo0 515 $50.20 LS. Dolar
+ L5 Labor Rate Foreman Bolermaker Standard Labor Rate Ple Hour L0 L0 2518 $52.20 U.S. Dolar
+ e Laber Rinte Foreman il Standard Labor Bt Fie rour 100 100 748 $90.20 LS. Doler

3.8.4.5 RESOURCE COST DETAILS REGISTER

Cost Breakdown Structure (CBS) Register Resource Rate Register l Resource Cost Details Register  © lmmn:wd

Drag columns here to group

User Resource

B Crganizational Geographic
Defined 1 =

Categary Area

Bl 10000
Carpenter Southwest
10002 Lsumw Fereman Iren Standard Labor Rate File Carpenter Southwest

STEP BY STEP — MANUAL SETUP OF SCALES

1. From the Scale column header, click the filter icon..

2. Set the From and To values to 2.

Cost Breakdown Structure (CBS) Register Resource Rate Register l Resource Cost Details Register ol Labor Rate Record

Drag columns here to group
Demed1™ | Coge | Desawton Desroaen ooy - Zre LasborBace | Tave

= 10000 Lcz Carpenter Journeyman Standard Labor Rate File Carpenter Southwest WageZone A | Lo numeric Fiters $0.00
10001 LSUPF Foreman Ppe Standard Labor Rate File Carpenter Southwest Wage Zone A $0.00
10002 LSUTW Foreman Tron Standard Labor Rate File Carpenter Southwest \Wage Zone A I| From | 2 To|d £0.00
10003 Lsuc Foreman Civil Standard Labor Rate File Carpenter Southwest Wage Zone A | $0.00
10004 LSUBM Foreman Bodermaker Standard Labor Rate File Carpenter Southwest Wage Zone A o £0.00
10005 LPFL Lead Pipe Fabricatar Standard Labor Rate File Carpenter Southwest Wage Zone A $0.00
10006 LPF2 Journeyman Pipefitter Standard Labor Rate File Carpenter Southwest Wage Zone A $0.00
10007 LPF3 Pipefitter A Standard Labor Rate File Carpenter Southwest Wage Zone A $0.00
10008 LPF4 Pipefitter B Standard Labor Rate File Carpenter Southwest Wage Zone A $0.00
10009 LEML Lead Bolermaker Standard Labor Rate File Carpenter Southwest Wage Zone A £0.00
10010 LEM2 abor Rate File Carpenter Southwest Wage Zone A $0.00

Clear Fiter Custom Cloge
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3. Back on the excel spreadsheet, highlight the base rates to bring in.

4. Right click and select Copy in the context menu.

LE] S Fo
A B < M L Q P a R 5 T L' v w x ¥ i

1 PRequired

 mlamedfieg —_——

3 Mot Required
4

5 Resource Rate Register fesource Cost Detalls Register

6 UserDefined 1 Resource Code |~ Description v [*Seale Factor 2| = *Scale Factor 3 flowad |+ [laborBase  » [Travel = Premium * |Holiday = |Savings = Penslon * |Vacatlon = |Subslstence = | Health & Weltare = | Apprenticestlp = | Usdefined Fringe 1= | U
7 10000 LC2 Carpenter jourmeyman 150 200y 52892 210 oo o o 0w 0.66 044 o 066 0.00 o
L] 10001 LSUPF  Foreman Pipe 1% 2000 52593 2310 0.00 Q00 0z 1) 0.86 04s 1) 088 0.00 a6d
9 10002 LSUIW Foreman Iren 130 o] 53097 2410 o 200 0z 000 0.66 04 2.0 056 0.00 1)
10 10003 LSUC Fareman Civil 150 2o0f 5319 2510 o0 00 or om 0.66 044 om 066 0.00 o
n 10004 LSUBM foreman Boilermaker 150 2000 32 2610 0.00 000 (5] 000 0.86 s aoa 088 0.00 a0d
12 10005 LPF1 Lead Pipe Fabricator 150 Jo0f $3292 710 ) am oz o 066 L) o 055 0.00 00
13 10006 LPF2 Jouwrneyman Pipafitter 150 200f $340 2810 0.00 000 (5] 00 0.66 04 om 066 0.00 o
14 10007 LPYS Pipefitter A 150 2008 53592 2910 0.00 Qo oz aom 0.86 s Ll 0ss 0.00 o0a
15 10008 LPF2 Pipefimer 8 150 Toof $3892 3010 L) am o am 066 04 om 0ss 000 om
16 10009 LAM1 Lead Boilermaker 150 2000 5379 Ei 1 o0 0 o L1 0.66 044 0 066 0.00 [l
17 10010 LA&M2 Jowneyman Boilermaker 130 2o0f sass3 3210 0.00 .00 0.22 0.00 0.86 04s 0.00 066 0.00 000
18
19

5. Go to Estimate. Right click and select Paste from the context menu.

Cost Breakdown Strecture (CDS) Regester Resource Rate Register I Resource Cost Details Regester oluhrnteweoud

Find: | [fearch For...]

Organizatonsl Gengraghc

Categony e Zone — — oy

a0z Lsumw Foreman Irn Standerd Labor Bale Fle Carpenier Soutatst Woge Zone A T e $0.00
10003 LSC Foreman Cra Staniard Laber Rate Fie Carpenter Souttraest Wage Jone & 2 $37.65 Cu 000
30004 LSLEM Foreran Bodermaber Standard Laber Eaie i Carpenier Zouthwest Wge Zone & 1 1S &t 000
10005 LPFL Lad Poe Fabricator Standard Labor Fate Fie Carpenter Southwest Wage Zone A 2 w0Es $0.00
10005 LFF2 Jouneyman Poeftier StandordLabor Rate Fle  Carpenter Soutwest Wage Zone & 2 gaz1s LN Ui 30,00
10007 LFF3 Poafitter & Standard Labor Fate Fie Carpenter Southwest Wage Zone A 7 sAEs B Link this fiald 12 Excel 0,00
10008 LPE4 Fpefitter 8 Standard Labor Rate File Carpenter Southwest Wage Zone & 2 §45.15 Unlink from Esce 0,00
10008 LBM Lead Bolermaker Standord Labor Eate e Carpenter Southwest Woge Zone & 7 s $A6.55 0.00 0.00 .00
Lo 1 Jourazyrman Bodermaker Standard Labor Fate Fie Carpenter Southwest Wage Tone & 2 15 Bt 415 .00 0.00 .00

6. You will be prompted with a Are you sure you want to insert these values? message as before.
Select Yes to continue.

7. Follow the same procedure for scale 3.

3.8.4.6 NON LABOR RESOURCE SETUP

The same principles can be applied for the other resource types within InEight Estimate. This
procedure covers installed material, but can also be used for the other six resource types.

3.8.5 CREATING A MATERIALS SAVED VIEW -
RESOURCE RATE REGISTER

Create a view to mirror both the register and excel sheets to easily bring information back and forth
from the two applications.

Example of columns
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» User Defined 1

» Resource Code

» Description

» Resource File Description - Validated Tag field
» Geographic Area - Validated Tag field

» Wage Zone - Validated Tag field

» Organizational Category - Validated Tag field
e Tag 1 - Validated Tag field

e Tag 2 - Validated Tag field

e Currency - Validated Tag field

» Apply Standard Tax - Validated Tag field

e Unique Sales Tax

» Unit of Measure - Validated Tag field

3.8.6 CREATING A MATERIAL RESOURCE

Follow the step by step once you have information filled out in excel.

STEP BY STEP — CREATING THE RESOURCE

Open the excel file.
Sort the sheet by sequential number in the Sort Code field.

Highlight the cells you want to bring into the estimate.

B w0 o=

Copy the cells using right click and selecting Copy from the context menu.
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S e Catei Tn AL =  Woap Text r N — E @ = T futasm + Ay Jo B Creats ¥
Pt O » WA i Sensitiy 14 © a: ! Foma lc‘u et Duitn Format | B SZ“-& ingy | O Chunge Stings
asl - H - . « BEE= e = - 4 - B -andihicrul Tk as o P elete Form, i
e o Fomatpae B T U - H - A - | EEEE S Mege & Center . $-% WA Formating Tobte- Sl | | - o k| & cuare T sers | [ Bateh POF

Clipboad Fart 5 pre— Serriity Humbies 5 Styles Calls Edting Blustean
a7 = i T

a [ c D £ r s H i ) K L M
e
[valicuted Field |

Bégeaiiaeagiis

|DireClass 8

Attt Annheile Precais
Labor | Owned Eqp | Rertal Egp

Select destination and press ENTER oe choose Faite

Anerages 300575 Cowunt 140 Sumi 180061

5. Open Estimate to the Resource Rate Register.

6. Select the User Defined 1 column in the Installed Material tab of the Resource Rate Register.

Cerst Breakdown Structure [(BS) Regrter Imm Rate Register O

al . Lo Constnacion Egupmet | Hm{;ﬂmmt Trestoded] Matenal
Liser Riesamuroe Riesuroe Fike
Sefned 1 Cade oy piicrs Diasroban
T | @ bew
Celete
o Copd
I Faste
s Eill Down

#  Link this field bo boce

Ll irik Proen Exce

L ofy to Besoarce Hie

7. Right click the empty cell and select Paste from the context menu. A pop up will appear asking

Are you sure you want to insert the selected values?
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8. You will be prompted with a Are you sure you want to insert these values? message. Click Yes
to continue.

3.8.7 CREATE A MATERIAL SAVED VIEW - RESOURCE
COST DETAILS REGISTER

Installed Material Resources are now in the system. You can apply rates to those resources. Create a
view to mirror the accompanying excel sheet or create one to bring in the associated resource cost in
the details register.

STEP BY STEP — MATERIAL SAVED VIEW

1. From the Ribbon, select the Actions tab.

2. Under the View section, select the Resource Cost Details option. The Resource Cost Details
Register opens.

3. Mo =0 Create a view to mirror the accompanying excel sheet or create one to bring in the
associated resource cost in the details register.

4. From the Saved views drop down, select the Installed material view to filter down to only
material resources.

5. Right click a column header and select Column Chooser.

6. Dragand drop the columns into the view identified below.

o | LsearchFor.. Saved views: | Labor ew
Swlek T Tod  lsbw  lshorfase  shorBuden  Lsborfrges Tl Gremum  Wokday  Sewgs  Peson  Vaaton  €a)cinen Poertcehp  UndefedPingel  Undefredfrpe?  Undefine

31 Som Descending .00
.00
200

ear Al Sortin
S M fotio e b calems fram balow 2o plece itisto the

¥ Group By This Column
Hide This Column 000 | adusment Adysstment

Heomance Mowarce
Ramove A3 Columns .00

t 1 X ! X ! ! X 4 L] Standard Tax Standard Tax
t f ! ’ ! ’ st BestFit .00

Busess Tases Business Tuses
aer 1 0.00 .00 0,00 .00 000 0,00 000 0,00 ®0.00 000 0.0 Bast Fit [all columns)

» Fised None o Conamption

Fized Left

Fined Right Ao ot
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Example of columns — The level of detail and utilization of specific cost categories is a decision for each

organization:

User Defined 1 - Non editable fields from resource rates register
Resource Code - Non editable fields from resource rates register
Description - Non editable fields from resource rates register

Resource File Description - Non editable fields from resource rates register
Geographic Area - Non editable fields from resource rates register

Wage Zone - Non editable fields from resource rates register
Organizational Category - Non editable fields from resource rates register
Unit of Measure - Non editable fields from resource rates register
Currency - Non editable fields from resource rates register

Total - Non editable fields from resource rates register

Installed Materials

Undefined Materials

Sales Taxes

Undefined Fees

Undefined

Billing Rate

Billing Rate Markup

Billing Rate Markup %

RELEVANT LINKS

Video - Import resource rates

3.9 QUANTITY CHECKING

The Quantity Checking feature allows you to compare the quantity of a superior cost item to the sum

of its relevant subordinate cost item quantities. This setting enables the use of the Quantity Check and

Quantity Warning columns in the Cost Breakdown Structure. The use of these columns can assist in

confirming whether or not your quantities are correct.

93120 The subordinate cost item quantities need to have the same unit of measure as the

superior cost item before you are able to choose the Quantity Check column.
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In the example below, break a concrete pour cost item into four subordinate parts. The Forecast (T/O)
Quantity of the superior item will be 156875.00 tons of concrete. Start by dividing each of the four
parts into 35000.00 tons each. Once you have broken out this concrete pour, determine if you need a
fifth pour or if you should distribute the remaining quantity to the four pours. The factors you keep in
mind are the trips and time involved in the extra pour vs capacity of equipment.

STEP BY STEP — QUANTITY CHECKING

1. From the Ribbon, select the Setup tab.

2. Under the section Initialize, select Job Properties. Then select the Cost Basis tab.

Me = Quantity checking starts by turning the feature on in the Job Properties. If you want
to have quantity checking turned on for all jobs in Estimate, then this setting needs

to be turned on in the Master Job Properties. The Master Job Properties is located
in the Library.

3. From the Rules data box, select the Activate Quantity Checking check box.

Estimate Quate Price Execution System Integrations
@ |2 B &I % a B @
-
T [} 43 Equcment -
Job Properties || Foundation  Pay Item & Bid Wizard | Resource Resource CostItem Standard Reports
- Eetup Data = Proposal Rates = iow Materials  Assemblies | Assemblies  Tables
Initialize Resources Assemblies Reports
Cost Breakdown Structure (CBS) Register Job Properties ©

Overview . Sequrity . Cover Shest | CostBasis | Mnority Setup | FuslCost | JobTrading | Job Folder Tags . Competitors | Pricing

Standard Shift Arrangements Standard \Wage Rate Composite Rules
[] Lock Cost Items to Pay ems

Wark Hours per Shift m Scale 1: lm el Pay Item Linit Price Precision: —2|
Pay Hours per Shift: |j Scale 2: @ %% [] Activate PBS Changes Log
100

IE Activate Quantity Checking I

Scale 3: 0.00 | %
b I— - [[] Maintain CBS Structure at Level: |G

Shifts per Day:

Days per Week: shift [ Rate Calculator When man-count changes: (®) Change UM / Man-Hour

() Change Days

4. Next bring a couple of columns into your view on the Cost Breakdown Structure (CBS) Register.
Right click on the column header and choose Go To Column.
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5. The Go To Column dialog box appears. Have the Include columns that are not currently in the
view check box selected.

Eg:m = L=mzm :r;;;fre gr‘:vagrnw Egsu:ue g;ltnem Lot T(Foot:g:ssl; :‘DOL‘iJrrasuan driven) ﬁ;.‘lfrfannn driven) Labor Total Cost

+ 42 Finegrade Subgrade Square Yard Superioe C1 Detai |DrectCost $0.15  §75848.36 320,00 000 IS
T - ot oo [t | S e s | e
+ 431 Place Aggregate Base Ton ‘Superior CI Detal _ $1.63 $73,460.92 240.00 30.00 _
+ 432 Blue Top Agoregate Base Square Yard Superior C1 Detai |DrectCost $0.06  $24,106.42 320,00 000 [ seaa
Es Asphalt Concrete Hot Mix Type A Ton Pay Item Detai Drect Cost $42.62 §1,491,580.59 466,67 5250 $108,952.25

+ 51 Furnish & Haul Hot Mix Ton Superior €1 Detai $39.27  §1,374,562.54 233.33

+ 52 Install Hot Mix Type A Ton Superior C1 Detal $3.34  $117,018.05 233.33

6 36InchRCP Culvert Class IIT Linear Feet Pay Item Detal

+ 6.1 Furnish RCP Materials Linear Feet Superior C1 Detai

+ 6.2 Excavate RCP Trench Cubic Yard Superior CI Detal Colamn: 3717

+ 6.3 Install RCP Pipe Linear Feet Superior C1 Detal l e Gt & | DefaitCaction

R [ Fipe Cubc Yard Superior C1 Detal l Indude coly Period Count Mismatch Period Count Mismatch ™
57 conaretepour - Superior I Detal Phase Code Phase Code No
+ 71 Concrete Batch One Ten Fixed Plug Days

+ 72 Concrete Batch Two Ton Fixed Quantity Check No
+ 73 Concrete Batch Three Ton i ity Dri Quantity Driver Yes
7.4 Concrete Batch Four Ton Quantity Warning No

Quote Group

_!—nmmr«umm (SDR21) Linear Feet

6. Click OK when you have selected your preferred columns.

Next, toggle the check box for the Quantity Check column.

A conceero |

+ 71 Concrete Batch One 35,000.00

+ 7.2 Concrete Batch Two 35,000.00 Remaining Quantity: 16,875.00 Ton
+ 7.3 Concrete Batch Three 35,000.00! W I Fixed

7.4 Concrete Batch Four 35,000.00 -:- V| Fixed

7. As you check Quantity Check for the four batches of Concrete, the superior cost
item Quantity Warning turns yellow. This is indicating a quantity warning. Hover
your mouse over the superior cost item Quantity Warning column. Then, an
overlay message appears showing the quantity discrepancy. Apply this discrepancy
to the Subordinate cost items. That way, the superior cost item with be the sum of
the parts.

8. The remaining quantity is 16875.00 tons which does not warrant a fifth pour.
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3.10 SECURITY IN ESTIMATE
3.10.1 ROLE BASED PERMISSIONS

Estimate uses a role-based security model, where users can be assigned to a role on a project. A role
identifies if a user has been granted access for various permissions to perform defined functions in
Estimate.

A role is a collection of permissions that defines a user’s responsibilities on a project or in an

e

For example, Johny can be an Estimator on Job A and a Lead Estimator on Job B, giving him elevated
permissions to perform actions that a less responsible estimator may not permitted to perform.

==

Estimator Lead Estimator
Job A Job B

organization.

Estimator
Job C

Update
Resource
Rates

Update Create Access the

Manage Receive

Manage Receive 5 Manage
Resource Versions of
= Cost Items Quotes

PBS
Cost H tes S hots
SRR . Rates Estimates S register

Roles are created and managed in the Roles and Permissions page in the Suite Administration section
of InEight Platform (Suite Administration > Roles and permissions).
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3.10 Security in Estimate

P
&

Hame

Aceount Administrator

fcoount Administrator- All Roles
Account Administrator- Copy
AJL Mew Raole LIV

AJL Rcle

AJL Role 22

AL - NoEditRole

AL - YesEditRale

AL Fiole &

Al Raole B

AL Role C

AL-no Templates, Mo Library
Default Role

Dev/Ops Adminestrater
Estwinale- AddJob-noViewSinapshot
Estimate-AddJob-ViewSnapshol
Estanate-AddSnapshot
Estmate-nodddJob-ViewSnapshot
Estamate-ViewSnapshot
ELLaaton

Fareman

tioe Settings

Priviaey. Statement

Descraption

Accaunt Administrator

Acoount Administrator

Account Administratar

Testing s_\"hthﬁ'- rales to estimate

125t rale to do S0 'mlﬂ'.n!j somenhere
mayhe this is the last roled

Rale cannot edit ibrary

Rale can edit library

Role A for use in test cazes

can delete snapshats

Rale to test mare stuff

wser cannot access Library or Templates
Default Role

Dev/Ops Adminsstrator

Testng ESInate permissadns scenaig
Testing Estimate permissons scenano

Testn S SOenano

Testing Estimate permissions sc

3o
Testing Estimate permissions scenario
Estanator

Foreman

ntegration Settings

Tarma & Conations Y3z

Adminesirator level

Level 3 - Account Admin

Level 3 - Account Admin

Level 3 - Accoun

Level 3 - Account Admin
Level 1 = Project Admin
Level 2 - Organization Admin

Level 3 - Account Admin

Level 3 - Aveo

Level 3 - Account Admin
Level 3 - Account Admin
Level 3 - Aocount Admin

Level 3 - Account Admin

Level D - Base

Level 3 - Account Admin
Lével 3 - Account Admin

Level 3 - Account Admin

Level 3 « Aoco

Level 3 - Account Admin
Level 3 - Account Admin
Level 1 - Praject Admin
Level 1 - Project Admin

Lével 3 - Aotount Admin

'

dmin

drnin

dmin

INEIGHT &

The following image shows how the Estimator role has been defined with permissions to launch
Estimate, add and edit jobs, and view snapshots, but it does not have permissions to delete jobs or add

and edit snapshots.
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= ) . i : - 9
— @ Suite administration / Roles and permissions OneDrive-0A-232 @ L0
Roles and permissions >  Edit role Cancel |
Role details
* Name Description * Administrator level
Estimator Estimator t i

Permissions

Suite administration v
Organization and project w
Master data libraries v
Model ~
Document w
Estimate ~
Select all
Jobs ISelect all Snapshots [0 Select al
Launch Estimate @) View snapshots
(%) Add jobs (®) add snapshats

[ Ed [ Edit snapshots

(%) Delete jobs

-

Privacy, Statement Tesme & Conditicn v23.2 INEIGHT &

For more information on setting up roles in InEight Platform, see Roles & Permissions in the Knowledge

Library.

3.10.2 SECURITY IN ESTIMATE

The capacity to grant permissions in a job and what can be performed is accomplished with a
combination of permissions that exist in both Platform and Estimate.

Generally, permissions managed in Platform determine which users can launch Estimate and who can
manage jobs, snapshots, templates and access the Estimate library. Permissions managed in the
Estimate determine which users are granted permissions to specific commands and destinations solely
in Estimate.

For any user to use Estimate, they need to have a role that has been granted the Launch Estimate
permission, which is found in the Estimate blade of the Roles and permissions page when editing the
details of a role.
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= {2t  Suite administration / Roles and permissions

Roles and permissions > Editrole

Role details
|

* Name Description * administrator level 1
Estimator Estimator Level 1 - Project Admin i

Permissions J
Suite administration / v
Organization and project ~
Master data libraries v
Model v
Document v
Estimate A

[ Select all

[ Select all Snapshots
(@) View snapshots
(®) hdd jobs [ @) Add snapshots
[ Edit jobs [0 [} Edit snapshots (7

[ (x) Delete jobs

3.10.3 GRANTING PERMISSIONS TO ACCESS JOBS
AND SNAPSHOTS

When creating jobs in Estimate, it is required to associate new estimates with existing Platform
projects and all the related OBS contents.

Jlell 2 Multiple estimates can be assigned to a single Platform project. In this case, permissions
granted to users on a project will be the same permissions for all the estimates belonging

to that project.
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InEight Estimate

— 5 Saved Views ~ (£ Colors - U] Extarnal Reparts - @ B About Estmate rré
%/ Tides = Q Output Settings - j\, External References - @ Release Notes
Customire Estimate @ InEght
Help (55 InEight.com Unnversity
Customize Help
DTSN Fltor pojects
M Project ID Project Mame Status Created Date
Core Project: ™  Project A4998 .
"’ \ Project A4997 Project A4997 P 412020 3:56: 14
Code: * |a4g0m [ Project A4598 Project A4958 Foew 412020 3:55:14
. Project A4599 Project A4999 Hagw 4/1/2020 3:56:14
Descnption: Clemson Creek Restorabon project] Project AS Project AS B 4/1/2020 3:52:36
Project AS0 Project ASD ] 4/1/2020 3:52:37
Project AS00 Project ASO0 P 412020 3:52:41
[ Auto-Update Job in Connected Analytics Praject AS000 Praject AS000 HNew 4/1/2020 3:55:14

:a.ICE:

This Platform project is used to assign roles for the purposes of granting various permissions.

To grant permissions to a particular user on a Job, go to the User Management page in InEight
Platform, edit the user, and then assign the user a role on a project on the Roles tab of the Add or Edit
User slide-out panel.

Page 172 of 402 InEight Inc. | Release 25.7



Estimate Essentials User Guide 3.10 Security in Estimate

. X
Edit user
@ oeTaiLs © roLes
Roles (10) (@ Add role
* Role * Organization/Project
Estimator v e o2
| Q
Dev/Ops Administrator » | \ ~ | 2 @
2023 Clow Creek Shoreline Restoratio
2020 Concrete Repairs Program | 499
Superintendant w7 | Bridge Deck Repairs and Shoulder Re: | e o
Springbrook Golf Course Dynamic Sig
Retaining and Noise Wall Rehabilitatic
Superintendant v | @
2020 Clow Crask Shareline Restaratio ™
4 »
Superintendant v Steel Structure Training Job | 105097 X «| 2@ @
Superintendant v Steel Structure Partner Job | 105094 x v O @
Foreman 1 Steel Structure Training Job 3 | 105093 ® v @ @
Foreman v Steel Structure Training Job 2 | 105092 x « | @ @

For more information on managing users, see the User Management section in Roles & Permissions in
the Knowledge Library.

In Estimate on-premise, roles are created and managed in the User Roles register. After
the role is created, users can be assigned to the role from the list in the Windows Active
Directory Users and Groups in Estimate. The Users assigned role as determined by the
currently logged in user is used to grant permissions at the application level. Because
Estimate on-premise uses the computer’s logged in user in determining the user’s role,
roles cannot be segregated by job. To enforce job-level security in Estimate on-premise,
populate the list of users allowed in the job on the Security tab of the Job Properties
form.

3.10.3.1 ORGANIZATIONAL BREAKDOWN STRUCTURE

Projects in Platform are required to have an Organizational Breakdown Structure (OBS) assighment.
The OBS assignments can be utilized for assigning roles and granting permissions to all jobs belonging
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to a node in the OBS.

In the following example, Johny has been assigned as the Lead Estimator for the Site Work node of the
OBS, which grants him the permissions assigned to the Lead Estimator role for every estimate created
that belongs to the Site Work node in the OBS.

@ oeTans © roLes

Roles (1) (¥) Add role
* Role * Organization/Project
Lead Estimator - Site Work W 0]
Q
v  Site Work =

2023 Clow Creek Shoreline Restoration | 45
2020 Concrete Repairs Program | 4992404
Bridge Deck Repairs and Shoulder Reconst
Springbrook Golf Course Dynamic Sign Ins

Retaining and Moise Wall Rehabilitation ane

4 F

MeJ =0 Permissions are cumulative, so if a user is assigned multiple roles on a single project, the
role with the most permissions is applied when attempting to access various functions.

3.10.4 GRANTING PERMISSIONS TO DESTINATIONS
AND COMMANDS

Estimate can grant permissions at a deep-rooted level by assigning which roles can access specific
forms. You can also assign certain roles that can perform specific commands or actions that can be
performed within those forms.
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Integrations

Bures 7y w

& print rew gy cony

O

o Preview Delete [y Paste »
— B o Expand | Show Classic Manigation PRefresh List of
Er Export to Excel Cut il Dowr Collapes = Meressble Objects Mecrsshie Objects
Print Edit Workbook View Took
User Roles Register @ - Access Control Register ©
Saved vews: — PN
Rioke Name: = Deseription
Type = Category = Subcategory
Estimator Estimator
B Command
Foreman Foreman
B Destination
Integration Settngs Integration Settings
B Access Regis!
15 Role 15 Ruole e ter
K ROLEL KNROLEL L) G e A S
Lead Estimator Lead Estimator dvision =
oo FRTRIST @ Address Book Record
MLg-1 testdevel 1 Address Book Register
MQ-2 testdevel 2 0 Attachments Register
M3 testdevel 3 Baond Cost Them Record
MLQ-3- Copy w/lAdd Projects | testdevel 3 Cash Flow
M1 Estimate Ful Access B Competitor Record
-2 [ B Competitors
Roke 01- Engineer Role 01- Engineer B Connected Analytics
Rabe 1 - Engineerr Role 1- Engineer = = Cost Breakdown Structure (CBS) Register
Role 2 - Extmatarr Role 2- Estmator Destination Cost Breakdown Structure (CB5) Register | Form
Role 3 - Lead Estmatar Role 3-Lead Estmator O CostCiwve Recond
Risle 4 - Ragunal Adsin Risle 4 Regonal Adein B CostItem Assembly Inputs
Rioke 5 - Admirn Rl 5- Admin

Roke & - Settings Admin
Roke 7 - Engineer @ Aot
Roke 8- ddein 2

51+ Rigle3-Snapshots-Add,i... | 5)-Rele3

Fiole 6- Settngs Admn
Fiole 7- Engnsar @ Root
Role B- Admin 2

-
55
. . 1

Ag-Entered Curvensy  As-Estered Units  OneDrive-QA-23.2  Librasy

B Cost Ttem Assembly Record

2 Cost Item Assembly Register

E Cost Item Record

B Custem Auto Price Record

E Customize

Default Quote Record b

Saved vaws: | Standard Ve -2

Cost Bresidonn Syuctune (CBS) Regster

Permissions are managed in the Access Control Register in the Setup tab of the Library.

This register is a list of accessible objects, which can be used to grant or restrict permissions to various

roles. By default, the register is organized by type, then by category. Removing the grouping lets you

search for key words using the search capabilities of the register.
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Access Control Register @

Type
Destination
Destination
Destination
Destination
Destination
Destination
Destination
Destination
Destination
Destination
Destination
Destination
Destination
Destination
Destination
Destination
Destination
Destination
Destination
Destination
Destination

Category

Fuel Cost Record
Geographic Area Record
Haul Calodator Record

Job Properties

Job Register

Job Snapshots

Job Status Register

Main Farm

Microzoft Excel
Organizational Category Record
Pay Item & Proposal Register
Pay Item Record

P8S Change Record

PBS Changes Register

Period Resource Quantities
Price % Add-On Record
Price Breakdown Structure
Price Category Record
Quantity Roll-Up Record
Quote Comparison & Award - Cost items

Quote Companicon 5 Award - Resources

Ribibon Name

Fuel Cost Record
Gengraphic Area Record
Haul Calodator Record

Jab Properties

Jobr Register

Job Snapshots

Job Status Register

Main Form

Microsoft Excel
Organizational Category Record
Pay Item & Proposal Register
Pay Item Record

PBES Change Record

PBS Changes Register

Period Resource Quantities
Price % Add-On Record
Prica Breakdown Structure
Price Category Record
Quantity Roll-Up Record
Quote Comparison & Award - Cost items

Quote Comparison & Award - Resources

The Type of the accessible object is one of the following:

e Command: Actions that are in the main ribbon navigation.

*

pac]

Estimate Essentials User Guide

e Destination: A form or location within the application. Restricting this type of permission means that

all the actions that are available in the form are unavailable.

* Register Command: These are the commands that appear for the specified register and are

commonly accessed either by using the actions menu in the navigation ribbon when the register is

active or using the right-click context menu commands on the records in a register.

Categories and subcategories can be used to further group and identify various accessible objects.

The Ribbon Name column provides the navigation path and name of the object as it appears in the

ribbon navigation. The Show Classic Navigation Accessible Objects button on the Actions tab of the

Access Control register can be used to identify accessible objects as they might have existed in the

legacy version of Estimate, and are still available to assist users who may have set up Access Control
prior to the newer ribbon navigation.

Follow these steps to set up Access Control on an Accessible object:
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1. Identify the role or roles in the User Roles register, then right-click to copy.

¢ In the Access Control register, you can filter on the Role Assigned field to help you

associated roles with Access Controllable objects.

User Roles Register - Library

Actions Actions

= Print [Zopen | & Link Field h print Ne: B Copy &, Link Field /"
R, Preview 4 copy Unlink Field R preview Delete [ Paste Unink Fi 4
&' Export to Excel & Export to Excel cut Fil Down ca;’;zg’v
Print Edit Workbook - Print Edit Workbook
Dr Saved views: e - Drag columns here to group
Role Name = Description Subcategory B Ribbon Name
1MR 2 Work Breakdown Structur...  Actions > Edit > Copy
=1 Admini = Work Breakdown Structur...  Actions > Edit > Cut
Account Administrator- Copy Work Breakdown Structur_.  Actions > Edit > Delete
Account Administrator- Work Breakdown Structur... ~ Actions > Edit > Fil Down
Account Administrator- D Work Breakdown Structur...  Actions > Edit > New
Account. Uik ion B Work Breakdown Structur...  Actions > Edit > Open
Account Administrator- Cop... ~ Account Administrator Work Breakdown Structur_.  Actions > Edit > Paste
Account Administrator- Cop... | Account Administrator Work Breakdown Structures  Actions > Edit > Copy
Account Administrator- Jay... | Account Administrator Work Breakdown Structures  Actions > Edit > Delete:
Account Administrator- Josh  Account Administrator Work Breakdown Structures  Actions > Edit > Fil Down
Account Administrator-KS  Account Administrator Work Breakdown Structures  Actions > Edit > New
Account -lav  Account av Work Breakdown Structures  Actions > Edit > Open
Account Administrator- Shu... |~ Account Administrator =+ WorkBreakdown Structures  Actions > Edit > Paste
Account Administrator- sree... | Account Administrator Work Breakdown Structures  Actions > View > Clear Filter
Account Administrator-Sri Account Administrator Work Breakdown Structures  Actions > View > Defauit Data Blocks
ACS Admin Kiewit ACS Admin . Work Breakdown Structures  Actions > View > Filter > Filter to WBS Level
222 Workers Comp Overrides  Actions > Edit > Copy
. R Workers Comp Overrides  Actions > Edit > Cut

Ae.Fntarad Curranns  Ac.Fntaradlinite 22 100A  Likrane

2. Select one or more accessible objects in the

User Roles Register  © = Acoess Control Register
Dr Saved views: | Standard View - oy
Role Name = Description
Type
<  Estimator Estimator -
Destination
Foreman Foreman
Destination
Integration Integration
tegration Settngs tegration Settngs Destrason
IS Role. IS Role.
Destinaton
KNROLEL KNROLEL
dvvision
Mmoo testievel 0
MQ-1 testdevel 1
Moz testdevel 2
mQ3 testievel 3
MLG-3- Copy wiAdd Projects  testdevel 3
N1 Estimate Ful Access
Dastination
-2 -2
Destination
Role 01 Engneer Role 01- Engneer
Destination
Role 1 - Engneerr Role 1- Engneer
Destination
Role 2 - Estmatorr Role 2- Estimator
Destinaton
Role 3 - Lead Estimator Roke 3- Lead Estimator
Destination
Reole 4 - Regonal Admin Role 4- Regional Admin
Destination
Role § - Adminn Role 5- Admin
Destination
Role 6 - Settings Admin Role 6- Settings Admin
Destinaton
Rl 7 - Engneer @ Root Rl 7- Engineer @ Root
Destination
Role 8- Admin 2 Role 8- Admin 2
Destination
5)- Role3-Snapshots-Add,vi..  5J-Roled
- Destination
55 Destinaton
4 v |

> @)
»
Show Classic Navigation | RefreshList of
Accessible Objects Accessible Objects
View Tools
Saved views:
B Role Assigned

see the

Standard View

Access Control register and right-click to paste.

Category

Job Status Register

Main Form

Micresoft Excel

Organational Category Record
Pay ltem & Proposal Regster

Ribbon Name:

Job Status Regster

Main Form

Mirosoft Excel

Organizatonal Category Record
Pay Item & Proposal Register
Pay Item Record

Price % Add-On Record

PES Change Record

PES Changes Regster
Period Resource Quantite
Price % Add-On Record

Price Struchuy ;

Frica Catogory Record Price Category Recard | —

Quantity Rol-Uip Record Quantity Roll-Up Record |

Quote Comperson & Awerd - Costitems | Quote Conparison 8 el O Lnk these fiekds to Excel
Quate Comparison & Award -Resources  Quote Compaisen B AWal = s = 10
Quote Cost [bem Record Quote Cost Item Record

Quote Group Tag Record Quote Group Tag Record

Quate Group Tags Regster Quote Group Tags Register

Quote Record Quote Record

Quote Regster Quote Regater

Quote Resource Item Record Quote Resource Item Record

Reports Reports

Request for Quote (RFQ) Record Reequest for Quote (RFQ) Record

Request for Quote (RFQ) Register Request for Quote (RFQ) Register

3. Expand the detail records of the accessible objects to verify the role assignments have been

correctly made.
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User Roles Register  © = Access Control Register  ©
Saved views: Type
Role Mame: = Description
Type Category Ribbon Name
Estimator Estimator -
Destination Job Status Register Job Status Register
Foreman Foreman
Destination Main Form Main Form
Integration Settngs Integration Settings
= = Destination Micresoft Excel Microsoft Excel
IS Role. IS Role.
Destination O Categor d d Categary Record
KNROLEL FNROLEL
Destination Pay Item & Proposal Rlegster Pay [tem & Proposal Register
=  Lead Estimator Lead Estmator dwvision
Destination Pary Item Record Pay Item Record
Mmoo testievel 0 P
= |~ Destinabon J| FES Change Record PS5 Change Record
MQ-1 testdevel 1 I !
Rioke
Moz testdevel 2
= Lead Estmator
mQ3 testiovel 3
Estmator
MLQ-3- Copy wfAdd Projects  testevel 3
PES Changes Register PES Changes Regster
w1 Estmate Full Access 2 CRlget Regie Shoss Ses
-2 -2
1+ Engr 1+ Engr
Role 1 - Engineerr Role 1- Engincer Lead Estmator
Role 2 - EsSmaterr Rode 2- Extmator Destination Period Resource Quantities Period Resource Quantities
Role 3 - Lead Estimator Roke 3 Lead Estimator Destination Price % Add-On Record Price % Add-On Record
Roke 4 - Regional Adnin Ruole 4 Regional Admin Drstination Price Breakd down Structure
Role §- Role 5- A Destination Price Category Record Price Category Record
Role 6 - Settings Adin Rele §- Sattings Admin Destination Quantity Rol-Up Record Quantity Rol-Up Record
Role 7 - Engineer @ Root g 7- Ergnesr @ Root Destinaton Quote Comparison & Award - Costitems  Quote Comparison & Award - Costiters.
Rl e- 2 R &- e Destination Quote Comparison & Award - Resources  Quote Comparison & Award - Resources
e Add i | 53- o3 Destrnation Quote Cost Item Record Quote Cost ltem Record
P P P " Destination Quate Group Tag Record Quote Group Tag Record
55 Destinaton Quate Group Tags Regster Quite Group Tags Register

W[l 2 You can drag and drop the Roles onto the accessible objects in these two registers.

If no roles are assigned to an accessible object, no restrictions are applied to the accessible object, and
anyone with access to the application will be able to access that destination or command. When
setting up Access Control, be sure to identify the commands and destinations in Estimate that you
want to restrict permissions to, and then assign the roles to explicitly grant permissions to those
accessible objects.

In the following example, both Estimators and Lead Estimators are permitted to invoke any of the
actions on the records in the PBS Changes Register, but only the Lead Estimator is permitted to
activate or deactivate the PBS Changes Log. Because no roles have been assigned to the Activate ‘View
Change Record’ prompt, anyone with access to the application will be able to perform that action.
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User Roles Register  © - Access Control Register
Saved views: - et
Reole Name R Description
Type =
Estmator Estimator -
+ Register Command
Feraman Foreman
+  Register Command
Integration Settngs Integration Settings
+ Register Command
IS Role 15 Roke
+ Register Command
KNROLEL KN ROLEL
~ Register Command
= Lead Estimator Lead Estmator division
Aok
MO0 testdevel 0
< Lead Estmator
MQ-1 testdevel 1
Estimator
Mgz testdevel 2
~ Register Command
ma-3 testievel 3 il
MLQ-3- Copy widd Prajects  testdevel 3 Aok
W1 Estmate Full Acoess % | Luad Sctimatoe
e = Estimator
Rcle 01- Engineer Rcle 01- Engneer =
Role 1 - Engineerr Role 1-Engineer Rale
Role 2 - Estimatorr Rl 2-Estimator = lead Estmator
Role 3 - Lead Estmator Rale 3- Lead Estmator Estimatar
Reole 4 - Regianal Admin Role 4-Regionsl Admin = Register Command
Role 5 = Adminn Rl 5= Admin Role
Reole 6 - Settings Adsin Role 6- Settings Admin = Lead Estmator
Role 7 - Enginesr & Root Role 7-Engneer @ Root + * Register Command
Reole 8- Admin 2 Role 8- Admin 2 ~ Register Command
S)-Role3-Snapshots-Add,vi. | S)-Roled aole
e o ...55_._.._ o o PpTE—
[y —]
“ vl |

3.10.4.2 ACCESS CONTROL REPORT

3.10 Security in Estimate

o -
* |PES 7 o[~ |~ [{x
Category Ribbon Name:
P85 Changes Register Actions > Edit > Copy -
BES Changes Register Actions > Edit > Cut
PBS Changes Register Actions > Edit > Delete
PBS Changes Register Actions > Edit > Fill Down
PBS Changes Register Actions > Edit > New
PBS Changes Register Actions > Edit > Open
PES Changes Register Actions > Edit > Paste
PBS Charsyes Register Actions > Todls > Activate Changes Log
PBS Changes Register Actions > Tools > Activate 'View Change Record” Prompt
PBS Changes Register Actions > Tools > Deactivate Changes Log
-
Brnsacte fevbanct s > Frse

You can use the Access Control report to audit user permissions, command access, and various

restrictions without having to search through the Access Control register for this information.

Reports - Access Control (Excel) ©

File name  C:\Users'\Paul

'\Downloads\AccessControlExport. dsx.

File Home Insert Page Layout Formulas Data  Review  View Help © Comments | | 5 Share ~
& - fr | Ribbon Name .
A B D E F -]
1 |Type Category Ribbon Name limMR 71981 Account Administ
2 Command
3 Command
4  Command
5 Command Bond Cost Item Record Actions > View > Default Data Blocks
& Command Bond Cost [tem Record N/A
e ;havm 7 Command Cash Flow Ax.l':ons = Print > Pagel Setup
Mooter J0b Properies 8 Command Cash Flow Actions > Print > Preview
9 Command Cash Flow Actions > Print > Print
Master Foundalion Setup Data 10 Command Cash Flow Actions > Tools > Cash Flow Options No No No
» Master Resources 11 Command Cash Flow Actions > Tools > Display Settings Na No No
Meater Resouroe W 12 Command Cash Flow Actions > Tools > Worksheet No No No
Access Control (Excel) 13 Command Cash Flow /A
» Saved Views (Lbrary) 14 Command Cash Flow N/A No No Mo
Custom Reports 15 Command Column Captions (Context Menu) > Change Caption...
» Saved Views 16 Command Column Captions {Context Menu) > Reset All Captions...
. " M 17 Command Column Captions (Context Menu) > Reset Caption...
18 Command Connected Analytics Actions > Tools > Auto-Update
T ccess contiol ke Bxport | G e b ] [

The report makes it easier to find the role names along with their associated Yes and No access

permissions to each form in Estimate.
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A B c o E F G H
Account Account Administrator-
1 Type Category Ribbon Name 4 all Design - Eng - Admin  Design - Eng - Project Admin  Design - Eng - Project Team
2  Command
3 Command
4 | Command
5 Command Bond Cost Item Record Actions > View > Default Data Blocks
& Command Bond Cost Item Record MSA
7 |Command Cash Flow Actions > Print > Page Setup
8 Command Cash Flow Actions > Print > Preview
9 |Command Cash Flow Actions > Print > Print
10 | Command Cash Flow Actions > Tools > Cash Flow Options No Mo Yes No No
11 | Command Cash Flow Actions > Tools > Display Settings No No Yes No No
12  Command Cash Flow Actions > Tools > Worksheet No No Yes No No
13  Command Cash Flow LY
14 | Command Cash Flow MSA No No Mo No No

STEP BY STEP — ACCESS CONTROL REPORT

1. Open ajob, and then select the Setup tab.

2. Click the Reports icon.

You can access the Reports menu from the Setup, Estimate, Quote, Price, and
Execution tabs.

Setup Estimate Quote Price System Integrations

H ¥ Bt &L % a B B

230 Equipment

Job Properties  Foundation — Pay Item &  Bid Wizard | Resources __ ) Resource CostItem  Standard Reports
- Setup Data = Proposal - iTE Materials  Assemblies | Assemblies Tabley
Initialize Resources Assemblies Reports

3. Expand Library Module, and then select Access Control (Excel).

4. Select a file name, or choose another file name path.
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File name | C:\Users\Downloads'AccessControlExport. dsx

3.10 Security in Estimate

@ saveas

Control

Schedule

[ This PC
J 30 Objects
[ Desktop
|Z| Documents
<} Downloads

~ Hide Folders

Git Projects  #

Compliancel

EstimateCloud

@ OneDrive - InEigh

File name:

4 4 > ThisPC > Downloads

Organize New folder

0SDisk (C) o+ =~ Name

~ Last week (1)
@ InEight Contrel Celumns List (1).xlsx
~ Last month (5)

B3] AccessControlExport.xlsx

B3] Excel impert.xlsx

E32] Suite Administration PTaxlsx

B3] Platform topics.xlsx

B3| Roles-and-Permissions-Workbook xlsx

~ Earlier this year (9)

B3 InFight Control Columns Listxlsx
B3] improved.xlsx

v O O Search Downloads

Date modified Type

11/7/2023 2:08 PM

Microsoft Bxcel Work,

Microsoft Excel Work...

Microsoft Bxcel Work...
Microsoft Bxcel Work...
Microsoft Bxcel Work...
Microsoft Bxcel Work...

Microsoft Bxcel Work...

Microsoft Excel Work...

Save as type:

slsx files (*xlsx)

Save

5. Click Save, and then click Run.

File name | C:\Jsers\Downloads\AccessControlExpart.xlsx

© savehs

GitProjects
Compliancel
Control
EstimateCloud
Schedule

@ OneDrive - InEigh

I This PC

2 3D Objects
B Desktop
[£] Documents

4 Downloads

File name:

45 0SDisk(Cy) # A

4 ¥ 5 ThisPC > Downloads

Organize = New folder

Name

~ Last week (1)
32 InEight Control Columns List (1).xclsx
~ Last month (5)

33 AccessControlExport.xlsx

B33 Excel importaclsx

B33 Suite Administration PTaxlsx

B33 Platform topics.dsx

B33 Roles-and-Permissions-Workbook xlsx

~ Earlier this year (9)

E33] InEight Control Columns List.clsx

B3 improved.xlsx
<

Date modified Trpe Size @
11/7/2023 2:08 PM Microsoft Excel Work... 47
Microsoft Excel Work, 40
Microsoft Excel Worl 41
Microsoft Excel W 38
Microsoft Excel Worl 57
Microsoft Excel W a7
Microsoft Excel W 16w
>

v B £ Search Downloads

~ Hide Folders

Save as type: | xlsx files (*xdsx)

Cancel

Run Close

Close

What's Next: Open the Access Control Excel file to filter, sort, or perform any type of audit to help you
determine user or role access.
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3.10.5 GRANTING PERMISSIONS TO THE ESTIMATE

LIBRARY

In Platform, permissions relating to the Estimate library are found in the Master data libraries

permission section.

Suite administration / Roles and permissions

Roles and permissions > Edit role

Master data libraries

Select all

Account code structure Select all Contacts
(@) View Account code @ View contacts
() Add Account code (&) Add contacts
[} Edit Account code [ Edit contacts
(%) Delete Account code Promote contact to user
Approve/Reject Account code (%) Delete contacts
Approve all account codes .
Cost centers Select all Currency
@) View cost centers
(@) Add cost centers (@) Add currency
[=] Edit cost centers [} Edit currency
(%) Delete cost centers (%) Delete custom currency
Estimate Select all Field attributes

[ Edit estimate library (@ View field attributes
Use templates
(@ Add template

[=] Edit template

(¥) Add field attributes
[ Edit field attributes

(%) Delete field attributes
(%) Delete template

Cancel

Search...

Select all Cost categories Select all
(@) View cost categories

[=*) Edit cost categories

Select all Disciplines and commodities Select all
@) View disciplines and commodities

(@ Add disciplines and commodities

[} Edit disciplines and commodities

(%) Delete disciplines and commodities

selectall General ledger accounts Select all
(B) View general ledger accounts

(¥) Add general ledger accounts

[ Edit general ledger accounts

() Delete general ledger accounts

To grant Estimate library permissions to a role, the role must be an Administrator Level 3 - Account
Admin. If not, the permissions are not selectable on the Add/Edit Role setup page.
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= fa!  Suite administration / Roles and permissions

Roles and permissions >  Add role

Role details
* Name Description * administrator level
Estimate Administrator Level 3 - Account Admin v i)
Level 0 - Base
. . Level 1 - Project Admin
Permissions ;
Level 2 - Organization Admin
Level 3 - Account Admin h
Suite administration

Organization and project

Master data libraries

The Master data libraries permission section is also where the permissions controlling which roles can
manage templates are found.

3.10.6 COMMON ROLES USED WHEN SECURING AN
ESTIMATE

The process of creating an estimate for a bidding opportunity commonly requires unrestricted access
to the capabilities of Estimate so that estimators can work efficiently. However, depending on the level
of data governance within an organization, you might want to preclude certain users from accessing
some of the more sensitive parts of Estimate. If changes were made, either accidentally or otherwise, it
could impose detrimental impacts on the organization.

Estimate’s security model is very detailed and robust. When designing a security model that restricts
certain features and functionality of Estimate, each company must weigh the benefit of the protection
of such restrictions which could bring unwanted or uncontrolled changes and negatively impact the
productivity of the estimating process. While it is possible to create a very detailed and robust security
model with many different roles for individuals within an organization, it is not necessary to set up and
maintain roles for all of Estimates accessible objects. It is likely a company can effectively secure their
sensitive data with no more than a couple roles granting permissions to a few commands and
destinations.

A common way to implement security on the Estimate application is to restrict access to certain
system level settings, such as who can modify data in the library, or who can change any company
specified custom column captions.
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The following are some of the more common Roles a company may set up, describing the purpose of
the role and typical permissions:

¢ Lead Estimator: Lead Estimators are commonly assigned to estimates based on their knowledge
and experience. They may be precluded from creating or deleting estimates themselves or
changing any system level settings, but commonly have full access to all the capabilities needed
to create and maintain the estimates they are assigned to.

¢ Estimate Manager: Estimate Managers are commonly responsible for identifying bidding
opportunities and determining which opportunities to pursue. Once it has been determined that
the company will pursue an opportunity, the Estimate Manager creates the estimate and assign
it to a Lead Estimator based on resource availability relative to all the bidding opportunities the
company will be pursuing. These roles manage the creation of estimates and assist in ensuring all
the necessary supporting data is available, such as assigning appropriate project attributes or
including needed resource libraries.

¢ Administrator: Administrators ensure accessibility and availability of the solutions utilized by
estimators. Typically, they control system level settings and activities that would affect company
standards, such as changing column captions, ability to define corporate views, list of job
statuses and ribbon settings. Other typical permissions restricted to only the Administrator level
roles are the ability to access the User Roles register and the Access Control register.
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LESSON 3 REVIEW

1. When you create a new job folder, all category labels defined in the Library Foundation Setup
Data Register will be copied to the new job folder automatically.

a. True
b. False

2. This resource type is a catch-all and can be used for anything from dump fees and security to
creating subcontractors as a resource.

a. Installed Materials

b. Unique

C. Labor

d. Construction Equipment

3. The Construction Equipment and Rented Construction Equipment Resource Rate Records include
consumption rates that will factor with the fuel cost you define where?

a. Library Foundation Setup Data
b. Library Resource Rates

C. Job Properties
d

. Cost Breakdown Structure

LESSON 3 SUMMARY

As a result of this lesson, you can define, adjust and explain:
e Library Job Properties
¢ Library Foundation Setup Data Register
e Library Resource Rate Register

e Library Assembly Register
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LESSON 4 —- PROJECT SETUP

LESSON DURATION: 45 MINUTES
LESSON OBJECTIVES

After completing this lesson, you will be able to:

¢ Create a new project
e Enter Job Properties

e Create pay items in the Pay Item & Proposal Register

LESSON TOPICS
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4.1 JOB CREATION

In InEight Estimate, a job represents the folder containing your estimate (or version of your estimate),
including its related bid items, cost breakdown structure, resources, quotes, and change logs. All the
jobs in your organization are stored in the Job Register Overview.

To create a new job, you can choose from multiple options available when selecting New in the InEight
Estimate Backstage view. The image and table below show the available options.

InEight Estimate - o x

Create a new Job from...

Snapshot

opton | Deserpton

Scratch Creates a new job folder from scratch that is empty, containing no existing data.

Template Creates a job from an existing template, selected from the Template Register.
For more information, see Templates.

Existing Creates a job from an existing job, selected from the Job Register. For more
Job information, see Copy an Existing Job.

Bid Wizard Uses a wizard tool to create a new job by selecting pay items and/or cost items
from an existing source job. For more information, see Bid Wizard.

Archive Creates a new job from an Estimate Job Archive (.est) File. For more information
on creating and using job archives, see Archive and Restore Jobs.

Snapshot Creates a new job from a register containing snapshots for all jobs. You can
filter the register of snapshots to find the snapshot you need. For more
information, see Snapshots.
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4.1.1 CREATE AJOB FROM SCRATCH

When you need a clean estimating environment that is not based on any past work, select the create a
new job from Scratch option. Creating a job from scratch gives you complete flexibility and ensures no
assumptions are carried over from past estimates.

4.1.2 PLATFORM PROJECT ASSOCIATION TO JOB

In Estimate, you create a job that represents your project estimate and all the information associated
with it. This job must be associated with a project in InEight Platform that represents the overall
construction project being managed by your organization, from planning to execution and turnover.

When you select to create a new job, in the New Job window, select a project in the Core Project field
drop-down list to associate to your job in Estimate. Core project refers to a project in Platform.

InEight Estimate

Developer Tools Integrations
e i, S @2 = o=
—r = Saved Views ~ (& Colors ~ 1§ External Reports - @ e About Estimate
— 9] LS .
3/ Titles ~ ﬂ Output Settings ~ %)) External References ~ & Release Notes
Customize Estimate InEight
Help @ InEight.com University

Customize Help

Platform projects

M Project ID Project Name Status Created Date
Core Project: ™ | Project A4938 .
Project A4997 Project A4997 New 4/1/2020 3:56:14
Code: = [a4398 / \ [@l Project A4998 New 4/1/2020 3:56:14
Project A4999 Project A4999 New 4/1/2020 3:56:14
Description Clemson Creek Restoration project Project A5 Project AS New 4/1/2020 3:52:36
Project AS0 Project ASO New 4/1/2020 3:52:37
Project AS00 Project AS00 New 4/1/2020 3:52:41
[] Auto-Update Job in Connected Analytics Project AS000 Project AS000 New 4/1/2020 3:56:14
x

Because projects in Platform are organized in an Organizational Breakdown Structure, associating your
job (estimate) to a project in Platform allows your estimates to be included in that organizational
structure.

After the job you create is associated to a Platform project, in the Job Register, you can view the job in
the context of your organization breakdown structure. In the example below, the job register is filtered
to the Tantalum Group > Estimating > Site Work level of the organization. Under project ID number
5013592, you can see two jobs, the original estimate and a second version.
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Job Register ©

Organization
ProjectID =
Name

M : — ;50_1. " B Code = InUse Description Status Project Name Organization
Archive
>  Mssets B 4985362 1
East 4985362 4985362 2020 Clow Creek Shoreline Restoration EBidding 2020 Clow Cree...  Site Work
~ Estimating 4992404 1
Industrial Sector - B 5013592 2
Paving 5013592 5013592 Springbrook Golf Course Dynamic Sign In... | Bidding Springbrook Gal... | Site Work
e 5013592 5013592-v2 Springbrook Golf Course Dynamic Sign In...  Bidding Springbrook Gol...  Site Work
‘ ol 5013787 1
» Program 1
»  Stampede Ventures
> West

For more information, see Job Register Overview.

CREATE A NEW JOB FROM SCRATCH

From the Backstage view, select to create a new job from scratch.

In the New Job dialog box, click in the Core Project field to select a Platform job from the list.
Modify the Code field as needed.

Enter a description of the job in the Description field.

a K~ w0 N o=

Determine if you want to select the Auto-Update Job in Connected Analytics check box.
6. Click OK to create the new project.

RELEVANT LINKS

Job Register

Archive and restore jobs
Video - Create a job

Video - Associate Estimate with a Platform project

4.2 PROJECT CREATION

You can create new projects in InEight Platform’s root and sub-organizations to which you can then
associate Estimates jobs. For example, you can create new projects in a node of the organization
dedicated to estimating, permitting estimators to create and manage projects for the opportunities
they are pursuing while allowing the rest of the organization to maintain a higher level of security over
active projects.

For more information about project creation, see Project Initiation in Platform.
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4.2.1 CONSIDERATIONS

You must have a Level 3-Account Admin role or the Add projects permission in your role.

RELEVANT LINKS

Video - Associate Estimate with a Platform project

Video - Create a job

4.3 JOB REGISTER OVERVIEW

The Job Register contains all the jobs created by your organization and includes columns showing job
properties and other job details to make it easy to view, group by, and filter job information for job
management and reporting purposes.

Integrations

2 print [ Load | [&] Properties cut Fill Dewn > Uy E
-
 Preview Close | @ New Copy L
Job Status  Assodiate Jobs | Organization
' Export to Excel € Delete paste o Praject Tree Fiter
Print Edit Tools View 2
| Job Register @ | -
Organization X || brag columns here to group saved views: jol
Name
e R - Code = InUse Description Status Schedule Location City County State Cor
cefisTestOganeaton o001 [ CommR7me-Tuide.. 02Sstma. Mo .
s = C1 | comomrms -rwde.. | v2catma.. | v
s Rmeowen
0003 [] C2AD¥R7704-Twicke.. 02Estma.. Manual Shreya Bhatt Ekhorn
see
= 007 [ ] EacraitessRero..  Biddng Mirosoft Pray...
N _ 008 O JEA-Circuit 696 ReRo. Bidding Microsoft Proj...
[Nendypzog || 0951TRSO0S "] Training Job -Maricop... Bidding Vicrosoft Proj Maricopa  Arizona
_ 105091-3 O Steel Structure Trainin...  Bidding Manual Denver Arizona
_ 180780 O JEA-Circuit 596 ReRo...  Bidding Microsoft Proj... | edit
> swowmochdAr 2528508 []  oPPIs6Li7lneRepl.. Cass3  MioosoftProl. edt
- SO -MemtCopersten 257 ChangeMan R T —r— Varicooa
B » [ ibdesc: 1z Bidding InEight Sched
Future Org 1
< » [ | Training Job-Maricop.. Biddng  MicrosoftProj Maricopa
Future Org 2 =
7 — Ranchmarkina. EALCir | Bidding Micrnenft Broi | adit
+ Luke Test s N
11158
Amn mE v 137
a4 » "l »

4.3.1 OPEN THE JOB REGISTER

You can access the Job Register from the Backstage view by selecting File > Jobs > Job Register.
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InEight Estimate - [m] =
Jobs
D
- —
Job Register Delete Job Compare Jobs Connected Analytics

Templates

Snapshots

Archive [/ Restore

A non-editable version of the Job Register opens where you can select a job to open. Click File > Open
to open the non-editable Job Register.

L] .
= O Saved Views + {3 Output Settings + 1) External References = @ About Estimate
- .
) Titles = Fe Quantity Ttem Settings ~ @ Release Notes
- Estimate InEight
Ty) Extemal Reports - Hep @) InEichtcom  University
Customize Help -

New
Select the job to open:

Open
Drag columns here to group % | Enter text to search...
Code = InUse Description Status Schedule Location City County State Cou
= o001 CZADXR7704 - Twicke... 02Estima... Manuzl 2
0002 CZADXR7704 - Twicke... 02 Estima... Manual
Jabs 0003 CZADXR7704 - Twicke... 02Estima... Manuzl Shreya Bhatt Ekhorn
0004 Industrial Estimating T...  Templates | Primavera (W
Library 007 JEACircuit 696 ReRo...  Bidding Microsoft Froj
008 JEA-Circuit 695 ReRo...  Bidding Microsoft Proj
Templates
105091 TRG 0306 Training Job -Maricop...  Bidding Microsoft Proj Maricops  Arzona |
105091-3 Steel Structure Trainin...  Bidding Manual Denver Arzona 1
Snapshots
180780 JEACircuit 695 ReRo...  Bidding Microsoft Proj...  edit
Archive | Restore bl lib desc : 1:12 Bidding InEight Sched
2528583 OPPIS 6137 Line Repl...  Class 3 Microsoft Proj...  edit
257-ChangeMgmt Change Managemnt 2...  Bidding Microsaft Praj Maricopa
» b desc : 1:12 Bidding InEight Sched .
197
. »

RELEVANT LINKS
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Video - Create a job

Video - Working with registers

4.4 MANAGE JOBS FROM THE JOB REGISTER

The Job Register lets you perform many tasks to manage your jobs. You can perform tasks such as:

Load jobs.

Edit job details

Open and edit a job's properties.

Use the columns to group jobs.

View and upgrade data versions.

4.4.1 LOAD AJOB FROM THE JOB REGISTER

You can load (open) a job from the Job Register by:

e Selecting a job, and then clicking Load from the Actions tab.

* Righ-clicking on a job's row header, and then selecting Load.
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4.4 Manage jobs from the

Job Register

Library - Estimate

[Ey- load | [opropertes | 5o cut [ rloown | A E
& previen Close | @ New Copy oS
& Eworttosrcel Qosee | Brase e A | eeri
print edit Tools View -
Job Register © -
g s ere o g Sovedvens. 0
Coce S mie Desapn Swws  Shedde  Location oy comty s
o001 [ CzaOm7s-Tidkemham sufa.. | 02€stma... Manual B
o0z [ CzaOm7s-Tuidenham sufa.. | 026stima... Manual
0003 [ CzaOm7s-Tuidenham sufa.. | 026stima... Manual Shreya shatt ko
0004 [[]  industrial Estimating Template: Templates  Primavera (W.
o7 || EacratssoReRouesudy  Bddng  Maosofteros
[ | JEACraitesReRouteStudy  Biddng  Maosoftroj
> M | 1raining Job -Maricopa C
1050313 T StedStuctreTranng b3 Oemver  Anio
070 [ Facatesreomesudya 8 S
» [ bdescimz (5] Broperies
2528588 []  oPis6137Lne Replacement -br.. cf @ New
257.Changegnt [} Change Managemnt 257t st 54 @ Delete Warcopa
» [ bdescimz d3< Cut
» [] Traing b -Marcopa CountyNo... B¢ 1 CoPY Varicops
¥ [ Training Job -Maricopa County No... 52 Paste Maricopa
662 [] benchmarking EArast6dsReR 5+ il Down
ALt -Newest Y 5 Corepemisiondebuginfo Lo oo oo
AL-070725A [ CopyofTraning JobX Bl Associtelobsto Project peoa  Marcopa | Ao
b 1
19
“ >

¢ Double-clicking the row header of a job.

e wp  Estmate

B print B load | [5]Properties | - Cut

2 revien Cose | @ New Copy

& Eworttosrcel © oeete paste
print edit

FilDown | S ¥
Ly

JobStatus  Assodate Jobs | Organization
o Praj Tree Fier

Tools View

Job Register ©

organtzation X || orag columns here to ru
Nome
IO | ¢ S mse  oesapton Sths | Schedde
SeieTestoganztn o001 (] cromrms-Tude.. o2Estma... Manua
e 0002 (] coromrms-Tude.. o2Estma... Manua
e U oo e, o2 s
, 008 [ EACraitsssReRo.. Hddng  MaosoftPros
[ R B [ ] Traning Job -Mariop.._Biddng __ MosoftProl.|
_ 105091-3 ] Steel Structure Trainin... Bidding Manual
= 15070 [ EACraitssReto. Hddng  MaosoftPro)
oos » O e sddng  1eghtshed
> swowoochidAr 2528588 [ oPPiseis7ineRepl.. Class3  Mosoftrol
- AL -KewtCoposten 257-Changevont [] | changeManagennt2.. sddng  McosofePro
=2 » [ ibdesci Hddng | Inichtsched
Firergn » [] Toaing oo -V Sddng  MaosoftPro;
FireED Tmes [l Ranrhmart Riddinn . 4D
- e Test 7 N
1158
s o 137
« ol
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4.4.2 OPEN A JOB’S PROPERTIES FROM THE JOB

REGISTER

You can also open the Job Properties form of a job from the Job Register by:
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e Selecting a job, and then clicking Properties from the Actions tab.

B preview

& opotoo

Drag columns here to group

Code = e

o001
o002
o003
o004
007
008

105091 7RG 0306 Maricopa  Arizo
= 3 iz
t696 ReRoute Study A Bidding oftproj.. edt
» o desc : 1:12 Biddng it sched
2528588 Replacement -Br... Cass3  MiosoftProj.. edit
257-ChangeMgmt Change Managemnt 25.7int. test  Bidding Maricop:
» o desc : 1:12 Biddng
E3 ... Biddng Maricop:
E ... Biddng Maricop:
77662 eR... Bidding
ALL-Newest 30 A Bdng  McosoftProj. 2122NClarkStrest  Chicago Tinoi
AL-o707258 Copy A of Training Job X Bddng  McrosoftProj peoria Maricops  Arizo
z 1

brag cokams hre to grup soved vews 0

Code = muss  Desaipton Sttus  Schedue Location Gy comty  smte

o001
o002
o003
o004

007 JEACrat 6% ReRoute Study  Bidding  MicrosoftProj
o0 JEACrat 6% ReRoute Study  Bidding  MicrosoftProj

105091 7RG 0306

e -
=

= -

= ) e

oz s B craesonan. | pene

o T =
e P— e e [
z 1

4.4.3 EDIT JOB DETAILS

Many fields in the Job Register are editable, so you can make changes to job details directly in the
register without needing to open the job and its job properties.

The table below summarizes key columns available in the Job Register and indicates which of them are
editable.
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Editable from
Columns Description Register

Job Properties Cover
Sheet related columns

Quote Management

Job Folder Tags

Project/Organization

Notes

Project Notes

Last Saved
Job Created By

Source Job

Upgrade Required

Columns such as job status, location, city,
state, country, engineer, owner, architect,
estimator, contract duration, forecast start
and finish dates, and liquidated damages.

Quote information including Request for
Quote (RFQ) contact and minority info.

Custom tags defined by your organization
for organizing and managing jobs.

The Project ID, Project Name, and
Organization level associated with each
job.

General notes entered for the job.

Notes entered in the project's details in
Platform.

The date and time the job was last saved.
The name of the user that created the job.

The source job or template the job was
created from (if it wasn’t created from
scratch).

The column check box is selected if the job
was created in a previous release of
Estimate and therefore needs to be
upgraded to the latest release.

Yes, for fields that only
exist in Estimate.

No, for fields that come
from the associated
Platform project.

Yes

Yes

No. The Project ID
fields contain links
that take you to the
project’s details within
Platform.

Yes

No

No
No
No

No

You can make changes in the register by clicking in any editable field and editing the content. This
includes free-form text fields and validated fields with drop-down lists.

When changes are made, the register’s Close button changes to the Save Modified Jobs and Close
button, which you can select to save changes and close the register.
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System Developer Tools

#=h Print [ oad | [&) Properties Cut Fill Down
A Preview Close | () New Copy
' Bxport to Excel © Dekete B Paste
Print Edit 2
Job Properties Job Register O -
to group Saved views: | Previous vie Byel
Code = InUse Description Status Schedule Location City County State Country Latitude Longitude Type
0001 CZADXRTPO4 - Twicke... 02Estma.. Manual 0.00000 0.00000 Feasabiity e
0002 CZADXRTI04 - Twicke... 02Estma.. Manual 0.00000 0.00000 Fessabiity
0003 % CZADNRTPO4 - Twicke... 02Estma.. Manual Shreya Bhatt Ekhom 0.00000 0.00000 Feasabiity
0004 Industrial Estmating T..  Templates  Primavera (W 0.00000 0.00000
007 JEACraut 636 ReRo...  Biddng Microsoft Proj... 0,00000 0.00000
008 JEACrrouit 696 ReRo...  Budding Micrasoft Proj 0.00000 0.00000
105091 TRG 0306 Training Job - Maricop...  Bidding Microsoft Proj Maricopa Arizona  United Stat 0.00000 0.00000  Highway and Gener
105091-3 Steel Structure Trainin... Bsdding Manual Denver Arizona United Stat... 0.00000 0.00000 Highway and Gener
180780 JEA-Circuit 636 ReRo Bidding Microsoft Proj edit 0.00000 0.00000
s P Lb description Bidding InEight Sched. 0,00000 0.00000
2528588 OPPIS 6137 Line Repl... Class 3 Micrasoft Proj edit 0.00000 0.00000
257-ChangeMgmt Change Managemnt 2...  Biddng Microsoft Proj Maricopa 0,00000 0.00000 Highway and Gener
> b desc : 1:12 Bidding InSight Sched 0.00000 0.00000
» Training Job - Maricop...  Bidding Micrasoft Proj Maricopa 0.00000 0.00000 Highway and Gener
k2 Training Job - Maricop...  Bidding Microsoft Proj Maricopa 0.00000 0.00000  Highway and Gener
TI066-2 Benchmarking-JEA-Crr Bidding Microsoft Proj . edit 0.00000 0.00000
AL1-Newest Job A& Bidding MirosoftProj... 2122NClarkStreet  Chicago linois  UnitedStat.. 4192290 -87.64830 v
= 1
196
« .
| Save Modified Jobs and Close | | caneel

4.4.4 EDIT JOBS IN BULK

The Job Register includes functionality to make edits to the job properties of multiple jobs in bulk.

EDIT JOB PROPERTIES OF MULTIPLE JOBS

1. From the Job Register, select multiple jobs by selecting the row headers of multiple jobs while
holding down the CTRL or Shift key.

2. Right-click the selection, and then select Properties. This opens the Multi-Edit Job Properties

form. Items in red can be edited.
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Overview | CoverSheet | CostBasis | MinoritySetup | JobFolder Tags | Pridng Equipment Maintenance
Identification
Location:  Varies Type: Varies Contract Duration: Varies
City: Varies Engineer: £ Time Measure: | Varies
County: Varies Owner: | Varies H Forecast Start: | Varies
Country: | United States O Architect: | Varies | ForecastFinish: | Varies
State: | Arizona Duration: Varies
Latitude: Varies
Longitude: Varies
Proposal
Bid Dat=: | Varies - Opening Type:  Varies
Bid Time: | 12:00 AM ~ Proposal Type:  Varies
Estimator: | Varies Plan Holders: Varies

Save Cancel

3. Edit fields in Job Properties as needed, and then click Save. The changed properties are updated
in the Job Register.

4.4.5 OBS FILTER TREE

You can use the organization tree filter to see where estimates are located in the OBS.

When the Organization Tree Filter is enabled, you can see the jobs that are associated with an
organization tree node in the new OBS filter tree. This helps you to quickly locate and organize
estimates inside of an organization hierarchy.
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Library - Estimate

Estimate Integrations Actions

Systemn

i i i W T
E:I‘ Print Load Properties Cut Fill Down b Jai | +]
= 'l A
%. Preview Close e New Copy
Job Status  Upgrade § Organization
@! Export to Excel Delete E Paste Jobs Tree Filter
Print Edit Tools
Job Register ©
Organization * Drag column: aroup
L5 i Code = In Use Description
vl Foot Organization &
_ 04 - Substation Storehouse I:' Substation Storehouse
-
— = 06-082022 | | Elingson Test Template
FrontRange 1016FF [] Page Fadlitiy Upgrade
Mountains Division 1018WF [] Williams Faciity Maintenance
Southwest Division 1019GC [] Globe Center Re Haul
_ 104582 |:| Abuanga - Revenue Management
_ 104827 |:| Revenue Management - Abuanga
_ 104827-3 D This is only a description test. ...
- Comwy 104827-CERT [ ] Morton High School Football Complex -E...
» Location
_ 104827-CERT EM D Marton ngh School Foothall COITIDIE}( -E...
_ 104827E5T D Marton High School Football Complex
-
10509 1KL [ ] steelJobosi
105093 Steel training job [] Steel Structure Training Job 3
111222v2 [ ] BITestingJob 111222v2
| R — - ..

If you group by Project ID, and then select a node in the organization, you can see all the projects and
their associated estimates belonging to that part of the organization. For example, there are three
estimates associated with project 4985362 and one estimate associated with projects 4992404,
5013592 and 5013787. This view shows you the relationship between all the project and estimate
associations.
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Job Register ©
Organization X
ProjectID =
Name
- Infight Demo Inc. IP[')"j = s Code Description =
_ = 4985362
EQw 4385362 4985362 2020 Clow Creek Shoreline Restoration
Industrial 4985362 4985362-v2 2020 Clow Creek Shorsline Restoration - revised per Addendum #1
_ 4985362 49853623 2020 Clow Creek Shoreline Restoration - revised per Addendum #2
Mg = 4992404
_ 4992404 4992404 2020 Concrete Repairs Program
= —
5013592 5013592 Springbrook Golf Course Dynamic Sign Install

= 5013787

4.4.6 DATA VERSION AND UPGRADE REQUIRED

COLUMNS

There are two columns in the Job Register that help you identify a job’s current data version and

whether an upgrade is required for the job:

e Data Version - Identifies the current data version of the job which might be different from the

Estimate application version. This column in not part of the standard view and must be added.

¢ Upgrade Required - identifies jobs that require an upgrade to match the current database

version before they can be used in the application. The jobs that require an upgrade have the

check box selected.

Setup Estimate System

=h print Load Properties cut FilDown | n E
'a Preview Close e New Copy LA
JobStatus  Associate Jobs | Organization
2} Export to Excel Delete 2 Paste Tree Filter
Print Edit Tools View &
Job Register @ =
Organization % || orag columns here to group Saved views: | Previous View mpel
Tame Code Project ID Data Version gzﬂﬁﬁ F InUse Description
> 53- Project 1-5CE 1- 2nd restore S1-Project 1 24.7.0.3 Il Movie 66/16 - FAN De
’ 22Z-OBFUSCATE Training Job Il Description
e SR AL -A11 Il b desc : 1:12
’ Obfuscate 20250625 105869 Il Description
DP-OnPrem 0002 .7 Il Training Job - Maricop
new3 *25.5 - Estimate... |24.7.0.3 Il CZADXRT704 - Twicke

RELEVANT LINKS

Page 200 of 402

InEight Inc. | Release 25.7



Estimate Essentials User Guide 4.5 InEight Platform project association

Video - Create a job

Video - Associate Estimate with a Platform project

4.5 INEIGHT PLATFORM PROJECT
ASSOCIATION

To create a job in Estimate, you must associate it to a project in Platform. Associating Platform projects
lets you organize estimates directly from Platform’s Organizational Breakdown Structure (OBS). Your
location assignment in the OBS determines the access you inherit and the visibility you have to other
areas of the OBS. For more information about associating a job to Platform, see Job Creation.

Extracting Platform project master data directly into Estimate promotes data consistency and helps
ensure that the data is being pulled from a single source of truth.

InEight Estimate
System Developer Tools Integrations
— P /D == e T
=8 (> SavedViews ~ (& Colors ~ |4 External Reports ~ @ About Estimate
—— o) ~ s
¢/ Titles ~ ﬁ Output Settings ~ %, External References ~ @) Release Notes
Customize Estimate InEight

Hep @) InEight.com  University

Customize Help

Platform projects

M Project ID Project Name Status Created Date

Core Project: ™ | Project A4998
Y \ Project A4997 Project A4997 New 4/1/2020 3:56:14
Code: * |A4993 v ot~ [ Project A4998 Project A4998 New 4/1/2020 3:56:14
Project A4999 Project A4999 New 4/1/2020 3:56:14
Description: Clemson Creek Restoration project] Project A5 Project A5 New 4/1/2020 3:52:36
| Project AS0 Project ASO MNew 4/1/2020 3:52:37
Project AS00 Project AS00 New 4/1/2020 3:52:41
[] Auto-Update Job in Connected Analytics Project AS000 Project AS000 New 4/1/2020 3:56:14

X

Platform project-specific master data is maintained in one place, and then flows directly into Estimate
in the cloud. Certain project data such as location and forecast start and finish dates are maintained in
Platform which helps to enforce data consistency and reduce duplicate entries.

The table below shows the fields maintained in Platform's Project details that integrate with the
Estimate's Overview tab in Job Properties.
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Project ID Project ID

Organization Organization
Name Project Name
Notes Project Notes

The table below shows the fields maintained in Platform's Project details that integrate with the
Estimate's Cover Sheet tab in Job Properties.

InEight Platform | InEight Estimate

Address 1 Location
City City
Country/Region Country

State State
Latitude Latitude
Longitude Longitude

Forecast start date  Forecast Start

Forecast finish date Forecast Finish

In Estimate, the Project ID field is a hyperlink field. You can click the hyperlink to navigate directly to
the project Details page in Platform.
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=

File Setup Estimate System Developer Tools Integrations Actions

= Frint Load Properties Cut Fill Down _\ Uy E

'5!\ Preview Close e New Copy e

& Export to Excel Delete E Paste obstats Asfgg?;?ei?bs O—F?:ngtl?n

Print Edit Tools View -

Job Register © -

brag ok here fo gracp Saved vene: Js)
Code = Project ID In Use Description Status Schedule Location City County State Country Latitude
Checkeing Allocation of DCI Training Job for those of you who ...  Bidding Microsoft Proj...  edit 0,000 ~
CRO WO Report for 902564690 105869 CRO WO Report for 9. 03 Peer .. Manual FortS...  Rurals Alberta Canada 53.71
DP *25.3- AWPRe Hwy 17, Schreiber -R iouto Microsoft Proj Thunder B 0.00(
DP-OnPrem 0002 Training Job - Maricop...  Bidding Microsoft Proj... Maricopa 0.00(
KMP2-01-RDS-BLDG KMP2-251 Restored after Genesi... Bidding Manual Utah United Stat... 0.001
KMP2-02-115- aytoniXing KMP2-251 1-15 Layton Crossing 11lest Manual Davis Utsh United Stat. 0.00(
KMP2-04-RDS-INFR-DOT-2 KMP2-251 RDS - Infrastructure -...  Bidding Manual County Utah United Stat... 0.000
KMP2-11-Pay-Ttems-Import KMP2-251 Pay Items import testi Bidding InEight Sched Utah United Stat. 0.00(
KMP2-20-T KMP2-251 Training Job - KMP2 Bidding InEight Sched Maricopa Utsh United Stat. 0.00(
KMP2-24-Currency-Test KMP2-251 Currency test - Austr...  Bidding InEight Sched... Utah United Stat... 0.00(
KMP2-25-410-005-2 KMP2-251 InEight NOW: Health Bidding Manual Utah United Stat. 0.00(
KMP2-31-Virachoca KMP2-251 Renewable Energy Bidding Micrasoft Proj... Utah United Stat... 0,000
KMP2-32-March-AFE KMP2-251 March AFB -KC-4618..  Bidding Microsoft Proj... Los Angeles  Utah United Stat... 0.00(
KMP2-53-5MP-Job KMP2-251 SMP Data base Bidding Microsoft Proj Utah United Stat. 0.00(
KSProjectd KSProjectd lib desc : 1:12 Bidding InEight Sched... 0.00
KSProject4-New KSProject4 lib desc : 1:12. Bidding InEight Sched... 0.000 =
z 0

196
4 >

Close Cancel

Modifications made to any of the integrated fields in Platform automatically show in Estimate. For
example, when you change the name of the project in Platform to show the year 2025 instead of 2023,
the change reflects in the in the Job Properties Project Name field form in Estimate.

4.5.1 JOB REGISTER GROUPED BY PLATFORM
PROJECT

Grouping by organization lets you see projects batched in an organizational breakdown level, and lets
you see a listing of projects in an organizational breakdown format and projects derived in Platform.
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Job Register ©

Organization =

a
L3
w

Crganization = Source Job Project Name Description tatus Schedule Le

> Unassigned
Estimate Infrastructure
Estimate Mining
=P = Estimate Power
Estimate Power T SR-2023FEB restored tj
Estimate Power SaaS-Fullmport232 SR-DBt;

00000  Bidding Microsoft Proj..

207414 Bidding

00000 Bidding Microsoft Proj...
Biddng

2000

Primavera
Estimate Power DWH-2 SR-2023FEB SR-2023FEB
Estmate Power SR-Job2 SR-2023FEB from existing Microsoft Proj
o Estimate_Infrastructure_South Central

=5 = 5100000 - PKS Inc

5100000 - PKS Inc Rail Rail 00000 = Bidding Microsoft Proj.
5100000 - PKS Inc 51201--name 51201 1.00000  Bidding Microsoft Proj.
5100000 - PKS Inc SR-Job3 03102022 03102022 *,00000 = Bdding Microsoft Proj
5100000 - PKS Inc KwiSaa52212-5¢l 226-5R 0000 Bidding Primavera
5100000 - PKS Inc DB-0209 New project name: 2:38 SR-TEST API-123 000  Bidding Manual

5100000 - PKS Inc. new proj API Job from Import 000 ' Bidding Microsoft Proj... T

4.5.2 MANAGE MULTIPLE ESTIMATE VERSIONS IN THE
JOB REGISTER

An advantage to associating Estimate with Platform project data is the ability to manage multiple
versions of estimates from one source project.

For example, if you have multiple addendums issued for the same project, you can maintain a version
of the estimate for each addendum you’ve received.

Job Register ©
Project ID Description - Country State City Latitude Longitude
4985362 2020 Clow Creek Shoreline Restoration - Per Addendum 1 United Stat... Dlinois  Naperville 41.77287 -88.14793
4985362 2023 Clow Creek Shoreline Restoration - Per Addendum 2 United Stat . Tlinois  Naperville 41.77287 -88.14793
4985362 2023 Clow Creek Shoreline Restoration - Per Addendum 3 United Stat... Tlinois  Naperville 41.77287 -88.14793
4985362 2023 Clow Creek Shoreline Restoration - Per Addendum 4 United Stat... Ilinois  Naperville 41.77287 -88.14793
4985362 2023 Clow Creek Shoreline Restoration - Per Addendum 5 United Stat... Ilinois  Napervile 41.77287 -88.14793

Grouping estimates together using a common project means there is no need to structure and enforce
a job coding schema in Estimate on the Job Code, tag fields, or user defined fields to identify and
manage different versions of a project in the Job register.
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Job Register ©

ProjectID =

;"J' : Desaription - Country State City Latitude Longitude
B Unassignet

~ = 4985362
4985362 2020 Clow Creek Shoreline Restoration - Per Addendum 1 UnitedStat . Ihnois  Napervile 4177287  -88.14793
4985362 2020 Clow Creek Shoreline Restoration Project - Original Estimate  United Stat.  Dinois  Napervill 4177287  -88.14793
4985362 2020 Clow Creek Shoreline Restoration Project -Per Addendum 1 United Stat.. [Dinois  Napervile 4177287  -88.14793
4985362 2023 Clow Creek Shoreline Restoration - Per Addendum 2 UnitedStat.. Thnois  Napervile 4177287  -88.14793
4985362 2023 Clow Creek Shoreline Restoration - Per Addendum 3 UnitedStat.. Thnois  Napervile 4177287  -88.14793
4985362 2023 Clow Creek Shoreline Restoration - Per Addendum 4 UnitedStat.. TBnois  Napervile 4177287  -88.14793
4985362 2023 Clow Creek Shoreline Restoration - Per Addendum 5 UnitedStat.. Iinois  Napervile 4177287  -88.14793
o 4985922
O 4992404
B 4996059

RELEVANT LINKS

Platform — Project initiation
Job creation
Video — Create a job

Video — Associate Estimate with a Platform project

4.6 JOB PROPERTIES

When you create a new project, the Job Properties form automatically shows. This is where you can
enter basic information about the project. You can access Job Properties on the InEight Estimate
landing page > Setup > Job Properties.

4.6.1 OVERVIEW TAB

The Job Properties form opens to the Overview tab. The image and table below show the Overview
options:
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Integrations

A AEE

23 Equipment
Job Properties  Foundation — Pay Item & Bid Wizard | Resources __ ) Resource CostItem Standard Reports
- SetupData ~  Proposal - =5 Materials Assemblies | Assemblies  Tables

Initialize Resources Assemblies Reports -
Job Properties rtmcture (CBS) Register Job Properties @ =

COverview Cover Sheet Cost Basis Minority Setup Fuel Cost Job Folder Tags Pricing Schedule Cash Flow Equipment Maintenance Benchmarking Alternates

oCUde: 101-1 estatus: eProject ID: 101 °0rganization: 5100000 - InEight Inc

Description:  Trairing Job - Maricopa County No. TM2324 Project Name: o ojecivameis 101

Notes:  Use this field to record notes, information, spedial provisions, unusual RoicaNotes:

o conditions, etc. You will also find many other places to enter notes in
your estimate. You might use this area to enter general job type
information and enter more specific notes at the item or record level.

core.project 101 notes. edit -

Example: Embankments shall be so constructed that adequate surface
drainage will be provided at all times. Roadway embankment materials
that consist predominantly of soil shall be placed in horizontal layers not
to exceed 250 milimeters (ten inches) in depth before compaction, and
each layer shall be compacted to a density not less than 95 percent of
maximum density. Unless otherwise specified, the top 150 milimeters
(six inches) of the roadbed in both cut and fill sections shall be
compacted to 95 percent of maximum density, Maximum density and
optimum moisture will be determined by the Engineer in accordance with
the "Standard Method of Test for Moisture Density Relationship of Soils
Using & 2.5 kilograms (5. 5 Pound) Rammer and a 305 millimeter {12-
inch) Drop®, AASHTO T 99, Method C. The determination of the density
of the soil in place will be in accordance with an approved AASHTO
method. Placing and compacting areas shall be kept separate,

Last Saved: 9/24/2024 10:18:35 AM
Job created by: marappa@ineight e

Source Job: Training Job@

Overview Tab

Description

1 Code The name of the Estimate job. The
name cannot be changed.

2 Status Current state of the job, such as
Bidding, Awarded, or Completed.
» When searching for jobs in
the Job Folders list, you can
filter and sort jobs by their
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Overview Tab (continued)

I

status.

» You can set statuses for jobs
to fit your company
requirements in the Jobs
Register > Actions > Tools >
Job Status.

3 Project ID Information in this field originates
from the Platform project the
estimate is associated with and
cannot be changed. You can click
the Project ID link to navigate to
the project in Platform.

4 Organization Information in this field originates
from Platform.

5 Description You can enter a job description.
You can edit the description any
time.

6 Project name Information in this field originates

from the Platform project the
estimate is associated with and
cannot be changed.

7 Notes Add estimate related information,
such as when creating multiple
versions of an estimate for the
same Platform project. For
example, you can enter This
version is per addendum #1 or This
version is per a specified design
change, or This version of the
estimate is incorporating last
minute changes.
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Overview Tab (continued)

T N

8 Project Notes Information in this field originates
from the Platform project the
estimate is associated with. The
notes can be added and edited at
any time in Platform to document
specific project-level details.

9 Job created by Indicates the user or entity that
initially created the job.

10  Source job The name of the original job that
the job was copied from.

Al = When you copy a job, the new job shows the name of the person who created the copied
job, and the name of the source job the job was copied from.

4.6.2 COVER SHEET TAB

The Cover Sheet tab is where you can define much of the general information about the project. It
includes fields to identify the job’s location, contacts, and bid details.

The following fields are available:
e Job Location
 City, County, Country, Province/State
¢ Job Type
¢ Engineer
e Owner
e Architect
e Forecast Start and Forecast Finish
* Bid Date and Bid Time
e Bid Location
* Estimator

¢ Opening Type and Proposal Type
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e Liquidated Damages (if applicable)

Cost Breakdown Structure (CBS) Register Job Properties @
Overview Security Cover Sheet | Cost Basis Minority Setup Fuel Cost | Job Tracking Job Folder Tags Competitors Pridng Schedule Cash Flow Equipmeny L3
Identification
Location: ‘I-IU MP 100 to MP 120 ‘ Type: |Highway and General Engineering Contract Duration:
City: Engineer: | Example Engineer -- Fred Jones O] Time Measure: | ContractDays =
County: Owner: | Example Owner — Jerry Slate 2] Forecast Start: | 1/6/2014 -
Country: | United States - Architect: | Example Architect — Robert Frost & Forecast Finish: | 5/5/2014 -
State: | Arizona - Duration:z
Proposal
Bid Date: | 12/23/2013 - Opening Type: |Puh|ic ‘
Bid Time: |10:00:00 PM Proposal Type: |Un|t Price ‘
Estimator: | Example Prime Contractor 1 - Tom Cross [z PlanHolders: | 5 ‘
M 11 -

The fields on this tab can be helpful for historical reference and job classification. It is good practice to
complete as many of these fields as possible, so you can reference and find the project later. These
fields can be updated as needed at any time.

4.6.3 COST BASIS TAB

The Cost Basis tab has some important settings that will affect how costs are calculated in your
estimate. The settings reviewed below are the ones you need to consider.

e [ seEmw

1 Standard Shift The default standard shift arrangements are set up as 8 hours per shift,
Arrangements 1 shift per day, and 5 days per week; this can be changed if a project
requires a different standard shift arrangement.

2 Standard Allows you to indicate what percentage of your labor hours will be
Wage Rate regular time (Scale 1), overtime (Scale 2) or double time (Scale 3). You
Composite: can enter these percentages manually, or you can use the Shift Rate

Calculator to obtain a more accurate figure.

3 Lock Cost For this sample job, you will check this box. When Cost Items are
Items to Pay locked to Pay Items, your level 1 estimate structure is controlled by your
ltems: list of pay items.

4 Default The default will be set to U.S. Dollar, but this can be changed if
Currency: needed.
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T ™

5 Sales Tax This field is not required but may be used to automatically apply a sales
Rate: tax to all your material and rental items. The default is set to zero.

Cost Basis Tab Overview

Job Properties © =
Overview | Secu Caover Sheet | Cost Basis tup | Fuel Cost | Job Tracking | Job Folder Tageompeﬁmrs | Pricing | Schedule | Cash Flow | Equipmen’ 4
Standard Shift Arrangements Standard Wage Rate Composite Rules
Lock Cost Items to Pay Items [] Preserve Original Cost Item
Work Hours per Shift 8.00 Scale 1: o, Pay Ttem Unit Price Precision: 2 Data Source

Pay Hours per Shift: 8.00 Scale 2: 0.00] % [ Activate PBS Changes Log
[] Activate Quantity Checking

shifts per Day: 100 Scale 3: %
e J [ Maintain CBS Structure at Level: 0
shift / Rate Calculator When man-count changes: (® Change UM [ Man-Hour

e () Change Days
Currency Standard Rates

| Sales Tax Rate: 5.00( o |

Days per Week:

Default Currency: | .5, Dollar -

Resource | Assembly Filter

Resource / Assembly Type ™ | | Resource / Assembly File ... * | | Geographic Area || Wage Zone “ || Organizational Category 2 Import Filtered
Labor Rate [AIl [AI [ an [AIl Resources
Construction Equipment R... [ Mone] [ Mone] [ mione] [ mione]
[ I R 2 M i1 4 Mo 13 4 Mra_ ;1 4 Mra_ ;12 4
< > < > < > < > < >

oK | | Cancel

4.6.4 SHIFT RATE CALCULATOR

Take a closer look at calculating your shift rates using the Shift Rate Calculator. For this example, you
will walk through setting up 2 shifts for your project.
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4.6 Job Properties

STEP BY STEP — SHIFT RATE CALCULATOR

1. On the Job Properties > Cost Basis tab, select the Shift Rate Calculator button.

Job Properties @

Overview | Security | Cower Sheet | CostBasis | Minority Setup | Fuel Cost | JobTracking | Job Folder Tags | Competitors | Pricing | Schedule | CashFlow | Equipment >

Standard Shift Arrangements Standard Wage Rate Composite Rules

Scale 1: Y
Scale 2: Yo
Scale 3: Ya

Shift / Rate Calculator

Lock Cost Items to Pay Items

Pay Item Unit Price Precision:

[] Activate PBS Changes Log
[] Activate Quantity Checking
[[] Maintain CBS Structure at Level: 0

D Preserve Original Cost Item

Waork Hours per Shift 8.00 Data Source

Pay Hours per Shift: 8.00
Shifts per Day:

Days per Week:

(@ Change UM [ Man-Hour

(O Change Days %

[ o]

‘When man-count changes:

Currency Standard Rates

Default Currency: U.5. Dollar ~ Sales Tax Rate:

Resource [ Assembly Filter

2. For Shift 1, type a number value of hours in the Monday through Friday Work Hours fields.
» You can enter up to three shifts for the project
3. For Shift 1, type a number value of hours in the Scale 1 fields.

» Scale 1 will be your regular time and Scale 2 will be any overtime

Shift / Rate Calculator Record - Training Job

Actions
.ﬁ:ﬂ Copy Calculator from Library

Ej[ Copy Calculator to Library

e Clear Al

Tools

shift Rate Calculator Name: |[Enher Mame] ‘

Monday Tuesday Wednesday Thursday

Friday Saturday Sunday Tatals
= rrrr
#  Work Hours 10.00 10.00 10.00 10.00 10.00 ' a 0.00 50.00
Scale 1 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
Scale 2 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
Scale 3 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00

4. Enter a number value for hours in the Scale 2 fields (just Monday through Friday).
5. For Shift 2, type a number value for hours as you did above in Step 3.

6. Click OK.

Shift 2
Work Hours 12,00 12,00 12,00 12.00 12.00 0.00 0.00 50,00
Scale 1 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
Scale 2 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
Scale 3 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
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* Now you have a blended shift arrangement, and your labor rates are a blend of
64.18% straight-time and 35.82% overtime

Job Properties &

Owverview Security Cover Sheet Cost Basis Minority Setup Fue

Standard shift Arrangements Standard Wage Rate Composite

Wark Hours per Shift Scale 1z %
Pay Hours per Shift: Scale 21 %
Shifts per Day: 1.71 Scale 3z U

Days per Week: 7.00 Shift / Rate Calculator

4.6.5 IMPORT FILTERED RESOURCES
You may have noticed the bottom portion of your Cost Basis tab called the Resource Filter.

Reszource f Aszembly Filter

Resource f Assembly Type
Labor Rate

Construction Equipment R...
Rented Construction Equi. ..
Installed Material Rate
Installed Equipment Rate
Supply Rate

Unigue Rate

Resource Assembly

Cost Item Assembly
Standard Table

Resource [ Assembly File ...
[an
[ More]

[] Non-Blanks]
[ standard Labor Rate File

Geographic Area Wage Zone

Al 1Al

[ More] [ (None]

[ Mon-Blanks] [] Mon-Blanks]
D Southwest |:| Wage Zone A

|:| Wage Zone B

Select your filters from left
to right

Organizational Category

[an

[ None]

[] Non-Blanks]

[ Truck Driver - Teamster
|:| Supervision

|:| Carpenter

[ welder

[[1 Mechanic

|:| Operator

[1 remediation

[ Labarer

[ tron worker

[ Finisher - Concrete

————

oK Cancel

The Resource Filter portion of the Cost Basis tab is the most important part of Job Properties. You use
it to import your labor, equipment, and materials from the Library. Until you import filtered resources,
you have no resources (labor, equipment, materials) in your project.

Updated resource rates can be imported into the Library on a regular basis. It is important to update
and have the “Latest & Greatest” rates available to import into your estimates.
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You will import the rates you need using a set of four filters called Resource Attributes. Especially for
labor rates, filtering by these attributes allows you to pare down the master list to just the resources
you need.

Each of the resource filter categories are open for use as determined best by your business. The
following are examples of common uses:

Resource Attribute Filters

Name Description

Resource File  This attribute can be used to designate the rate type or the year to which the
Description rates pertain.

Geographic This attribute is used to designate regions, cities, or provinces based on

Area geographical location of a project.

Wage Zone This attribute is typically used specifically for labor resources. For example,
it may designate the trade and union agreements your labor resources
belong to.

Organizational  This attribute can be used to designate what trade or work type your
Category resources pertain to.

Resource filters become more specific from left to right, so it makes sense to start with Resource File
Description and end with Organizational Category. The geographic area, wage zone and organizational
category attribute titles can be changed to meet your business needs for filtering resources.

TIP You can sort the filter lists by clicking on the filter category titles.

The following steps walk through using the Resource Filter to import resources.

STEP BY STEP — IMPORT FILTERED RESOURCES

In your Job, go to the Job Properties > Cost Basis tab, select the Labor Rate resource type.
Under Resource File Description, select Standard Labor Rate File.
In the Geographic Area, select an Area.

For Wage Zone (Work Center), select a Wage Zone.

a K~ w0 N =

For Organizational Category, select All.
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6. Follow the same steps for the remaining resource types.
7. Select the Import Filtered Resources button to bring your selected resources into the job.

* For this example, we'll select the following filters for the Labor resource type:

Resource | Assenbly Fiter

Resaurce | Assemtly Type Resource | Assembly Fie .. Geograptic Area iage Zone Crganizationdl Category

LaboRite O Oy O u

Constructon EqupmentR.., [ ne] [ one] [ one] [ lhene]

Rented Construction Equi.. T Monarg] T bonflanks] T Monfiane] [ on k]

Installed Materd Rate Standard Labar Rat Fle Sauthest Wage Zone A ] Truck rver -Teamster
Insteled Equipment Rate [ Wiage Zore B [ Supenision
SupplyRate [ capenter

i D3t T Wl

Aleg = You must select “Import Filtered Resources” to import your resources. Clicking OK on the
Job Properties form will not import your resources.

4.6.6 FUEL COST TAB

On this tab you can enter the cost for fuel (or other energy sources). These unit cost will be multiplied
by the consumption rates entered on each equipment record to define the fuel operating cost of each
piece of equipment. The Cost per UM fields default to $0.00.

STEP BY STEP — ENTER FUEL COSTS

1. Inyour job, open the Job Properties > Fuel Cost tab.
2. In Cost Per UM column, enter a dollar amount into the following:
¢ Diesel

e Gas & Gasoline
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e Off Road Diesel

Job Properties @

Owerview Security Cover Sheet Cost Basis Minarity Setup Fuel Cost Jc

Fuel o E;'ft Curre Account
Type UM Code
Diesel £4.20 | U.5. Dollar Gallon

Gas £3.90 | U.5. Dollar Gallon

Gasoline £3.90 | U.5. Dollar Gallon

Off Road Diesel £3.20 | U.5. Dollar Gallon

3. Currency should read U.S. Dollar and UM should read Gallon.

4.6.7 JOB FOLDER TAGS TAB
On this tab, you can enter tag fields to label your project, so you can reference it later.

Job Properties @

Overview Security | Cover Sheet | CostBasis Minarity Setup Fuel Cost | Job Tracking Job Folder Tags Pricing Schedule Cash Flow Equipment Maintenance Benchmarking | Alternates

Job Folder Tag Assignments

Tag 1: - Tag 13: -
Tog 2: | | Tag 14: -
Tag 3: | | Tag 15: -
Tag 4: - Tag 16: -
Tags: | | Tag 17 -
Tag 6: ‘ | Tag 18: -
Tag 7: ‘ | Tag 19: -
Tag 8: - Tag 20: -
Tag %: - Tag 2L: 0.00
Tag 10: - Tag 22: -
Tag 11: - Tag 23: -
Tag 12: - Tag 24:

Many of these fields are validated fields, meaning you can choose from options in a drop-down list.
The names of these tags and the drop-down values are defined at a master level within the Library
Foundation Setup Data. Some job folder tags are setup to be date fields or numerical fields. These tags
are used to sort and filter the job register as well as for selecting which past estimates to utilize for
benchmarking.
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4.6.8 SCHEDULE TAB

The Schedule tab is used to define the scheduling options for the integration of Estimate with InEight
Schedule, Microsoft Project, or Primavera. The settings you define determine what information is sent
to your scheduling application or tool, and how it’s structured.

Cost Breakdown Structure (CBS) Register Job Properties @ =
Overview Cover Sheet | CostBasis Minority Setup Fuel Cost | Job Folder Tags Pricing Schedule Cash Flow Equipment Maintenance Benchmar Ly
Integrated Schedule: InEight Schedule - [ Always use Plug Days when updating Estimate from the schedule
Schedule Currency: .5, Dollar

Cost Item Roll Up

@ Automatically calculate Plug Days when rolling up costitems for scheduling purposes

Q Longest scheduled days amang all rolled up cost items

() Total scheduled days for all rolled up costitems

Note: When rolling up cost items for scheduling purposes, the Plug Days of the superior costitem
will be recalculated when a change is made to the scheduled days of a subordinate.

To force immeadiate recalculation of Plug Days for superior cost items, use the 'Recalculate Plug Days’
button or the 'Calculate Plug Days...' command on the Tools' menu in the CBS Register.

Recalculate Plug Days

¢ Integrated Schedule — Select your integrated schedule from InEight Schedule, Microsoft Project,
Primavera, or Manual.

¢ Schedule Currency — When you use Microsoft Project or Primavera, you can select the currency
type used for the integration. The InEight Schedule and Manual option is set to U.S. Dollar by
default.

¢ Plug Days - You can select Always use Plug Days when updating Estimate from schedule.

e Cost Item Roll Up — You can select to automatically calculate plug days when rolling up cost
items for scheduling purposes.

4.6.9 OTHER JOB PROPERTIES TABS

There are several additional tabs on the Job Properties form. The other tabs will not be discussed here
because they are either used for project controls, or they will be covered at another time.
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Other Job Properties Tabs

Name Function

Minority Setup  Used to set up minority participation goals (for example, DBE or MBE) and
you want to track minority participation goal attainment status during the bid
process,

Job Tracking Used to select the code that will be used when tracking job progress, define
the planned production calculation, define the percent complete calculation,
define the forecast methods, and define markup rates for calculating earned
revenue on Time and Expense pay items.

Pricing Used to define how you want the Balanced Unit Price for each of the job's
pay items to be calculated when using the AutoPrice feature. You can also
choose form several options in determining how markup is defined.

Cash Flow Defines the cash flow rules (payment terms) that are used in the calculation
of Job Financing and cost/revenue realization to generate the curves that
display on the Cash Flow form.

Equipment Used to define the calculation of maintenance labor man-hours based on
Maintenance equipment utilization, to capture the impact on total man-hours when
changes are made that affect the job's total value.

Benchmarking Used to establish the historical data to be used for benchmarking the current
job, and to define the default benchmark graph display and calculations.

Alternates Used to define Alternate Scenarios, to assess the impact of those scenarios.
RELEVANT LINKS

Video - Job properties

Video - Associate Estimate with a Platform project
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EXERCISE 4.1 — DEFINE JOB PROPERTIES

In this exercise, you will continue to define your Job Properties from the job you have created in two
parts. Complete the following steps:

Page 218 of 402 InEight Inc. | Release 25.7



Estimate Essentials User Guide Exercise 4.1 — Define Job Properties

1. On the Cover Sheet tab, fill out the following fields:

City Scottsdale
County Maricopa
Country United States
State Arizona

Type Infrastructure
Engineer Fred Jones
Owner Jerry Slate
Architect Robert Frost
Contract Duration 80

Time Measure Calendar Days
Forecast Start October 15, 2019
Duration (days) 70

Bid Date and Bid Time 10/1/2019 2:00 PM
Estimator Jim Sly

Bid Location 123 Main Street
Owner's Estimate $500,000.00

Opening Type Public

Proposal Type Unit Price

Plan Holders 10

Liquidated Damages  $1000.00 Per Day
RFQ Contact Jim Sly

In this part 2 of this exercise, you will continue to define your Job Properties from the Job you have
created. Complete the following steps:
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2. On the Cost Basis tab:

e Ensure the Shift Arrangement is 8 hours a day, 5 days a week
¢ Ensure the Wage Composite is set to 100% Scale 1

e Ensure the Sales Tax is set to 8%

You should end up with similar results

The following Cover Sheet properties are defined:

Job Properties O

Overview Seu.rn'anslBaa Mority Setup | FuelCost | JobTrackng | JobFolder Tage | CompeStors | Prisng | Schedue | CashFlow | EquiomentMsintensnce | Benchmarking | Alternstes
Identfication

Location: |Scottsdale Type: [infrastructure | Contract Deration: )
Gity: :swmaau Enginesr: | Exampie Engraer - Fred Jones i Time Measure: | Calenda Days -
County: I"-| aricopa Owner: | Example Owner -- Jerry Slate L Forecast Start: | 10/15/2019

Country: | US Architect: | Example Architect -- Robert Frost

§ ForecastFinish: | 12/34/2019
State: | AZ Duration: | ?ﬂj
Latitade: | 0.00000]
Lengitude n.onnca:

Proposal

Bid Date: | 10/1/2019 . Opening Type: [public

Bid Time: Proposal Type: _‘L‘mt Price
Estimator: | Hard Dollar Corporation - Chief Estimator - Jm Sly ) Flan Halders: -.c-'_
BidLocation: [123 Main Street | Liguidated Damages: |

$1,000.00]
Owners Estimate: |

$500,00000)  Liq. Damsges Pers | Doy

RFQ Contact: | Hard Dol Corporation - Chief Estmateor - Jm Sly

The following Cost Basis settings are defined:
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Job Properties O

Standard Shift Arangements

Work Houwrs per Shift s.un]
Pay Hours per Shift: 800
Shifts per Day: 1.un]

Days per Week: 5.00

Currency

Default Currency: | U5, Dolar

Resource [ Assembly Filter

Resource [ Assembly Type
Labor Rate

Construction Eguipment R...
Rented Construction Equi...
Instabed Material Rate:
Instaled Equpment Rate
Supply Rate

LUnique Rate

Resource Assembly

Cost Item Assembly
Standard Table

Standard Wage Rate Composite
Scale1: [ 100.00]%
Sealed: | 000)%
Sale: [ 000%

Shift | Rate Caleulator

Resource | Assembly Fie ...
O

[ Mon-Blanks]
Standard Labor Rate Fle

Rules

A Lock Cost ltems to Pay ltems
Pay Item Unit Price Precision:

[] activate PES Changes Log

[ Activaze Quantity Checking

[ Maintsin CBS Structure at Level:

When man-count changes:

Standard Rates
Sales Tax Rate:

[ Geographic Area
On

[ ione]

L inon-Banks]
Southwest

Exercise 4.1 — Define Job Properties

[ Preserve Original Cost Item

I

1

(O Change UM | Man-Haur
(®) Change Days

8.00| o

Wage Zone
Oan

[ rionel

[ (en-Btanks]
[=] wage zone &
[ wage Zone B

| Crganizational Category
]

[ (hone]

[ Non-Blariks]

[T Truck Driver - Teamster

[ carperter
[ weider

[ Operator
gaemm

mlmwlmm:m&ulmmt|mwm MFMT$|MM|M|M|MM|MtW Banchmarking | Alternates

Import Filtered
Resources

Congratulations, you have completed this exercise!

e
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4.7 PAY ITEM CREATION

Pay items typically represent the owner required deliverables a contractor must submit pricing for.
Within InEight Estimate, pay items are used to distribute the cost calculated in the Cost Breakdown
Structure and all markup, fees or contingency calculated in the Price Breakdown Structure to a list of
defined items. This allows the total estimate value to be distributed to a structure that is different then
the CBS. Pay Items are predominantly used by Contractors to prepare a bid sheet. Owners may use pay
items to identify funding sources or for various reporting needs.

Many Bid Forms are organized by grouping bid items for related scopes of work. Pay items within the
Pay Item and Proposal screen can be grouped in a hierarchy by utilizing the Position Code column.

You can create pay items in the Pay Item & Proposal Register. Access this form by selecting the Setup
tab > Pay Item & Proposal.

Estimate Quote Execution System Actions

& Bt &5 % a B B

24 Equipment
Job Properties  Foundation | Pay Item & | Bid Wizard = Resource __ ) Resource CostItem  Standard Reports
- Setup Data ~ Proposal Rates ~ &= Materials  assemblies | Assemblies  Tables

Initialize Resources Assemblies Reports

= =

1 Proposal and ltem Related to pricing during bid close-out. You can disregard them at
Recaps this time.

2 Pay Iltem Number Represents the bid item number from the client (if they give you
one) or can be a number you specify. This field is alpha-numeric

3 Position Code Controls the way pay items can be grouped, and provide you with
an efficient way to sort.

4 Description You can enter a pay item description.

5 Pay Quantity and The Pay Quantity is the quantity provided by the client.
Forecast (T/O) The Forecast (T/O) Quantity is your measured quantity for the
Quantity item.
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4.7.1 OVERVIEW - PAY ITEM & PROPOSAL REGISTER

Pay Item & Proposal Register ©

(1)

Proposal Recap - Training Job X | | Ttem Recap - 200 SITEWORK & ROADWAY x
Current Target Forecast | Variance Descrption UnitPrice  TotalPrice  UnitPrice  Total Price
Price: | $6,569,735.00 | $5897,950.68 | $6577,22380 | $67178432 | CUT =) G |ICoed gza)
Distrbution $319,781.07 $888,140.07
Margin%: 15.03 535 1588 | $731,83684 |CUT s $150,141.93 718,70.%
Profit (Markup records) $0.00 $568,618.53
A Business Overhead $150,141.93 $150,141.93 v
rag columns bmo aroup Saved views: Bre
Pay mme Positon 9 Lock L = 6 Pay Forecast (T/0) [ unitof Curency | UnitPrice Total Price UnitMarkop | TotalMarkup  Unit Total UnitMas
Number Code Quantty  Price Quantty  Quantty Measure (current) (current) (balanced) (balanced) Dstibuton | Distribution (aurrent
=[5 200 1 0 | | smework arosoway U.S. Dollar $3,402,700.00 $150,141.93 $319,521.54
+ 6410100 11 Mobiization 1.00 100 [ LumpSum | U.S. Dollar $395,600.00  $395,600.00 §737.74 §737.74 $4,435.45 $4,435.45
+ 210102 12 Clearing & Grubbing 10,00 10.00 | Ace Us. Dollar $5,300.00 $59,000.00 $257.19 $2,571.93 $1,25161  $12,516.08
+ 2020183 13 Undiassified Excavation 50,000.00 50,000.00 | Cubic Yard  U.S. Dolar $550  $275,000.00 $0.30 51484072 $083  $41,41420
+ 23812 14 Aggregate Base 40,000.00 45,000.00 | Ton U.S. Dollar $26.50  $1,060,000.00 $0.94 $37,486.90 $205 8205463
+ 3034263 15 ‘Asphalt Concrete Hot Mix Type A 38,000.00 35,000.00 | Ton U.S. Dollar $4245  $1613,100.00 2.9 $94,505.14 471 $179,101.18
= 400 2 . n] | warer s sewer U, Dollar $718,550.00 $34,584.99 $76,228.25
+ 413@) 0464 (2.1 36 Inch RCP Culvert Class Il 1,000.00 1,024.00 | Linear Feet  U.S. Dollar $97.45 $97,450.00 $4.33 $4,325.59 $9.94 $9,944.34
+ 8000220 22 10 Inch PVC Force Main (SDR21) 12,000.00 12,000.00 | Linear Feet  U.S. Dollar $29.50  $354,000.00 $1.43 $17,165.84 $3.04  $36,53154
+ 8000330 23 241nch PVC Gravity Sewer (SOR35) 3,000.00 3,000.00 | Linear Feet  U.S. Dolar $6450  $193,500.00 $3.16 $9,984.98 .32 $21,%5.47
+ 8000400 24 4Foot Diameter Manhole 16.00 16.00 | Each U.S. Dollar $4,600.00 $73,600.00 $225.57 $3,609.08 $486.68 $7,786.90
= 500 3 - | | smucturAL concreTE a srIDGES Us. Dollar $631,895.00 $32,304.21 $78,703.66
+ s01(a) 1306 |[3.1 Structural Excavation & Backfil 800.00 800.00 | CubicYard  U.S. Dolar $28.00 $22,400.00 $1.39 $1,11152 $3.16 $2,55.3
+ s0(a) 1322 |[3.2 Steel Reinforcement 30,000.00 30,000.00 | Pound U.S. Dollar s1.70 $51,000.00 $0.08 $2,53%.15 $0.13 $4,011.30
+ soymian laa Retaining Wal 55000 850,00 | Cibic Yard | 11.5. Dolar ssas 46325000 ©7.45 ©33%6.43 768 SS7.5%6.49 M
2 $6,569,735.00 $315,692.95 $645,755.99

STEP BY STEP — CREATE A PAY ITEM

1. Open your job and select Setup tab >Pay Item & Proposal from the InEight Estimate landing

page.

¢ The Pay Item & Proposal Register displays

In the Pay Item Number column, in the first blank row, type a number value.

Use the Tab key to move to the Description column and type a description.

Leave the Pay Quantity at 1.00 and change the Unit of Measure to LS (Lump Sum).

* The Forecast (T/O) Quantity will auto populate to match your pay quantity, but can be

changed later

e You can tab to the next row to create additional pay items if needed

Drag calumns heg sl
Pay Ite ock Row -
Number rice Mumber =

+ 1000

> n
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Line
Number

11

Find: | [Search Fo
Pay Unit of
De=cpbiont Quantity Measure =
Mobilization 100 LS

Saved views: | Simple View -

Total Price
(current)

$0.00

Unit Price
(current)

$0.00

% Margin

0.00
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4.7.2 PAY ITEM PRICES BY CATEGORY

Owners are increasingly requiring more information from contractors as part of their bid submissions.
Many times, this is a further breakdown of a bid price such as separating the price of an item based on

its labor cost, material cost or man-hours. Select columns in the Pay Item & Proposal register enable
users to summarize their pay item prices by up to 10 price categories.

In addition to seeing the price by category, these additional columns also give users better visibility
into how the price is established, including columns for the total cost, total distribution, total markup
and markup percent. These new columns make it easier to verify that the distribution of unassigned
cost and markup are calculated as intended by the estimator.

S L e P oot 0) kot o e | LR uecr WoR s Lscr |umr—vnce
mber Cod Quntty ntty  Quantty  Messure Cost oot o Marep et ey Pres(amen Markup % (urrent)

E0 Ty - SITEWORK &ROADWAY US.Doler  stez5z|  ssiareal S7,2474 $350,526.47 $394,902.06 2%

Fesowo 11 Mobii L0 100 LumpSun | US. Dolar $2,449.51 $306.50 s0ss| 209715 $31,365.80 298 539550000
+ w002 12 w00 .00 Aze Us.Dolar | s14880.57 730127 s 5% s22,405.37 23 $5,900.00
+ w2083 13 50,000.00 000000 CubicYard  US.Dolar  $62,230.08 $2,800.01 SLSSSL §73,576.00 §73,150.96 24 55
+o3s 14 40,000.00 45,000.00 Ton Us.Doler  $59,79493  SISE09.35 2am0 s1s083.29 17174265 24 s26.50
+ 03463 15 Asphalt Concrete Hot Mix Type A 38,000.00 3500000 Ton Us.Dolar  §12,473.43  §18,17487 97405 1340235 SL2,97.60 24 S35
= a0 2 WATER 8SEWER US.Dolar | $128,895.90 62,3244 Q202 152,427 $167,735.34 24
+ a0 21 36 Inch RCP Culvert Class I 1,000.00 102900 LnearFeet  US.Dolr  $19,602.99 308468 sw6ss 2317466 28474 24 so7.45

4.7.3 STANDARD PROPOSAL REPORT

The Pay Item Standard Proposal report is located in Execution > Reports > Pay Item & Proposal >
Standard Proposal, and is intended to be used as a bid form, and distributed to other clients, partners,
and contractors. In the Details box below, you can determine which key fields you want included and
shown on your standard proposal report.
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Reports - Standard Proposal O
« Reports

Job Propertes

Foundation Setup Data
Resources

Resource Assemblies

Cost Breakdown Structure
Quotes

Price Breakdown Structure

Settings: | Defoult

Print | Details | Layout | Header/Footer

Show the below Pay item details
Line Number
Pay Ttem Number

PositionCode

Filker by currency:

No Fiter

Show the below Proposal header items

Pay Item & Proposal

[ subtotzls

] Running Totals
[ Suspended Items

Pay Item Currency Comparison) Include Additional Proposal pages

Pay Item Frice Breakdonn [ coversheet

» [E] Biling Rate Reports
> 48 Job Tracking
Estimate C

[ preferences sheet

Audt @ Truncate values based on dedmal precision

b Register O Do nottruncate values (show decimal precision)

S

Library Module

[ 20b Code [aobcity

(] 20b Description [ 20b County
[ 5id Date [ 20b state
[ 6id Time [ 20b Country

[ abLogtion

‘Term for Document:
@ Proposal eid
O Tender

O custom

[

Custom Reports Certification Text:

O Nene

® Custom

4.7 Pay Item Creation

aved Viens

©  BudgetExports
ASystems
‘American Contractor (versions 4.1
Bidtek Vision

Print
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EXERCISE 4.2 — CREATE PAY ITEMS

In this exercise, you will practice creating pay items in the Pay Item & Proposal Register. Complete the

following steps, using a job of your own.

Position Pay Item Unit of
Code Number Description Quantlty Measure

SITEWORK

& ROADWAY
1.1 6410100 Mobilization 1 LS
1.2 201 0102 Clearing & Grubbing 10 Acre
1.3 202 0183 Excavation 50,000 CY
2 400 WATER & SEWER
2.1 800 0220 10 PVC Pipe 1,000 LF

You should end up with the following results:

Forecast

e UL 7 S PN e BT
—@ SITEWORK & ROADWAY
i L 5410100 Mabilization 1.00 1.00 LS
+ 12 2010102 Clearing & Grubbing 10.00 10,00  Acre
+ 13 2020183 Excavation 50,000.00 50,000.00  CY
—ﬁ;ﬂl WATER. & SEWER
00 0220 10 PVC Pipe 1,000.00 1,000.00 LF

Congratulations, you have completed this exercise!
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LESSON 4 REVIEW

1. This is where you enter basic information about the job as well as define your cost basis.
a. Pay Item & Proposal
b. Job Properties
C. Library
d. Job Folder

2. On the Job Properties form, this tab is where you enter information such as the start
date, bid date, job type and location.

a. Overview
b. Cover Sheet
C. Cost Basis

d. Foundation Setup Data

3. These are the project deliverables; anything the owner agrees to measure and pay for.

a. Cost Items

b. Resources

C. Target Price
d

. Pay ltems

LESSON 4 SUMMARY

As a result of this lesson, you can:

¢ Create a new job
e Enter Job Properties

e Create pay items in the Pay Item & Proposal Register

InEight Inc. | Release 25.7 Page 227 of 402



Lesson 4 Summary Estimate Essentials User Guide

This page intentionally left blank.

Page 228 of 402 InEight Inc. | Release 25.7



Estimate Essentials User Guide

LESSON 5 — DIRECT COSTS

LESSON DURATION: 30 MINUTES
LESSON OBJECTIVES

After completing this lesson, you will be able to:
¢ Explain the Cost Breakdown Structure and its purpose
e Create cost items
e Add costs and production

e Manage cost item details

LESSON TOPICS
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5.1 COST BREAKDOWN STRUCTURES

The Cost Breakdown Structure (CBS) is the main form where you will do your cost estimating.

e Itis the hierarchy of work activities that make up the estimate
e Each row in the CBS represents a work activity or organizing category and is called a cost item

To access the Cost Breakdown Structure, from the InEight Estimate landing page select the Estimate
tab, then under the Breakdown Structure section select Cost Breakdown Structure (CBS).

Quote Price Execution Actions More Actions

M = o, & ¢

s @ | |Base -
Workbook

System

Alternate Scenario: | @

Reports

ol by

+

Price Breakdown |
Structre (PBS) = | £y Alternates

Overhead and Pr...

Indirect
Cost Items

Cost Breakdown -
Structure (CBS) i

Schedule  Cash Flow

Breakdown Struc... Res... Workbook Schedule Indirect Cost Alternates Reports

Overview - Cost Breakdown Structure (CBS) Register

T T S

1 Actions Shortcut icons allow you to edit cost items and import items from other
Menu sources such as Excel.

2A  CBSTree The CBS Tree filter shows the CBS hierarchy and is used to quickly help
Filter Mode filter cost items, instead of scrolling the CBS to locate certain cost items.
(drop- The CBS Tree Filter lets you choose between a filter mode or a new
down) navigation mode.

2B CBS Tree  Both Filter and Navigation modes on the left side of the page provides you
Filter or with the visibility of your entire CBS structure, as well as giving you the
Navigation option to navigate and filter throughout the CBS estimate. The Cost Item
Mode record can also be tiled next to the tree to make navigating and filtering

possible, while viewing all the cost item record details at the same time.

3 Left CBS This side of the register contains all of the estimate activities (cost items)
register that you create or import, organized into a parent-child hierarchy.

4 Right CBS  This side of the register contains numerous columns for cost detail,
register production values, and user-defined tags and fields.
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Training Job - Estimate

&Eh print @ New  GgyCopy Split Indent Link Field Cost Ttem Assembly Resource /‘ s w E (CES Tree Filter Mode:
=B, Preview Delete Paste Split by Cost Type Outdent Unlink Field | "= Subordinate CostItem | = Subordinate Assembly Resource Assembly ” » Filter -
Expand/ Fiter Clear ||| cBSTree
& Bxport to Bxcel cut Fil Down ¥ Toggle Suspended E% Dependent Cost Item Colapse =~ Filter Filter
Navigation
Print Edit Workbook Insert View - 0
Cost Breakdown Structure (CBS) Register @ = o
&) 0
e CBS Tree (Filter Mode) % || brac columrs here 1o aroun A4 b "4 Saved views: | Stancard vizn -0
cgc-de Desaription <] ; y Gptional Forscast Unit of ; Total Cost Subject Cost
S Position Code = Desaiption Code (T/0) Quantity Measure G (Forecast) StDjectCost Rate Alocaid
v 08
gg Prime Bond - B JoB 20.04 | Mile $294,138.13  §5,882,762.51 m &
g8 Frice % Add-On Prime Bond FRIME BOND 1.0q | Lump Sum 547,146.68 $47,148.58
= Job Financing Price % Add-on PRICE % ADD-ON 1.0g | Lump Sum $295,638.13 $295,638.13
og
oo Indirect Cost Esc Job Financing FINANCE EXPENSE 1.04 | Lump Sum $33,105.26 $33,105.26
g8 Direct Cost Escal
oo 1 Indirect Cost Escalation INDIRECT COST ESCALATION 1.0 | Lump Sum $£2,131.11 €2,131.11
g8 Indirect Cost Add§
og Direct Cost Escalation DIRECT COST ESCALATION 1.0q | Lump Sum $15,048.80 $15,048.80
g8 Direct Cost Add-J
oo -
Indirect Cost Add-On 1.0q | Lump Sum $5,888.67 £5,888.57 $294,433.42 200
> g@/ 1 | SITEWORK &RO)
Direct Cost Add-On DIRECT COST ADD-ON 1.0 | Lump sum §104,088.34  $104,088.34  §5,204,417.24 200
> gal2 | WATER & sEweR)
» 3| smUcTRALCO) E1 SITEWORK & ROADWAY 200 1.0 | Each $2,464,161.55  $2,%4,161.56
» 4| mousTanL aR +oaa Mobilization £410100 1.0 | Lump sum $11,909.51 $11,909.51
> g8 comvERCIAL + Az Clearing & Grubbing 2010102 10.0q| Ace $3,918.50 $33,184.87
> §@/8 | GUARDRAIL &SI E 13 Undlassified Excavation 2020183 50,000.0q) | Cubic Yard $4.68 £233,915.81
> am|? | Indrect Costs T aaa Excavation 13.1 50,000.0q) | Cubic Yard $3.00 $149,922.88
[®] &8  Spedil Risk Allow, + 132 Embankment 132 50,000.00 | Cubic Yard $1.68 $83,592.94
E 14 Agaregate Base 3035912 45,000.00 | Ton $15.40 $692,928.99
+ 141 Furnish & Haul Base Material 141 45,000.00 | Ton $11.54  $519,513.30
+ 142 Finegrade Subgrade 142 400,000.00) | Square vard .18 §75,84.36
B 143 Install Agaregate Base 143 45,000.00 | Ton $2.17 $97,567.33
+ 1431 Place Aoorecate Base 1431 45.000.0 | Ton $1.63 £73.960.92 M
107 $5,882,762.51
< 1 »

5.1.1 COST ITEM TERMINOLOGY

The CBS contains both direct and indirect costs.

 Direct Cost Items contain costs that pertain directly to the deliverables of the project. Therefore,
direct cost items are typically assigned to pay items

¢ Indirect Cost Items contain overhead costs that are not directly associated with particular
deliverable items but contribute to the total cost of the project (e.g., supervision, site office,
safety supplies, bid securities). Occasionally an indirect cost item may be assigned to a pay item
(e.g., Mobilization costs that are indirect but assigned to a Mobilization pay item).

InEight Estimate uses various terms to describe the parent-child relationships of the multiple levels in
the CBS:

Superior A Superior cost item has subordinate (child) items below it that determine
hours and costs.

Subordinate A Subordinate cost item is a child to a Superior cost item.

Terminal A Terminal cost item has no subordinate items. Resources, costs, and
production can only be added at the terminal cost item level.
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o= A Terminal cost item may or may not be a subordinate.

The levels of the CBS are referred to as Level 1, Level 2, etc., as you drill down in the structure. As costs
are defined on the terminal items, the sum of the terminal cost items roll up to the superior cost items.

TIP A superior cost item can have no costs of its own; its costs are strictly the rolled-up total
from the subordinate cost items below it.

You can use superior cost items as buckets for organizing your work.

As hours and costs are defined on the terminal items, the sum of the terminal cost items roll up to the
superior cost items.

5.1.2 WORK BREAKDOWN STRUCTURES

The Work Breakdown Structure (WBS) allows you to reorganize the estimate using different formats
such as Construction Specifications Institute (CSI) MasterFormat or UniFormat. WBS formats are used
when you need multiple variations and summary reports of an estimate. The WBS retains the same
relationships between items as in the original estimate while only changing the view and items
arrangement in the WBS hierarchy.

To view the Work Breakdown Structure View Register, in the Ribbon select the tab Estimate > Work
Breakdown Structures.

Overview - Work Breakdown Structure (WBS) View
Register

[ | emmaw

1 WBS Use the WBS Tree to filter to a particular WBS item.
Tree

2 WBS When a specific WBS item is selected in the WBS
Grid Tree, all subordinate WBS items display in the WBS
grid.

3 Cost The Cost Items associated with the WBS
ltems  subordinate in the WBS Grid displays in this data
block.
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5.1 Cost Breakdown Structures

Cost Breakdown Structure (CBS) Register Quote Register

Quote Comparison & Award - Resources Work Breakdown Structure View Register ©

wBS Tree g X [llorag columns here to group Find: | [Search For...] + | Saved views: | Standard View -
N Unit of Total Cost
wes: | CEAS - Code = Description Quantity Tt currency Unit Cost Forecant)
= il Engineeri 4
& Desaiption CEAS Civil Engineering Account Code System 100 Each U.S. Dollar $2,494,088..  $2,494,088.07
s il Engineering Account Corde System = 10 GENERAL PROVISIONS 100 Lump Sum U.S. Dollar $35,054.51  §35,05451
>0 GENERAL PROVISIONS _-KIEI\I’ 100 Each U.S. Dollar $14,000.00 $14,000.00
> 12 PAVEMENT WORK 10.10.200 OFFICE FACILITIES 100 Each U.S. Dollar $2,000.00 $2,000.00
> 13 BRIDGE WORK 10.10.500 UTILITIES 100 Each U.5. Dolar £8,000.00 $8,000.00
> 14 CONCRETE STRUCTURES SETUP 1.00 Each U.S. Dollar 514,624.39 $14,624.39
> PIPE WORK 10.20.100 MOBILIZATION 1.00 Load U.S. Dollar $11,909.51  $11,909.51 ¥,
37 $2,494,088...
< >/
Cost Ttems x
Drag columns here o Find: | [search For..] | saved views: | Standard view -
8BS L Gptional Forecast Unit of . Total Cost Alocation Cost Resource Assembly
Foston Code —  DEERon Code (T/0) Quantity Measure R e S T CONEnCY | pgustment | Quanty
S o+ 231 Setup Yard UNASSIGNED 1.00  Lump Sum $4,000.00 $4,000.00 | U.S. Dollar I 0,
1 100 $4,000.00
R >

5.1.3 LOCKED

VS. UNLOCKED APPROACH

There are two basic approaches to structuring your cost items and pay items. You can choose to work

in a “locked approach” or an “unlocked approach.”

In a locked approach, level one cost items are automatically created and assigned to pay items. This
locked approach works well when pay items adequately represent the work plan. Subordinate cost

items inherit the pay item assignment of superior cost items.

Pay Item &
Proposal

0
S
=
>
©

o
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Meyg= If the Lock Cost Items to Pay Item rule is checked in Job Properties, InEight Estimate will
automatically create level 1 cost items in the CBS Register for each of your pay items.

The unlocked approach may work better when the pay items do not adequately represent the work
plan. You can then assign your cost items to your pay items in any arrangement. Companies looking to
standardize the way they estimate and use templates will want to use this approach as it allows you to
dictate the cost breakdown structure. Owners will also typically use the unlocked approach since pay
items are not necessary to their estimating process.

Pay Iltem &
Proposal

-
£

-
>
®

o

Pay Items

Pay Item 3 | Pay Item 2

S

The option of working in a locked approach vs. an unlocked approach is available in the Job Properties
Form, on the Cost Basis tab under the Rules section. By selecting the checkbox for Lock Cost items to
Pay Item, you are choosing to work in a locked approach.

|Jnh Properties @ |

Overview | Security | Cover Sheet I Cost Basis I Minority Setup | Fuel Cost | Job Tracking Job Falder Tags | Competitors | Pricing | 5

Standard Shift Arrangements Standard Wage Rate Composite Rules
I Lock Cost Items to Pay Items I C

Work Hours per Shift 8.00 Scale 1z 100.00 | 2% Pay Item Unit Price Precision: 2
Pay Hours per Shift: 8.00 Scale 2: % [] Activate PBS Changes Log

[[] Activate Quantity Checking

Shifts per Day: 1.00 Scale 3: %
= g [] Maintain CBS Structure at Level: 0
shift / Rate Calculator When man-count changes: (®) Change UM/ Man-Hour

(O change Days

Days per Week:
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5.1.4 TAKE-OFF QUANTITIES

In the Cost Breakdown Structure, estimated quantities are entered into the Forecast (T/O) Quantity
field with a corresponding unit of measure. The quantity will default to 1 each when you create a new
cost item and should be updated to reflect the work being estimated.

CES

Eoosdigon = Description ?}OegaQsjanﬁty

+ 1 Mobilization 1.00
+ 2 Clearing & Grubbing 10,00
2 3 Unclassified Excavation 50,000.00
+ 31 Excavation 50,000.00
+ 3.2 Embankment 50,000.00
= a4 Aggregate Base 45,000,00
+ 4.1 Furnish & Haul Base Material 45,000,00
+ 4.2 Finegrade Subgrade 400,000.00
= 43 Install Aggregate Base 45,000.00
+ 43.1 Place Aggregate Base 45,000.00
+ 4.3.2 Blue Top Aggregate Base 400,000,00

Meyga Forecast (T/O) Quantities are only used for your cost items in the CBS Register.
Pay Quantities are used for final pricing in the PBS and Pay Item & Proposal forms.

Because the training project is a “locked” job, you already have level 1 cost items, and their default
take-off quantities are populated from their corresponding pay item quantities.

The following step by step walks you through adjusting the default take-off quantities on a couple of
your cost items.

STEP BY STEP — ADJUST TAKE-OFF QUANTITIES

1. From the Estimate tab, select Cost Breakdown Structure (CBS).

2. In the Forecast (T/0) Quantity column, the Forecast (T/O) Quantity is brought over from the Pay
Iltem & Proposal Register, but here you can adjust it if needed. Practice adjusting the Forecast
T/0 quantity of one of your cost items.

e For this example, we’ll change Clearing and Grubbing to 15.00 Acre and Excavation to
40,000 CY.

InEight Inc. | Release 25.7 Page 235 of 402



5.2 Cost Iltem Creation

I |

+ L3

- SITEWORK & ROADWAY

Mabilization
Clearing & Grubbing
Excavation

WATER & SEWER
10 PVC Fipe

5.2 COST ITEM CREATION

Estimate Essentials User Guide

1.00

1.00
15.00
40,000.00
1.00
1,000.00

Each
LS
Arre
CY
Each
i

During estimate development, you will create new cost items to break down your work into specific

activities. You can create superior and subordinate cost items as needed to organize your work.

5.2.1 INSERT SUBORDINATE COST ITEM

You can add subordinate cost items in two different ways:

OPTION 1

Right-click on the row header of the superior cost item and select Insert Subordinate.

Drag columns here o up = VI
I-Zq Paste
CEBS
Pasition Code pesciptha | Fill Down
1
= 108 “EL Link this field to Excel
Prime Bond .
y UnLink from Excel
Price % Add-On |
Job Financing | Indent
Job Management & Equ Outdent
General Expense
Insert
+ 1 HMobilization
L2 Insert Subordinate "
+ 3 Insert Dependent Cost ltem
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5.2 Cost Item Creation

The row header is considered the far left edge of the CBS row where the small arrow appear appears
above. It is used to open records and perform actions on items instead of clicking on cells within the

row which will allow you to directly type into the selected cell.

OPTION 2

Click on the Subordinate Cost Item icon on the Cost Breakdown Structure (CBS) Register toolbar.

Quote Price Execution System Actions More Actions
Fill Down g Cost Item + Assemb
Split 2L | 7= subordinate Cos \tem = Subordinate Assend
Toggle Suspended £ Dependent C4
Insert
) Register ©
Drag colun ere to gro Find: | [Search For...]
EE: fon = Forecast
Code (T/O) Quantity
+ 1 1.00
=2 3 Unclassified Excavation 50,000.00
i kil Excavation 50,000.00

5.2.2 INSERT COST ITEM

You can add cost items at the same level in two different ways.

OPTION 1

Right click on the row header of the superior cost item and select Insert.

InEight Inc. | Release 25.7
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$2 Description ~ -
Position Code ﬁ) Paste
+2  Clearing & Grubbing &4 Link this field to Excel
_@dm é-!, UnLink from Excel
ol Excavation = Indent
a2 EStEiment 4= (Qutdent
=4 AggregateBase -

N rﬁwadesmg'ade F:. :nsertSugordlnate
= 43 Install Aggregate Base i nsert Dependent Cost ltem
+ 431 B et Base E’ Insert Cost ltem Assembly
+ 432 B A egate Base ==+ Insert Cost ltem Assembly as Subordinate
S5 AsphaltConcreteHot MixTyy | SPlt
+ 5.1 Furnish & Haul Hot Mix Ze Insert Resource

| e 4 E£n Tectoll et Bl Toeme A beS o " i

OPTION 2

Click on the Cost Itemicon on the Cost Breakdown Structure (CBS) Register toolbar.

Quote Price Execution System Actions More Actions
" Fill Down +== Cost [tem == Assembly Z
| Split 4= | Il | "= Shbordinate CostItem | [ Subordinate Assembly | g
; Toggle Suspended H Ddoendent Cost Item
Insert
i) Register ©
Drag columns here to group Find: | [Search For...]
EES.ﬁ Forecast Unit of
ositan {T/O) Quantity Measure
1.00  Lump Su
10,00 Acre
50,000.00  Cubic ¥z
BT
+ 3.2 Embankment 50,000,00  Cubic Yz
I
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Because the project you are working in is a “locked” job (where cost items are locked to pay items),
your CBS Register will already have level 1 cost items representing each of your pay items, and each
cost item will be assigned to its corresponding pay item.

The following step by step walks you through creating a subordinate (child) cost item for one of your
level-one cost items.

STEP BY STEP — CREATE A SUBORDINATE COST ITEM

1. From the Estimate tab, select Cost Breakdown Structure (CBS).
2. Right-click on a cost item and select Insert Subordinate.
¢ This creates a new subordinate cost item below your selected cost item
3. For the subordinate cost item, enter a description.
4. Add a quantity and select your Unit of Measure.

¢ For this example, we'll insert a subordinate under Clearing & Grubbing for Clearing

=1 SITEWORK & ROADWAY 1.00 Each
+ 11 Mobilization L00 LS
= 1.2 Clearing & Grubbing 15.00 Ace
+ L2.1 Clearing 15.00 Acre

1.3 Excavation 40,000.00 CY
=2 WATER & SEWER 1.00  Each
- 21 10 PVC Pipe 1,000.00 LF

TIP You can create a subordinate at the same level, by right clicking on an equal-

level cost item and selecting Insert.

5.2.3 MOVE COST ITEMS

As you develop your estimate, you may need to move cost items around in the Cost Breakdown
Structure. To move a cost item:

1. Select the row header of the cost item you wish to move. If you select a superior cost item, it will
bring the subordinates along with it.

2. Drag and drop the cost item to the right place in your structure. Notice one of two cursor
symbols appears:
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The symbol with three equal bars will drop the cost item at the same

level as the cost item you drop it on. =9
The symbol with a subordinate bar will make the cost item become a =
subordinate to the one you drop it on. P
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EXERCISE 5.1 — CREATE COST ITEMS

In this exercise, you will practice creating additional cost items. Create the following cost items,
using your own job.

Code Description Forecast (T/O) Quantity Unit of Measure
1.2.2 Grading 10 Acre

1.3.1 Excavate 40,000 CcY

1.3.2 Haul 40,000 CY

41 Furnish Pipe Materials 1,000 LF

4.2 Excavate-Install-Backfill Pipe 1,000 LF

You should end up with similar results:

a1 smowoncaRomowar 120 e
+1 Mobiization .00 LS
B 12 Clearing & Grubbing 15.00 Acre
+oL21 Clearing 15.00 Age
+ 122 Grading 10.00  Acre
B 13 Excavabon 40,000.00 CY
+ L31 Excavate 40,000.00 CY
+ 132 Haud 40,000.00 CY
22 wammasons 100 e
= 21 10 PVC Pipe 1,000.00 LF
+ 211 Furnish Fipe Materials 1,000.00 LF
+ 212 Excavate-Instal-Backfill Ppe 1,000.00 LF

Congratulations, you have completed this Exercise!
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5.3 COSTS AND PRODUCTION

For the cost items you’ve created, you can now add their costs and production. All information for a
cost item is contained in a Cost Item Record.

5.3.1 COST ITEM RECORD

You can open the Cost Item Record by either double clicking on a cost item row header, or right
clicking and selecting Open.

Cost Item Record Overview

T T S

1 Cost ltem Provides general information about the cost item. It displays the cost
Header item’s take-off quantity, Unit of Measure, and Cost. It also indicates what
Information  Cost Source is being used.

The Cost Segment drop-down is used to differentiate estimated costs in
the Direct Costs, Job Overhead or Business overhead categories.

2 Costing Section where costs are defined. There are three ways to enter costs:
Area Detail, Plug, and Quote. The Cost Summary tab summarizes whatever
costs are defined.
Under the Cost Segment drop down, you can choose

3 Data Blocks Contains a set of tabs for entering additional information including
production, shift arrangements, man-hour factors, notes, and scheduling
information.
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Cost Ttem Record © o =

CBS Code: Optional Code:  Description: Forecast (T/0) Qty:  Unit of Measure: Unit Cost: Tatal Cost: Currency:

EE 2020183 Unclassified Excavation 50,000.00 | Cubic Yard $4.68 $233,915.81/ [ U.5. Dollar

IR [3.1 | [excavation I 50,000.00] | Cubic Yard -1 s3.00] | $149,922.88] | U.S, Dollar |
PIAssignment:  PILine Number: PIDescription: Cost Segment: Pay Quantity: Cost Source: Alternate:
2020183 30 Unclassified Excavation Direct Cost 50,000.00 | Detal - | [Base -
Cost Ttem Summary | 5 Detail : $3.00 | & Plug : $0.00 | () Quote : $0.00 | Allocation | Employment Setup x
A
; Cost Cost ~ Total Identification
[Cost Category Unit Cost Total Cost Unar‘husbed Adjustment = €% Adjustment Bilng Unit Billing i
Total Cost | pENo e Rate e i Code: ETWT Type: Construction Equipment Rate
Description:
. Total $3.00 $149,922.88 §145,922.88 0.00 50.00 $3.28 $153,381.06 S (R e
» Labor $0.66  $33,170.48  $33,170.48 0.00 $0.00 $0.93  $45,433.66 Qua"titv\éLEfS) W;the%
aste): -on:
> Owned Equipment $2.34 §116,752.40 §116,752.40 0.00 0.00 $2.35 §117,342.40
» Rented Equipment $0.00 $0.00 $0.00 0.00 £0.00 $0.00 £0.00 Quantity: P’“d"g“&ﬂ' 1
actors
> Supplies 50.00 0,00 £0.00 0.00 0.00 0,00 $0.00
»  Materials £0.00 $0.00 £0.00 0.00 £0.00 $0.00 £0.00 CostDriver:
Subcontract .00 00 .00 0.00 .00 00 .00
» | Subconira 0. 0 o 0. 0 . Employment Cost
> Fees 50.00 50,00 £0.00 0.00 50.00 £0.00 50.00
» Alowance .00 0.0 sa.00 0.00 .00 0.0 sa.00 Unit Cost: $29.60 Total Cost: §1,302.40
Custom Categoryl 50.00 £0.00 £0.00 000 > 0.00 £0.00 $0.00 T D S
Undefined 50.00 £0.00 £0.00 000 > 50.00 £0.00 $0.00
Unit Cost: £0.00 Total Cost: £0.00 vl

10
[ 1]
H

. e e.é_ B[ & 2 2 = & . :

5.3.2 COST SEGMENTS

The Direct Costs, Job Overhead, and Business Overhead cost segments helps to classify the scope of
work so you can report on direct vs indirect costs, and accurately control how markup is spread
throughout your bid. This differentiation is necessary to effectively price work based on the risk profile
of each segment of cost.

Cost Item Record @

CBS Code: Optional Code:  Description: Forecast (T/O) Qty:  Unit of Measure: Unit Cost: Toti

B2 0 WATER & SEWER 100 Each - $496,284.83

Bu21 |#13(B) 0464 | |35 Inch RCP Culvert Class 111 1,024.00 | Linear Feet - $67.54

PI Assignment: PILine Number: PI Description: Cost Segment: Pay Quantity: Cos
413() 0464 B 60 36 Inch RCP Culvert Class III 'DirectCost = | 1,000.00 | Def
M, Description

Business Overhead

CostItem Summary | 5 Detail: $67.54 & Plug:$0.00 | ¢ Quote: $0.00
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5.3.3 COST SOURCES

You can define costs on a cost item in one of three ways, called Cost Sources:

Detail  This is the recommended costing method, where labor, equipment, and material
resources are defined, along with productivity, to determine costs.

Plug This method allows you to enter a unit or total cost directly, without needing to enter

resources or production. This should rarely be used, but does have a couple of use
cases:

» Place holder value until you get more information (from subcontractors or
designers)

e For preliminary estimates when limited information is available

Quote  The Quote cost source is for contractors, subcontractors or vendor quotes.
» Creating and managing quotes is covered in Lesson - Quote Management

Compary: Aceme Guardrail

Cost Category Urit Cost  Total Cost Conact Johnson, Joe
Dozer D8 = Total $1.090.00  $1.090.00 Phone: 555-555-5555
|Scraper 623 [ @ Labor 450000 $50000 Uit Price $31.00
.l:urnpal:lor Smooth Dirum | & Owned Equipment $550.00 459000 Band: $0.00
.l:urnpal:lor Sheeps Foot | & Rented Fouinmert 4N nn 0 NN Conditons: $0.00
|Laborer [ Taves: $0.00
. ' \ Toa B

Detall

Crews,
Resources, &
Productivity

Directly Subcontracts
Entered Cost

On each Cost Item Record, InEight Estimate gives you the option to define both Plug and Detail values
on each respective tab.
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5.3.3.1 PLUG TAB

5.3 Costs and Production

The Plug tab allows user to input unit or total cost to any of the listed cost categories which can be

customized based on company requirements.

Cost Breakdown Structure (CBS) Register Cost Item Record @

CBS Code: Optional Code:  Description: Forecast (T/0) Qty:  Unit of Measure: Unit Cost: Total Cost: Currency:
Bu 7 1200 0100 Toll Booth 100 | Each §25,264.55 $25,264.593] U.S. Doller
[®] 171 0220 | ‘Site Preparation | \ .00 Flimp Sim i 53,554.55| | 53.554‘55\ 1.5, Dollar
PI Assignment: PILine Number:  PI Description: Cost Segment: Pay Quantity: Cost Source: Alternate:
1200 0100 170 Toll Booth Direct Cost 1.00 | Detail - | BASE -
Cost Item Summary | S, Detail : $3,664.55 | % Plug: $2,500.00 | () Quote : $0.00 | Allocation Cost Item Setup x
Cost Category Unit Cost Total Cost Default Pay Rules *
: Scale2:  Scale3:
~  Total £2,500.00 £2,500.00 =
»  Labor £0.00 &0.00 Composite Wage Scale:
» Owned Equipment $0.00 §0.00 hours worked, pay hours
» Rented Equipment $0.00 $0.00
»  Supplies $0.00 $0.00 Default shift Arrangements
»  Materials $0.00 &0.00 Work Hours per Shift: Shifts per Day: Days per Week:
»  Subcontract $2,500.00  $2,500.00 8.00 | | 1.00 | ‘ 5.00
» | Fees $0.00 $0.00 Default Froperties
> AMlowance $0.00 $0.00 Account Code: | 8000 =
Custom Category1 $0.00 $0.00
Undefined &0.00 .00 Cost Curve: | Linear - -
Billng Rate $0.00 $0.00 bl "
™ y - " =
Billng Rate Markup $0.00 §0.00 BNE =, =:. &.. =B
5.3.3.2 DETAIL TAB
Cost Breakdown Structure (CBS) Register Cost Item Record & -
CBS Code: Optional Code:  Description: Forecast (T/0) Qty:  Unit of Measure: Unit Cost: Total Cost: Currency:
ﬁ 17 1200 0100 Tall Booth 1.00 | Each §25,264.55 $25,264.55 | | U.5. Dallar
[®] 7.1 0220 | [stte Preparation [ 1.00] | Lump 5um - §3,664.55] | £3,664.55| | U.5. Dollar
PI Assignment: PILine Mumber: PIDescription: Cost Segment: Pay Quantity: Cost Source: Alternate:
1200 0100 170 Toll Booth Direct Cost 1.00 | Detai - | | BASE -
Cost Item Summary | 2, Detail : $3,664.55 | & Plug:$2,500.00 | [JQuote:$0.00 | Allocation Cost Item Setup x
Drag columns here to group Find: | [Search For...] Saved views: | Previous View - Default Pay Rules -
Scale 1:  Scale2:  Scale 3:
B o . e ooton Eug:gntv L - A Composite Wage Scale: | 100.00
Mu... = Assembly ° ' 3
Waste) Add-on For every hours worked, pay hours
= 1|z Labaorer 3.00 E
Default Shift Arrangements
2 o1 Operator Class 1 1.00 E } }
Work Hours per Shift:  Shifts per Day: Days per Week:
3 EG14G Grader 14G 1.00 E
racer 00| | o] | 5.00
4 ETWT Water Truck 100 E
5 LT Teamster 100 g DefaultProperties
N Account Code: | 8000 L
Cost Curve: | Linear - - t
'l 3
I = [
' ER | T Ts. B 3

Entering both a detailed and plug cost allows you to define costs at a higher summary level initially

(Plug tab), and then define more detail as the estimating process progresses (Detail tab). You can
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review and compare your plug and detail values by toggling between tabs, but your cost item will only
contribute the total cost from one of the tabs based on which cost source is selected.

You control which cost is used by selecting Detail or Plug in the Cost Source field on the Cost Item
Record.

i e =
Forecast (T/Q) Qty:  Unit of Measure: Unit Cost: Total Cost: Currency:
1.00 | Each 524,100.00 £24,100.00 | .S, Dollar
| | .00/ | Lump Sum - £2,500.00 £2,500.00 . Dollar
Cost Segment: Pay Quantity: Cost Source: lternate:
Direct Cost 1.00 | Plug = | | BASE -
th Description
Dg_uote : &0.00 Allocation Cost Ttem Setup
Detail
sved views: | revious View - Defaul Pay Rules
. Quote
Quantity Waste L Composite Wage 5cg
(Less Yo Qua... N
Waste) Add-on For every hot
3.00 E
Default Shift Arrangemer
1.00 E )
Work Hours per Shift:
1.00 E
800] | x
100 E
100 E Default Properties
Account Code: | 8000 o
Cost Curve: | Linear - -
4 »
i ) - - . [

TIP The Quote Cost Source can only be selected from the Quote Comparison & Award form.
See Lesson 8 — Quote Comparison.

5.3.4 PLUG COSTS

The following steps walk you through defining a plug cost on a cost item.

STEP BY STEP — DEFINE A PLUGGED COST

1. From the Estimate tab, select Cost Breakdown Structure (CBS).
2. Right-click on the row header for a cost item and select Open.

3. In the Cost Source drop-down field select Plug.
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4. In the left section of the cost item, select the Plug tab.
5. Click in the Unit cost or Total cost field for a cost category and type in a Numeric Value.

* For this example, on the Mobilization cost item, we’ll add $10,000 in the Total Cost field
for both Labor and Owner Equipment.

ial 200 SITEWORK & ROADWAY

[=] 1.1 641 0100 Mobilization
FI Assignment: Pl Line Number; Pl Description:

541 0100 al| 1.1 Mobilization

CostItem Summary | S Detal:$0.00 ¢, Plug: 520,000.00 | (Z'Quote: $0.00 | Alocation

Cost Category Uit Cost Tokal Cost
« Total 520,000,000  520,000.00
»  Labor $10,000.00  510,000.00
» | Cwmed Equipment $10,000,00  $10,000.00
G EETEE || AR T oWl Fa Wyl

5.3.5 DETAIL COSTS

The Detail cost method is also defined on the Cost Item Record. On the Detail tab, you can add
resources (labor, equipment, and material) and define production.

On the Production tab (right side of screen), define production by entering one of the following:

e Aduration, or
¢ A unit per duration, or
¢ A duration per unit

When you enter a production value, all the other production fields will auto-fill based on what you

Cost Item Summary | 5o Detail : $11,909.51 | # Plug: $20,500.00 | (JQuote: $500.00 | Allocation Production x
Drag columns here to group Find: | [Search For...] | Saved views: | Previous View - | Production | Qtyoriven  *
Hourly
Duration Driven Resources Resources
Row - - I el o Uit of Product..  W..  Pay Unit
HNu... Assembly Vi) Add-on Mea... Factor Hue H.. Cost Customize Displa
1 Teamster 100 Each 100 80,00  80.00 $30) Eave 1000« T
> 2|ent Lowboy Trailer 100 Each 1.00 80,00 80.00 £33 Shifts: 10.00 0.00
3| ETTT Tractor Truck 1.00 Each 1.00 80.00 80.00 578 Hours:| 80.00 0.00
Man-Hours:| 80.00 0.00
| Resources | Equip-Hours:| 160.00 0.00 }

w
5

Be
,
&

B e s 2
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The hours defined on the Production tab drive the labor and equipment resources you employ on the
left, multiplying their unit costs by the production hours.

When you employ material resources, their costs are driven by the quantity you enter into the quantity
field.

The Total Cost of each resource is added together to give you the Total Cost for the cost item.

Cost Breakdown Structure {CBS) Register Cost Item Record ©
CBS Code: Optional Code:  Description: Forecast (T/0) Qty:  Unit of Measure: Unit Cost: Total Cost: Currency:
OB |s410100 HMobiI\zat\on || 1.uu| Lump Sum - $11,909.51 511,909.51| U.5. Dollar
PI Assignment: PILine Number: PIDescription: Cost Segment: Pay Quantif Cost Source: Alternate:
6410100 10 Muobilization Direct Cost 100 | Detail - | | BASE -
Cost Item Summary spgetawl +$11,809,51 # Plug : $20,500.00 Dguobe : 500,00 Allocation Production *
Drag columns here to group Find: | [Search For...] Saved views: | Prey] lew - Pt
) ) Duratio
. \;:;aste Cn_st ?L::!ﬁty Productivity EE::I e e '\—:,unuljrks Duration Driven Resources '
' Add-on Bz Waste) ek {Forec... Eri= Rules Customize Display. Ix
T couein | | oo SRR Enployed ... | | Days|  1000]«
2 CI Duration 1.00 52,688.00 | U.5. Dollar  Employed C... ShiftS:
3 CI Duration 1.00 55,272.00 | U.S. Dollar Employed C... Hours:
Maanours:
Equip-Huurs:

STEP BY STEP — DETAIL COSTS

1.
2.

On the Detail tab, add resources (labor, equipment, and material).
On the Production tab, define production (duration, unit per duration, or duration per unit).

The hours defined on the Production tab drive the labor and equipment resources on the left,
multiplying their unit costs by the production hours.

With material resources, their costs are driven by the quantity entered in the quantity field.

Costltem Summary | S, Detad : 51154 | § Pug:$0.00 | (O Quote:$0.00 | Alocation Production x
Save -1 P PRODUCTION

Row Code Resource Dascriot Quantity Waste % Urit Duration Oriven  Factored Duration  Qy Oriven Cost Item
Number Asserbly e Less Waste) Add-on ity e Resources DrienResouces  rourly Resources  Summary

1|m Teamster 200 EacH Days 45.00 45.00 000 4500

2 | emor Dump Truck 200 Eself Shifts 4500 45.00 0.00  45.00

3| ™eR Aggregate Base Rod: 5,500.00 5.00 47,775.00 Ton Hours 260.00 360.00 0.00 360.00

Man-Hours 720,00 720.00 000 72000

RESOURCES Equp-Hours 720.00 720.00 0.0 7200

Betmol. [Frotes [FcCost. ZoProd. ZBMan-. SlReso. TSche. 8 User Benc

5.3.5.3 ADD COST DETAIL

The following steps walk you through adding resources and production on a cost item.
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STEP BY STEP — ADD COST DETAIL

1. From the Estimate tab, select Cost Breakdown Structure (CBS).
2. Right-click on row header for a cost item and select Open.

3. Select the Detail tab.
4

. A blank row is available to define your costs. With your cursor in the code field, click the
Resource Selection icon to open the Resource Selection Register.

Select a resource tab (e.g., Labor).
Select a resource.

Select OK.

©® N o O

Repeat the steps to add additional resources as needed.
9. Click in each resource’s quantity field to change their quantity as needed.
10. From the lower-right section of the form, select the Production tab.
11. Type a numeric value in the Days field, then press Tab.
12. Click OK to close the record.

¢ For this example, we’ll add cost detail to the Clearing cost item, adding the following labor
and equipment resources and production value:

Resource Quantity
LL2 Laborer 2
LO1 Operator Class 1 1
EL988 Loader 988 1

Cost Item Production Value (in Days)

8
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5.3.5.4 ADD ASSEMBLY

STEP BY STEP — DEFINE COST DETAIL BY ADDING AN ASSEMBLY

1. From the Estimate tab, select Cost Breakdown Structure (CBS).
2. Right-click on the row header for one of the cost items and select Open.
3. Select the Detail tab.

4. With your cursor in the Resource Assembly field, click the Resource Assembly Selection icon to
open the Resource Assembly Selection Register.

Select an assembly, then click OK.

Because this crew includes duration-based resources, you need to enter a Production value.
Select the Production tab.

7. Type a numeric value in one of the production fields (e.g., UoM/day), then press Tab.

¢ For this example, on the Grading cost item, we’ll add a Grading assembly with a
production value of 1 Acre/Day.

M 122 | [Grading [ 10.00] | Age -] $1,397.01] | $13,970.08] | Us. Dotar
PI Assignment: PILine Number: PIDescription: Cost Segment: Pay Quantity: Cost Source: Alternate:
010102 @) 1.2 Clearing & Grubbing Direct Cost - 6.67 | Detail - | | BASE
Costltem Summary | S, Detai: $1,397.01 | & Plg:$0.00 | (D Quote:$0.00 | Abocation Production X
ns here to group Saved views: Previous Vie - p
Row Resource Quantity Waste % Unit of | Duration Driven  Factored Duratior
Number = Assembly L5 (Less Waste) Add-on e Measure [ Resources Driven Resources
- 1 CGRADE Grading Crew 100 Hour Days 10.00 e
Row Resource Quantity Waste % Unitof  Prog Shifts 10.00 bl
Number = s Assembly rEaE) (Less Waste)  Add-on Quantity Measure  Fac
Hours 80.00 8
= 1| ETWT CGRADE  Water Truck 0.50 Each
Man-Hours 320.00 3A
22 CGRADE  Laborer 1.00  Each
Equip-Hours 200.00 200
3 03 CGRADE  Operator Class 3 2.00 Each
4 EGI4G  CGRADE  Grader 14G 100 Each
5 ECOMP1 CGRADE Compactor Smooth Drum L0D Each
Acre/shift 1.00
6 104 CGRADE  Operator Foreman 100  Each
AcrejHour 0.13 [}
a 3

AcreMan-Hr 0.03 [}

Page 250 of 402 InEight Inc. | Release 25.7



Estimate Essentials User Guide Exercise 5.2 — Define cost detail

EXERCISE 5.2 — DEFINE COST DETAIL

For cost items you create in InEight Estimate, you need to add resources, assemblies and production
to define their costs. In this exercise, you will practice defining cost details. Complete the following
steps, using your job:

Add the following or similar resources and production to your 1.3.1 Excavate cost

item.
LO1 Operator Class 1 1
LL2 Laborer 2
LL3 Labor Foreman 1
EX225 Excavator 225 1

CY/Hour 400

Add the following resources and production to the 1.3.2 Haul cost item.

LO1 Operator Class 1 1
LL2 Laborer 2
LL3 Labor Foreman 1
LT1 Teamster 1
EL950 Loader 950 1
ETDT Dump Truck 1
EX225 Excavator 225 1
CY/Hour 400

InEight Inc. | Release 25.7 Page 251 of 402



Exercise 5.2 — Define cost detail Estimate Essentials User Guide

Add the following resource and quantity to the 2.1.1. Furnish Pipe Materials cost

item.
MPP10 Pipe 10” PVC SDR21 1,000 with 5% Waste % Add-on = 1,050 LF

Add the following assembly to the 2.1.2 Excavate-Install-Backfill Pipe cost item.

CPIPE Pipe Crew 1

Add the following production value to cost item.

Days 3

You should end up with the similar results:

S1 SITEWORK&ROADWAY 100 Each $87,020.21  §87,021.21
+ 11 Mobiization 100 LS $20,000.00  $20,000.00
2 12 Clearing & Grubbing 15.00 Acre $1,399.82 $20,997.25
+ 121  Clearing 15.00  Acre $468. 4 §7,027.16
+ 122 : Grading 10.00  Acre $1,3597.01 $13,970.09
2 13 B Enticon 40,000.00 CY $115  $46,023.96
+ 131 . Excavate 40,000.00 CY .43 $17,227.04
+ 132 . Had 40,000.00 C¥ 0.72  $28,79.93
=2 WATER&SEWER 100 Each $9,60373  $9,603.73
8 21 10 PVC Pipe 1,000.00 LF 49.60 $9,603.73
+ 211 " Furnish Pipe Materials 1,000.00 LF §3.54 43,533.08
+ 212 | Excavate-Instal-Backfill Pipe 1,000.00 LF $5.07 $5,065.65

Congratulations, you have completed this exercise!
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5.4 COST ITEM DETAILS

5.4 Cost Item Details

The Cost Item Record contains other tabs (called Data Blocks) in addition to the Production tab, for
storing and calculating information specific to that cost item.

Cost Item Setup X
Cost Item Setup Fs Period Quantities -
Scale1: Scale2: Scale3:
Composite Wage Scale: | 100.00 0.00 0.00 [ UsePeriod Quantities
For ever\f. 8.00] hours worked, pay 8.00| hours
Default Shift Arrangements Execution
Work Hours per Shift: Shifts per Day: Days per Week: Allow As-Built: | None -
8.00 1.00 5.00
Default Properties
Account Code: | 1020 Tag 1: | Estimator 1 -
Cost Curve: | Linear - Tag 2:  Roadway -
Worker's Comp Override: - Tag 3: -
Quantity Driver: | Pay Item Tag 4: -
Quantity Roll-Up: i Tag 5: -
Quote Group Tag: - Tag 6: - —
4 >
| Ze Emplo...  [5/ Notes [4cCostit.. 2o Produc.. S8 ManH. ZS*Resou.. == Schedule & UserD.. 3 Bench |

You can add to or adjust the information on these tabs as needed, based on the cost item’s
circumstances. In this section, you will review three of the tabs (in addition to the Production tab) you

will likely use most often: Cost Item Setup, Notes, and Man-Hour Factors.

5.4.1 COST ITEM SETUP

On the data block where the Production tab was found, there is also a Cost Item Setup tab where you
can adjust wage scale and shift arrangements for a specific cost item.
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Cost Item Setup x

Default Pay Rules Period Quantities =
Scale1:  Scale2:  Scale 3:

Composite Wage Scale: | 100.00) [ 0.00] [ nan| | [JUsePeriodQuantities
For e'.'er)' haours \f.'orkecl,pa)-I hours

Default Shift Arrangements Execution
Work Hours per Shift: Shifts per Day: Days per Week: Allow As-Built: | None -
| so0| | Loo| | 5.00
Default Properties
Account Code: | 1020 = Tag 1: | Estimator 1 -
Cost Curve: | Linear - Tag 2: | Roadway -
Worker's Comp Override: - Tag 3: -
Quantity Driver: | Pay Item Tag 4: -
Quantity Roll-Up: it Tag 5: -
Quote Group Tag: - Tag 6: -
Minority Goal Allowance: Tag 7: -
Fhase Code: | Tag 8: -
Tag 9: -
When man-count changes: (# Change UM / Man-Hour Tag 10: -
(O change Days Tag 11: -
Tag 12: -
suspend: [ | Tag 13: -
Tag 14: -
Tag 15: - o
4 »

2o Emplo...  [5) Notes | [ cCostlt.. | ZcProduc.. ZEManH.. S2Resou.. ‘== Schedule & UserD.. 5 Bench..

The composite wage scale and work and pay hours are used in the calculation of the cost of employed
labor resources. The data reported on the Default Pay Rules tab is, by default, the composite wage
scale and work and pay hours defined on the Job Properties - Cost Basis tab for the current job.

These settings can be modified from the default on a cost item-by-cost item basis.

The Pay Rules for cost items can also be defined or modified on the Cost Breakdown Structure (CBS)
Register in the Scale 1, Scale 2, Scale 3, Work Hours Rules, and/or Pay Hours Rules columns in the row
of the subject cost item.

5.4.1.1 COST CURVES

Cost curves are used to determine how the cost of a cost item is distributed over time. The main
benefit of defining the cost curve for a cost item is to create a more accurate estimation of the cash
flow over the life of a project.

The schedule dates entered on a Cost Item are used to define the periods across which a cost item will
incur its costs. A cost item’s start and finish dates can be entered manually by the user or established
using Schedule Integration, and the time periods (day, week, month, quarter, year) are determined in
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the Cash Flow settings in Job Properties. For more information on scheduling, see topics Microsoft
Project and Primavera.

By default, Cost Items have a linear cost curve, which distributes the cost of the cost item equally
across all periods for the Cost Item. There are 5 different types of cost curves that can be selected from
in the Cost Item Record > Cost Item Setup page.

Cost Item Setup
Default Pay Rules Period Quantites
Scale1:  Scale2: Scale3:
Composite Wage Scale: | 100.00 0.00 | 0.00 | [] UsePeriod Quantities

For Evgry. 8.00| hours worked, pay| B8.00| hours

Default Shift Arrangements Execution
Work Hours per Shift: Shifts per Day: Days per Week: Allow As-Built: | Mone
| a.un| 1.00 | 5.00
Default Properties
Account Code: | 1110 P Tag i: Estimat
Cost Curve: | Linear o - Tag 2: | Roadw
Worker's Cofnp Override: | ¢ Description Tag 3:
Qudntity Driver: | Back Loaded Tag 4:
Quantity Roll-Up: Bell Shaped Tag 5:
Fromt Loaded
Quotg Group Tag: Tag 6:
Minority Gogl Allowance: Tag 7:

Phase Code: Tag &:
Tag 9:
When man-count changes: | = Tag 10:

~ —

Back Loaded Costs are low for most of an activity's
timeline, but then increase towards the end.
This curve type starts out with a lower slope
and gradually becomes steeper as the work
progresses. Most resources are assumed to
be consumed later in the activity and may be
more characteristic of subcontracted work
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(continued)

where costs are incurred as the work nears
completion.

Bell Shaped Expenses are low at the start of an activity,
increase during construction, and decrease
as the project approaches completion. Bell
shaped cost curves incur the maijority of their
costs towards the mid-point of the work and
exponentially increase and decrease from
the beginning to the end of the activity. This
type of curve can be characteristic of larger
portions of work that start with a few
resources, ramp up to a peak, incurring
more costs during the ramp up, then ramp
back down as the work nears completion.

Front Loaded A front-loaded cost curve is when costs are
incurred early in a activity. This can happen
for several reasons such as early
procurement of materials to take advantage
of lower prices or to address long lead times.

Linear Linear cost curves take the total cost of the
activity and spreads it equally amongst the
specified periods.

Cost Item Periods Invoked by using the Period Quantities
feature (described below). Cost Item Periods
are used to customize cost curves based on
the quantities consumed in various periods.
In comparison to the other curves which
spread the items total cost proportionally
based the chosen cost curve, the Cost Item
Periods option can generate a more precise
distribution of costs to specific periods
because the user can simply define how
much quantity of work is getting completed in
each specific period.
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You can also choose to create your own custom cost curve by clicking on the add button in the Cost
Curve drop-down menu.

Account Code: | 1110 n¥

Cost Curve: | Linear o -

“omp Override: | &% Description
Juantity Driver: Back Loaded
Bell Shaped
Front Loaded
ote Group Tag:
= moml Al mcssmom =
Custom cost curves let you define your own from and to durations along with their associated values,
which need to add up to 100%.

sjantity Roll-Up:
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‘-l" Cost Curve Record - Training Job — | *

Description: * |Expeditedprojects ‘ J

Number of Points: ] ]

From Duration % To Duration % Value % 1
S I I
50 50 5
30 50 101
50 50 10
50 100 30
100 100 10 |
100 100 10
100 100 20 | |
{
100.00
t
oK Cancel

CASH FLOW

All cost curves, regardless of type, impact the generation of the cash flow graph. The Cash Flow form
provides a graphical representation of the cash flow and resource utilization of your project, so you can
quickly assess financing and resource needs.

You can open the Cash Flow form by selecting the Estimate tab from the Estimate landing page, then
selecting Cash Flow from the Schedule section.

To generate a cash flow curve, the estimate must be populated with schedule dates either directly
from integration with Primavera, Microsoft project, or input manually.
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Schedule List Updated 5252013334 it

sart: [y o st [
End: | Juamie - Bnd 43

CASH FLOW OPTIONS

The Cash Flow Options are used to define the cash flow rules (revenue timing, cost timing, cost of
money, and quantities) needed to calculate the finance expense and cash flow for your project.

Cash flow rules (revenue timing, cost timing, cost of money, and quantities) describe how cash flow
occurs between a contractor and a client, and between contractors or owners and
vendors/subcontractors. Cash flow is then calculated based on both the earning and payment terms
you specify, and the job's schedule and pay item prices.
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= & o
B 2 Bt &IL7 WM a = @
n _a . 2 A
-
Job Properties  Foundation  PayItem & Bid Wizerd = Resources Resource CostItem  Standard
- Setup Data = Proposal -

A Materills  pssembles | Assembles  Tables

Initialize Resources Assemblics Report:
Cash Flow Job Properties @

Owverview | Cowver Sheet | Cost Basis | Minority Setup | Fuel Cost | Job Folder Tags | Pridng | Schedule | Cash Flow
Revenue Dmlna

Eills are submitted to the owner: Average calendar days elapsed from billing to collaction: days
(O) at the end of the job Amount of each billing thatis withheld by owner as retainage: 5.00| %
(@) Every manth on this day: |25 Retainageis released: (@) At the end of the job
O Every L wasks () On a spedfic date: -

) Every |1 | days [] Seread revenue using the same Cost Curves a5 the contributing Cost tems
Cost timing
Bills are received from subcontractors Average calendar days elapsed from receipt of invoice to payment: 35 days

and vendors:

Amount of each invoice received thatis withheld by you as retainage: 5.00( %

() At the end of the job e :l
Retainageis released to (@) At the end of the job

| subcantractors and vendors:

(O On a specific date: | -

(@) Every manth on this day: |23

() Every |} weeks

Apply cash timing rules for all procurable cost categaories {non labor and equipment),
' 1
) Every I—I days EA wren iFtheir cost ecaree is not et to "Quote™?

Cost of money : . Quaniities

Average annual interest rate paid to borrow money (when cost exceeds revenuel: | 8.00] % ©) Pay Quantity

Average annual interest rate earned (when revenue exceeds cost) 3.00] % (®) Forecast (T/0) Quantity
Reporting Periods

Period getting for caghflow: | Day - Early Start / Finish -

Canced

CASH FLOW DISPLAY SETTINGS

The Cash Flow Display Settings allow you to control what information displays on the Cash Flow graph.
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Cash Flow Display Settings

Saftings: | Previous - Cost Categanes
[ Display this text a2 a custom report title;
Example cash flow Lzbor
Owned Equipment
Period Wesek: w Rented Equipment
Cost kame Supplies
Total Cost Mazenal
a (Farecast) - sens
0 Tatal Price ] Subcontract
(cuwrrent)
Total Cost [ Fees
% (Ferecast) - Cash
Tatal Price Allowance
%) (current) - Cash -
[[] Cash Flow Customn Category 1
] Finence Cost - Undefined
As-Built -
O Total Cost
CE-Total Cost
O Eamed (fo-date) -

CASH FLOW EXAMPLE

Estimated

O

O

OoO0ooooaoao

i1 11k
OoOoO0oooaoag

As-Built

O

|

1 111
Oooodoooaoao

Flanned
To Date

O

|

5.4 Cost Item Details

Resources

] Resource Utilization

Summarize resources by- | Resource Type ~

Get data from: (®) This job's utilized rescurces

() All Library resources
Value Oty Cost ABGty ABCost
[ Labor

[ Construction Equipment
[ Rented Construction Eq..
[ Instaled Matesial

[] Installed Equipment

[ Supply

[ Unique

Cost

Stacked Bar ~
As-Built Cost:

Nane \,

Cluantrty:
None ~

As-Bult Guantity
Marie W

Using the Period Quantities cost curve type as an example, on the Cash Flow graph, you can see that
50% of the total cost for this cost item, represented by the red line, is incurred in the first period of the
project. Half of the project’s cost is incurred during the first period of the project’s lifespan as

determined by what is entered in the cost item’s period quantities.

A reason why half of the project’s cost is being used during the first period could be that resources

available to perform the project happen to be mostly available during the front end of the project.

InEight Inc. | Release 25.7

Page 261 of 402



5.4 Cost Iltem Details Estimate Essentials User Guide

hiumber of Peniod Quantities: 5 Re-spresd quantiies

Schedule Quanity value %

0e01-1% 5,625.00 1250
3 002214 5,625.00 2.5
4 0403214 5,625.00 12.50
5 os0e-me 562500 250
100,000.00 |
¥ T 45,000.00 100.00
Farecast (1/C) Qty 45000
Quantity leftto saread: 0
$80.000.00 —
$60,000.00—
$40000.00 —
£20,000.00—F
w5 -, -, [2 3. kN &, & o, 2
% %, %, %, s %, =, Y, =, *,
e % v ¥ % % v

Schedule Last Updated: 5252013 334 PH

W Construction Equipment (5) N Lsbor ($) Total Price Total Cost
(current) - Cash (Forecast) - Cash
Date Range Cost Rem Range Giick and drag inthe gra i thie Job's Target Price
areat
at: | 3mmne -] et [43 ©) caloul rically according tothe Cash Flaw graph

nd [Rzone v| End: [43 g number directly in the PES

After the first period, the project incurs the remaining balance of the total project cost of $95,000. This
is spread equally with quantities of $5,625 amongst the last three periods. This information helps you

to better understand when the owner provides payment, in addition to deciding if more project
funding or financing is needed.

$100,000

520,00000

PPy T NS S S DU S ot N S

10,0000

52000000 l |
' | .
: | o= = o w w

o ", %, 2, %, %,

‘Schedule: Last Updaled: 3252013 334 P

W Corstruction Equpment (5) W Labor (5) Totsl e Total Coat
== (cument) - Cash = (Forecast) - Cash

Date Range Cost Rem Range [ include Finance Cost in this Job's Target Prica
St |y v | Skt (43 ) Calculate autamatically according to the Cash Flow graph
~ [ Jymes -] e [a3

@) Enter 3 plug number irectly in the PSS
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Perhaps most costs on this one item will be incurred at the end of the activity, such as a subcontractor
billing for most of his work as it nears completion. If it’s determined costs are incurred towards the end
of the activity, you can attribute most of the cost items quantity in the last period. You can add any
number of additional periods to a custom cost curve or to a cost curve defined by period quantities
curve and the costs will be proportionally spread across the actual number of periods defined by the
Cost Items start and finish dates and cash flow settings. Be aware reducing the number of periods in a
front or back end loaded curve may show a steeper total cost in some periods.

$100,000.00

Using period quantities as the cost curve helps you determine how much of a cost item’s cost is going
to be spread in different durations of time.

PERIOD QUANTITIES

Like the other four cost curves, Period Quantities are used to customize cost curves, which show you a
graphical representation of the cash flow and resource utilization so you can assess the proper
financing and resource project needs. When the Period Quantities check box is selected, the Cost
Curve automatically changes to Cost Item Periods.
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Cost Ttem Setup

Default Pay Rukes Period Quantises

Composite Wage Scale: | 100.00 0.00 0.00 b UsePenod Quantities Egit

Forevery| 8.00| hours worked, pay| 8.00| hours

Default Shift Arangements
Work Hours per Shift: Shifts per Diay Days per Week

Defaut Properbes

unt Code: | 1122. 100 Tag 1: Estmator 1 - Tag 16

e: | Cost Item Periods 2: Roadway - Tag 17

L)
|
)
U

I

¥

[ L]
T

(1
g
5

[ ]

i
1
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n
]
L)

[ 13
W
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The Period Quantity calculator uses the cost item quantity assigned to various periods to calculate the
specific percentages attributable to each range of periods covered by the cost item. The purpose of
using period quantities is to spread costs via the cost curve in the cash flow analysis. For example, if
you have an item where 50% of the cost is incurred when you start the work because you have to buy
all the material first, then you would want a customized cost curve to reflect that this is how the costs
will be incurred over time when building that work.

In the example below, since 50% of the cost is incurred when the project starts, period one's quantity
is 50% of 45,000 Forecast (T/O) Qty which is 22,500. The remaining costs are then spread equally
across the remaining three periods.
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CBS - - Forecast
Position Code = Description Start Finish (T/0) Quantity
2 43 Install Aggregate Base 3/31/2014  5/26(2014 45,000.00
Period Quantities
Number of Period Quantities: 5 Re-spread quantities
Period # Schedule Quantity Value %
1 03-31-2014 22,500.00 50.00
2 04-01-2014 5,625.00 12,50
3 04-02-2014 5,625,00 12,50
4 04-03-2014 5,625.00
P :
Forecast (T/O) Qty: 45000
Quantity left to spread: ]

5.4 Cost Item Details

You can also choose to select the Re-spread quantities button to spread the quantities equally among

the periods entered in the Number of Period Quantities field.

Number of Period Quantities: s I Re-zpread quantities J
Period # Schedule Quantity Value %

2 9,000.00 20.00

3 9,000.00 20.00

4 9,000.00 20.00

5 9,000.00 20.00

45,000.00 100.00
Forecast (T/O) Qty: 45000
Quantity leftto spread: 0

oK Cancel
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STEP BY STEP — ADJUST SHIFT ARRANGEMENTS

1. From the Estimate tab, select Cost Breakdown Structure (CBS).
2. Right-click on the row header for a cost item and select Open.

3. Select the Cost Item Setup tab in the lower-right portion of the form (the tab name may be
abbreviated).

4. In the Default Pay Rules data block, adjust your Composite Wage Scale as needed.

1500 | Acre - | 51,U!':l.':lj| | 51E|r1':lti.':lf| U, 5. Dollar -
Cost Segment: Pay Quantity: Cost Source: Alternate:
Direct Cost 10.00 | Detail - | | BASE -
Cost Item Setup X

- Default Pay Rules pe

Scale 1:  Scale 2: | Scale 3:

Quantity Composits Wage Scale: | au.uu| | | u.uu| [
(Less
Waste) For every| 8.00| hours worked, pay| 8.00 hours
Default Shift Arrangements 1
Waork Hours per Shift:  Shifts per Day: Days per Week:
| a00| | 00| | 5.00
Default Properties

- e #

5. Under the Composite Wage Scale, adjust the number of hours and paid as needed

Cost Item Setup
Default Pay Rules
Scale1: Scale2: Scale 3:
Composite WageScale: | 80.00) [ 20.00] [ 0.00]

For every| 10.00| hours worked, pay| 10.00| hours

Default Shift Arrangements
Work Hours per Shift: Shifts per Day: Days per Week:

[ ananl [ 1anl cnnl

6. In the Default Shift Arrangements data block, make changes as needed.
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Cost Item Setup
Default Pay Rules
Scale1: Scale2: Scale3:
CompositeWageScaIe:| su.uu|| 20.uu|| n.uu|

For every hours \f.'orket:l,pa)-I hours

Default Shift Arrangements
Work Hours per Shift: | Shifts per Day: Days per Week:
| 10.00 | El| | 5.00

P b P mmmrbime

* For this example, we’ll make the following changes on the Clearing cost item:
e Composite Wage Scale — 80% Scale 1, 20% Scale 2.
e For every 10 hours worked, pay 10 hours.

e Default Shift Arrangements — Change Work Hours per Shift to 10.

Cost Item Setup

Default Pay Rules
Scale1: Scale2: Scale3:

Composite WageScale: | 100.00] | 0.00] [ 0.00]

Forevery| 8.00( hours worked, pay| 8.00| hours

Default Shift Arrangements
Work Hours per Shift: Shifts per Day: Days per Week:
800] | o] | 5.00

5.4.2 NOTES

On the Cost Item Record, you can enter any cost item-specific instructions, parameters, or general
information on the Notes tab. Below are a few examples of the kinds of notes you might enter:

¢ For a Hauling cost item: There should be very little waste. If so, we can spread it out in the right
of way at MP 111

¢ For a Structural Excavation and Backfill item: The backfill cannot be the native material. Have
to use clean base rock

e For an Underground Pipe cost item: The average depth is close to 10 ft.

TIP You can use the Notes tab to reference cost item changes (e.g., changing shift
arrangements, changing a resource rate).
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5.4.3 MAN-HOUR FACTORS

Estimate Essentials User Guide

For items that have known risks or potential resource concerns, you can apply a Man-Hour Factor to

take those risks into consideration.

Man-Hour factors are applied on the Man-Hour Factors tab on the Cost Item Record. Factors are

applied in relation to 1, where slower production is greater than 1 and faster production is less than 1.

TIP Man-Hour Factors affect both Labor and Equipment Hours.

For example, if you predict production to be 20% slower due to weather concerns, you would type 1.2
in the weather factor field.

Man-Hour Factors

Man-Hour Factors

Factor Name:
Factor 1:
Factor 2:
Factor 3:
Factor 4:
Factor 5:
Factor 62
Factar 7:
Factor 8:
Factor 9:

Factor 10:

Factor:

e
=

1.00
1.00
1.00
100
100
1.00
1.00

1.00

Factor Composite:

L

Even after defining a Man-Hour Factor, the Production tab will still display the original Production

values.

¢ To see the factored Production values, click the Customize Display link on the Production tab

and select Show Man-Hour Factors

¢ Both original and factored production are then displayed on the Production tab
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Production h 4
Qty D
H
Duration Driven Resources Resc
Customize Displav
DI Show Man-Hour Factors I
Sh Show All

TIP You can apply Man-Hour Factors to multiple cost items at once by Multi-Editing selected
cost items on the CBS Register.

5.4.4 UNIQUE IDENTIFIER

You may have noticed when you made changes on the Cost Item Setup tab, that the fields you changed
and the Cost Item Setup tab became highlighted, indicating they were altered from their original state.
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Cost Ttem Setup

Default Pay Rules
Scale 1: Scale 2: | Scale 3:

Composite WageScalf: | 80.00] [ 20.00] | 0.0]
Forevery| 8.00| hours worked, pay| &.00( hours
Default Shift Arrangements
Work Hours per Shift: Shifts per Day: Days per Week:
| 00| | Lon| | 5.00
Default Properties

Account Code:
Cost Curve: | Linear -
Worker's Comp Qverride: -
Tag 1: -
Tag 2: -
Tag 3: -
Tag % -
Tag 5: -
Quantity Driver: | Superior CI -
Quote Group Tag: v

Minority Goal Allowance: | 100.00

Phase Code: |

When man-count changes: () Change UM / Man-Hour

(7} Change Days
Suspend: []

Bl E- b 8. 2. =. 2

[iq "

On the CBS Register, the cost item you edited now has a Unique Identifier in the row header indicating
the cost item was altered from the default values set in the project job properties or in the project
library of resources rates.

= JuB
d Prime Bond PRIME
1dd-On Price % Add-On PRICE
icing Job Financing FINAF
IQEMENN] Job Management & Equipment JOB I+
Hpense General Expense GENEI
an + 1 Mobilization 1000
% Grubt = 2 Clearing & Grubbing 2000
n + 3.1 Clearing
Yipe fe W 22 Grading
3 Excavation 3000
+ 3.1 Excavate
+ 3.7 Haul

If you hover over the identifier, a pop-up menu appears indicating what data points were changed.
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+ 41
+ 2.2

Scale 1
Scale 2

This same identifier will show up for resources as well, if you make changes to the employed resource’s
cost to be different than the original resource rate imported from the Resource Rate Register.

Cost Item Summary s,getall 1 §972.93 # Plug : $0.00 D Quote : ! ¢ Resource Employment Breakdown X
Diigdol [Search For...] | saved views: | Previous View - Cost Categary cale 2

~  Total
Row - Resource

Mo, = Code Assembly Description »
» Owned Equipment e
1 LWz Laborer » Rented Equipment £0.00 0.0
2 o1 Operator Class 1 »  Supplies $0.00 $0.c
3 Eg88 Loader 988 > | Materisls $0.00 0.
» Subcontract $0.00 0.0
» Fees 50.00 0.0
»  Allowance $0.00 0.0
Custom Category1 $0.00 $0.C
Undefined $0.00 0.0
Biling Rate £28.00 840,
Biling Rate Markup 50.00 0.0
Rillinn Rate Marl n 5. nnn nr’

5.4.4.2 HIGHLIGHT UNIQUE (DELTA) TOGGLE

You can turn the highlighting of unique resource and cost item fields off and on from the Actions menu
of the Cost Item Record, under the View section.

Training Job - Estimate

Setup Estimate Quote Price Execution 5 m Actions
Ix’j rl—l—l "= Display Parent Information "."'& Highlight Unique (Delta) Resource Fields ag, Edit Resource F
Fj Digplay Billing Rate EE Highlight Unique (Delta) Cost Item Fields | "= Insert Subordin
Split Default
Data Blocks Break Cost Allo
Edit View
Cost Breakdown Structure (CBS) Register Cost Ttem Record @
CBS Code: Optional Code:  Description: Forecast (T/0) Qty:  Unit
A c 203 Anca Rmmbali Fameeaba Lk Mis Tima & 2c ann nnl | Tam
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5.4.5 COST DRIVERS

Each type of resource has a default cost driver. For example, Labor resources are duration driven so
the cost driver is Cl Duration, meaning their costs are driven by the duration of the cost item. If you
want an Operator to only be assigned to a specific cost item or work activity for half the time, you can
change its quantity to .5 and it will be driven by half of the cost item’s hours.

Drag columns here to group Find: | [Search For...]
W N 5 Waste Qual
i Gie RS omewen  umy 0 2 G2
1 w2 Laborer Each $29.00
2 o1 Operator Clas. .. 1.00 Each £29.94
3 EL933 % Loader 988 1.00 Each §73.75

To enter work hours manually for the employed resource, you can change the Cost Driver option to CI
Quantity or Fixed.

Drag columns here to group Find: | [SearchFor...] Saved views: | Previous View
Row s Resource P — Unit of Unit Cost \;,i‘“te E::;'ﬁt” mer_‘
Number Assembly Mea... Cost Driver Add-on Waste) stomiz
2 101 Operator Clas... 1.00 Each $29.94 | th Description
3 ELsss Loader 988 100 Each $73.75 | 1 Duration

Fixed
Scheduled Periods

T

With Cl Quantity as your cost driver for the Operator, you can adjust the Work Hours manually, where
previously that column was read-only.

Let’s say you want your Operator to work specifically 80 hours.

Irag columns here to group Find: | [Search For...] = | Saved views: | Previg
ot REME oepmn gy T ek e G e
Add-on v
[ | Jaew | osmes | B ox| | cosw |
2 Lo1 Operator Clas... 1.00 Each £29.94 120.00 120.00 CI Duration
3 EL988 Loader 988 1.00 Each £73.75 120.00 120.00 CI Duration

However, since the resource is now quantity driven, if you change the Forecast (T/O) Quantity to 50
you will see that the work hours will still adjust from 12 to 40.
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Cost Breakdown Structure (CB5) Register CostItem Record ©  Cost Item Record
cos code: Optional Code:  Description: Forecast (T/0) Qtys  [Unit of Measure:  Unit Costs Total Cost: currency:
[m22 [ | [clearing |l sn.w\ICubuhrd i- $1,156.70 §57,835.17 [ U.S. Dolar
PlAssignment:  P1LineNumber:  P1Description: Cost Segment: PayQuantity:  Cost Source: Alternate:
010102 » Clearing & Grubbing Direct Cost 50.00 | Detai - | [ease
£0etal: $1,155.70 | 8 Pug: $0.00 | (Jouote:$0.00 | alocation Production x
« Find: | [SearchFor...] -] saved views: | Previous View - Factored  Qty Driv *
Duration Driven Hou
st Guration Driven Resources Resources  Resour
Row coge  Resource Sespton " ntof | Unt wiork Pay H d
Namber Assembly 5 Quantity 3. Cost Lrs B of 61,2000
e 1w Laborer 0.50 Eath $2.00 240.00 240.00 c o @
2 101 Operator Clas... 100 Each .94 480.00 480.00 c 4800 8.
3 a8 Loader 583 100 Each 7375 480.00 480.00 c 490.00 440,
480.00 20
480.00 0

If you want it set at 80 hours no matter what changes you make to your quantity, you can change the
cost driver to Fixed. Then when you change the Forecast Quantity to 500, the work hours for the
Operator will not change and will remain at 80 hours as shown below.

€8S Code: Optional Code:  Description: Forecast (T/0) Qty:  Unit of Measure
w22 | [crearing i 500.00] [CubicYard .
PIAssignment:  PILine Number: PI Description: Cost Segment:
210102 20 Clearing & Grubbing Direct Cost

Cost Item Summary sgemu :5106.39 | ¥ Plug:$0.00 | (JQuote: $0.00 | Allocation

Drag columns here to group Find: | [Search For...] - | Saved views: | Previous View
] Waste Quantity
—_ Resource ) Unit of Unit Work Pay Cost Prd
= Code Desaription Quantity % ” ess
Assembly Mea... Cost Hours Hours sdon Driver Waste) Fa
ra 1 Uz Laborer 0.50 Each 39,00 | sn‘nnl 30.00 Fixed
2 Lol Operator Clas... 100 Each $20.94 430,00 430,00 CI Duration
3 EL9se Loader 988 100 Each $73.75 480,00 480,00 CI Duration

If you followed along and made any adjustments to cost item 2.1 Clearing, change the Cost Driver for
the Operator resource back to Cl Duration and the Work Hours back to 100.

5.4.6 SUSPEND COST ITEMS

The Suspend feature allows you to turn cost items on and off in order to perform “what-if?” analysis or
evaluate alternative approaches to the work.

A cost item can be suspended in InEight Estimate for various reasons including the following:
¢ Manually suspended cost items
¢ Suspended parent
¢ Parent with cost source that is not Detail (plugged or quoted)
e Parent cost item with a zero quantity
e Payitem is suspended
e Allocated cost items

¢ Alternate scenarios:
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e Overridden by another alternate
¢ Alternative is not active

Suspended cost items do not contribute any cost to the job's total value. Suspended items can be un-
suspended at anytime in order to be included in the total project value.

STEP BY STEP — SUSPEND A COST ITEM

1. On the Cost Breakdown Structure (CBS) Register, select a cost item.
2. Right click on the selection and select Toggle Suspended from the menu.
¢ You can also select Toggle Suspended under the Edit section of the Actions tab up above

¢ You can also suspend cost items by checking the Suspend checkbox on the Cost Item Setup
tab of a cost item record

embly s Subordinate

e If a superior cost item is suspended, its subordinate cost items are automatically
suspended as well

L Cxcavate R P PVIVIVATIV I
+ 3.2 Haul 40,000.00 _ CY
= a 10" PVC Pipe 1,000.00 LF
+ 4.1 Furnish Pipe Materials 1,000.00 LF
+ 42 Excavate-Install Backfill 1,000.00 LF

¢ The costs associated with these cost items will no longer contribute to the estimate
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5.4.6.3 EDITABLE MAN-HOUR FACTORS IN SUSPENDED COST
ITEMS

You can edit Man-Hour Factors for a suspended cost item by creating and maintaining cost items,
including Man-Hour Factors. This can be accomplished in a suspended state while having the scope of
work included in your estimate. The cost to contribute is excluded from the scope of work until you are
ready to make it part of your estimate.

ol P oo M el |10 B B L=t L]
oL | wm Hahdretor A EATIRED L
- wapeas . emtegees By D = -
e el L] g [ [ el
o e ey Dl 3000 g Cjemir 1 3 i R — T
- L
K . =
- . - - o . :
i e . s e - e o i
5 e Frmowr Fruck L e [E ] el E - i
—
1o N e (N - . o T
san [ tewer I L vm [ W =
B2 aM
e 7. % B r ® &
—
=1 =

5.4.6.4 UNSUSPEND A COST ITEM

Follow the step by step below to unsuspend a cost item.

STEP BY STEP — UNSUSPEND A COST ITEM

1. On the Cost Breakdown Structure (CBS) Register, select a cost item.
2. Right click on the selection and choose Toggle Suspended.
¢ You can also select Toggle Suspended from the Edit section of the Actions tab

¢ You can also unsuspend cost items by unchecking the Suspend checkbox on the Cost Item
Setup tab of a cost item record

5.4.6.5 SUSPEND COLUMN

Within the CBS Register, the Suspend column indicates which cost items are suspended.
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Position Code

CBS

+ 1
= 2
+ 21
+ 22
= 3
+ 31
+ 3.2
=2 4
sl
+ 4.2

Description

Mobilization

Clearing & Grubbing
Clearing
Grading

Excavation
Excavate
Haul

10" PVC Pipe
Furnish Pipe Materials
Excavate-Install-Badkfil

Suspend

<=l

Estimate Essentials User Guide

Forecast

(Tj0) Qu

¢ Hover over the checkmarks to see why the cost item is suspended

+ + @+

Sl

4.1
4.2

Haul
10" PVC Pipe

Furnish Pipe Materials

Excavate-Install-Backfil

i

Parent is Suspended

e You can suspend and unsuspend cost items by checking and unchecking the checkboxes in the

Suspend column as well

5.4.7 ADDING COST ADJUSTMENTS

Total Cost and Billing Adjustments can now be made in the CBS register which can be viewed either

from the Standard view of the CBS register, or a saved view affiliated with change.

Cost Breakdown Structure (CBS) Register ©

BS
Position Code

+

+

o

35
351
352
353
36
361
362
a
41
411
412

414
4141
4142
4143
5

Description

Forecast
(T/0) Quantity

REBAR 100
Rebar 100
Post Tension Tendons 100
Crane 100

034100 - Precast Structural Concrete 2,800.00
Precast Panels 27.00
Crane 1.00

DIV 04 - MASONRY 1.00

042000 - Unit Masanry Loo
MU Walls 100
Precast Conarete Caps 1.00

Scaffolding Loo
Setup & Maintain Scaffoldng 2.00
Additional Month 0.00
Netting on Exterior 0.00

DIV 05 - METALS.

100

Unit of
Measure

Lump Sum
Lump Sum
Lump Sum
Lump Sum
SQFT

EA

Lump Sum
Lump Sum
Lump Sum
Lump Sum

Lump Sum

Lump Sum
Monith

Month
Lump Sum

Lump Sum

Total Cost
(Forecast)

$2,618,414.00
$2,512,724.00
$0.00
$105,690.00
$128,640.00
$64,320.00
$64,320.00
$2,326,834.67
$2,326,834.67
$1,879,709.33
$170,552.67

T T

$105,360.00
$105,360.00
$0.00
$0.00
$354,880.00

$20,381,473.74

Find: | [SearchFor...]

-|  Saved views: | Cost Item Adjustment View

s Total Cost Total Cost Labor Cost Labor Cost Owned Equipment Cost q
Adjustment Adjustment Amount Adjustment Percent Adjustment Amount Adjustment Percent Adjustment Amount I

0.00 0.00 $0.00 0.00 s0.00

$0.00 0.00 $0.00 0.00 $0.00

$0.00 0.00 $0.00 0.00 s0.00

$0.00 0.00 $0.00 0.00 $0.00

0,00 0.00 $0.00 0.00 0,00

v $1,708,826.67 1000.00 $0.00 0.00 .00

$0.00 0.00 $0.00 0.00 $0.00

£0.00
$0.00
$0.00

$1,733,328.68

5

0.00
0.00
0.00

$0.00
$0.00
$0.00

$17,567.79

0.00
0.00
0.00

$0.00
$0.00
$0.00

$176.78

Adjustment fields have been added to the CBS to view and modify the adjustment amount and

adjustment percent without going into each individual cost item.
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Any adjustment made to the Adjustment Amount fields on the CBS register will then have the
Adjustment Percent field automatically calculated. Changes made to those fields will be highlighted in
yellow signifying an adjustment has been made.

+ 361 Precast Panels 27.00 EA §54,320.00 $0.00 0.00 £0.00 0.00
+ 386.2 Crane 1.00  Lump Sum §64,320.00 $0.00 0.00 $0.00 0.00
= 4 DIV 04 - MASONRY 1.00  Lump Sum §2,326,834.67 L]
B 41 042000 - Unit Masonry 100 Lump Sum $2,326,834.67
+ 4Ll oMU walls 100 Lump Sum §1,879,709.33 v $1,708,826.67 1000.00 £0.00 0.00
+ o412 Precast Concrete Caps 100 Lump Sum §170,882.67 $0.00 0.00 £0.00 0.00
) [P = I T T ; I I
= 414 Scaffolding 1.00  Lump Sum §105,360.00 R
4141 Setup & Maintain Scaffolding 2.00 Month §105,360.00 $0.00 0.00 £0.00 0.00
4.1.4.2 Additional Month 0.00 Month $0.00 $0.00 0.00 $0.00 0.00
4.14.3 Netting on Exterior 0.00  Lump Sum $0.00 $0.00 0.00 $0.00 0.00
25 DIV 05 - METALS 1.00 Lump Sum $854,880.00
261 $30,381,473.74 $1,733,328.68 $17,567.79

Other adjustments fields in the CBS register include the many adjustments fields that have been added
to the Billing Rates View.

A new Saved view called Cost Item Adjustment View has been added to the Cost Breakdown
Structure.
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EXERCISE 5.3 - MANAGE COST ITEM DETAILS

In this exercise, practice adjusting your cost item details. Complete the following steps, using your
Job:

1. Open the Cost Item record for cost item2.2 Grading.

2. From the Cost Item Setup tab, change the Composite Wage Scale to 80% Scale 1,
20%Scale 2. Also adjust for every10 hours worked, pay 10 hours.

3. Change the Default Shift Arrangements to 10 Work Hours per Shift, 1 Shift per Day, 5Days
per Week.

4. From the Man-Hour Factors tab, apply a Man-Hour Factor of 1.1 to the same cost item.
5. On the Notes tab, type Added man-hour factor due to hard soil conditions.

You should end up with similar results.

Production
Duration Driven  Factored Duration
Cost Item Setup Resources Driven Resources
Default Pay Rules + | D= L LEL
Scale 1:  Scale2:  Scale 3: Shifts 8.00 8.80
Composite Wage Scale: | 80.00 Hours 80.00 83.00 Notes
For every|IEEill] hours worked, poy [JREH| hours e o — Added man-hour factor due to hard soil conditions
Equip-Hours 200.00 220,00 '
Default Shift Arrangements
Work Hours per Shift: Shifts per Day: Days per Week:
B B =L Ll AcreDay L25 L4
[ 1000 | L00] | 5.00
Acre/Shift L.25 L14
AreHour 0.13 0.11
Acre/Man+Hr 0.03 0.03
Acre/Equip-Hr 0.05 0.05

Congratulations, you have completed this exercise!
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LESSON 5 REVIEW

1. Resources, costs, and production can only be added to what type of cost item?
a. Superior
b. Terminal

C. Parent

2. What Cost Source is used for defining resources and production?
a. Plug
b. Detail

C. Quote

3. On the Cost Item Record, what tab is used for changing the cost item’s Default Shift
Arrangements?

a. Cost Item Setup
b. Production

C. Man-Hour Factors
d

Notes

LESSON 5 SUMMARY

As a result of this lesson, you can:

Explain the Cost Breakdown Structure and its purpose

Create cost items

Add costs and production

e Manage cost item details
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LESSON 6 — INDIRECT COSTS

LESSON DURATION: 45 MINUTES
LESSON OBJECTIVES

After completing this lesson, you will be able to:
e Explain how indirect costs are defined in InEight Estimate
e Estimate default indirect cost items

e Estimate user-defined indirect cost items

LESSON TOPICS
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6.1 INDIRECT COSTS OVERVIEW

Indirect costs such as the cost of prime bond, mobilization, or site supplies are typically overhead costs
that are not directly associated with a particular project deliverable but contribute to the total cost of
the project. However, indirect costs can be assigned to a pay items. This gives you the flexibility to
more accurately control the cost basis of bid items and strategically price the work to maximize cost
recovery and profit.

Once your direct costs are defined, you can add indirect project costs. Estimate provides two ways you
can create indirect costs:

1. Default Indirect Cost Items: These are pre-built cost items created by InEight Estimate, located
at the top of the CBS Register.

CBS

Posiion = Description
Code

= JOB

Prime Bond

Price % Add-On

Job Financing

Indirect Cost Escalation
Direct Cost Escalation
Indirect Cost Add-On

Job Management & Equip...
General Expense

Direct Cost Add-On

2. User-Defined Indirect Cost Items: Any cost item you create in the CBS Register that is not
assigned to a pay item is considered indirect cost.

= 23 Job Overhead - Indirect ...
- .
e ————

s Utilities
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TIP The Cost Breakdown Structure (CBS) located in the Library under the Estimate tab,
Master Breakdown Structures section, controls which of the default indirect cost
items to copy into new job folders.

6.1.1 NAVIGATION TO INDIRECT COSTS

From the Estimate tab of the InEight Estimate landing page, you can quickly access indirect costs from
the Indirect Cost section.

Estimate Quote Price Execution System

ﬁ != Account Code Utilization a Resource Rates - m -— ag Job Finance
— b f oo

& Waork Breakdown Structures 'E; Resource Utilization % Price % Add On

Cost Breakdown - Workbook Schedule  Cash Flow Indirect P
Structure (CBS) & Resource Cost Details - - Cost Items E] Prime Bond 3

Breakdown Structures Resources Workbook Schedule Indirect Cost

e Select Indirect Cost Items to open the Cost Breakdown Structure Register filtered to only your
indirect costs

¢ You can select Prime Bond, Price % Add On, and Job Financing to access those indirects

The following section takes a closer look at the default indirect cost items.

6.2 DEFAULT INDIRECT COST ITEMS

InEight Estimate contains various default cost items to help you calculate your indirect costs.

6.2.1 INDEPENDENT INDIRECT COST ITEMS

Independent indirect cost items function very much like the direct cost items you defined previously:
¢ Job Management & Equipment

e General Expense

6.2.1.1 JOB MANAGEMENT & EQUIPMENT

The sample Job Management & Equipment Record below shows that you can add resources and
production just like in your direct cost items. Supervisory staff resources were added, and the
production duration is set to 100 days.
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Cost Breakdown Structure (CBS) Register Cost Item Record  © -
CBS Code: Optional Code:  Deseription: Forecast (T/0) Qty:  Unit of Measure:  Unit Cost: Total Cost: Currency:
= 108 MANAGEME‘ I]Dh Management & Equipment || 1.00] | Lump Sum - £157,006.28 §157,096.28 | U.S. Dollar
PIAssignment:  PILine Number: PIDescription: Cost Segment: Pay Quantity: Cost Source: Alternate:
Job Overhead 1.00 | Detal - | [Base -
CostItem Summary | 5, Detai : $157,096.28 | & Plug: $0.00 | {2 Quote:$0.00 | Allocation Production x
Drag columns here to group Find: | [Search For...] Saved views: | Previous View - Factored *
Duration Driven
o Duration Driven Resaurces Resources
Mmooy &+ [Code | Desrption wnty LY. weem SN R ST (e A
Customize Displ £1.0000)
- | olea | seal el el || v 0] 4 100
2 LSSEC  Sedetary 100 Each §20.41  B00.00  800.00 e o000 1000
3| LsPE Project Engineer 100 Each $51.03  800.00  800.00
Hours: 800.00 800.0
4 ETST Service Truck 100 Each $50.60  800.00  800.00
Man-Hours: 2,400.00 2,400.0
5 ETPU Pickup 2,00 Each $1550  1,600.00  1,600.00
Equip-Hours:| 2,400.00 2,400.0
. ™ n

The following Step by Step walks you through defining resources and costs for your Job Management &
Equipment indirect cost item.

STEP BY STEP — ADD JOB MANAGEMENT & EQUIPMENT COSTS

In your job, from the Estimate landing page, select the Cost Breakdown Structure (CBS).
Double-click on the row header of the Job Management & Equipment indirect cost item.
Add resources by clicking in the Code column and selecting the Icon.

Select the Production tab.

Enter a production value.

o a bk~ 0w DN =

Click OK to close the record.

e For this example, we'll add the following resources and production:

Resource Quantity

LSSEC Secretary 1
LSSUPT Project Superintendent 1
Cost Item Production Value (in Days)

70

Page 284 of 402 InEight Inc. | Release 25.7



Estimate Essentials User Guide 6.2 Default Indirect Cost Items

STEP BY STEP — ADD GENERAL EXPENSE COSTS

1. From the Estimate tab, select the Cost Breakdown Structure (CBS).
2. Right-click the row header of the General Expense row header and select Open.

¢ You could add existing resources here, but in this case, you will create an ad hoc resource.

3. Inthe first blank row, enter a description, quantity and unit of measure.
4. Click on (highlight) that row, and then click the Resource Employment Breakdown tab.
5. Type a numeric value in the Undefined Supplies cost category.
6. Click Ok to close the record.
e For this example, we’ll add General Office Supplies, 1 Lump Sum, $1,000 in the Supplies
category.
& [GENERAL BPE | [Genersl penae 0 0] [umpSm - s10000 $10000 [ U5, Dor

Pl Assignment:  PlLine Number: Pl Description: Cost Segment: Pay Quantity: Cost Source: Alternate:

Job Overhead = 1.00 | Detad - || BASE
CostItem Summary | S Detsd: §1,000.00 | & Plug:$0.00 | {2 Quote:$0.00 | Alocation
Saved views: o Ve -] SO || costCategary Seale 1

~ | Total $1,000.00

Row Resource Quanibity Waste % Uit of

. cde ; Desai e Quan

Mumber < Asgembly i) fLess Waste) Add-on u.d [T » Labor £0,00
= 1 Ganeral Office Supp.. 1.00 0.00 1.00 LumpSum = »  Owned Equipment 50,00
»  Rented Equipment $0.00

v Supphes $1,000.00
I |

6.2.2 DEPENDENT INDIRECT COST ITEMS

The other default indirect cost items are dependent indirect cost items, meaning their costs depend
on other costs, prices or hours. They include:

¢ Direct and Indirect Cost Add-On

Direct and Indirect Cost Escalation

Prime Bond

Price % Add-On

Job Financing
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¢ Man-Hour Add-On

Actions

uspended g_-, Link Field Cost Item

Unlink Field Subordinate Cost Item

| H Dependent Cost Item

Workbook

It’s possible to assign any assigned or dependent cost Item to any of the 3 cost segments and provides
greater control over where costs exist in the Price Breakdown Structure (PBS).

Cost Breakdown Structure (CBS) Register @ Pay Item & Proposal Register

g:inm Code = Descripton g:;:m: ML E:;m:“ Code :
=2 JOB
# Prime Bond
Job Financing
Indirect Cost Excalation

Direct Cost Escalation
Indirect Cost Add-On

Mobilization
=1 SITEWORK & ROADWAY
+ 11 Mobilization -
+ L2 Clearing & Grubbing Drect Dot AT LZ
= 13 Undassified Excavation Direct Cost 2020183 1.3
+ L3l Excavation Direct Cost 2020183 1.3

6.2.2.2 DEFAULT DEPENDENT COST ITEM DELETION

Meyg= If you need to use additional dependent cost items, you can create your own, but you
must delete all the existing default dependent cost items first.

The following steps walk you through deleting your existing default indirect costs so you can create
your own.
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STEP BY STEP — DELETE EXISTING DEFAULT DEPENDENT COST

ITEMS

From the Estimate tab, select Cost Breakdown Structure (CBS).
Select an Indirect Cost Item by clicking on its row header.
Press and hold the Ctrl or Shift key to select multiple indirect cost items.

Right-click on the selection and select Delete.

a K~ w0 N o=

Select Yes to confirm you want to delete the selected cost items.

6.2.2.3 PRIME BOND

The following steps walk you through adding and defining your prime bond for the job.

STEP BY STEP — DEFINE PRIME BOND

From the Estimate tab, select Cost Breakdown Structure (CBS).

Right-click on the row header for any cost item and insert Dependent cost Item.
On the resulting Attention prompt, select Based on Bond Table.

Click OK.

Right-click on the Prime Bond row header and select Open.

Use the Table Name drop-down to choose a table (e.g., Example: General Construction).

N o g s~ e bdh =

Click OK to close the record.

MULTIPLE BOND RATE DEPENDENT ITEMS

For certain projects, it may be desirable to calculate costs for bond or insurance premiums based upon
multiple different rate tables. It is now possible to add multiple bond/rate table based dependent
items in the CBS.

For example, in addition to having a prime bond, the job may also require insurance coverage where
the premium is calculated using a rate table-based approach. This can now be accomplished by adding
another Bond/Rate-table based dependent cost item to the job.
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Cash Breakiomn Stracture [((B5] Register O

rigry

ﬁmm - Serrpn :?-:M F“ar:'f;:rﬂr '::.‘r: Urat Cent *f:f:. Mlocated ey [our ation drrver]
L] ou Hin e HITAMAL 85,551,300 . 1.5, Dolar SARLTY

J—— PIE BOHD 100 Lump Sure PLNES LA U, Dlar

Imarasce PELBCE 100 Lusp S ST SN U, Dolar

Jab Fmancing FEMARCE EinEs L0 Lusp S 3 843 53 fr PR ] LA, Dol

Indirect Cost Eacalation PORECT COST ESCALATION LO0  Lusp Sum 2,091 £3,13L01 L5, Colar

Carect € oat Evcabation DERECT COST ESCALATION LOO Luspg Sum $L5,048. 80 5,0 B0 L5, Collar

Indirect Cost Add-0n LO0  Lump fum AL 1T ra b L] 5. Colar

Dereck Cost Add-On SERECT 0T ADD-GM 100 Lump Surs FUOAZH  BHOATH 5. Colar
E1 SIOWORXE ROAIWAY o 100 Each LA LT LA L U5 Coler 183
+ 11 Motskzaton 812100 100 Lumg Surs HLWREL HILRSE 5. Colar e
* 12 Cearng A Grubbng T 000 Ae 9850 £39,184.97 U5. Colar o
a 1y Ul et Excareston w228 S.000,00 Cubsc ard $hea EILEISE U5, Dolar HLET

DELETING BOND TABLES

Delete bond tables that are not applicable to your estimate by selecting them and then clicking the
Delete button. You can customize the Bond Table window to only view the tables that are relevant to
your estimate from the Table Name drop-down list.

Band Table b4

Identification
Table Name: | EXAMPLE: GENERAL COMNSTRUCTION e - Edit Name Debete

Last Maintenance:

Bond Rate Layers
Friom $1,000
8.20000
7.00000
5.00000
4,80000
$20,000,000.01 $40,000, 000, 00 3, 50000
$40,000,000.01 &60,000,000.00 3.00000

4 BondTable [ CostltemSetp [5) Motes ‘= Schedue

6.2.2.4 PRICE % ADD-ON

The following steps walk you through defining the Price % Add-On.
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STEP BY STEP — DEFINE A PRICE % ADD-ON

1. From the Cost Breakdown Structure (CBS) Register, right-click on the row header for any cost
item and select Insert Dependent Cost Item.

2. On the resulting Attention prompt, select Based on Job’s Price.

) Attention

Lol

Choose what type of Dependent Cost Item to add:
(®) Based onJob's Price

{_) Based on Job's Finance Cost
Based onBond Table

(") Based on Direct Costs

() Based on Indirect Costs

() Based on CBSMan Hours

D Based on CBS Equipment Hours

{_) Based on Resource Utilization

() Basedon Assembly Utilization

Cancel

3. Click OK.

4. Double-click on the Price % Add On row header to open the record.

EDB:ﬁon Code = DECEue gopéljgnal [I
JOB
Job Management & Equipment JCB MANAGEMENT &E...
General Expense GEMERAL EXPEMSE
Prime Bond PRIME BOMD

+ 1 Mobilization 1000
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5. The Price % Add-on Record opens to the Description tab. Type a description in the Description
field and enter a numeric value for rate.

Cost Breakdown Structure {CBS) Register Price % Add-On Record ©

CBS Code: Description:
Price % Add-On

Description Dependency

Drag columns here to group

Account
Code

Description Rate

Pl Cffice Overhead

6. Click OK to close the record.

. For this example, we’ll enter a description of Office Overhead and a rate of 4%.

6.2.2.5 DIRECT COST ADD-ON

The following steps walk you through creating a Direct Cost Add-On dependent cost item.

STEP BY STEP — DEFINE A DIRECT COST ADD-ON

1. From the Cost Breakdown Structure (CBS) Register, right-click on the row header for any cost
item and select Insert Dependent Cost Item.

On the resulting Attention prompt, select Based on Direct Costs.
Click OK.
Double-click on the Direct Cost Add-On row header.

a & w0 N

On the Description tab, type a description in the Description column.
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Cost Breakdown Structure (CBS) Register

CBS Position Code: Description:

6.2 Default Indirect Cost Items

Direct Cost Add-On Record ©

|Direct Cost Add-On

Description Dependency Cost Categorization

Drag columns here to group

Description /

Allocation

Curre...

& ESmalITu:qus &

Total Cost
(Forecast)

6. Press the Tab key (you can define additional rows for other add-on costs as needed).

7. Click on the Dependency tab to see what contributes to your subject cost.

8. For this activity, leave the default (lower) button selected.

Toggle Include All

(Affects displayeditems only) | @ Define the Subject Cost using column filtering (all current and future items that match the filter will be induded automatically)

(O Define the Subject Cost by viewing all available items and clicking the Include boxfor the desired items

9. On the Cost Breakdown tab on the right, add an add-on rate (percentage) or cost at any of the

cost category levels you need.

e This updates the Total Cost (Forecast) of your item on the Description tab

10. Click OK to close the record.

e For this example, we’ll create a new Direct Cost Add-On, giving it a description of Small

Tools with a rate of 10% on the Labor cost category

CBS Position Cade:  Description:

[pirect costagd-on

Pl Assignment: Pl Line Number: P1Description:

Total Cost: Currency:

] £5,701.36|  U.5. Dollar

575
10.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00

Cost Ssgment:
| | 208 Overhaad
Description | Dependency | CostCategorization | Aocation Cost Breakdown
Saved views: - Cost Category m;;.ec: Rate
Cost

Description Currency Total Cest (Forecast) w Total $99,107.22

#  smallTooks 1.5, Dolar $5,701.36 d == B.01562

»  Owned Equipment §38,555.52

»  Rented Equipment £0.00

» Supplies §0.00

»  Materials §3,276.00

»  Subcontract $0.00

» Fees $262.08

»  Alowance $0.00

Custom Categoryl $0.00

Undefined §0.00

InEight Inc. | Release 25.7

0.00

Alternate:
BASE -

Pay Quantity:

Cost

$5,701.36
$5,701.36
$0.00
£0.00
$0.00
$0.00
$0.00
$0.00
$0.00
$0.00
$0.00

Page 291 of 402



6.2 Default Indirect Cost Items Estimate Essentials User Guide

6.2.2.6 REPOSITIONING DEPENDENT COST ITEMS

Repositioning dependent cost items creates a simpler way to manage the hierarchy of your project by
placing items of more importance ahead of other line items.

Since dependent cost items can now be repositioned, a Position Code field has been added with the
functionality similar to column remaining the same. The below listed dependent cost item fields are

now exposed in the CBS register so you can more easily see the various percentages used in dependent
items.

e Subject Cost

* Subject Cost Rate

¢ Subject Billing Amount
e Subject Billing Rate

These columns can also be found in the new saved view Bid Review.
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CBS s o inti
Position Code = 2 L]
= JOB

Prime Bond

Price % Add-On

Job Financing

Indirect Cost Escalation
Direct Cost Escalation
Indirect Cost Add-On

Job Management & Equipment

gt General Expense
Direct Cost Add-On
+ 1 HMeobilization
+ 24.1.2 Day Two
25 Prime Bond
26 Price % Add-On
27 Job Financing
28 Indirect Cost Escalation
29 Direct Cost Escalation
30 Indirect Cost Add-On
+ 31 Job Management & Equipment
+ 32 General Expense
33 Direct Cost Add-On

RELEVANT LINKS

Video - Classifying Direct & Indirect Costs

6.3 User-Defined Indirect Cost Iltems

Optional
Code

PRIME BOMD

PRICE %2 ADD-OM

FINAMCE EXPENSE

INDIRECT COST ESCALATION
DIRECT COST ESCALATION
INDIRECT COST ADD-OM

JOB MAMAGEMENT & EQUIPMENT
GEMERAL EXPEMNSE

DIRECT COST ADD-OM

6410100

PRIME BOMD

PRICE % ADD-OM

FINAMCE EXPENSE

INDIRECT COST ESCALATION
DIRECT COST ESCALATION
INDIRECT COST ADD-0OM

JOB MAMAGEMENT & EQUIPMENT
GEMERAL EXPEMSE

DIRECT COST ADD-OM

6.3 USER-DEFINED INDIRECT COST ITEMS

You may prefer to create your own indirect cost items. You create user-defined indirect cost items the

same way you create direct cost items. The only difference is that your indirect cost items will not be

assigned to pay items. One advantage of creating your own indirect cost items is the ability to create a

parent-child structure for your indirect costs.

Here is an example of user-defined indirect cost items, expanded to show their employed resources:

InEight Inc. | Release 25.7

Page 293 of 402


https://learn.ineight.com/Estimate/Content/Categories/VideoStartPage.htm?wchannelid=wlkiph4dhe&wmediaid=tdunoxca1m

6.3 User-Defined Indirect Cost Items Estimate Essentials User Guide

Eggﬁun Code = Dl ?}S;ﬁzanﬁw I'I:I"Igi;::re LU -I(E;Efnlacc:sstg
B 5 Indirect Cost 1.00  Each £10,584.36 £10,584.36
- 51 Head Office 1.00  Each £370.32 £370.32
P A A s
= 1 Head Office Project ... 1.00 Each 3.00 800 546.29 5370.32
- 5.2 Field Office 1.00 | Each §1,775.04 §1,775.04
lomowen ey M e
14 1 Field Office Clerk 1.00  Each 4.00 4.00 £38.00 £152.00
FiLa 2  Field Office Safety M... 1.00  Each 8.00 8.00 562.38 £499.04
3  Field Office Site Supe... 1.00  Each 16.00  156.00 570.25  51,124.00
- 33 Site Facilities 1.00  Each 5905.00 5905.00
 Jomowin iy Y P e
= 1 Field Office Telephone 0.50  Manth £250.00 £125.00
2 Field Office Trailer 1.00 Each 0.00 0,00 $5.94 £0.00
3 Pick Up Truck 1.00 Each 80,00 30.00 £9.75 £780.00
+ 5.4 Misc, Expenses 1.00  Each §2,765.00 §2,765.00
+ 5.5 Supervision 1.00  Each §4,769.00 §4,769.00

STEP BY STEP — ADD USER-DEFINED INDIRECT COST ITEMS

Let’s walk through a specific scenario for this step by step.

1. At the bottom of your CBS, create an indirect cost item called Job Overhead with a Forecast
(T/0) Quantity of 1 and Unit of Measure of Each.

2. Add two subordinates under the new cost item named Job Trailer and Utilities. Job Trailer is 1
Each but change Utilities to 1 Lump Sum.

3. Open the Job Trailer cost item by double-clicking on the row header.

¢ Assuming there is no Job Trailer in our Resource Rate Register, you will create this
resource “on the fly”.

4. In the Detail grid, click on the Resource Register icon in the Code field as if you were going to
select from the Resource Rate Register.

5. On the Resource Rate Register, click the Rented Construction Equipment tab.
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Right-click on one of the Line Items and select New to add a new resource.

Enter a Resource Code of RIT and description of Job Trailer.

®©® N O

In the Amount column enter 25 for the Rented Equipment category.
9. Click OK to close the Resource Rate Record.
10. Select the new resource you created, then click OK to return to the cost item record.
11. On the cost item record, adjust the Job Trailer quantity to 2.
12. On the Production tab, enter 70 days.
13. Click OK to close the record.
14. On the CBS register, select the Utilities cost item by double-clicking on the row header.
15. Create an ad hoc resource on this cost item called Electricity, which will be 1 Lump Sum.

16. Finally, go to the Resource Employment Breakdown tab and enter 1500 in the Custom Categoryl
row.

17. Click OK to close the record.

=3 Job Overhead 1.00 Each £31,740.00 £31,740.00
= =4 Job Trailer 1.00 Each §30,240.00 §30,240.00
Row Resource Quantity Waste % Unit of Work  Pay = Total Cost
Number = Code Assembly gescson (Less Waste) Add-on Quantity Measure Hours Hours SOIECOSE (Forecast)
= 1 RIT Job Trailer 2.00 Each 11...] L1.. §27.00 $30,240...
= 32 Utlities 100  Lump Sum §1,500.00 §1,500.00
Row Resogurce ettt Quantity Waste % . Unitof Work  Pay - Total Cost
Number = Code Assembly Desaiption (Less Waste) Add-on Quantity Measure Hours Hours Unit Cost (Forecast)
= 1 Electricity 1.00 0.00 1.00 Lump ...

6.4 COST ALLOCATION

The Cost Item Record - Allocation tab lets you to spread costs from a single Cost Item Record to one or
more other cost items in the Cost Breakdown Structure (CBS) Register.

» Allocation Item - The cost item to be allocated, where you define the quantities, resource
employments and the logic that determines how to allocate the item throughout the bid.

» Allocation Target - A cost item to be the recipient of allocated cost, as defined within the
Allocation Item. There may be one or many Allocation Targets for one Allocation ltem.
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« Distribution - A read-only cost item in the CBS representing an Allocation Target's
proportional share of the Allocation ltem.

You can choose from several methods to determine specifically where and how much cost to spread:

» Quantity - Specify the amount of the Allocation ltem to be spread to each Allocation
Target.

» Proportionately based on another field - Allocate proportionately by one of many
available cost item values, usually based on time or cost.

» Percentage - Specify the percentage of the Allocation ltem to spread to each Allocation
Target.

» Unit Cost - Use the unit cost from the Allocation Item and the quantity of each Allocation
Target to drive the Forecast (T/O) Quantity of the Allocation Item.

Cost Item Allocation is a good means of spreading costs throughout a bid for the purpose of
determining appropriate bid prices.

(\e3 = Only Level 1 cost items can be allocated, including Add-On and Escalation dependent cost
items. A subordinate cost item cannot be allocated, and a cost item that is assigned to a
pay item cannot be allocated.

6.4.1 COST ALLOCATION

With Cost Item Allocation, you can track the cost of one broad cost item by distributing the cost of that
item to other cost items, so that the cost can be tracked on a more detailed level. This gives better
visibility into the cost that makes up an item. For example, you can spread ST&S from one cost item to
multiple cost items that will use ST&S.

Imagine that a large portion of your scope of work for the job you are bidding has concrete. You face
the options of batching your own raw materials or purchasing the materials from a supplier. You can
use cost allocation to create the cost of a batch plant and allocate it to different items, and then
compare this unit cost to the unit cost of purchasing the materials from a supplier.

The Allocation tab allows you to spread costs from an Allocation Item to one or more Allocation Target

(s).

[\[eJp 2 In the Allocation Target list, the [Unit of Measure] Quantity column caption displays the
Unit of Measure of the Allocation Item. For instance, if the Allocation Item's Unit of

Measure is Cubic Yards (CY), then the caption displayed for this column is CY Quantity.

A Distribution cost item is created as a read-only subordinate cost item under each Allocation Target. It
is copied proportionally with the quantity/cost defined to each different item in CBS.
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6.4.2 VIEW FILTER EXCLUDES COST ITEM
ALLOCATION DETAILS

A View Filter option is added to show only the level 1 cost item distribution in the allocation
destinations to provide you with a clear and comprehensive view of the CBS register, especially when
there are many allocations. When you are allocating cost items, the allocations are created in the
destination cost item by creating a copy of the entire allocated cost items structure. This filter allows
you to simplify the view by displaying only the parent level allocation cost item.

|

B Print [Aopen 3<cut Fill Down T3 Toagle suspended | X Link Field CostItem Assembly o Resource e
£l

w 'E CBS Tree Fiter Mode:
n Navigation

R Preview @new  Eycopy [ spit Indent Uniik Field | 73 Subordinate Cost Item | [ Subordinate Assembly | %§ Resource Assembly »
@& EportioExcel | @) Delete [y Paste ¢ Spitby CostType = Outdent Dependent Cost Item Gomal B G | ORI/ BoendessTree
print Edit Workbook Insert ¥ Fiterto CBS Level
Job Properties Cost Breakdown Structure (CBS) Register © W Fiterto Terminal Cost kems
Drag columns here to group ¥ Filterto Direct Cost ltems
Forecast v L WEsS: CEAS
T o B ML e RS e o B |) o
= J08 2000 Mie $3,996,575.15  §79,931,503.08 = U.S. Dollar 52,4592
Prime Bond PRIME 50ND 100 Lumpsum s1,57.5 31258753 U.S. Dollar ; B0ND
Price % Add-On PRICE % ADD-ON 100 Lump Sum $3,785,175.55  §3,785,175.55 U.S. Dollar 4 TAXES
Job Financing FINANCE EXPENSE 100 Lumpsum 974790.06 $974,798.06 LS. Dallr ¥ FEES
Indirect Cost Escalation INDIRECT COST ESCALAT.. 100 LumpSum 2,151 s2,15L11 U5, Dollr v LABOR ING
Direct Cost Escalation DIRECT COST ESCALATION 100 LumpSum 667,306.87  $687,306.87 U.S. Dollr v LABOR INC
Indirect Cost Add-On 100 LumpSum $6,2512  $46,25L%6 - 200 LABOR SET
Direct Cost Add-On DIRECT COST ADD-ON 100 LumpSum  $1449,85.93  $1,44,859.33 ’ 200 LABOR SET
=1 SITEWORK & ROADWAY 200 100 Each $65,690,759..  $68,690,759.67 sm23 ¥ PAVEMENT
- o | m o005t sisossi) M| ¥} T Filter by Unique (Delta) Resources | [ wosuay
+ 12 " Clearing srubbing 10102 1000 Ace $81.50  §39,18487 50.0( ¥ Fitter by Unique (Delta) Cost tems CLEARING
s 13 Undiassified Excavation 20183 50,000.00  Cubic Yard ses 23391581 U.S. Dollar 616 w . commonE
+ 131 Excavaton 131 50,000.00  Cubic Yard 00 s14802288 U.S. Dollar 125 commont
+ 132 Embankment 132 50,000.00 Cubic Yard s168 c83,002.04 U.S. Dl ey I EMBANKVE
= 14 Aggregate Base 035912 4500000 Ton SLH7.10  $66,919,557.30 U.s, Dellar s1g,5640 5 Fiter Resources with Waste Percentage UNTREATE
+ 141 Furnish & Haul Base Meterid | 14,1 45,00000 Ton siLs4 851951330 U5, Dollr 3B0.00 1220090 BUY MATEF
+ 142 Finegrade Subgrade 142 400,000.00 Square Yerd SI00.00 $40,000,000.00 U.S. Dollr 168,757.77 1170300 FINEGRADI

*(lls Allocation Distribution Subordinate] EQUAL False)

6.4.3 COST ALLOCATION TO BY UNIT COST

Having an under allocation or over allocation is ok, but it can be fixed by updating the Forecast (T/O)
Quantity of the Concrete Batch Plant. To do this, change the cost allocation to by Unit Cost.

6.5 DEPENDENT COST ITEM ALLOCATION

When allocating cost for a dependent cost item, the calculation of the cost item’s subject cost aligns
with the allocation target values (such as values based on quantity, percentage, or unit cost). The
target values are the owner’s target values. This allows you to better manage allocation values.

When you allocate costs for a dependent cost item that defines its subject costs from other cost items
that include allocation from other cost items and select the option Use owner’s quantities to calculate
cost, the subject cost calculation is based on how the cost items are currently allocated. In other
words, it includes the distributed costs from the allocated cost item.
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Cost Breakdown Structure (CBS) Register Direct Cost Add-On Record &
85 Position Code: ~ Desaription: Total Cost: Currency: Alternate:
Direct Cost Add-On 0.00| [ U.S. Dollar - | [aase
PlAssgnment:  PILine Number: Pl Desarption: Cost Segment: Pay Quantty:
| [ b overheas - 1.00
Descripbion | Dependency | Cost Categorization | Alflcation Cost Item Setup x
Saved views: | Previous <| O] Properses
. = Account Code: =
o Description L Include Currency T el Unit Cost a o [
JoB U.S. Dolar 20,00 Mie §288,071.25 * oo 1:
Indirect Cost Markup 100 U.S. Dolar 100 | Lump Sum $3,764.81 R
Direct Cost Markup 1.00 U.S. Dolar 100 Lump Sum $641,014.37 W3
Prime Bond 1.00 U.S. Dolar 100 Lump Sum $46,691.21 U5ES
Price % Add-On 100 U.S. Dolar 100 | Lump Sum $291,520.92 ElieRe Code
Job Financing 1.00 U.S. Dolar 100 Lump Sum $0.00 suspend: [
Indirect Cost Escalation 100 u.S. Dolar 100 Lump Sum 40.00
Direct Cost Escalation 100 U.S. Dolar 100 | Lump Sum $0.00
Indirect Cost Add-On 1.00 U.S. Dollar 100 Lump Sum $0.00 Exeaution
Job Management & Equip... 1.00 U.S. Dollar 100 Lump Sum $157,096.28 Allow As-Buit: | None
General Expense 1.00 U.S. Dollar 100  Lump Sum §4,200.00
Direct Cost Add-On 1.00 U.S. Dollar 100  Lump Sum $0.00 Detal Method
- B e 6D e o) L e Cost cateory braakdown I '© Use owner's quantities to cakulate cost I
= Clearing & Grubbing e ey el e $3918.50 table ) Use takeoff quantities to caloulate cost
3 Unclassified Excavation $0,000.00 u.s. Dolar 50,000.00  Cubic Yard $4.68 Subject costbasedon: | Default
31 Excavation 50,000.00 U.S. Dolar 50,000.00  Cubic Yard $3.00 .
3.2 Embankment 50,000.00 U.S. Dollar 50,000.00 Cubic Yard $168 -
z ] z 0.00 - | - Security
104 LastChanged By:  Julio Salguero
LastChanged On:  7/29/2025 1:28:58 PM
O Define Subject Cost using the Indlude chedkbax for the desred items: Toggle Indude Al

O Define Subject Cost using column fitering
- All current and future items that match the fiiter will be induded automatically.
- The filter is evaluated using the default currency and UM View Mode.

- Filtering may not be supported on al avalable columns. 4 CostBreakdown < BilingBreakdown [ CostlItemSetup  [) Notes "= Schedule

[ ] Cancel Prev Next

6.5.1 TURNING OFF COST ALLOCATION

If determined that you no longer want to spread the cost of an allocated item, you can turn off cost
allocation for that cost item. To turn off cost allocation, in the cost item record’s Allocation tab,
deselect the Allocate this Item’s Cost check box. The logic that you created to spread the costs are
retained, so you can easily select it again later.

Jlelg 2 Distributions cannot exist in the CBS when a job is published for Job Tracking. To remove
distributions, either break the Cost Allocation link or deselect the Allocate this Item’s
Cost check box on the Cost Item Record - Allocation tab.

6.5.2 BREAK COST ALLOCATION LINK

You can break a cost allocation link and make a distribution be a permanent part of the CBS and permit
its costs and quantities to be directly editable under the cost items to which it has been distributed.

Breaking the cost allocation link breaks the link from the cost allocation item to the distribution items,
making the distribution items permanent cost items in their current locations. If the allocation item or
any of its distributions are included as a dependency on a dependent cost item, then breaking the link
could result in a change to the job’s target price. The action cannot be undone.
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BREAKING A COST ALLOCATION LINK

1. In the CBS, open the cost item record.
2. Inthe Actions tab of the record, click Break Cost Item Allocation Link.

3. In the Attention dialog box, click Yes.

2 = Insert Subordinate il Trench Caluiator
(o) B Highlght Unique (Deita) Cost Item Fiekds. £, Edit Resource Periods £5 shift / Rate Caladator
Spit Defaut
Deta Blocks J Break Cost Alocation Link
Edit View Tools
Cost Breakdown Structure (CBS) Register Costltem Record O  Price Breakdown Structure
CBS Code: Cptional Code:  Description: Forecast (T/O) Qty:  UnitofMeasure: Unit Cost: Tatal Cost: Currency:
You have chosen to break the Cost Alocation Ink fromthe Cost
= a Alocation tem o the Distrbuon Rems. Ths wil make the Distrbution B $3,00000 $3,00000 |U.S. Dolar
PI Assgnment: PlLine Number: Pl Description: Ll Coxlkams B ekt lecslang rent Pay Quantity: Cost Source: Alternate:
B Fthis Alocation kem of any of ts Distrbutions are included 38 a bhead - 100 [Pl - BASE =

ona ‘cost Rem. then breaking this ink could

= T = resultin a change to this job's target prce.

S Detad:$0.00 | $Phug:$3,000.00 | {JQuote:$0.00 | . Alocation | Quantitylter *  * | CostItem) X
1 This action cannct be undone. Do you want to continue ?

18 Alocate this Itens Cost Defaty s
8 Alocaton target Pay Item t Alocation Detais - =
How do you want to determine alocation percentages? To Be Alocated - —
O by Quantty $3,000.00 + 1.00Each = $ For every (1800 hours worked, pay (1880 hours
O propartonately based on . Default Shift Arrangements Executon
© by Percentage $3,000.00 + 1.00 Each = § WorkHowrs per shift:  ShiftsperDay:  Days per Week: Alow As-gult: [Nene
800 100 500
O by Unit Cost (drives the Alocation Item's Forecast (T/0) Quantity) Quantities Fully Allocatu
Defauit Propertes
Account Code: < Tog I: = Tag 16:
Cost Curve: | Uinear > Tog 2: - Tag 17:
ted Saved views: | Previous Vie 1R Worker's Comp Override: - Tog 3 = Tag 18:
- Quantity Driver: | Superior €1 - Tag 4 - Tag 19:
=3 Pay Foce| Quantity Rol-Up: i Tags: = Tag 20:
Mo OB code Desaription L Indude pirke
Takeoff Driver: | Measurement - Tage: - Tap 21
152 nstal Hot Mox Type A 38,000.00 B
- o s = Quote Growp Teg - Teg7: - Tog22:
= - Mincrity Goal Alowance: [J180100 Tags: - Tag 23:
7.5 General Expense 1.00
432 et AbadmSe | Ao __hd ose Code: Tog 9; - Tag 24
= 1 . Tag 10: - Tag 25: o
102 | _ S
,| & empoymen.. [Jnotes [Fcostitems. ZjProducton ZZMentowF.. SPResowrceE. TmSchedde  § UserDefned i Benchmarking
‘ <prev Next ) | cone ‘

6.5.3 PAY ITEM ASSIGNMENT FOR ALLOCATION
DISTRIBUTION

In locked jobs, the Allocation distributions inherit target Pay Item Assignment option is automatically
selected and cannot be changed. This is normal Estimate behavior for locked jobs.

In a job that is unlocked, you have the option to select the Allocation distributions inherit target Pay
Item Assignment check box to use the same allocation distribution for the cost item’s costs anytime
the cost item is copied and added to a job.

InEight Inc. | Release 25.7 Page 299 of 402



6.5 Dependent cost item allocation

Estimate Essentials User Guide

Cost Breakdown Structure (CBS) Register Cost Item Record © -
CBS Code: Optional Code: Description: Forecast (T/0) Qty:  Unit of Measure: Unit Cost: Total Cost: Currency:
PI Assignment: PILine Number:  PI Description: Cost Segment: Pay Quantity: Cost Source: Alternate
I I 100
£ petal: $0.00 | 4. Plug : $3,000.00 | ©2 Quote : §0.00 | ~/ tllocation | Quantity Ttems ‘ | CostItem Setup x ‘
A
locate this Ttem's Cost Default Pay Rules Period Quantities
Scale 1 Scale 2 Scale 3:
Allocation distributions inherit target Pay [tem Assignment | Allocation Details Composie Vage Scde: [[40000 [17000 [060 | Use Period Quantities Edit
How do yeu want to determine allocation percentages? ToBe Allocated
) by Quantity $3,000.00 + 1.00 Each = $3,000.00/Each For every 7_ hours worked, pay 7_ hours
O srpmtenteybsston [N et ettt mrarsenens -
},000.00 + 1.00 Each = $3,000.00/Each . . . . _
© by Percentage $3, 43, )fEax Work Hours per shift: ~ Shifts per Day: Days per Week: Allow As-Built:
) by Unit Cost (drives the Allocation Item's Forecast (T/0) Quantity) Quantities Fully Allocated
Default Properties
o coce: | —_— o ss
concre: (] T2 [ -
sotvens [rovmmien ] 0| wrhwscompoverce: ] _— o ss
Allocated =
iy orvr: (SR -y T 1s
s et oyt [ s [ T
Alle... = Description Indude
- Position Code janti janti
E teioty T Ts: [ To2s
n- Paint Top Coat 25,000.00 O 25,000 +
P o7 [ o2z
L 1433 Place Aggregate Base w8889 | | 46,000
| m T e ———— b
phase Code: [N T [ T2
Install Hot Mix Type A 33,000.00 O 35,000 —
Indirect Costs 400 ‘ - -
When man-count changes: © Change UM / Man Hour oo 1: [
General Expense o [] oz © / =
L s beessies | wme 0@ O i
B T o —————————
7 — _—y
v ] _—
L&D O seaurity.
hd LastChanged By:  Julio Salguero
z 102 z LastChanged On:  8/5/2025 2:04:14PM -
: .
102 —
. 5 = -
B ,| & Emloyme.. [Frotes [ costitem.. ZoProduction % Mantowr. Z2Resouce.. = Schedue § UserDefi.. i Benchmar
e | tets [k ] [ co
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EXERCISE 6.1 — DEFINE INDIRECT COSTS

In this exercise, you will practice entering Indirect Costs. Complete the following steps, using your
Job:

1. Double click on the Price % Add On row header.

2. You already have Office Overhead as your first line item. In the next blank row type
Corporate Insurance in the Description field and enter a rate of .10.

3. Click OK to close the record.
4. Double click on the Direct Cost Add-On row header.

5. You already have Small Tools as your first line item. On the Description tab, type Safety &
Training in the next blank row’s Description field, then press Tab.

6. The Dependency Cost Breakdown appears on the right. Enter a rate of 5 for Labor Costs
only.

7. Click OK to close the record.

You should end up with similar results like below:

Cost Breakdown Structure (CBS) Register Price % Add-0n Record O -
(BSCode: Descriotion: Total Cost
Price % Add-On §9,082.87
Qescripton | Dependency Cost Item Setup b
s bere (Sigeau [Seorch For...] Zaved views: | Previous View Propas et &
ot Currency: | U.5. Dolar
Description Rate e
— Accoust Code: s
Cost Corver | Linsar
Cororate Insursnce 0.10

< | Dffice Overhesd 400 ‘

Taglt
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Cost Breakdown Structure (C85) Register Direct Cost Add-On Record ©
CBS Position Code:  Description: Total Cast: Al
|Direct Costadd-on $8,845.47 | BASE
Descrioion | Dependency | Cost Categorization | Alozation Cost Breakdown
Drag ﬁuh [Search Fer...] | saved views: | Previous view -| Cost Category Subjpct Cost | Rate Cost
~ Total $130,799.83 235 $2.948.99
— Total Cast [
Deacription g Cure.. | (rorecsst) d > Labor §50,969.83 5.0 §2,948.49
»  Owmed Equipment §68,251.92 0.0 §0.00
-5 ¥ Hented Equpment 2000 000 S0.00
- »  Suppies 000 0.0 0,00
»  Materals §3,276.00 0.0 §0.00
»  Subcentract 0000 0.00 §0.00
» Fees 26208 0.0 0,00
»  Alloveance 000  0.00 50,00
Custom Category1 2000 0.0 @ §0.00
Undefined #0000 $0.00

Congratulations, you have completed this exercise!
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LESSON 6 REVIEW

1. Default indirect costs are pre-built created by InEight Estimate, located
within the CBS Register.

a. billing rates
b. costitems

C. payitems

2. By default, any cost item you create in the CBS Register that is not assigned to a pay item
is considered indirect cost.

a. True

b. False

3. The cost segment field in the CBS is used to indicate:

a. Whether your costs will be considered job overhead, business overhead, or direct
cost.

b. The source of your costs (Detail, Plug or Quote).

C. What pay item your cost item is assigned to.

LESSON 6 SUMMARY

As a result of this lesson, you can:

¢ Explain how indirect costs are defined in InEight Estimate
e Estimate default indirect cost items

e Estimate user-defined indirect cost items
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LESSON 8 — QUOTE MANAGEMENT

LESSON DURATION: 60 MINUTES
LESSON OBJECTIVES

After completing this lesson, you will be able to:
¢ Create and publish RFQs
¢ Define quote pricing
e Compare and award quotes

¢ Create and analyze scope items

LESSON TOPICS
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8.1 QUOTE MANAGEMENT OVERVIEW
8.1.1 QUOTE MANAGEMENT WORKFLOW

When you make the decision to send out RFQs (Requests for Quote), as the estimator you will outline
the specifications for the request, select the vendors you wish to contact, and issue the request for
quotes.

When you receive quotes back from vendors, you can enter their pricing into InEight Estimate, where
you can compare them, award them, and update your CBS costs in one fluid process without the need
to re-enter data in multiple locations. InEight Estimate lets you enter multiple vendor quotes to enable
price comparison.

TIP Awarding a quote in InEight Estimate does not mean the vendor is awarded the contract,
but rather that their price is selected as the carrying cost in the bid.

InEight Estimate provides a built-in workflow for managing your quotes, consisting of three steps:
1. Creating and publishing Requests for Quote (RFQs)
2. Updating quotes with vendor/subcontractor pricing
3. Comparing and awarding quotes
InEight Estimate has a separate form to manage each step:
1. Request for Quote (RFQ) Register
2. Quote Register

3. Quote Comparison & Award

Quote

Comparison
& Award

8.1.2 QUOTES AND QUOTE GROUPS

Typically, an estimate contains two types of quotes:
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1. Quotes for resources (materials, equipment) purchased or rented from suppliers.
2. Quotes for subcontracted work.

In InEight Estimate, quotes from suppliers are managed at the resource level. In other words, you can
use material resources to represent the items purchased from the supplier.

For the cost items in your project that you plan to subcontract, you can manage quotes at the cost
item level, using the cost items themselves as the descriptions on the quote request.

You can use Quote Groups to group together multiple resources or cost items that will be sent in an
RFQ package. Using quote group tags can save a great deal of time generating packages of items to
request quotes for.

8.1.2.1 RESOURCE LEVEL QUOTE GROUPS

When sending out quotes, you may want to organize your resources into groups based on the type of
material, such as pipe, aggregate, or concrete. When creating Requests for Quote, you will be able to
select your pre-defined quote group and it will bring all the related resources along with it. You can
assign quote groups using a pre-defined tag called a Quote Group in the Resource Rate Register.

Below is an example of resources with a quote group assigned:

Resource Rate Register ©

all Labor Construction Equipment Rented Construction Equipment Installed Material Installed Equipment Supplies Unique

o = ot e,
+ IECT Cooling Towers Process Equipment Install Standard Installed Equipment Rate... | Each
+ IEFC Feeder Controls Landscaping Work: Standard Instaled Equipment Rate... | Each
+ IEHS Heating System Process Equipment Install Standard Instaled Equipment Rate... | Each
+ IEPHP Pump High Pressure Commercial Work Standard Installed Equipment Rate... | Each
+ IERMT Raw Material Tank Concrete Materials Standard Installed Equipment Rate... | Each
+ IERS Recovery System Process Materials Standard Installed Equipment Rate...  Each
+ IEST Separator Tank Process Materialz Standard Installed Equipment Rate... | Each

8.1.2.2 CBS LEVEL QUOTE GROUPS

For your subcontracted items, you can assign quote groups at the cost item level to group together
subcontractor work, such as Commercial Work or Landscaping Work. These labels are assigned using a
pre-defined tag called Quote Group in the Cost Breakdown Structure register.
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Forecast -
Eggﬁan Code = Description gjaﬂgﬁty rI:I"IZI.:sDLTrE Quote Group T
= 13 Paint Existing Steel Bridge Structure 1.00  Lump Sum Structural Painting
= 14 Process Equipment 1.00  Each Process Eguipment Install
= 17 Toll Booth 1.00  Each Commerdial Work
+ 18 Guardrail Type 2 1,000.00  Linear Feet Guardrail Work
+ 19 Guardrail Type 3A 200.00  Linear Feet Guardrail Work
-+ 20 Type 4 Signs 1,000.00 | Square Feet Sign Work

8.2 REQUESTS FOR QUOTE

Requests for Quote (RFQs) are invitations to sellers that include a requested list of items or
services/pricing and terms. When you create an RFQ in InEight Estimate, you are able to indicate the
line items you want to include in the quote, and the vendor(s) to whom you want to send it.

8.2.1 REQUEST FOR QUOTE (RFQ) REGISTER
OVERVIEW

To access the Request for Quote (RFQ) Register, from the InEight Estimate landing page, select the
Quote tab, then click on Request for Quote (RFQ).

Estimate Price Execution System Actions

I : = Quote Group Tags - .-‘ | @
I - an f
) Minority Setup
Address = Request For Resources  Cost Items Reports
Book Attachments Quote (RFQ)
Setup Quote Management (Quote Comparison & Award Reports

¢ The RFQ register lists all of the RFQs you’ve created, with a Description, a Status, and a Response
Deadline Date
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Cost Breakdown Structure (CBS) Regist: R Rate Regist | R st for Quote (RFQ) Register © |
Drag columns here to group
S Response Response Published RFQ Buyer's
Desription . Sots Deadline Date Deadline Time Date Instructions Special Terms =pd a2 =D LE=
Guardrailltems  New 1/3/2020 11:00 AM 0 0 0
> | k k D

8.2.2 REQUEST FOR QUOTE (RFQ) RECORD

You can double click on the row header, or right-click on any request for quote in the Request for
Quote Register and choose Open to access an existing Request for Quote (RFQ) Record.

Description = Status g::ﬂﬁ::eDate
N =
f o]
N Open
New
Delete
Cut
Copy
Paste
Fill Down
E Link this field to Excel
&4 UnLink from Excel

Overview - Request for Quote (RFQ) Record

I

1 RFQ Each record contains a Description, Deadline Date and Deadline Time
Description  fields to identify the RFQ and indicate when a response is due.

2 RFQ Tabs The record is organized into tabs where you can define the items for the
quote, terms & conditions, and the seller companies to receive the RFQ.

3 Statusand  The Status and Published Date let you know if it is new or published (sent
Published out), and when it was published.
Data
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Request for Quote (RFQ) Record © -

Description Status
Guardrail Items New
Published Date
ResponseDeadline Date: | 7/28/2009 - Response Deadline Time: [11:00 AM

Line Items Terms & Conditions Vendor Companies Attachments Setup |

Resources Cost Items

Drag columns here to group Saved views: | Standard View - ,O
CBS = Quote Group - Optional - .
Position Code = LRl Tag = Code pesoys Quantity

= 6.1 s 6.1 Guardrail Work 1500 0100 Guardrail Typ... 1,000.00
6.2 6.2 Guardrail Work 1500 0200 Guardrail Typ... 200.00

Cancel New... < Prev Next >

8.2.3 CREATE AN RFQ

When putting together your RFQs, you will be able to select the appropriate material resources and
cost items for which you need quotes in your estimate. To create a new RFQ, you have a few options:

¢ Create RFQ from scratch: This creates an empty RFQ Record for you to define

e Create RFQ from Quote Group Tag(s): This option lets you create an RFQ from a quote group so
you can add multiple materials or subcontract items at once

¢ Create RFQ using Default Seller data: In your address book you can store vendors with a list of
their default materials. This option lets you select the vendor and have it automatically find their
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materials in the job

Cost Item Identification

Usethe following fields CBS Position Code

Flease select from the following options:

Description

(@) Create RFQ from scratch

(") Create RFQ from Quote Group Tag(s)

Only show Quote Group tags that
are currently utilized in this job

0On the resulting RFQ recard, only
list resources with utilization
currently greater than zero

(") Create RFQs using Default Seller data

This option scans the job for all
Resources and Quote Groups
utilized in the job. For any that are
listed inthe Address Book as
'Default Quotes' for the Sellers you
select on the subsegquent selection
register, a new RFQ record will be
added for each Seller listing their
default items.

Create separate RFQ records for
each Quote Group, per seller?

The rest of this section walks through each tab on the RFQ Record in more detail.

oK Cancel

8.2.3.1 LINE ITEMS

8.2 Requests for Quote

The Line Items tab lists the resources or cost items selected for the RFQ, including the Description,

Quantity, Quote Group, Currency and other user-defined tags.

InEight Inc. | Release 25.7
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ResponseDeadline Date: | 7/29/2009 - Response Deadline Time: |11:00 AM

Line Items Terms & Conditions Vendor Companies Attachments Setup

Resources Cost Items

Drag columns here to group

CBS - Quote Group - Optional -
Position Code = ERL Tag = Code SEIET

= 6.1 s 6.1 Guardrail Wark 1500 0100 Guardrail Typ...
6.2 6.2 Guardrail Work 1500 0200 Guardrail Typ...

8.2.3.2 TERMS & CONDITIONS

Quantity

1,000.00
200.00

Unit of
Measure

Linear Feet

Linear Feet

This tab provides ample space for you to enter terms, conditions and instructions that need to be

included on the RFQ.

Response Deadline Date: | 7/29/2009 - Response Deadline Time: |11:00 AM
Line Items Terms & Conditions Vendor Companies Attachments Setup

Buyer's Special Terms & Conditions

‘ Any penalites assessed by the owner due to quality control compliance deviations by the supplier will be deducted from the supplier's payment.

RFQ Instructions

lease contact site super John Smith @ 623-555-6982 for delivery instructions.

8.2.3.3 VENDOR COMPANIES

Newi... < Prev Next =

You will use the Vendor Companies tab to select the suppliers or subcontractors that will be receiving
the RFQ. This is done by selecting them from the Estimate Library Address Book. This tab will store all
of the pertinent contact information for each seller, including their fax number and/or email address

so that you can send them the RFQ.
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Response Deadline Date: | 7/29/2009 - Response Deadline Time: (11:00 AM

Line Items Terms & Conditions Vendor Companies Attachments Setup

Fir=a ol imne here 0 Ao r
Drag columns here to group

-
L}

Vendor Contact =1 Status ?thlaEll':sSuan ities Vendor Phone
-+ 5SUB18 SUB 18 — Mel Blank Mew ' 111-222-3232

SUBE4 SUE4 -- Harry Belefony Mew V' 111-222-1111

Ven 13 Ven13 - CARRIE Matty Mew v 111-333-3434
» =

The following options are particularly noteworthy:

¢ Publish Item Quantities: If you want the RFQ to specify your take-off quantities, select this
checkbox. If you want to keep that information to yourself and let the vendors or contractors
determine their own quantities, deselect this checkbox

¢ Publish by Fax: If you choose to publish by fax, InEight Estimate creates a Word document with
a template filled out. It is ready to print and send, but you have the opportunity to double-check
the information before emailing the RFQ

W\[e3i= When RFQs are generated for multiple vendors using the Publish by Fax option, be
sure to separate the MS Word document pages and send only the correct pages to
each vendor.

¢ Publish by Email: If you choose to publish by email, the Word document is created, the
template is filled out, it is attached to an email, and automatically sent to the email address
listed for that vendor in the Address Book

\[eJ) 3 When using the Publish by Email option, the process is automatic and it does not
give you the opportunity to double check your information before the RFQ is

emailed. For this reason, it is recommended to Publish by Fax, review the
information, and then email the RFQ manually.

8.2.4 ATTACHMENTS

This tab allows you to specify any electronic files that need to be attached to the RFQ, such as drawings
or specifications for the work.
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Response Deadline Date: | 7/29/2009 - Response Deadline Time: [11:00 AM
Line Items Terms & Conditions Vendor Companies Attachments Setup

Drag columns here to group Saved views: Previous View - ,D
File Mame =N Description Location File Type File Size Attached By Date Attached
plumber quote.pdf plumber quote  Job Folder Adobe Acrob... 166875 Paul Trippi@ine...  7/31/2023 11:08:21 AM

=

8.2.5 SETUP

The Setup tab lets you indicate what information will display on the published RFQ template, including
custom tags. In addition to selecting tags and adding notes on the Setup tab, you can also specify your
RFQ Publication Settings and can choose whether you want to include the instructions, special terms
and conditions, notes and attachments.

Description

Guardrail [tems

Response Deadline Date: | 7/29/2009 - Response Deadline Time: |11:00 AM

Line Items Terms & Conditions Vendor Companies Attachments Setup

Tag 1: =
Tag 2: -
Tag 3: -

RFQ Publication Settings
Cost Item Identifier: CBS Position Code -

Include RFQ Instructions

Include Buyer's Special Terms & Conditions
Include Notes

[] Include Attachments

Publish Item Quantities
Publish To File
Publizh By Email
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8.2.6 PUBLISH AN RFQ

Once created, InEight Estimate allows you to generate a Microsoft Word RFQ template that can be
faxed or manually sent via email to the supplier or subcontractor.

When you complete all of the fields that are required for this RFQ, you are ready to publish the RFQ, To
do so, select all of the vendors that you want to receive the RFQ and click Actions > Publish on the RFQ
Record ribbon.

STEP BY STEP — CREATE AND PUBLISH AN RFQ

This exercise walks through a specific example using the Training Job.
1. From the Estimate landing page, select the Quote tab.
2. Select Request for Quote (RFQ).
3. From the Actions tab, click on the New icon to create a new RFQ.
4

. Select Create RFQ from Quote Group Tag(s), leaving the checkboxes checked to only show
guote groups and resources that are being used.

o

Select the Aggregates quote group from the right panel.
6. Click OK.

7. In the Response Deadline Date field, select a date two weeks from today, and for the Response
Deadline Time, type a time stamp (e.g. 11:00 am).

Response Deadline Date: | 7/29/2009 - Response Deadline Time: [11:00 &M

Line Items Terms & Conditions Vendor Companies Attachments Setup

8. Select the Terms & Conditions tab.

9. Create and type Prices are good for the duration of the contract in the Buyer’s Special Terms &
Conditions field.

10. Type in All items to be delivered to jobsite by supplier’s trucks in the RFQ Instructions field.

11. Select the Vendor Companies tab and click in the first blank row in the Company Name column.
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Line Items Terms & Conditions Vendor Companies Attachments Setup

Drag columns here to group

Vendor Contact Status IPthla?'il':SSuanﬁﬁes Vendor Phone
SUB13 SUE 18 -- Mel Blank Mew W 111-222-3232
SUB4 SUB4 - Harry Belefony Mew W 111-222-1111
Venl3 Venl1d -- CARRIE Matty Mew J 111-333-3434

12. Click on the Address book . icon, and then select the following example vendors:
e Example Vendor 1: Pat Roberts
e Example Vendor 2: Stan Mark
e Example Vendor 4: Lester Slim

13. Click OK.

14. Make sure Publish to File is checked for all vendors.

15. Uncheck Publish by email for each vendor.

16. Select the sellers to whom you want to send the RFQ.

e Word opens the file automatically for you to review; and from here you can either print it
or send it in an email as an attachment
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REQUEST FORQUOTATION

Job:  Training Job Training Job - Maricopa County No. TM2924

TO: FROM:
Name: | Pat Roberts MName: | Tom Cross
Company: | Example Vendor 1 Company: | Example Prime Contractor 1
100 Tenth Street 400 First Street Suite 4000
Hometown, AZ 530060 Hometown, AZ 538004
Phone: | 111-123-2134 Phone: | 111-122-1111
Maobile Phone: Mabile Phone:
Fax: | 222-123-1234 Fax: | 222-112-2211
. Email: Email:

Job Information:

Training Job
Training Job - Maricopa County Mo, TM2924

‘Owner: Example Owner

Job Type: Highway and General Engineering
Job Location: 1-10 MP 100 to MF 120
City: Phoenix

County: Maricopa

State / Province: Arizona

‘Country: United States

Bid Location: Engineer's Office

Bid Date: 11812020

Bid Time: 10000 P
Measurement System: English

Renuact far Dunta (IREFND) Infarmatinn-

17. On the Actions tab of the record, select Publish to create your RFQ document.
18. Select the folder to publish to.
19. Click OK to save the RFQ Record.

8.2.7 RFQ EMAIL DRAFT

When sending out Requests for Quotes (RFQ) on a bid, it is essential to be able to effectively
communicate the project requirements to potential subs or suppliers to ensure you have good quote
coverage within your estimate. Email RFQs open as a draft email message, giving you, the sender, the

opportunity to control specifically what is sent and customize the message before sending it out to
subs and suppliers.
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RFQ from InEight Corporation - SKIP for Training Job - Infrastructure: Training Job - Maricopa County No. TM2924 - Message (HTML)

File Message Insert Options Format Text Review Help @ Tell me what you want to do
[T1 = SE||| TmesNewRo v| 112 v|EBEESU 2w A= e = e RS e | oS [ 0 ()
& it
B> To Charlie Bravo
Send Ce
Subject RFQ from InEight Corporation - SKIP for Training Job - Infrastructure: Training Job - Maricopa County No. TM2924

REQUEST FORQUOTATION

Job:  Training Job-1 Training Job - Maricopa County No. TM2824

TO: FROM:

Name: | Harry Belefony Name: | Tom Cross

Company: | Example Sub #1 Company: | Example Prime Contractor 1
600 First Street Suite 5000 400 First Street Suile 4000
Hometown, AZ 889006 Hometown, AZ 889004
Phone: | 111-222-1111 Phone: | 111-122-1111
Mobile Phone: Mobile Phone:
Fax: | 222-221-2212 Fax: | 222-112-2211

Email: | charlieb1234@example.com Email:

Job Information: Training Job-1
Training Job - Maricopa County No. TM2924

Owner: Cwmer
Job Type: Highway and ral Engi ng
Job Location: I-10 MP 100 to MP 120
City: Phoenix
County: Maricopa
State / Province: Arizona
Country: United States
Bid Location: Engineer's Office
Bid Date: 1/6/2020
Bid Time: 5:00 AM

Request for Quote (RFQ) Information:
Publication Date:  &21/2020 3.57 PM

Response Deadline Date: 77292009 11:00 AM

8.3 QUOTES

When you receive responses to your RFQ, the next step is to enter their pricing in the Quote Register.
The Quote Register stores all of the quotes you have for that job. Each quote has a Description and a
Quote Status, and each quote displays seller contact information.

In this case, an estimator in charge of receiving quotes would need to determine how best to input
these quotes within the Quote register.
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8.3.1 SAMPLE RECEIVED QUOTE SCOPE SHEET

Overview - Received Quote Scope Sheet

om0 Emedw

1 Section one Scope item one includes 4 items the subcontractor has considered as
work to be done onsite. You may want to consider adding all 4 items as
individual quotes. Then creating a package identifying these quotes as
on-site work, totaling $203,000.

2 Section two Scope item two includes 3 items the subcontractor has considered as
work to be done offsite. You may want to consider adding all 3 items
as individual quotes. Then creating a package identifying these quotes
as offsite work, totaling $24,650.

3 Exclusions The subcontractor is showing 9 items they excluded from their scope of
responsibility.

4 Qualifications The subcontractor has included 3 stipulations pertaining to this bid. If
selected all 3 are considered accepted terms.

InEight Inc. | Release 25.7 Page 319 of 402



8.3 Quotes Estimate Essentials User Guide

Received
Quote Scope Sheet

DATE: 12/19/2019
PROJECT: TRAINING JOB TRAINING JOB - MARICOPA COUNTY NO. TM2924
LOCATION: PHOENIX, AZ

SITE CONCRETE: FORM, SUPPLY AND INSTALL

ONISTE IMPROVEMENTS

Vertical Curb; Curb and Gutter; Valley Gutter w/ rebar

4" thick broom finish walk with wire mesh; ramp w/ domes

Flow-Through planer slab and walls

&" thick crosswalk paving with rebar 36" x 36" pattern broom finish and 18" x 36" pattern
colored aggregate finish (1 location only @ 16" street entrance)

el

Price: $203,300
OFFSITE IMPROVEMENTS
1. Curb and Gutter
2. HC Ramps w/ domes; planter w/ rebar
3. 367 x 36" patterned finish walk w/ wire mesh
Price: $24,650
EXCLUSIONS:
1. Layout of i and grades
2. Site grading
3. Aggregate base and/or compaction; sand cushion
4. Sealants, caulking and waterproofing; precast items
5. Misc post footings and masonry wall footings
6. Supply of embedded iron or metal
7. Demolition
8. Traffic control and pedestrian protection

QUALIFICATION

1. Price valid for U days
2. GC will provide a concrete pump washout area
3. 5% retention will be released 45 days after completion of our work

Alternate Price to furnish and install 4" aggregate base under parking structure lab. Sand
by others. Price based on rock being placed prior to piles, pilecaps and grade beams.
$24,100

This proposal is good for thirty (30) days from the data herein, after which time Summit Construction reserves the
right to review the proposal for any changes in price. Flease call me if you need any further information.

Rick
Estimator

8.3.2 QUOTE REGISTER OVERVIEW

To access the Quote Register, choose Quote > Quotes on the main InEight Estimate menu or click the
Quotes icon on the toolbar.
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Quote Register @

Drag columns here to group

Description E g;?mpunn ?t";nui Seller Company %‘;TE ?;‘E'I-dEd Currency
Aggregates Aggregates Accepted Example Vendor 1 - PatRob... = Example Vendor 1 $402,192.00  $402,192.00 U.S5. Dollar
Aggregates Aggregates Accepted Examgng Vendor 4 DEE -- Les...  Example Vendor 4 ... 0,00 0,00 .S, Dollar
Aggregates Aggregates Accepted Example Vendor 2 —StanMark |~ Example Vendor 2 £0.00 £0.00  U.S. Dollar
/% Asphalt Materials Accepted Example Vendor 1--PatRob... = Example Yendor 1 §1,115,97...  §1,102,50... .5, Dollar
/% Asphalt Materials Accepted Example Vendor 2 —Stan Mark  Example Vendor 2 $1,263,17... $13,671.00  U.S. Dollar
Electrical Work Electrical Work ~ Accepted Architectural Designs, Inc, --... Architectural Desig. .. £4,200,00 £0,00 LS, Dollar
Electrical Work Electrical Work  Accepted HD Engineering Group - Rog...  HD Engineering Gr... £4,450.00 £€0.00 .S, Dollar

8.3.3 QUOTE RECORD OVERVIEW

The Quote Record establishes who the vendor is, along with quoted prices and all terms and
conditions. Once a requested quote returns, you can either create the quote in InEight Estimate from
scratch or convert the original RFQ to a quote and enter the supplier or subcontractor pricing. Each
Quote Record contains additional fields and options for managing the quote.

Quote Records utilize data blocks allowing you to reposition tabs, detach tabs into individual windows,
and redock tabs in new locations. Using the data blocks layout, you can input and maintain important
guote data like Vendor Qualifications and Special Terms & Conditions.

Right click on any existing quote in the Quote Register and choose Open to access the Quote Record.

Overview - Quote Record

Lo 0 Emmewm

1 Header  You can include detailed contact information about the supplier or

block subcontractor. This automatically fills when you select the seller from the
Address Book. The External Ref field can be used to access information
specific to the bid/quote.
2 Price The Price data block contains a breakdown of pricing information for the
block quote, including taxes, item conditions, and special conditions.
3 Quote The tabs at the bottom of the screen hold detailed information regarding the
tabs quote.

4 Default Data blocks include Special Terms & Conditions, Qualifications, Packages,
Data Taxes, Vendor's Profile, Setup, and Minority.
Blocks
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Quote Record ©
Description: | Pipe Materials Optional Code: Extended Price: $0.00

T .
Date: | 7/20/2023 LR 2

Quote Tax:

Vendor: | 1128354 AlbertaLtd —0010... iz)| Vendor Name: 1128354 Alberta Ltd Vendor Phone: 780-920-3163 Source: -

Contact: | <Ad-Hoc Contact> g First Name: | Contact Office: Currency: | U,S, Dollar Item Conditions: $0.00

Primary Email: | Last Name: ‘ Contact Mobile: Status: Incomplete Special Conditions:

External Ref. Ignore: [] Reason: Total: $0.00

Resources Cost Items o Special Terms & Conditions O x

Saved views: Buyer's Special Terms & Conditions

Code = RFQID Quote Group = gg;;‘”a‘ Description No Spit Free Awarded Duration
1 1 1 payitem 1 v [ vendor's Special Terms &Conditions

2 2 2 payitem 2 v

Special Conditions Adjustments:

Distriby |

Include s

, | SpecalTerms &Conditons ~ Qualfications  Packages  Taxes  Vendor'sProfie  Setup  Minority

Cancel New... Prev Next >

8.3.4 HEADER BLOCK

The Header block portion of the screen is where you enter in description information pertaining to the
quote, along with vendor/contractor information.

There is an External Ref field you can use as a hyperlink for attaching any supporting bid quote
attachments from the vendor/contractor.

On the right portion of the header block is where you enter optional information related to:
¢ Optional Code — a code used to reference the received quote.
¢ Date — date the quote is received.

e Source — this is the method by which the quote was received. The options are email, fax, hard
copy, phone, and other.

¢ Currency — system of money in general use for a particular country..

¢ Ignore — by ignoring the quote, and providing a reason, the quote will turn grey in the Quote
Comparison & Award screen.

8.3.4.1 QUOTE RECORDS

The Quote record header block includes a vendor field with a searchable address book library register
drop-down list. You can select shared vendor data to populate your quote header record with
Platform’s shared master data.
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Quote Record ©
Header
Description: | Asphalt Materials

Vendor: | 1128354 AbertalLt... i2]|] Vendor Name: 1128354 Alberta Ltd Vendor Phone: |780-920-3163
Contact: | Alberta —-FrankMa... {2 First Name: Frank Contact Office:

Primary Email: Frankmatty@gmail.com Last Name: Matty Contact Mobile:

External Ref.:

Address Book Register - Library

Vendor ID Vendor Mame = Vendor Type Tax ID Tax Jurisdiction Address 1
= 0010087554 1 Alliance Geomatics LLC 2001 461564451 4803300400 12514 120th Ave NE -
+ 1 NP -Vendor2 1_NP - Vendor2 1_NP Vendor 12345 abe S0th Street
+ 1 NP -Vendorl 1_Vendorl 1_NP Vendor
+ 1MNP-Vendorl  1_Vendorl 1_NP Vendor
0010099994 10X Engineered Materials LLC 001 824568213 1516913100 1162 Mancheser Ave
0010099994 10x Engineered Materials LLC z001 824568213 1516913100 1162 Mancheser Ave
4 »

Using Platform’s shared data also reinforces accurate Estimate quote reporting. For example, you can
report on which vendors and contacts have been awarded quotes or run a report on how many RFQs
have been sent to select vendors and how many RFQs were returned for certain jobs. Additionally,
using Platform shared vendors makes it possible to report on all activity related to a particular vendor.
Examples include seeing how many subcontract agreements have been executed in InEight Contract,
or how many claims/issues a vendor has been involved with in InEight Change. The predominant value
for Estimate using Platform vendors, along with other InEight applications, ensures that the same
vendors are being used by all applications.

8.3.5 PRICE BLOCK

The Price block includes the quotes extended price, along with any additional taxes, bonds, item
conditions, and special conditions.

8.3.6 QUOTE RECORD TABS

8.3.6.2 RESOURCES & COST ITEMS

The Resources & Cost Items tab displays the resources or cost items quoted, along with their estimated
guantities and units of measure.

e A Unit Price column is included on this tab for entering the quoted pricing from the seller, either
manually or by pasting from an electronic format
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o If a Package code is entered, the Unit Price field is greyed out, and the Package code amount is
used

» Additional columns are provided for making conditional amount or percentage adjustments to
the gquote to manage last-minute changes

¢ A note field is included for explanation changes

* A No Split option indicates that the seller will only provide the quoted goods or services if they
are selected to provide all listed items. They will not provide one quoted item without you
procuring all others from them as well.

e You can check an item as Free for circumstances where the vendor will include the price of one
item with another. Marking the included item(s) as free reminds you there is no quoted price for
that item

Find: | [SearchFor...] views: | Previous View

Package Code = RFQID T = T Description Nospit  Free Awarded Du.. Quantity

Unitprice | Extended
rice

F

21 31 31 Excavation, sarapers v 50,000.00  Cubic Yard $0.00 $0.00

Pi 32 32 3.1 Excavation, ruds 50,000.00  Cubic Yard P1 PL  $200,000.00

1
v 1

P1 33 3.3 32 Embankment v 1 50,000.00 CubicYard P1 PL

P1 3.4 3.4 Rock Excavation v 1 3,000.00  Cubic Yard P1 P1

COST ITEM TAGS AND USER DEFINED FIELDS

There are 25 tag fields in the Quote Record register cost items tab. There are also 15 user defined
fields that let you sort, filter, and group on selected quote records more efficiently.

For example, you can use tags and user-defined fields to isolate certain cost items, or group cost items
together.

$30.200.00

o Phane: | 1112223232 e

Fac 222221111 a0

$30,200.00

User s
Defreds | Defneds

2 53
[, [omtcama | [ | |

8.3.7 DATA BLOCKS

The Quote Record utilizes data blocks that allows you to customize the layout and focus on data block
tabs that matter most to you. You can select the default data block action in the ribbon to revert back
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to the default setting, which shows all six data blocks.
Data Block tabs include:

¢ Special Terms & Conditions

e Qualifications

* Packages

¢ Taxes

e Vendor's Profile

e Setup

e Minority

File

Setup Estimate Quote Price

3 Package Entire Quote O rl-l-I /

Refresh Default
Data Blocks /

Edit Tools View ("

Actions
|

The seven data blocks appear at the bottom right of the screen.

Special Terms & Conditions x

Buyer's Special Terms & Conditions

Vendor's Special Terms & Conditions

Special Conditions Adjustments: | SEI.EIEIl

Distribute Special Conditions: () Evenly (@) Using Weighted Average

Include Special Conditions costs forunawarded quotes in Comparable Totals

Drag columns here to group Saved views: | Standard View e | p
Row =2 Scope Item Quote Group = Incduded Amount % of Total Notes
MNurmber

40,00
e >

Special Terms & Conditions ~ Qualifications  Packages Taxes Vendor's Profile  Setup  Minority
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It’s possible to move the entire data block, or individual data blocks to other parts of the screen. For
example, select the Special Terms & Conditions header row, and drag to the desired part of the screen.

ial Terms & Conditions
e " drag and move

Buyer's Specia g & Conditions

Seller's Special Terms & Conditions

Drop the data block on top of an arrow where you wish to land the data block.

Qualifications b4
Bond
|:| Vendor can provide a BOND for all work quoted

[[] Add Bond Costto the Quote T

%S-md‘ Ferms&Conditi... X
Cost of BOND to be added to quoted price: | - | | o | I
Rate/$1,000: £0.00 Buyer's Special Terms & Conditions ™
Bond Cost: $0.00
Insurance |Z Vendor's Special Terms & Condi

|:| Vendoris INSURED as required by applicable law |

Insurance Company: :
Special Conditions Adjustments: r v

Qualifications Packages Taxes Vendor'sProfile Setup  Minority

Cancel New... < Prev Next >

The data block will now reside on the left side of the screen.
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Quote Record ©
Header

Description: | Pipe Materials Optional Code:

Date: | 7/20/2023

Vendor: | 1128354 Alberta Ltd - 0010... {2]| Vendor Name: 1128354 Alberta Ltd Vendor Phone: ' 780-920-3163 Source:

Contact: | <Ad-Hoc Contact> i First Name: I:l Contact 0ff|cz:| ‘ Currency: | U.S. Dollar
s (T — R

External Ref.: { Ignore: [] Reason:
Special Terms & Conditions X Resource - Qualifications
Buyer's Special Terms & Conditions Ab - btoc | Bond

‘ DVendnrcanprovideaEOND for all work quoted

R
Vendor's Special Terms &Conditions
= R e
| 2 2
. =

Special Conditions Adjustments: N - [[] Add Bond Cost to the Quote
Distribute Special Conditions: () Evenly (@ Using Weighted Average Cost of BOND to be added to quoted price:
Include Special Conditions costs forunawarded quotes in Comparable Totals Rate/$1,000: = $0.00
Drag columns here to group Saved views: | Standard Vien - Bond Cost: $0.00
Row _ N Insurance
Number = O Quote Group & Ees Amount AL . [] vendoris INSURED as required by applicablelav

Insurance Company: :
Insurance Agent:

Qualifications Packages Taxes Vendor's Profile

You can also close a specific tab if it’s not commonly used. In this example, you can right click on a tab
(like Special Terms & Conditions) and select close.

Float

Dock
Spedal Terms & Co i

Close

8.3.8 DATA BLOCK TABS

8.3.8.3 SPECIAL TERMS & CONDITIONS

Special Terms & Conditions is where you can include buyers and sellers special terms, add fixed cost to
the quote, and include/exclude scope items.
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Special Terms & Conditions

Buyer's Special Terms & Conditions

Estimate Essentials User Guide

Vendor's Special Terms & Conditions

Special Conditions Adjustments: |

Distribute Special Conditions:

su.uu|

() Evenly (@) Using Weighted Average

Include Spedial Conditions costs forunawarded gquotes in Comparable Totals

Drag columns here to group

Row o
Number =

4

Special Terms & Conditions

Scope Ttem

Qualifications

Saved views: | Standard View

Quote Group = Incuded Amount % of Total

Packages

$0.00

Taxes Vendor's Profle Setup  Minority

8.3.8.4 QUALIFICATIONS

Motes

This tab allows you to include bond. You can enter the bond rate and the system will calculate the total
Bond Cost or vise versa. This tab also allows you to enter insurance contact information and seller
license information. If the vendor in the address book already had this information, then this
information will get pre-filled when the seller is assigned to the Quote.
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Qualifications x

Bond A

Vendor can provide a BOND for all work quoted

Bonding Company: | |

Bonding Agent: |American |

Bonding Phone: |

Add Bond Costto the Quote

Costof BOND to be added to quoted price:

Rate/$1,000: sn.uo|
Bond Cost: | $330.00]
Insurance

[] vendoris INSURED as required by applicable law
Insurance Company: I

Insurance Agent: |American

Insurance Phone: |

License
[] vendor is LICENSED to perform all work quoted

Licensor: | |

ID: |E?_-Licinsenll |

Class:

W

Special Terms & Conditions  Qualifications  Packages Taxes Vendor'sProfle Setup Minority

8.3.8.5 PACKAGES

Using the Packages feature lets you logically organize quotes into an arranged collection of like
grouped packaged quotes. You can determine how to enter quotes from subcontractors and classify
them into a package grouping. When you create a package within the Packages block, and give it a
monetary value, you can then assign that package code to one or more quote records. The package
code is limited to three characters.

When comparing various vendor quotes in the Quote Comparison and Award form, with each quote
containing its own scope of work, you can easily distinguish which items belong to each package. This
helps to identify which quotes to award in your decision-making process.

As an example, the following Civic Center Parking Structure quote has three packages defined in it. The
P1, P2, and P3 on the left represent the grouped package numbers that will be used to determine the

package structure in the quote record. The vendor that submitted this quote shows detailed estimates
defined for each of the three packaged items, but there is no breakdown provided in the quote of how
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much each line item is worth. Rather, this quote is showing a package price for each collection of items
(scope of work).

102';'::;:‘: o Phone (758) 555-9854
Scottsdale, AZ . ]
soss0 % Civic Center Parking Structure
Du:a'lnhr‘l.lm Addendum 1-6
mum Price
DEMOLITION, EXCAVATION AND GRADING (PARTIAL) $150,780.00
Site Cléaring of trees and bushes
Demo of AC Paving, Concrete Curbs and Walks
Sawcut AC Paving and Concrete

Remove storm drain, SS, CB's, MH & pole bases
P1 Rough grace parking structure pad, commerical pad
Place 12" non-expansive fill

Fine grade pads

Demo and remove 16th street curbs and paving
Grade for new noadway

Grace for exterior concrete sidewalks

2 mobilizations ¥
Site Oearing of trees and bushes

P2 Demo ourbs, excavate for paving

Demo median on 16th Street, place temporary paving section
Patch pave parking lot with 3° AC over 6° AB

$139,900.00

PAVING (PARTIAL)
P3 Place aggregate base for AC Paving, curbs and walks
Place 5™ asphalt conrete section -
Key Exclusions: slurry seal, striping, fencing, conorete work

OTHER ITEMS

Load out stockplled dean spolls $26.00/CY
Grade, fabric, place 47 AB for contractor paridng (63,000 SF) $0.85/5F
Excavate Duct Bank 45,900.00
Patch pave AC outside pave area (500 5F) $8.00/5F

STANDARD EXCLUSIONS:

Any permits, fees, inspections, plans, bond premiums, soll testing, etc.

Any hard rock excavation. (Hard rock Is defined as unable to be removed by CAT D6 or CAT 325
Excavator)

Ary trenching for footings of bullding or masonry structures.

Aryy termporary fiencing or trench plating.

Ary export of materials other than spedfically included offhauls.

Spoils over 12 in diameter will be offhauled at an additional agreed to cost.

Any structure demolition or removal, {Conarete, asphalt, fending, trees, bulldings, signs, masonry)
Amy and all landscape repadr, Installation, or removal

Ary storm waber pollution prévention o énosion control unless specifically mentioned.

Base rock under concrete walkways of bullding dlab areas unless spedfically mentioned

Fod =

S0 0N SN A

—-
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Estimate's Package feature lets you pick all the cost items that belong to a particular package, then
assign the price to that collection of packages. It then proportionally distributes the total package price
across all of the corresponding cost items when comparing and awarding.

Quote Register QuoteRecord ©
Header Total
Description: [Stework optionalCode: Bended Fice: s239,60260
ot = e s1843
Vendor: | Civiworks Inc. ~Ven 07 © iz VendorName: |Civilworks Inc Vendor Phone: 480 555 5698 Source: o
Contact: [ Gvinorks Inc, — John Jacobs ol Contact office: Currency: U, Dollr s000
Primary Emaili jacobs jacobs@civilworkscom LestName: Jacobs ContactMobile: Stetus: | Received
Exernal Ref.: ] Ignore: || Reason: oo TS 70205
Resources CostItems Packages x
— Saved views: | Previous Vien -0 oo saved B
Padage = Code 2 g;ﬂ: g::g"ﬂ' Desaription No Split Duration Quantity Unit of Measure Unit Price E:i"d d Curr| X
B e P2 Assisted Parking Lot $43,535.00
P1 131 131 Excavation v 1 5000000 CubicYerd P1p1 stomoo s L5 Favrg StEmme
Pt 142 142 Finegrade Subgrade v 1 400,000.00 Square Yard P1PL us|
P1 15 3034%3  Asphelt Conerete Hot v 1 3500000 Ton P1 PL us,
P1 16 131 Grading v 1 100 Cubic Yard P1 PL us,
5 P2 (Assisted Parking Lot)
[ a1 Process Equi... 700 v 1 100 Each P2 P2 $43,53500 US.
[ 421 421 v 1 200 Each P P2 us,
P2 s 0220 v 1 100 LumpSum P2 P2 us.
& p3 (Paving)
P3 17 131 Paving v 1 100 Cubic Yard P3 P3  $139,00000 US.
>
3
» | SpedalTerms & Condiiors  Qualfications  Packages Taxes VendorsProfie Setup  Minarity

Gancel e <re Nex >

STEP BY STEP — CREATE A MULTI-PACKAGED QUOTE

1. From the InEight Estimate landing page, select the Quote tab.
2. Click on the Quotes icon under Quote Management.

3. Double click on an item (e.g. Pipe Materials).
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Cost Breakdown Structure (CBS) Register Quote Register @  Quolte Record
Descriplion = Y g:Ewnm sqtfmh;
= Pipe Materials Received  Example Vendor
/% | Pipe Materiais Received  Example Vendor
Pipe Matenals Received  Example Vendor
/% | Pipe Materials Recsived  Example Vendor

4. In the Description field, type in or replace the description.

5. Inthe Contact field, select a contact.

Cost Breakdown Structure ((BS) Register ©  Quote Register Quote Record ©
Header

Drescription: || Pipe Materials for site improvements.

Contact: | Example Vendor 1 — Pat Roberts L H

Company Mame: Example Vendor 1

6. Click OK

7. Select the Cost Items tab on the left side of the screen.
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Hegources Cosk Thermns

Code Quote Group
{4  mPP10 Pipe Materiak

MPP24 Pipe Materials

MPRL15 Fipe Matenals

8. Add a cost item under Cost Items.

9. Then, add another cost item under Cost ltems.

Descripbon

Pipe 10" P¥WC SDR21
Pipe 24" PYC SDR3S
Pipe RCP 36 In

10. On the Packages tab, enter the following 2 new records:

e Code: P1

¢ Description: On Site
e Amount: $200,000
e Code: P2

e Description: Off Site
e Amount: $300,000

InEight Inc. | Release 25.7
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Code
Pl

Desophon

O Sute
OFF Site

11. Type in P1 under Package for cost item 7.

12. Type in P2 under Package for cost item 8.

Resources Cost Items

yrofnd: | [Search For...]

Padage Code

P1 7

#P2 |8

13. Select OK.

RFQ ID

Saved views: | Previous View

Quote Optional
Group Code
Pipe Materials BOD 0220 10 Inch PVC Force Main..

Pipe Matenals BOO 0330 24 Inch PVC Grawity Se..

Description

Estimate Essentials User Guide

Amount
£200,000, 00
S300. 000, 0D
Packages
Code Description Amount
P1 OniSite $200,000,00
P2 Off Site $200,000,00

14. Under the Quote Comparison and Award ribbon, select Cost Items.

15. Under Quote Groups, select Pipe Materials.

* Quote Comparison and Award shows the newly created quote with the associated

package quotes.
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E i vender 1 Esampls vendor |

WO
ron et Pt Materisls

i

T $3as1 APl 1290,000.00 #P1 m:-.m:n.w:&'ﬂ $300,000.00
T 524 £ §126,000.00 & P2 §125,000.00 | 000,00

HH
i
]

1137 200% 4:1... IHI.HH:I.!'H.-..- 17132019 4:3...

¢ The Package Price can quickly be modified in the Quote Comparison and Award form by
selecting the Edit Package action in the Actions tab or by using the right click context
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menu.
Example Vendor 1
Ppe Materials for site
Improvements,
_________ .. TR
P1  £200,000,
Eg ————————— % Award
P2 $300,000,
& = Award And Lock
a  Lock
Unlock
et Edit Quote

8.3.8.6 TAXES

Item Tax and Quote Tax have been combined to display on a single data block called Taxes. Using the
taxes feature allows you to add item taxes to each item's price. You can also add taxes to the quote.
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Taxes

Item Tax
Add Item Taxes to each Item's Price

Quote Tax
Add Taxes to the Quote

Taxes to be added to Awarded Total as a Percentage of Total:

Total Tax: (e  5450.00

Special Terms & Conditions  Qualifications  Packages | Taxes | Vendor's Profle  Setup  Minority

8.3.8.7 SELLER’S PROFILE

The Seller’s Profile tab populates with address book notes and alternate contact information.

Vendor's Profile

Address Book Motes

Example....save for training as needed,|

Alternate Contact Information

[ Name:
(] Email:
] Phone:

[ Fax:
] Maobile:

Spedial Terms & Conditions  Qualifications  Padkeges  Taxes | Vendor's Profile | Setup  Minority

8.3.8.8 SETUP

This tab provides extra space for any additional notes and tags to be assigned to the quote.
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Setup *
Current Status
RFQ Status:
Last Update: 5/5/2020 7:05:03 PM
Quote Origin: WMFarr
Tags
Tag 1: | Pipe
Tag 2:
Tag 3:

Motes

Spedal Terms & Conditions ~ Qualifications  Packages  Taxes Vendor's Profile Minority

8.3.8.9 MINORITY

This tab allows you to determine if the seller qualifies for any type of minority business, and the ability
to apply a certification number.
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Minority
Minority Business Enterprise
[]vendor qualifies as the following type of MINORITY BLISINESS ENTERPRISE an this jobt

DBE  DBE Cettification: [ |
MBE MBE Certffication: [ |
WBE WBE Certification: [ |
0BE1 OBE1 Certification: |:|
OBE2 OBEZCertification:[ |
OBE3 OBE3 Certification:[ |
OBE4 DBE4Certification:|:|
0BE5 OBES Certification: |:|
OBE6 OBES Certification: [ |
0BE7 OBE7 Certification:[ |

Special Terms & Conditions  Qualifications  Packages Taxes  Vendor's Profile  Setup | Minority

TIP If any of your Data Blocks become deleted on a Quote Record, simply click the
Default Data Block icon.

Estimate Quote Price Execution System Actions

C| @

Refresh Default
Data Blocks

Tools View

8.3.9 CREATE A QUOTE FROM RFQ

Walk through the steps of creating a quote from an RFQ.

TIP To create a quote from scratch, click the New icon on the Quote Register and fill in the
quote details and seller fields manually.

STEP BY STEP — CREATE A QUOTE FROM RFQ

This exercise walks through a specific example using the Training Job.
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From the Estimate landing page, select the Quote tab.
Select Request for Quote (RFQ).

Open the RFQ record for which you’ve received quotes.

w0 o=

Select the Vendor Companies tab and select the vendors for whom you need to create quotes.
In this case, select all the vendors.

5. From the Actions menu, select Create Quote.
6. Click OK on the Quotes created prompt.
7. Close the RFQ record and the RFQ register.

8.3.10 ENTER QUOTE DETAILS

Now that you have quotes created, you can enter pricing.

STEP BY STEP — ENTER QUOTE DETAILS

This exercise walks through a specific example using the Training Job.

1. To open the Quote Register, select Quote from the Estimate landing page.
Select Quotes from the Quote Management section.
Open the Aggregates Quote Record for Vendor 1 — Pat Roberts.

On the Resources tab, make sure No Split is unchecked for all items.

o~ w0 DN

Also on the Resources tab, enter the following unit prices:

MBR Aggregate Base Rock $8.00
MDIRTB Dirt Class B $6.00

6. Click OK to close the Quote Record.
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STEP BY STEP — CREATE A MULTI-PACKAGED QUOTE

1. From the InEight Estimate landing page, select the Quote tab.
2. Click on the Quotes icon under Quote Management.

3. Double click on an item (e.g. Pipe Materials).

Cost Breakdown Structure (CBS) Register Quote Register ©  Quote Record
Descripton T | Destripion Sns | S
= | Pipe Materials Received  Example Vendor
/% | Pipe Materials Received  Example Vendm
Pipe Matenals Receved  Example Vendor
/% | Pipe Materials Recsived  Example Vendor

4. In the Description field, type in or replace the description.

5. In the Contact field, select a contact.

Cost Breakdown Structure ({BS) Register ©  Quote Register Quote Record &
Header

Description: || Pipe Materials fior site improvements.

Contact:] Example Vendar 1 - Pat Roberts L JH

Company Name: Example Vendor 1

6. Click OK

7. Select the Cost Items tab on the left side of the screen.
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Resources Cosk Ttems

Code Quote Group Descripbon

J&  MPP10 Pipe Materiaks Pipe 10" PYC SDR21
MPP 24 Pipe Materials Pipe 24" PYC SDR35
MR35 Fipe Matenals Fipe RCP 36 In

8. Add a cost item under Cost Items.
9. Then, add another cost item under Cost Items.
10. On the Packages tab, enter the following 2 new records:

e Code: P1
¢ Description: On Site
e Amount: $200,000
e Code: P2
¢ Description: Off Site
e Amount: $300,000
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Code Desophon
1 O Sate
= P2 Off Site

11. Type in P1 under Package for cost item 7.
12. Type in P2 under Package for cost item 8.

Resources Cost Items

to grofind: | [Search For...] Saved views: | Previous View
Quote Optional -
Padsage Code RFQ ID Group Cods Descripbon
P1 7 Pipe Materials BOD 0220 10 Inch PVC Force Main..
# P2 =8 Fipe Materials BOD 0330 24 Inch PYC Gravity Se...

13. Select OK.

8.3 Quotes
Amount
£200,000. 00
S200. 000, 00
Packages

Code Desoription Amount

Pl OnSite $200,000,00

P2 Off Site $300,000.00

14. Under the Quote Comparison and Award ribbon, select Cost Items.

15. Under Quote Groups, select Pipe Materials.

» Quote Comparison and Award shows the newly created quote with the associated

package quotes.
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e~
Fiager Mot gl

T s22S1 #P1 29000000 SP1 $300,000.00 | P1  $200,000.00
T ssama P2 51200000 P2 ua,m:l.un-dﬂ' /000,00
S428.694.. 54 1 b, (00 DO M_ §50), D03 DO
SAIR B0 54 b, 0N CHE 2% DO, 00 S4500, 00 D0
R0, SO0 b i g R
$A4.18,694. . 4 1 b, (=000 Sl 2%, 00, 00 5 5000, O} 00
$0.00 000 s0.00 000
A3/ 3009 1. 11713/ 3009 4., . 1113 300 4:3...

¢ The Package Price can quickly be modified in the Quote Comparison and Award form by
selecting the Edit Package action in the Actions tab or by using the right click context
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menu.

Example Vendor 1
Ppe Materials for site
mprovements.

——————— —1 %  Award

R = Award And Lock
m  Lock
Unlock
et Edit Quote

8.3.11 USE UNIT PRICE OR EXTENDED PRICE ON
QUOTE RECORD ITEM

It's possible to enter the Extended Price for a Quote Item, and the Unit Price is then calculated, which
makes entering quotes more efficient and results in less errors.
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Quot
Hea
ptionalCod:
Vendor 2  Stan Mark © & Phone: 111-133-2123
Mobile: Source:
Fac 2221232134 Currency: [US. Dollar
Email Staty 7]

ef.
Resources | Cost Tter
jumns here to or aved vie
- HNo Extended
Code = Shit ded  Duration Quantity | Unitof fMeasure | UnitPrice &=
5 maam v 1 3500000 Ton $3400  $1,130,000.00 |U.S. Dolar
AAAAA v 1 1,860.00 Ton s7.00 $13,020.00 |U.S. Dolar

8.3.12 DUPLICATING AN EXISTING QUOTE

You can create a new quote by duplicating an existing quote from the Quote Compare & Award form.
Duplicate Quotes will contain the same scope as the quote that you previously copied.

STEP BY STEP — DUPLICATE AN EXISTING QUOTE

1. From the InEight Estimate landing page, select the Quote tab.
2. Select the Resources icon under Quote Comparison & Award.

3. Highlight any row under the Quote column you want to duplicate.

(Cost Breakdown Structure (CBS) Register Quote Register Quote Comparison & Award - Resources @
Drag columns here to group Find: | [earch For]  ~|  Savedviews: | Standard View
Resouee N (R Utiization  Unitof Unit Cost - oetet Exempl Vendor 2 Excple Vendor 3| EXample Vendor 4
ode Count Measure (Seale 1) Asphalt Materials Pipe Materials Pipe Materials
MAAM ‘Asphalt Mix (Finish) 36,750.00 Ton $31.50 $34.13 $3413 3§ @ $31.50 & §35.70 $34.13 $34.13
MAFA Fine Aggregate 1,850.00 Ton $7.25 $8.19 8.9 § & $7.25 & §7.35 $5.19 4819
| Pipe 10" PVC SDR2L =
MPP24. Pipe 24" PVC SDR35 3,000.00 el $22.05 $20.98 $20.48 $20.98 sm.48 & 520 § & $22.05
MPR36 Pipe RCP 36 In 1,024.00 e $32.55 $34.13 $34.13 $34.13 $3413 & $3150 § & $32.55
Scope Ttems
Summary
Minorit ity Type DBE
Quoted Total $1,406,973.75 $0.00 $1,171,100.70 $1,325,646.00 $266,616.00 $271,471.20
Comparable Total < $140697375  $140697375  $1308747.30  $146329260  $1535943.15  $1,540,79835

4. Select the Actions tab.

5. Under the Quotes section, select the Duplicate Quote icon.
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B print (3 By Quote Group | 2 Set All to Reviewed [N @ [ Duplcate Quote | @ Padkage Entre Quote | 8 Award Lock o (® Quoted Ite
& prevew & AlQuote Groups | @ setAlbootReviewsd | IEY 2 tgnore quote B & averdandiock | £ triock | O[] neprce
EditResource EdtQuote EdtPrices
& ExporttoExcel | $9 All Quote Items. Substitute Val
Print Layout Quote Group Status | Resources
Cost Breakdown Structure (CBS) Register Quote Register Quote Comparison & Award - Resources ©
Drat up
Sl erdor 1 ample Vendor 4
Resource: uilzsion Untof unit Cost Example Vendor 2
Cod =77 Meastre (scale 1) 6 petal Asphalt Materiaks :ﬂ“ = Ep —

MAFA Fine Aggregate 1,860.00 Ton .19 s $7.25 49 §7.35

MPP10 Pipe 10"PVC SDR21 12,600.00 $13.65 .28 $2.28 228 $3.28 @
P24 Pipe 24" PUC SDR35 3,000.00 2205 s2.s8 s0.%5 s20.48 5.8 &
R3S Pipe RCP 36 In 1,024.00 ss2.55 s34.13 $3023 $39.19 3213 &
Scope Items:
Summary
Minorty Type
Quoted Total $1,406,973.75 $0.00 $1,171,100.70 $1,325,646.00
Comparable Total < $1,406,973.75 $1,406,973.75 $1,308,747.30 $1,463,292.60

$12.60 : & $13.65

2sm 8O sa0s

sum 5O sass

oee

5266,616.00 s271,471.20
5153594315 $1540798.35

8.3 Quotes

» The resources and prices from the quote you previously selected have been copied

into a new Quote Record.

6. From the Header block, enter in any missing information.

» The information listed in the Header block will not copy over to the duplicated quote.

7. Enter additional Cost Items in the Quote tabs data block.

» Check the default data blocks for any information you want to add to your duplicate

quote.

<AdHoc Vendor>

<AdHoc Contact>

Description:  Asphalt Materials OptionalCode:

Total
Extended price:

savedviews: |5t 10
o . Extended Defaut
Gz owsGaps  Deaown o, Free  Aweded  Duston  Quy  Untofdesure  Untpiee SO Creney | Ot
Jo MAM Asphataters Asshatex () % v 1 30000 Ton SO0 $10500000 U oolr
MAFA Asphalt Materials Fine Aggregate v v 1 1,860.00 Ton $6.90 $12,834.00 U.S. Dollar

‘Special Terms & Conditions

Buyers Special Terms & Condtions,

$1,062,834.00
$53,141.70

$0.00

$1,115,975.70

Distribute Sp

8. Once done, click OK.
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() Vendor's Special Terms.

&Conditions

Special Conditions Adjustmens:

Quaifications  Packages  Taves  Vendor'sprofle  Setup

—

Cancel
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EXERCISE 8.1 — QUOTE MANAGEMENT

When you receive quotes from vendors, you will need to record their pricing and conditions in their
Estimate quote records. In this exercise, you will practice entering quote details. Enter the following
quote record details, using the Training Job:

Quote Name: Seller Name: Example Vendor 2 - Stan Mark

Aggregates

Resource Description Unit Price

Code

MBR Aggregate Base Rock $7.45

MDIRTB Dirt Class B Not Quoted (delete)
Special Instructions Seller is NOT willing to split items.

Quote Seller Name: Example Vendor 4 - Lester Slim

Name:

Aggregates

Resource Description Unit Price

Code

MBR Aggregate Base Rock $8.15

MDIRTB Dirt Class B FREE

Special Instructions Seller is NOT willing to split items.

You should end up with similar results like below:

Description I:R)Egcripﬁon Seller Contact Name ?:t?atle
Aggregates Aggregates Example Vendor 4 DBE -- Lester Slim Slim, Lester $408,834.56

Aggregates Aggregates Example Vendor 2 -- Stan Mark Mark, Stan $373,719.94

Aggregates Aggregates Example Vendor 1 -- Pat Roberts Roberts, Pat $402,192.00

Congratulations, you have completed this exercise!
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8.4 QUOTE COMPARISON & AWARD

Now that you’ve received quotes and entered pricing information, you will compare them to
determine which is the preferred vendor or contractor to carry their pricing in your estimate. The
Quote Comparison & Award forms improve visibility into comparative analytics, while increasing
efficiencies in populating the estimate with quoted values.

The Quote Comparison & Award screen is designed to closely match the layout of a vendor comparison
sheet. It’s designed to show all scope items with prices provided by multiple vendors and substitute
pricing where items have been excluded.

Now that you’ve entered contextual quote information in the Quote Register, the Quote Comparison &
Award screen provides you with the ability to make better, and more efficient determinations for
awarding the quote.

8.4.1 QUOTE COMPARISON & AWARD OVERVIEW

To open the Quote Comparison & Award form, select Quote > Quote Comparison & Award.

Overview - Quote Comparison and Award Form

T T

1 Resourceand  You can show either your quoted resources or cost items.
Cost Item Filter

2 Quote Group This section provides checkboxes to further filter your items. The

Filter Quote Group Filter allows you to mark the quotes as reviewed.
3 Quote Your quotes display with the vendor name plus the quote description.
Description and

* Awarded items have an award symbol X

Vendor L - N
If an item is designated as No Spilit, it has a chain link icon &
» Awarded and Locked items have a lock symbol next to the award
symbol L
4 Cost Source The cost source can either be a Plug or Detail type.
Type
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|z| (Zh Quote Group Tags E Q liH: E @

Q Minarity Setup

Address RequestFor  Quotes Resources _ Cost Items Reports
Book () Attachments Quots (RFQ)
Setup Quote Management Quote Comparison & Award Reports
Quote Comparison & Award - Costitems © Quote Register
Quote Group(s) e X Drag columns here to group o o Find: | [Sez
= E==iEin B Rar=—a css N Forecast Uit of nitcest | TotE Cost . B Example Sub #2 Example Sub #1 gD EaT=ig
Electrical Work Position Code SR (T/0) Quantity Measure it Cos (Forecast) 2 el Guard Rail Items Guard Rail Items —.
v Guardrail Work 18 Guardrail Type 2 1,000.00 Linear Feet $24.00 (O §24,000.... £25,000.00 % & s2a00000 & £25,000.00 &
Sign Work 19 Guardrail Type 3A 200.00 Linear Feet $31.00 (O $6,200.00 $7,000.00 700000 § &  $6,200.00 & $5,000.00
Scope Items
Minority Type
Quoted Total $32,000.00 $0.00 $30,200.00 $31,000.00 $50,000.00
Comparable Total < $32,000.00 $57,000.00 $30,200.00 $31,000.00 $57,000.00

8.4.2 EDIT MODE

You can make last minute modifications to the quote price directly in the Quote Comparison and
Award form.

When in Edit mode, the quote item's price, unmodified by the quote's bond cost or special conditions,
can be updated. You can modify the Unit price or the Extended price for each of the quote items that
are not part of the package or marked as Free.

The updates made to quote items in Quote Compare and Award will update the estimate in real time
allowing you to see the impact of the changes in the estimate.

Quote Comparison & Award - Costitems  ©

d views: | Standerd ven

Quote Growp(s) x Di&g coiunins here t group Find: | [Search For...] - Saves

ity I N PO B e m) - =

v Concre! ucnural 242 place and finish 100 Lump Sum $28E,000.00 Q $235,000.00 £375,500.00 $285,000.00 & §294,000.00 £548,567.00
o e ——
Elecirical Summary
Frshes (DI 3) Minority Typa
Fre Protacton Quotzd Total $3,656,700.00 50.00 $285,000.00 52,525,200.00 $294,000.00 $2.865,307.00
Founcations ComparsblaTotal < §3,656,700.00  $3,810,200.00 $2,810,200.00 $2,810,300.00 £2,819,200.00 £2,865,807.00
v
PLUmHINg
Rebar Inctall
Scaffulding
Sterd

8.4.3 SUBSTITUTE VALUES

You can display a substitute value by selecting Actions > Substitute Values.

Notice the entered quotes. One of the vendors did not give pricing for three of the CBS items.
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HD Engineering
Group
Conaete, Sitewark

18 Guardrail Type 2 1,000.00 Linear Feet $24.00 ¢ $24,000.00 §25,000.00 & §50,000.00
19 Guardrail Type 3A 200.00 Linear Feet $31.00 $6,200.00 §7,000.00
20 Type 4 Signs 1,000.00 SquareF... $15.00 & $15,000.00 % $15,000.00
27.1 Electrical Work 1.00 Each $5,000.00 & §5,000.00 § $5,000.00

When you compare this quote to the others, it can be difficult to see if the total cost of the quote is
high or low because it is missing some of the pricing. InEight Estimate can help you make an “apples to
apples” comparison by filling in a substitute price for items that are missing.

Duplicate Quote Package Entire Quots Award Lock 'o @ Quoted [tems =] Zero Ttems f? Caonfigure Totals
"
Ignore Quote Edit Package Award And Lock Unlodk [I‘LJ Unit Price ] Scope Items :D:I Set Substitute Ranking
Edit Quote Edit Prices —
B Substitute Values @ Ignored Quotes  [T]] Default Data Blocks
Quotes View

You can tell when it’s a substitute value because the price displays in italics.

HD Engineering
Group
Concrete, Sitework

18 Guardrail Type 2 1,000.00 Linear Feet $24.00 O $24,000.00 §25,000.00 & $50,000.00
19 Guardrail Type 3A 200.00 Linear Feet $31.00 (O $6,200.00 £7,000.00 7
20 Type 4 Signs 1,000.00 SquareF... $15.00 & $15,000.00 § $15,000.00
27.1 Electrical Work 1.00 Each $5,000.00 & §5,000.00 § $5,000.00

InEight Estimate grabs the substitute value from one of four places:
1. Awarded splittable quote
2. Lowest splittable quote you’ve received
3. Detail (this only applies to quoting cost items)
4. Plug cost (the rate defined for that resource in InEight Estimate)

You can set the order for a substitute value by selecting Actions > Set Substitute Ranking.

P (& Quoted Items "= Zero Items 5% Configure Totals

s
e Unit Price 7, 5cope Ttems [ Set Substitute Ranking
Edit Prices —
B substitute Values (%) Ianored Quotes [ Default Data Blocks

View

On the resulting Substitute Ranking window, you can use the up and down arrows to change the
selection order. It will look from the top to the bottom of the list. The plug being in red represents the
most risk, while the Awarded Splittable Quote is the least risk. Users can modify the color coding of
these Substitute values by navigating to System Customize dialog and then selecting Substitute Quote
Ranking in the colors sections.
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Awarded Splittable Quote [ |
Lowest SplittableQuote F
Detail
Plug

0K Cancel

Note that the substitute values are color-coded so that back on the Quote Comparison & Award form

you can see the source that your substitute value comes from. When you hover- over a substitute

value it displays the vendor whose substitute value has been used.

Example Wendor 1 Architectural
Fipe Materials for site = Designs, Inc.
improvement 2 Electrical Work

&Pl $300,000.00
P2 §125,000.00

N

HD Engineering Group
Lowest Splittable Quote

When you use a substitute value, it is included in your Comparable Total so you can have a more
realistic comparison of your quotes.

= Print % Quote Groups | Set Al to Reviewed Edit Quate Lock Quoted Items Scope Items [ Set Substitute Ranking [ ) Session Recap
B Preview ) Al Ttems Set All to Not Reviewed Award Unlock Unit Price =) Ignored Quotes LL1] % Auto Award -
& Export to Excel Eat Award And Lock Edit Package 5* Configure Totals Dfé':ﬁés
Print Layout Quote Group Status. Cost Ttems Quotes View Tools
(Cost Breakdown Structure (CBS) Register Request for Quote (RFQ) Register Request for Quote (RFQ) Record Quote Register Quote Comparison & Award - Cost items @
Quote Group(s) X Drag columns here to group Find: E
- Desaription = REveEd cas FreTe - ?}555“ g;‘“ Unit Total Cost £ == Example Sub #2 Example Sub #1 H? EEQ‘"EE”"Q
Electrical Wark Position Code Quantity o Cost {Forecast) Guard Ral Ttems Guard Rail Ttems Comete, Sitework
Electrical work 2 18 Guardrail Type 2 1,000.00 Linear.. $24.00 (O $24,000.00 $25.00 s2500 § & $24.00 & $25.00 _
Eectrical work 3 19 Guardrail Type 3A 20000 Linear.. $31.00 O $6,200.00 $35.00 500 & @ $31.00 @ $30.00 _
v Guardrail Waork 17 Toll Booth 1.00 Each $40,00... (O $40,000.00 $25,000.00  §25,264.55 % & $40,000.00
Pipe Materials Scope Items
[ Sign Wiork Summary

Quoted Total $57,000.00 $25,264.55 $30,200.00 $71,000.00 _

Comparable Total <] $57,000.00 $57,264.55 $55,464.55 $71,00000 | $82,26455

Awarded Total $0.00 $0.00 $30,200.00 $40,000.00 _

Guoted Items Total $57,000.00 $25,264.55 $30,200.00 $71,000.00 _
Spedal Conditions $0.00 $0.00 £0.00 $0.00 _
> Last Update 7/29/2000 2:21=... 11/13/2019 9:0... _
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8.4.4 DISPLAY IGNORED QUOTES

You can view ignored quotes by selecting Actions > Ignored Quotes.

You can ignore a quote by right clicking on the subcontractor header, then selecting Edit Quote.

Example Vendor 1 Example Vendor 4
iﬁ;ﬂ"jﬂ :t"écr':f';l 52 Pipe Materials for site  DBE
improvements Pipe Materials

................................................... Eward
13,671.0
& g Te  Award And Lock
Lock
Unlock
I-i;é";- Edit Quote
= Duplicate Quote
:;i Ignore CQuote
. _ DBE
¥ Package Entire Quote

D Edit Package !
$1,325,646.0/ 1,471.20

s — .,E_. Edit Resource

0,798.35

From the Quote Record screen, select the Ignore check box and also a Reason, then select OK.
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Currency: | U.5, Dallar -
Status: Ignored
Ignore: Reason: -
M Description
Packages
ID:: Mot Use
Drag columns here to grd Mon Compliant 7
feend Code = De
=
%.
»

Jleyg=n If the quote record is already awarded, you will not be able to select the Ignore option.

If the Ignored Quotes button is pressed, the ignored quote will display in grey. An ignored Quote
cannot be awarded. The ignored quotes get appended to the right end of the QC&A form.

: Award ﬂ Lock 'o ’ Quoted Items =1 Zero Items f‘ Configure Totals O Session Recap
:h Award And Lock E| Unlock . Unit Price ' Scope Items b Set Substitute Ranking : Auto Award ~
Edit Prices
E; Substitute Values @ Ignored Quotes | Iff] Default Data Blocks
View -~ Tools a
pte Comparison & Award - Costitems @ \ -

Find: | [Search For...] gd views: | Previous View -

Unit of Unit Cost Total Cost Detail E_xample Sub #3 Example Sub #2 £ 5ub #4DBE | Example Sub #1
Measure (Forecast) Sign Items Guard Rail Items Guard Rail Items
Linear Feet $24.00 (O $24,000.... $25,000.00 £25,000.00 $25,000.00 § & $24,000.00
Linear Feet $31.00 (O $6,200.00  $7,000.00 £7.000.00 $7,000.00 § &  $6,200.00
Square F... $13.00 (D $13,000.... $15,000.00 $13,000.00 | & $11,000.00 £13,000.00
%
$500.00
%
D D
$47,000.00 $0.00 %11,000.00 %30,200.00
$47,000.00 %45,000.00 %43,000.00 $43,200.00
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8.4.5 EXPORT QUOTE COMPARISON AND AWARD TO
MICROSOFT EXCEL

The Microsoft Excel file generated when you export the Quote Comparison & Award form closely
resembles the form in Estimate, so users of this output can more clearly understand what the
estimators knew when they made determinations on which numbers to carry.

File  Home Inset  Pagelayowt Formulas Data  Review Vi Automate  Help  Developer & Comments 5 share ~

. " A B R D SEEE e O F
B 1 ou- i H- A §-9% 9 49 Lin;\::l[\:n:\ F::‘r;::k-n\ Sr;‘:‘u_ et Deete Format | :;::Es: ;.l:[ -\t:'ﬂf.t senstity
Font Number £l Styles Cefts Eating Analysis Sensitivity ~
A1 cas "
£ 3 G H [ ) 3 L M N[
Total Cost 1_Vendorl Cooper Outdoor Advertising Inc WonderBoyB WonderBoyB
1 | unitcost |~ (Forecast) ~ Plug - Detail = Guard Rail items ~ | Guard Rail Items ~ Guard Rail ltems - Guard Rail Items. -
2 524.00 $24,000.00 52500000 52500000 & & $24,000.00' <" M1 524218756 $562,344,000.00 & $562,344,000.00
3 s31.005 $6,20000  $7,000.00 5700000 & & $6,200.00 7 1 $6,781.25F $145,272.200.00 $145,272,200.00
4
5
6
7
8 $0.00 $0.00 $30,200.00 $31,000.00 $707,616,200.00 $707,616,200.00
9 $0.00 $0.00 $0.00 $0.00 $0.00 $0.00
10 $0.00 $0.00 $0.00 $0.00 $0.00 50.00
n $0.00 $0.00 $0.00 $0.00 50.00 50,00
2 $0.00 $0.00 $0.00 $0.00 50.00 50.00
13 $32,000.00 50,00 $30,200.00 $31,000.00 §707,616,200.00 $707,616,200.00
14 50.00 50.00 $0.00 $0.00 50.00 50.00
15 $32,000.00 $0.00 $30,200.00 $31,000.00 $707,616,200.00 $707,616,200.00
16 $0.00  $32,000.00 @ $0.00 50.00 $0.00 50.00
17 $32,000.00  $32,000.00 $30,200.00 $31,000.00 §707,616,200.00 $707,616,200.00
L] $0.00 $0.00 $30,200.00 50.00 $0.00 $0.00
19 5/11/2023 2:36:01 AM 7/24/2023 11:24:01 P 6/2/2023 12:29:38 AM 6/2/2023 12:37:37 AM
20
21
2
2| -
Formatted Data | Raw Data D [ 0
Ready & Acessibinty: ivvestigate B E D -— 3 - oom

The Quote Comparison & Award form changes frequently in the closing hours of a bid, which can
prompt estimators to keep track of what the subcontractor and supplier quotes might have looked like
at any point throughout the bid closing. Some estimators rely on such bid leveling information but do
not want to access live information directly in the application, making it crucial to produce an identical
output file of the Quote Compare & Award form at any given time.

To create the Quote Comparison & Award Excel file, click on the Export to Excel icon. Enter a file name
for the Excel file, and then click Save.
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Estmate e Frics e e — Actons _

E\ Print Q By Quote Group [ e'. @ Q) Duplicate Quote 'o Q All Items Eﬂ Unit Price : Scope Iter
. G
'ﬂ Preview 3 All Quote Groups | 53 w: & Ignore Quote e @ Quoted Items BX substitute Values @ Ignored Q
- Edit Resource | Edit Quote Edit Prices
@‘ Export to Excel | &} All Quote Items @ Unquoted Items | [=7 Zero Items f’ Configure
Print Layout - Resources View
Quote C & Award - R [+]

Quote Group(s) ° Export spreadsheet to... 3 X Bavedviews: | Standar

T ‘ » ThisPC » Downloads V] Search Downloads
AT Organize + New folder B e
Pipe Material . .
& OSDisk (C:) # *  Name Type Size )
Git Projects o

v Yesterday (2)
<] InEight Control Columns List.xlsx Microsoft Excel Work... a7
£33 improved.xlsx Microsoft Excel Work... 16
~ Last week (1)

@ Contacts_09142023051609.xlsx Microsoft Excel Work... 10

o coia.

ZN RN Quote Comparison and Award 09212023 xlsx v
Save as type: | Excel files ("xlsx) ( ~
~ Hide Folders Save Cancel

8.4.6 ADDITIONAL QUOTE COMPARISON AND AWARD
FUNCTIONS

The Quote Comparison and Award form contains other notable functions which improves the process
of selecting the quote that brings the greatest value to the estimate.

Overview - Additional Quote Comparison and Award Functions

T T S

1 Asterisk nextto  An Asterisk (*) is displayed on a quote to indicate when that quote

Quote ltem includes quote items appearing in other Quote groups.
2 Zero value Award quotes to Plug or Detail when its value is zero.
Plug/Detail
3 Updated Quote  Quote Item Tool tip displays details including:
Items Tool tip e Unit Price
e Extended Price
» Bond
o Taxes

» Special Conditions
« an indicator for a delta quote item
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8.4 Quote Comparison & Award

Quote Comparison & Award - Cost tems O

Description

formwork

place and firish

Scope Items

Summary
Minerity Trpe
Piates

‘Quoted Total

it of
Measure

LU Sum

et Cost

Totsl Cast
Forecast)

$2,39,113. O 239,100

Pug

$1,281,200.00

CAH Concrete
Cormtruction, I
Concrete Placement

@

L Saim wm 8 0.00 375,500, w £205,000.00

rere o A N N

$3,656.700.00

$3,656,700.00 | $2,525,200.00

$0.00 $285,000.00

§2,810,200.00

g Congtrucion
Concrete Formmwork

Find: | [SearchFar. ]
Morin Concrete
Cantractors
Concrete Placement
$2.525,200.00

& $294,000.00

$2.525.200.00
$2.810.200.00

$294,000.00
$2,819,200.00

$2.892,622.15

8.4.7 CONFIGURE TOTALS

You can display and sort additional Summary Totals, Special Conditions, and Last Updated fields by
selecting Actions > Configure Tools.

]

Caption

= Seller
Quote Description
Minarity Type
MNotes
Extended Price
Item Taxes
Quote Tax
Bond
Item Conditions
Quoted Items Total
Spedal Conditions
Quoted Total
Substitute Values
Comparable Total
Awarded Total
Last Update

A |V

Options

Location:

InEight Inc. | Release 25.7

() Top

Configure Totals

Visible

(@) Bottom

SIS &S

Sort
MNaone
None
MNone
MNaone
None
Mone
MNaone
None
None
MNaone
None
None
MNaone
Ascending
None

Mone

Cancel
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The Options radio button give you better control for viewing totals at the tops of the screen or after
the quotes.

After selecting additional captions, the new fields appear at the bottom of the Quote Comparison &
Award screen. Notice that the caret symbol next to the Comparable totals in the below screenshot
indicates that the Quotes are sorted based on Comparable totals in an ascending order.

CBES

Position Code Description
18 Guardrail Type 2
19 Guardrail Type 3A
20 Type 4 Signs
Scope Items
Mabilization
Survey/Layout

Temporary Traffic control de...
Summary

Minarity Type

Notes

Extended Price

Item Taxes

Quote Tax

Bond

Item Conditions

Quoted Items Total

Spedal Conditions

Quoted Total

Substitute Values

Comparable Total <

Awarded Total: £43,200.00

Last Update

8.4.8 ADDING NOTES TO QUOTE COMPARISON &
AWARD

The Notes feature within the Configure Totals tool, allows you to quickly add, edit, and view notes for a
guote in the Quote Comparison & Award form. Having visibility into the notes such as phone
conversations with vendor/supplier, quotes that need clarification, or notes on other attributes will
help you in making better decisions on who to consider when awarding a particular quote.
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STEP BY STEP — ADD THE NOTES SECTION TO QUOTE COMPARISON

& AWARD FORM

1. From the InEight Estimate landing page, select the Quote tab.

2. Select the Resources icon under Quote Comparison & Award.

» Notice the absence of the Notes section. This is the default option until you follow the
next steps.

Select the Actions tab.

From the View section, select the Configure Totals icon.

@ Posaann | © et
2 tgrore cunte Edtpaciage

tResource | Edit Quote

UUUUUUUU

5. Select the check box in the Visible column for the Notes caption.
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Caption
Seller
Quote Description

Minority Type

Configure Totals

Visible

Estimate Essentials User Guide

Sort
Mone -
Mone

Mone

B IEES S

Extended Price
Item Taxes
Quote Tax

Bond

Item Conditions
Quoted Items Total
Spedal Conditions
Quoted Total
Substitute Values
Comparable Total
Awarded Total

A Y

Options

Location:

O Top

6. Select OK.

(®) Bottam

Mone

Mone
Mone
Mone
Mone
Mone
Mone
Mone
Mone
Ascending

MNone o

Cancel

» The Notes section displays on the Quote Comparison & Award form.

B5) Register
Drag columns here to group
Resource Utlization | Unitof Unit Cost
Description Measure | (Scale 1)
MAAM ‘sphalt Mix (Finish) 36,750.00 Ton
MAFA Fine Aggregate 1,860.00 Ton
veP10 Pipe 10" PVC SDR2L 12,600.00 Linear Feet
P24 Pipe 247 PVC SDR3S 3,000.00 Linear Feet
VPR35 PpeRCP 36 Tn 1,02400 Linear Feet
Scope Items.
Summary.

Minorty Type

150

225
365
2205
2.5

Plug

& Award - Resources ©

413
8.9
Ex]

s20.48

3413

Detal

Find: | [search For..] -] saved views: | Previous view

Example Vendor 1
Pipe Materials for site | DBE

Example Vendor 4

Example Vendor 1 Example Vendor 2

Rehvids | oo hars | oMot =N
7417 § & $3150 & $35.70 $94.17 $34.13
819 2 & $7.25 & $7.35 $8.19 $8.19
$3.28 $3.28 5.2 & $1260 % & $13.65
2.4 2.4 XA 2520 § & 52205
$34.13 $34.13 9413 @ 5150 § & $3255

3

B ————ryrri———l— DL L
Quoted Total $1,406,973.75 $0.00 Example Note| 5.00 $266,616.00 $271,471.20

Comparable Total <

Page 360 of 402

$1,406973.75

$1406,97375

260 5153594315 $1,54079835

ok || cancel
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8.4.9 ALL QUOTE GROUPS LAYOUT

The All Quote Group icon, located within the Quote Comparison and Award ribbon, allows you to see
all the quote groups at the same time.

Estimate Quote Price: Execution System Integrations
= print (3 By Quote Group | b Set All to Reviewed @T' 3 Dupbicate Quote | (% Package Entire Quote
=h Preview ¢ All Quote Groups | T Set All to Not Reviewed &) Ignore Quate [y Edt Package
- Edit Cost Edit Quote
& Export toExcel | All Quote ltems Ttem
Print Layout Quote Group Status Cost Items Quotes

You can make appropriate quote group selections based on understanding how choosing a quote
group impacts the entire estimate. In addition, the quote groups layout provides you with the visibility
and flexibility in aligning scopes, and being able to perform an efficient comparison of various quotes.

Features of this layout include:

Overview - Quote Groups Layout

T - S

1 Totals per Quote Ability to see the Awarded Total Plug, Detail and Quote amount per

Group Quote Group
2 Total Awarded Visibility into the Total Awarded Amount per Quote Group
Amount

3 Comparable totals  Better visibility into the Comparable totals per Quote Group

4 Expand/Collapse Expand/Collapse individual or All Quote Groups to display the
quote items
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IE| Print (3 By Quote Group a e o & Duplicate Quote ﬁ Package Entire Quote : Award ﬂ '. @ Quoted Items I=1 Zero Items
i Preview 3 Al Quote Groups | (% .:' (7_' Ignore Quote @‘,‘ Edit Package ,'& Award And Lock ﬁ [e“‘ Unit Price [j Scope Items
' Export to Excel | 3 All Quote Items BT | EREnE Edt rices B2 substitute Values %) Ignored Quotes
Print Layout Resources Quotes View
Cost Breakdown Structure (CBS) Register Quote Comparison & Award - Resources @
Drag columns here to group Find: | [Search For...] Saved views: | 5Y
Quote Group F Plug Detail Quote Quote Group Total
= = Asphalt Materials $0.00 $0.00 $1,171,100.70 $1,171,100.70 o
G " & |Desrptin court = e D P B Pkt ety
MAAM Asphalt Mix (Finish) 36,750.00 Ton $31.50 $34.13 3413 § & $3150 & $35.70
MAFA Fine Aggregate 1,860.00 Ton §7.25 §3.19 ST $7.25 & §7.35
Scope Items
Summary
Minority Type
Quoted Total e $1,269,327.15 50.00 %$1,171,100.70 $1,325,646.00
Comparable Total < $1,269,327.15 $1,269,327.15 51,171,100.70 51,325,646.00
o | Awarded Total; $1,171,100.70 50.00 50.00 51,171,100.70 50.00 |
EP\DE Materials 40.00 $0.00 §271,471.20 §271,471.20
Example vendor 4
i S Y el g T T
MPP10 Pipe 10" PVC SDR21 12,600.00 Linear Feet $13.65 $3.28 $3.28 é’ $12.60 : é’ $13.65
MPP24 Pipe 24" PVC SDR35 3,000,00  Linear Fest $22,05 420,48 $20.48 & $2520 § & $22.05
MPR 38 Pipe RCP 35 In 1,024.00 Linear Feet $32.55 $34.13 $34.13 & $31.50 : & $32.55
Scope Items
Summary
Minority Type o DBE
Quoted Total $137,646.60 50.00 $266,616.00 $271,471.20
| Comparable Total < $137,646.60 $137,646.60 $266,616.00 s171,471.zo|
Awarded Total: $271,471.20 $0.00 50.00 $0.00 $271,471.20

You can scan through all the quote groups in the estimate and see if you are carrying the most
appropriate quote. You can also review the Totals per Quote Group and better analyze the risks in the
estimate based on whether the cost is a plug number, detailed estimate or a quoted value.

8.4.10 COMPARE AND AWARD QUOTES
To award an item, right click on that item and select Award.

Example Sub %3 Example Sub #2 Example Sub %4 DBE
Sign Items Guard Rail Items Sign Items

$25,000.00 § & $24,000.00 £25,000.00
$7,000.00 § &  $6,200.00 £7,000.00

@

Lock
Unlock

5500.00

E —
0 Edit Quote

Duplicate Quote

DBE
D Ignore Quote
¥  Package Entire Quote
$11,000.00 ,000.00
Edit Package
$0.00 $0.00
$0.00 & Edit Costltem $0.00
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The Award icon displays next to the awarded item(s).

Example Sub #2
Guard Rail Items

§24,000.00
$6,200.00

Once you award a quote in InEight Estimate, you can see it adds the Awarded Total on the comparison
screen, and the pricing updates automatically in the Cost Breakdown Structure.
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Faorec... Unit ] Total
EDB:ﬁUn Code Besamiin g:gg I?ﬂfa... gglstt ([:Foosrte...
17 Toll Booth 1.00 Each $40,000... (2 $40,0...
18 Guardrail Type 2 1,000.00 Linear ... $25.00 (D $25,0...
19 Guardrail Type 3A 200.00 Linear ... $30.00 (O %6,00...
20 Type 4 Signs 1,000.00 Sguare... $15.00 # %15,0...
7.1 Electrical Work 1.00  Each £5,000.00 # £5,000...
Summary
Minority Type
Quoted Total

Comparable Total

Awarded Total
Quoted Items Total
Spedial Conditions

Last Update

Plug

£25,000.00
£25,000.00
£7,000.00
$15,000.00
$5,000.00

%77,000.00

%77,000.00
$0.00

Detail

Estimate Essentials User Guide

Example Sub #2
Guard Rail Items

Example Sub #1
Guard Rail Items

£25,264,55 % & $40,000.00

& $24,000.00 § & $25,000.00
£7.000.00 £,200.00 § &  $6,000.00
£$25,264.55 $30,200.00
$99,764.55

$25,264.55

$72,964.55

$30,200.00

$0.00
7/29/2009 2:21:...

$0.00

11/13/2019 9:0...

e =0 You can award multiple Quote items by selecting all the items and then using the right

click context menu to award.

8.4.10.1 OPEN STATUS

If a quote is yellow, this indicates that the quote record is open in another screen. Closing out of the

quote record, will turn the record back to gray.

Drag columns here to group

Find; | [Searc
. - - HD Engineering
CBS Forecast Unit of Total Cost Example Sub #2 Example Sub #1
Position Code Desapio (T/C) Quantity Measure leatCosty (Forecast) Plug Detail Guard Rail Items Guard Rail Items grﬂ?'\UD'EtE Sitework
18 Guardrail Type 2 1,000.00 Linear Feet $24.00 (D $24,000.... $25,000.00 5 & s2400000 & $25,000.00 | $50,000.00
19 Guardrail Type 34 200.00 Linear Feet $31.00 (O $6,200.00 £7,000.00 o0 § & $620000 & $5,000.00
Scope Items
Summary
Minority Type
Quoted Total $32,000.00 $0.00 $30,200.00 $31,000.00 4$50,000.00
> Comparable Total < $32,000.00 $57,000.00 %$30,200.00 $31,000.00 $57,000.00
8.4.10.2 AWARD STATUS
The Award Status indicates whether or not all quotes are awarded within a quote group.
Quote Register  Quote Comparison & Award - Costitems O
x to group Find: | [SearchFor...] - | Saved views:
17 Toll Booth $40,000.00 (O $40,000.00  $25000.00  $25,264.55
18 Guardrail Type 2 52500 O 52500000 2500000 & o000
19 Guardrail Type 3A $30.00 O $6,00000  §7,000.00 $7,000.00 57, $7,000.00
20 Type 4 Signs $1500 ¥ $15,000.00 $15,000.00 & $13,000.00 & Off $300,000.00
7.1 Electrical Work. 500000 ¥ $5,00000  $5,000.00 @ $3,500.00 @ $3,700.00
> Summary
oBE
$77,00000 52526455 $30,20000 $71,000.00 $13,000.00 $4450.00 $50,000.00 5420000 $300,000.00
Comparable Total < $77,000.00  $98,764.55 $71,964.55 $87,500.00 $98,764.55 $98,764.55 $98,764.55 $98,964.55 $385,764.55
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8.4.10.3 REVIEW

You can keep track of what quote groups have been reviewed by checking the Reviewed check box.

Quote Group(s) »
v Description = Reviewesd
v Electrical Wark
v Guardrail Wark o
«f Sign Wark:

This can be helpful when there are many quotes to track and several users managing them. If any
changes are made to quotes within a quote group after the quote group is marked as Reviewed, the
guote group will be highlighted in yellow to indicate something changed since the last review.

Quote Group(s) »
Vv Description = Reviewesd
o Electrical Waork
o Guardrail Work o
o Sign Work:

Once reviewed again after the changes, you can uncheck and check the Reviewed checkbox again to
indicate it is up to date, and the yellow highlighting disappears.

The following steps walk you through comparing and awarding the Aggregate quotes.

STEP BY STEP — COMPARE AND AWARD QUOTES

This exercise walks through a specific example using the Training Job.
1. From the main Estimate landing page select Quote>Quote Comparison & Award.

2. Select Resources on the Quote Comparison & Award ribbon.
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Actions

@

Resources | CostItems Reports

Quote Comparison & Award Reports

Under Quote Groups, select Aggregates.
4. Review the quotes to determine the lowest bidder:
e MDIRTB is marked as Free for Example Vendor 4 and their quote is not splitable.
¢ Vendor 2 Stan Mark did not give a quote for MDIRTB, so a substitute value is being used.

5. Vendor 2 has the lowest comparable amount for MBR Aggregate Base Rock and Vendor 1 has
the lowest comparable amount for MDIRTB, so you decide to award each respectively. Award
each of them by right-clicking on the value and selecting Award.

6. On the attention prompt click Yes.

8.4.11 PACKAGE ENTIRE QUOTE

The Package Entire Quote function allows you to mark an entire quote as a package. This is beneficial if
you are attempting to quickly update an existing detailed quote to a lump sum quote from the Quote
Record or Quote Compare and Award form.

Za Set All to Reviewed Ef @ 2 Duplicate Quu(EI (72 Package Entre Quote I: Award i Lock P (© Quoted Items (= Zeroltems 5 Configure Totals 1) Session Recap
(% Set All to Not Reviewed 5 Ignore Quote %y Edit Package: 5 Award AndLack | (3 Unlock e [Z] urit Price 7, Scope Items. ]y SetSubstitute Ranking | § Auto Avard -
EditCost | EditQuote Edit Prices.
Ttem B2 substiute values (% Ignored Quates [T Default Data Blocks
Quate Group Status Cast Ttems Quotes View Took
r Quote Comparison & Award - Cost tems  © =
< here to group Find: | BearchFor..] | Saved views: | Previous View
Bar
cBs = Faracact Urit of o Total Cost Varmon Constructon | Eagie Concrats Carp.
Positon Corde Dascio (T/0) Quantity  Measwe  WMCOSt (Forecast el et Concrete, Stenork | Congete, Steviork o
a1 Sidewaks 4,54.00 SQFT 289 8 $4,99.07 $#4532.07 § $44939.07 PPl 520500000 P PL $242,500.00 &Pl
312 Vb .00 LF st 8 §1,725.32 f172532 § sa73532 PP1 @r &P
313 Curb and Gutter 1,25.00 F 351 & $43,133.12 12 % 54313312 @P1 &P fr
314 Valley gutter 50.00 F §34.51 3 $1,725.32 f1.725.32 § $1,72532 &P fr &r
) Quott
315 Handcap ramps 192,00 SQFT 98 & asw csme 8 S157247 BP1 &r & e Mot
% Duplicate Quote
316 Truncated domes 100 Lump Sum 52500000 &  $25,000.00 § $25000.00 $25.000.00 & P1 &r er ek
ES W Flow thru planter siab 15.00 (F .04 8 $12,005.46 24§ $12,00546 &1 &P &
3.8 Flow thru planter walls 1500 \F $5.0¢ & sw0054 szeosw § $12,00546 @P1 @ or
319 Median Infil 235.00 €Y sa0z 8 £,230.60 9.27.60 §  $9,230.60 & P1 &
.10 Rolled arb adjacent to 0.00 (F sus1 8 s7sm s1,725.32 §  $1,72532 @P1 &
ESRT Reinforcng 261240 b 345 8 $12,000.00 § $12,000.00 $1,306.20 & P1 &ri
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8.4 Quote Comparison & Award

8.4.12 INCOMPLETE QUOTES

The Incomplete quotes status indicates if a quote includes quote items that do not yet have a price.
This is often the case when vendors respond to an RFQ expressing interest in bidding but do not

provide their prices until right before the bid is due. These quotes display in gray in the Quote Compare

and Award form.

Cost Items Quotes

Quote Comparison & Award - Cost items ©
85 Forecast Unit of Total Cost
Position Code Descrption (T/O) Quantity Messure Unit Cast (Forecast)
411 CMU Walls 100 Lump Sum $485,822.07 (O $485,922.27
412 Precast Concrete Caps 100 Lump Sum $14,577.67 O $14,577.67
413 Stes| Embeds .00 Lump Sum §12,148.06 O $12,148.06

Scope Items
Demoiition

Cauking, Sealants &...

Scafolding

Shoring/Bradng

Testing/Inspection
Summary

Minority Type

Notes

& (2 Quoted Items [E7 Zero Items £ Configure Totals ) Session Recap
= Unit Price T, Scope Ttems [ Set Substitute Rarking = § Auto Award ~
Edit Prices 25
B85 Substitute Values  (*) Ignored Quotes [T Default Data Blocks
View Tools
Find: | [SearchFor...] Saved views: | Previous View
: =H.P, Construction
= Natomas Masonry, Inc. | Marquis Masonry
Plug Detail Ny edictnt Inc.
Masonry
£400,000.00 $400,000.00 § & P1 $512,648.00 | $526,724.53 | 2 P1  §766,352.00
$12,000.00 sizooo.00 % &P1 4 $12,375.47 | 7 P1
$10,000.00 sig.000.00 § £P1 e $0.00 | & P1

o o o

u] (n} u]

o o a

$15,000.00 $12,000,00 o

u] o [u]

MBE
b ] O

Incomplete Quotes that are Scope Only can be viewed in the Quote Compare and Award form using

the Zero Items toggle. These are quotes that have none of the Items priced. These quotes are

displayed to the right of all the Comparable Quotes.

(3 By QutcGron | 3 SctAl to Reviewed Dulicate Quots Packege Entire Quote

” 4
3 allquors Groups | (33 set Al m ot Reviewsd 1gnore CLots Edir Package award ard Lack Uninck [l [ rrence 7] scope rtems ssrsibemnite Rankng | Auto award -
- EditCost | EditQuote EdtPrices
05 All Quote Tiems Tiem B2 Substiute Yabies ) Ignored Quotes fault Data Blocks
Layout Quate Group Status Cost Hems Quotes View Tools
Cost Breakdown Structure (CBS) Register & Quote Comparison & Award - Costilems @
Quote Group(s) X || orag coiumng here 1o grocp Fnc: | [SearchFor,, ] ved views: | Pravious Yiew
= Descripion = B — foeaa Unit of I Total Cost. . . Natomas Masonry, Inc. ;f_"' Corstiucbion | ;s Masanry
Concrete, Precast ol o Quantity ez o Forecsd e - e Masanry Lo
Concrete, Sitework At U wals 1.00 | Lmpsum $1,879,705.33 €D $1,379,705.33 | $4,900,000.00  $1,708,525.67 | & P P1 $512,648.00 D P1  $766,352.00 | @ 0.0
Concrete, Struchural 412 Precast Conrete Caps 100 Lump Sum $170,862.67 (O $170,862.57 $12,000.00 $12000.00 | § P PL Pri Fa 40.00
Doors & Windows 413 Steel Embeds 1,00 Lump Sum $170,8682.67 O $170,862.57 $10,000.00 $10.000.00 § AP Fr & $0.00
Eectrical Scnpe Ttems
Frishes {Div 3} Demolinon o =}
Frroiam caking, Sealants & Backer Rod a [a}
Foundations Scafcldng o )
ShoringfBracng §15,000.00 o
Tasting/Tnspection al o
7] i summary
Plmbing Minority Type (] MBE
Reder Ingtal Motes k) o o
seaffoiding Quoted Total $4,422,000... $1,708,826.67 $512,648.00 $574,764.00 $0.00
Shest Metsl K Comparabie Total < $4/422,000... $1,720,826.67 £512,648.00 $574,764.00 51.730.826.67.
Sitenrk

Lok s & Quoted Iters ) Session Recep

I [Ei Zero lioms I 57 Confiours Totals

RELEVANT LINKS

Video - Compare and Award Subcontractors
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8.5 SCOPE ITEMS

During the bidding process, it’'s common for subcontractors and suppliers to provide a quote(s) for
work during the tail end of the bidding process. These last-minute offers make it extremely difficult for
you to evaluate and compare the various quotes and your ability to award them. With scope items,
you can create and evaluate checklists and quote group exclusions, and account for them within the
Quote Comparison and Award form.

You can view scope items as a checklist of items that break down the quote’s scope of work into
individual tasks to aid in the process of evaluating subcontractor and supplier quotes in greater detail.
This can be used to ensure that certain items of work are included or excluded. If excluded, the scope
items need to be properly accounted for by contractor awarding the quote.

Overview - Quote Record - Scope ltems

T

Seller’s By default, all scope items are considered included in the quote, and the Special
Special Conditions amount is $0.00. On the quote record, by selecting the checkbox, you
Terms & can indicate scope items and uncheck items that are not included. The amount

Conditions  associated with these items will then total up in the Special Conditions subtotal.
The person responsible for awarding quotes needs to update the Inclusions field
to correspond with what the subcontractor has agreed to include in the quote.
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Special Terms & Conditions b4
Quote Tax Item Tax
Add Taxes to the Quote: (O) Yes (@ No Add Item Taxes to each item's price

TAXES to be added to awarded TOTAL as a % of total :
Tax Rate: 0.00

Total Tax: £0.00

Buyer’s Special Terms & Conditions

Seller's Special Terms & Conditions

\

FIXED COST to beadded

Seller's awarded total (any combination of items) :

Distribute Special Conditionk: (@) Evenly () Usingweighted average

Include Special Conditionsiosts forunawarded guotes in Comparable Totals

Drag columns here to group Find: Saved views: | Previous View -
Eznmnlber - Scope [tem Quote Group Induded Amount % of Total Motes

> 1 Permits Electrical Work - -
2 Surveying and Layout Electrical Work > £500.00 14.29
3 Temporary Traffic Control Devices Electrical Waork o
4 Trench and Backfill for Electrical W...  Electrical Work b v

%950.00
4 3

Spedal Terms & Conditions ~ Qualifications  Packages  Seller's Profile  Setup  Minority

Overview - Quote Comparison and Award - Scope Items

1 Scope ltems Quote Comparison and Award checklist items for your quote that help
with evaluating subcontractor and supplier quotes in greater detail. This is
used to ensure certain items are either included (inclusion) or excluded
(exclusion) in the quote and accounted for by the entity awarding the
quote.

2  Scope ltem Maintained in Quote Record form. These are the Seller's Special Terms
Inclusions & Conditions scope items that the subcontractor is including in their
quote price. When the scope item contains a value, the subcontractor is
agreeing to perform the work.

3 Scopeltem Maintained in Quote record form. These are the Seller's Special Terms &
Exclusions  Conditions scope items price. If the Inclusions checkbox is blank, the
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Overview - Quote Comparison and Award - Scope Items (continued)

T T

subcontractor is NOT agreeing to perform the scope items.

4  Scope ltem An entered value means that the subcontractor is excluding this scope of
value work. However, you may add an amount because this scope could incur
a cost. Once the bid is awarded, you may find another subcontractor to
perform the work. You are simply accounting for a cost for this scope of
work. In the example below, HD Engineering is not going to paint the
electrical equipment, but you know the cost is $150.00. You are showing
this cost to account the cost for this scope of work that needs to happen.

5 Sellers By default, all scope items are considered included in the quote, and the
Special Special Conditions amount is $0.00. On the quote record, by selecting
Terms & this checkbox, you can indicate scope items and uncheck items that are

Conditions  not included. The amount associated with these items will then total up in
the Special Conditions subtotal. The person responsible for awarding
guotes needs to update the Inclusions field to correspond with what the
subcontractor has agreed to include in the quote.

Cost Breakdown Structure (CBS) Register Quote Register Quote Comparison & Award - Cost items  ©

Quote Group(s) x Drag columns here to group
v Eectrical work Rosuonicode Quantity  me. | ot (Ferest Electrical Work Flectrical Work

Electrical work 2 71 Electrical Work 100 Each £4,200... O £4,200.00 £5,000.00 420000 § & $4,20000 & £4,450.00
Electrical work 3 Scope Items
Guardrail Work o Permits o] o]
Pipe Materials Surveying and Layout $500.00 $500.00
Sign Woark Temporary Traffic Control Devices o
Trench and Backfil for Electrical Work 9 u] o
Painting Electrical Equipment O $150.00
Temporary Power and Lighting O e $300.00
Summary
Minority Type
Quoted Total $5,000.00 $0.00 $4,200.00 $4,450.00
Comparable Total < $5,000.00  $4,200.00 $4,200.00 $4,450.00
Awarded Total $0.00 $0.00 $4,200.00 $0.00
Quoted Ttems Total $5,000.00 $0.00 $3,700.00 $3,500.00
= 6 Spedial Conditions £0.00 $0.00 $500.00 $950.00

Last Update 11/13/2019 1:0... 11/13/2019 3:5...

The example below in the Quote Register form shows quotes from two subcontractors, both with
different quote prices. It is important to understand all scope of work the subs are quoting. By just
viewing these quotes alone, it’s difficult to understand which quote will provide you with the best
value. In other words, just because Example Sub #3 is the lowest priced quote, does not mean it is the
best quote to go with.
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Quote Register ©

Drag columns here to group

- RFQ Quote Quote Awarded - Awarded
Description Description Status Seller Compary Tatal Total Currency Awarded Status
Electrical Work Electrical Work  Accepted Example Sub #5 MEE -- Chr... Example Sub #5 MBE £4,450.00 $0.00 U.5. Dollar None
Electrical Work Electrical Work  Accepted Example Sub #3 —Frank M... Example Sub #3 £4,200.00 $0.00 U5, Dollar Mone

The example below in Quote Comparison and Award shows that HD Engineering Group is excluding 3
scope items in their quote that totals $950. This provides a more granular picture for what is being
included within each subcontractor’s scope of work. It also displays how much each scope of work
costs, so you have the option to find another subcontractor to perform this scope work.

& Register Quote Comparison & Award - Cost items @
g columns here to group
gntﬁnn Code Description ?;g;ast ;Ifmt gzistt ?gféf;:tg Flug Detail ;;':;:;jﬂill:il Ell?oﬁgglneerlng
Quantity Me... Electrical Work Electrical Work
7.1 Electrical Wark 1.00 Each $4,200... O $4,200,00 §5,000.00 420000 § & $4,200.00 & §4,450,00
Scope Items
Permits a %)
Surveying and Layout §500.00
Temporary Traffic Control Devices ] %)
Trench and Badkfill for Electrical Work a %)
Painting Electrical Equipment m] £150.00
Tempoarary Power and Lighting [m] m
Summary

Minority Type
Quoted Total $5,000.00 $0.00 $4,200.00 $4,450.00
Comparable Total < $5,000.00  $4,200.00 $4,200.00 $4,450.00
Awarded Total $0.00 $0.00 $4,200.00 $0.00
Quoted Items Total $5,000.00 $0.00 $3,700.00 \53,500.00
Spedal Conditions $0.00 $0.00 £500.00 $950.00
Last Update 11/13/2019 1:0... 11/13/2019 3:5...

Utilizing Scope Items enables you to more effectively compare quotes from subcontractors and
suppliers by providing a deeper comparison of quotes. Moreover, it provides clearer visibility of what a
proposal may or may not be including at the time you are attempting to make an award.

You can make a more informed decision on whom to award the quote to, now that the vendor quotes
and associated scope items are all visible on one screen.

8.5.1 SCOPE ITEM SETUP

Scope items are stored within each quote group tag in the Foundation Setup Data form. On each
Quote Group Tag Record, you can list out scope items that break down the work into smaller scopes of
work, along with the estimated cost amount associated with each scope item.
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Foundation Setup Data Register Quote Group Tag Record ©

Description: % |Electrical Wark

Award Status: Complete
Reviewed:
Last Reviewed:

Quote Last Changed:

Drag columns here to group

ES?\.‘. = Scope Item Amount % of Total
1 Permits > £0.00
2 | Surveying and Layout > £500.00
3  Temporary Traffic Control Devices > £0.00
4 Trench and Backfill for Electrical Wark > 0,00
5 Painting Electrical Equipment > &0.00
& - £300.00

Temporary Power and Lighting

STEP BY STEP — SET UP SCOPE ITEMS

This exercise walks through a specific example using the Training Job.
1. Open your job.
Select the Setup tab.
Click on Foundation Data Setup in the Initialize section.
Select the Quote group tags tab to set up scope items within a quote group.

Create a new Quote Group Tag called Electrical Work and click Ok.

o 0o bk v DN

Open Electrical Work and add the following scope items:
e Permits

e Surveying and Layout

e Temporary Traffic Control Devices

¢ Trench and Backfill for Electrical Work
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¢ Painting Electrical Equipment
e Temporary Power and Lighting

7. Enter 500 in the Amount field for Survey and Layout, and a 300 for Temporary Power and

Lighting.
8. Click Ok.
Row . o
Number k., Scope Item Amount % of Total
1 Permits » €0.00
2 Surveying and Layout > £500.00
3 Temporary Traffic Control Devices > €0.00
4 Trench and Backfill for Electrical Work » £0.00
5 Painting Electrical Equipment » €0.00
6 Temporary Power and Lighting » £300.00

STEP BY STEP — SET UP QUOTES FOR SCOPE ITEMS

This exercise walks through a specific example using the Training Job.

From the Estimate tab, click on Cost Breakdown Structure (CBS).

Change your saved views to Quote Group Setup view.

Create a cost item Entry Gate with a subordinate Electrical Work.

Assign the Electrical Work quote group to the Electrical work cost item.
From the Quote tab, click Request for Quote (RFQ) to open the RFQ register.
Create an RFQ by selecting the New icon on the Actions tab.

Select Create RFQ from Quote Group Tag(s) and select Electrical Work.
Click Ok.

© 0 N o g b~ w N =

Click on the Seller Companies tab and select the following company names:
¢ Architectural Designs

e HD Engineering Group
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10. Highlight both companies and select Publish.

11. Assuming you’ve already received quotes back from both companies, create a quote from this
RFQ for both companies by selecting the companies and selecting Create Quote.

12. Click Ok to close the RFQ record.

RFQ Quote
Description Status

S— N e
Sh— D

Description - Seller

Aggreaates Aggregates Received Example Vendar 1 —-F;
Aggregates Aggregates Received Example Vendaor 4 DBE
Aggregates Aggregates Received Example Vendar 2 - 5
Asphalt Materials Received Example Vendaor 1 -—-F;
Asphalt Materials Received Example Vendaor 2 - 5
o st [ ) o
Electrical Wark Electrical Wark Received Architectural Designs

Electrical Wark Electrical Wark Received HD Engineering Growu

8.5.2 SCOPE ITEM CREATION AND AWARD

The following Step by Step assumes you are putting out an advertisement for bids for some electrical
work on a project. You will add scope items with some fixed costs as a special condition, then will
compare quotes in order to decide which vendor quote is the best deal.

STEP BY STEP — MANAGE AND AWARD SCOPE ITEMS

This exercise walks through a specific example using the Training Job.

1. Click the Quote tab and then click the Quotes icon to open the Quote register.

2. Open the Quote Record for HD Engineering Group and enter a Unit Price of 3,500 which is based
on the quote you received.
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10.
11.
12.
13.
14.
15.

16.

Select the Special Terms & Conditions tab and select the Seller's Special Terms & Conditions
radio button.

Assuming the HD Engineering is excluding certain scope items from this quote, click on the
Included checkbox to exclude (uncheck) the following scope items:

Surveying and Layout

Painting Electrical Equipment

Temporary Power and Lighting

Type 150 in the Amount field for Electrical Equipment.

Notice how the 3 scope items you just excluded are now added to the Special Conditions total
for the quote.

Click Next to move to the other Quote record for Architectural Designs.
Enter a Unit Price of 3,700.

Press Tab to move to the Special Terms & Conditions tab and select the Seller's Special Terms &
Conditions (at right) radio button.

Uncheck the inclusions checkbox for Surveying and Layout.

Add the amount 500.

Click Ok.

Select the Quote tab.

Open the Quote Comparison and Award form, and select the Cost Items tab.
Under Quote Groups, select Electrical work.

Right-click on the quoted amount for Architectural Design and select Award to award the work
to them.

Click Yes on the resulting prompt to mark the quote group as reviewed.

8.6 QUOTE ITEM ADJUSTMENT

Quote items can be adjusted even after a quote has been awarded. This could happen on closing day
when a vendor sends in a last minute discount. For example, vendor 3 has sent in a 10% discount on

piping materials. This percentage discount is applied to the vendor 3 quote by entering the 10% in the

Condition Adjustment column.
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STEP BY STEP — QUOTE ITEM ADJUSTMENT

From the Ribbon, select the Quote tab.
1. Under the Quote Comparison and Award section, select Resources.
2. Locate a Vendor column.

3. Select the quote you want to edit under the vendor column. In the Ribbon, select the Actions
tab.

4. Under the Quotes section, select Edit Quote. You can also right-click and select Edit Quote. This
launches the Quote Record.

5. You can make Condition Adjustments by a percentage or an amount. Select the field to adjust
the percentage or amount of the Condition Adjustments.

6. Items adjustments can be applied individually or by using the multi-edit function. Select multiple
resources in the Quote Record, then right-click and select Open. This opens the Quote Resource
Item Record.

7. If you populate a 10% discount adjustment to all of the items selected using the multi-edit tool,
the amount value changes to “Varies”. This is because of the variance in the unit rates for each
selected item.

8. Click Ok to save the changes to the line items in the Quote record and to save the Quote.
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LESSON 8 REVIEW

1. When you receive responses to your RFQ, the next step is to enter their pricing in the

CBS Register
PBS

Quote Register

a o T o

RFQ Register

2. On a Quote Record, No Split means
a. The quote must be combined with other quotes from the same vendor
b. All items on the quote must be purchased from that seller

C. You can't split the quote into multiple quotes

3. When a quote group is highlighted in yellow on the Quote Comparison & Award form, it
signifies that

a. The quote group has changed since it was last marked as Reviewed
b. No quotes have been awarded for that quote group

C. There are some quotes in the quote group that contain substitute values

LESSON 8 SUMMARY

As a result of this lesson, you can:
¢ Create and publish RFQs
* Define quote pricing
e Compare and award quotes

* Create and analyze scope items
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LESSON 9 — FINALIZE THE
ESTIMATE

This lesson is primarily suited towards contractors who must add profit or markup to their total
estimated cost, which will be submitted in the form of a bid or proposal. Most owners can divert from
this lesson as it's more geared towards adding profit and markup. There are a few use cases in which
an owner may wish to use the price breakdown structure. For example: to add risk, contingency, or
reserves if it is preferred, these are not shown directly in the budget line items. The price breakdown
structure also provides a summary level review of the total estimate and is a great reference during
estimate reviews.

LESSON DURATION: 45 MINUTES
LESSON OBJECTIVES

After completing this lesson, you will be able to:
¢ Add job markup (profit)
¢ Use tools on the PBS form to review your estimate
e Spread Target Price over pay items

¢ Make bid adjustments

LESSON TOPICS
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9.1 JOB MARKUP (PROFIT)

&

On the Data Map =
percentage amounts that make up Direct Costs, Indirect Costs and Target Profit. lllustrations below
show how the Data Map values correspond to the values that make up the cost and profit.

Patal2p otice how the different segments within the pyramid coincide with the

To open the Data Map, select the Price tab, then Data Map from the Overhead and Profit section.

9.1.1 TARGET PRICE

For contractors building the price of your project is like building a pyramid. The foundation of your
price consists of the direct costs of the job.

The images below represent a default examples.

Target Price $6,569,736
Markup $984,120 14.98%
Indirect Cost Markup $15,123 0.23%
Direct Cost Markup $623,074 9.48%
Business Overhead $345,923 527%

Total Cost $5,585,617
Indirect Cost $332,422 5.06%
Job Overhead $332,422 5.06%
Direct Cost $5,253,195 79.96%
Unassigned Direct Cost $1,000 0.02%
Assigned Direct Cost $5,252,195 79.95%

*Values are based on Charge Rates

$6,569,735 (100.00%) Current Price
$1(0.00%) Variance (vs. Target Price)
($851) (-0.01%) Changes Register

On top of your direct costs, you can decide if costs with a cost segment of business overhead should be
indirect costs or markup. You estimate your direct and indirect costs in the CBS Register.
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TargetPrice $6,569,736
Markup $984,120 14 98%
Indirect Cost Markup $15,123 0.23%
E Direct Cost Markup $623,074 9.48%
Business Overhead $345,923 527%
\ Total Cost $5,585,617
Indirect Cost $332,422 5.06%
Job Overhead $332422 5.06%
Direct Cost $5,253,195 79.96%
Unassigned Direct Cost $1,000 0.02%
Assigned Direct Cost $5,252,195 79.95%

*Values are based on Charge Rates

$6,569,735 (100.00%) Current Price
$1(0.00%) Variance (vs. Target Price)
($851) (-0.01%) Changes Register

At the top of the pyramid you add an amount for profit. You add profit in the Price Breakdown
Structure (PBS) form. There is a very small block at the top of the Data Map, which comprises 0.22% of

Indirect Cost Markup.

TargetPrice $6,569,736
Markup $984,120 14.98%
Indirect Cost Markup $15123 0.23%
" Direct Cost Markup $623,074 9.48%
Business Overhead $345,923 5.27%

Total Cost $5,585,617
Indirect Cost $332,422 5.06%
Job Overhead $332,422 5.06%
Direct Cost $5,253,195 79.96%
Unassigned Direct Cost $1,000 0.02%
Assigned Direct Cost $5,252,195 79.95%

*Values are based on Charge Rates

$6,569,735 (100.00%) Current Price
$1(0.00%) Variance (vs. Target Price)
($851) (-0.01%) Changes Register

The total of the direct cost, indirect cost, and profit in the project is referred to in InEight Estimate as
the Target Price. This is the final price that you want to submit as your proposal.
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|Target Price $6,569,736 |

Markup $984,120 14.98%
Indirect Cost Markup $15,123 023%
Direct Cost Markup $623,074 9.48%
Business Overhead $345 923 527%

Total Cost $5,585,617
Indirect Cost $332,422 5.06%

Job Overhead $332,422 5.06%
Direct Cost $5,253,195 79.96%
Unassigned Direct Cost $1,000 0.02%
Assigned Direct Cost $5,252,195 79.95%

*Values are based on Charge Rates

$6,569,735 (100.00%) Current Price
$1(0.00%) Variance (vs. Target Price)
($851) (-0.01%) Changes Register

9.1.2 PRICE BREAKDOWN STRUCTURE

As you already practiced, your direct and indirect costs are estimated in the CBS. Your project’s profit
needs to be defined in the Price Breakdown Structure (PBS) form.

The main purpose of the Price Breakdown Structure (PBS) is to add markup (profit) to the estimate.
The Price Breakdown Structure is a visual run-down of the costs and profit that make up your Target
Price. It helps you analyze how your costs contribute to the price you are targeting, including the
amount of profit you would like to include.

You can open the PBS from the InEight Estimate landing page by selecting the Price tab, then Price
Breakdown Structure (PBS) from the Overhead and Profit section.

Overview - Price Breakdown Structure

T T

1 PBS The left side of the screen displays several cost classifications:
Description « Target Profit
» Business Overhead
e Job Overhead
» Direct Cost

2  Various The Assigned and Unassigned columns show which costs are either
Columns assigned or not assigned to pay items. Unassigned costs are spread back
to pay items based on the distribution logic set in Job Properties > Pricing.
The Total columns represents a summation of both columns.
Each layer displays with an amount, and the percentage of the Target
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Overview - Price Breakdown Structure (continued)
I T
Price that this amount represents.

3 PBSMenu Therightside of the screen holds several tabbed pages of information.
This information is useful in analyzing the job at a summary level.

4 Refresh To ensure that you are always reviewing the most up-to-date factors and
Data ratios, click the Refresh Summary Data button whenever you are
reviewing the data.

Price Breakdown Structure @ n

Assigned Unassigned  Total ;/-of | Markup Analysis | Price Status | CostSource | Resource Utiization | Minority Goals | SubcontractStatus | Vendor Status l E
arget
] I | | ..., i bsed n 4 Quatits and Chrge Rt Hark
$5,252,19.. $1,317,54.. $6,569,73. 100.00 S G roe =
$0.00 $984,119.62 $984,119.62 14.98
Teet Butl o0, 0521 ¥690,1%.32 o7 Markup as % of  All Costs (Target Price - Markup) 17.62
Indrect Cost Markup $15,122.66  $15,122.66 0.23
Drect Cost Markup 23,0736 $623,073.66 5.8 Markup as % of  All LaborCosts 12270
A\ | Business Overhead SOOI 923 S0jj iS5 22550, 527 | || Markup as % of Al DirectLabor Costs 14211
55 Price % Add-on $0.00 $295,638.13 $295,638.13 4.50
85 s0b iy o (e | o o Markup as % of Al Indirect Labor Costs 898.32
85 Indrect Cost Escala. $0.00  $2,13L11  $2,13L11 0.03 Markup as % of  All Owned Equipment and Rented Equipment Costs 10126
58 Direct Cost Escalation) $0.00 $15048.80 $15,048.80 0.23
o Markup as % of  All OE Ownership and RE Rental Costs 23923
% Business Overhead $0.00 $0.00 $0.00 0.00
~ A Total Cost $5,252,19.. $333,42.97 $5,585,61 85.02 Markup as % of Al OE Operation and RE Operation Costs 177.02
v A IndrectCost $0.00 $332,421.97 $332,421.97 5.06 Markep 8% of  AllMateroh et
v A JobOverhead $0.00 $332,421.97 $332,421.97 5.06
58 Prime Bond $0.00 $47,148.68  $47,148.68 072 of  Allsupplies Costs 3571.02
oo
DyUIDONecE CoetA SO So0 ST oe C 2 e as%of Al Subcontract Costs 90051
88 Direct Cost Add. $0.00 $104,088.34 $104,088.34 1.58
&% Job Overhead . $0.00 $175296.28 $175,296.28 267 (=220
~ s DirectCost $5252,19..  $1,000.00 $5,253,19. 799 o B T oo
% Drect Cost Items $5,252,19..  $1,000.00 $5,253,19. 7.3

(4]

Refresh Summary Data

TIP All costs in the Price Breakdown Structure are based on pay quantities (not forecast take-
off quantities).

9.1.3 MARKUP VS. MARGIN

Let’s look at the difference between Markup and Margin.
e Markup is a function of cost, while margin is a function of price
e Markup indicates how much you are marking up the cost
e Margin indicates what percentage of your price the markup represents

The percentages on the main PBS screen are margin, so you can see what percentage each category in
the PBS represents compared to the total price. If you enter 10% in the Target Profit field, your profit
will be 10% margin of your total price.
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Description Assigned Unassigned | Total 3;;;1; ¢
- ‘ Price Breakdown Structure _—_
w ‘ Target Price £5,252,19...  §1,317,54... 56,5689,73.. 100,00
w Markup 50,00  5984,119.62 | 5984,119.62 14,93
¥ Target Profit £538,196,.32 5S638,196.32 9.7
» = Business Overhead £0.00 $345,923.30 §345,923.30 5.27
~ gk Total Cost £5,252,19...  §333,421.97 §5,585,61... 35.02

When you open the Direct or Indirect Markup Records, the Rate percentage there indicates markup of
the cost. If you enter 10% markup on $100, the markup will be $10.

Within Job Properties, you can choose if costs with a cost segment of business overhead should be
indirect costs or markup. If selecting markup, then Business Overhead will be spread within the

Markup category of the Price Breakdown Structure. The Total Markup will be the sum of Target Profit
and all ltems categorized as Business Overhead.

Data Map Job Properties @

Overview | Seauity | CoverSheet | CostBass | MoritySetp | Fuel Cost | JobTracking | JobFolderTags | Priang

O Billing Amount

Distribute Unassigned Cost/Billing Amourt by:
@® Individual Categories

O Toplevelcategories

O Total Cost/Billing amount
Markup Cptions

Markup Pay Item by:

@® Using Weighted Distribution

O Keeping Markup vith Assigned Costs

Categorize Business Overhead as:
O Indirect Cost
@ Markup

This lets you see the true total cost of the job, including the total markup inclusive of the business
overhead. You can also create cost items and categorize them as business overhead, then possibly

include overhead costs such as estimating or home office expenses. This provides you with added
flexibility in marking up your job.

9.1.4 DEFINE PROFIT

Before you define profit, review the PBS. You estimated your direct cost items, and you also estimated
some indirect cost items in the CBS. You can view your direct and indirect cost totals on the Price
Breakdown Structure. Notice you have not defined profit yet.
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Description Assigned Unassigned | Total .T"_r;r':g'lzt
~ A | Price Breakdown Structure _—_—
~ jh TargetPrice £5,252,19... §645,755.99  £5,397,950.68 100.00
v % Markup £0.00  $315,692.95 $315,692.95 5,35
v | Target Profit £0,00 £0,00 0,00
Indirect Cost Markup £0.00 £0.00 0.00
Direct Cost Markup &0.00 &0.00 0.00
w ™=  Business Overhead £0.00 5315,692.95 £315,692.95 5.35
80 Price % Add-On £0.00 £265,407.78 £265,407.78 4,50
B8 3ob Financing $0.00  $33,105.26 $33,105.26 0.56
OC Indirect Cost Escala... $0.00  $2,131.11 $2,131.11 0.04
DL Dbirect Cost Escalation £0.00  §15,048.80 £15,048.80 0.26
B Business Overhead ... £0.00 £0.00 £0.00 0.00
~ JA Total Cost $5,252,19... §330,063.05  $5,582,257.73 94,65
~ # Indirect Cost $0,00 $329,063.05 $329,063.05 5,58
+ = Job Overhead $0.00 $329,063.05 $329,063.05 5,58
B2 Prime Bond £0.00  §43,789.75 £43,789.75 0.74
B8 indirect Cost A... £0.00  £5,888.67 £5,888.67 0.10
BE Direct Cost Add... £0.00 $104,088.34 $104,088.34 1.76
B& Job OverheadI.. $0.00 $175,296.28 $175,296.28 2,97
~ s Direct Cost £5,252,19...  £1,000.00  £5,253,194.68 §9.07
B Direct Cost Items $5,252,19...  $1,000.00  $5,253,194.68 §9.07

You can define profit by entering a profit percentage directly on the PBS, or by modifying the Direct or
Indirect Cost Markup Records.

The following steps walk you through plugging a Target Profit percentage directly on the PBS form.

9.1.4.1 PROFIT AS A PERCENTAGE OF TARGET PRICE

STEP BY STEP — ADD PROFIT AS A PERCENTAGE OF TARGET PRICE

1. Open your job.

2. Select the Price tab.
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3. Select Price Breakdown Structure (PBS) from the Overhead and Profit section.
4. On the Target Profit row, enter a numeric value in the % of Target Price column; press Tab.

e For this example, we’ll add 10% for the Target Profit.

9.1.4.2 PROFIT THROUGH DIRECT COST MARKUP RECORD

The following steps walk you through how to add profit as markup on the Direct Cost Markup record.

STEP BY STEP — MODIFY THE DIRECT COST MARKUP RECORD

. On the PBS form, double-click on the Direct Cost Markup row.

—_—

2. Inthe record, overwrite the Default entry with Direct Cost Markup in the description field.

3. In the Rate column on the Dependency Cost Breakdown, add a numeric value in Labor, Owned
Equipment, Materials and Fees categories. Then reset other categories back to 0.

4. Click Ok to save your changes and return to the PBS.
5. Click the Refresh Summary Data button to see the changes reflected.

e For this example, we’ll add a rate of 15 for Labor, 10 for Owned Equipment, 8 for Materials, and
2 for Fees, then zero out all other categories.

Pescrpgon | Dependency | Allocabion Coat Breakdowm o
S waed: -1 2 Cost Cabegary E‘”f"' Feate Coest
At
Descripbion Currency Total Cost Forecast) 2 - Totd 102, 785 173 $13,081.83
b Labar 57,7907 15.00 49,568.91
¥ Owned Equipmenit 4L455.92 10.00 #1455
»  Renbed Equpment .00 .00 o
v Supples $0.00 000 o0
v Maberighy A2 00 .00 b=
v Subcoriract $0.00 ] o
v Fees §262.08 o0 3524
v Alowance .00 000 w00l
Custors Category i $0.00 0.00 $0.00
Undefined §0.00 .00 $0.00

9.2 COST ESTIMATE AUDIT/REVIEW

InEight Estimate offers built-in reports to double check your estimate and review different aspects of
your project, including material costs, quotes, man-hours and production.
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9.2.1 PRICE BREAKDOWN STRUCTURE TABS

The purpose of the tabs on the Price Breakdown Structure is to assist with estimate reviews.

Markup Analysis Price Status Cost Source Resource Utilization Minority Goals Subcontract Status Vendor Status

9.2.1.1 MARKUP ANALYSIS

On this tab, you can compare your profit to your costs for labor, subcontract and other cost groupings.
By seeing the ratios of your markup compared to your different cost categories, you can gauge if you
have the right balance of costs in your estimate.

Markup Analysis (based on Bid quantities)

Markup as % of  All Costs (Target Price - Target Profit) 11.11
Markup as % of  All LaborCosts 79.42
Markup as % of  All Direct Labor Costs 44,07
Markup as % of  All Indirect Labor Costs 510.05

For example, if your markup is more than 100% of your Labor cost, it may indicate that you don’t have
enough labor cost in your estimate to cover the work, which could indicate labor cost overruns during
execution that would eat into your profit margin.

9.2.1.2 COST SOURCE

The Cost Source tab shows the breakdown of Detail, Plug and Quote cost sources, as well as the
amounts and percentages of each that are attributable to Direct and Indirect cost. Your Plug cost
source should be the lowest percentage.
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Markup Analysis Price Status I Cost Source I| Resource Utilization Minarity Goals Subcontract Status Vendor Status

Cost Source Analysis (based on Bid quantities)

Detail Plug * Quote Total
Amount %o Amount e Amount| % Amount Yo
Direct Cost £5,156,491.67) 97.95 £64,600.00f 1.23 §43,200.00f 0.82 £5,264,291.67) 100.00
Indirect Cast £638,694.52] 98.62 §5,338.76]| 0.82 £3,570.19] 0.55 £647,603.460 100.00
Total §5,795,186.19] 98.03 £69,938.76] 1.18 §46,770.19) 0.79 §5,911,895.14] 100.00

* Includes values entered as flat amounts (not percentages) on dependent cost items.

9.2.1.3 RESOURCE UTILIZATION

The Resource Utilization tab shows a breakdown of the man-hours and equipment hours utilized on
the job, based on take-off quantities.

Markup Analysis Price Status Cost Source Resource Utilization

Resource Utilization Analysis (based on T/O

quantities)

Total Manhaours 26,838.86
Total Equipment Hours 15,961.51
Total Shift Hours 5,508.23
Total Days * 68270
Total Schedule Days 168.00

* shift hours divided by (hours per shift times shift per day)

9.2.1.4 SUBCONTRACT STATUS

The Subcontract Status tab displays a breakdown of subcontractor amounts, costs, and percentages for
guoted cost items. This is a good place to review how much of your estimate is subcontracted.

9.2.1.5 VENDOR STATUS

The Vendor Status tab displays a breakdown of vendor information, including amounts and
percentages of the Target Price represented by vendors. This is a good place to review how much of
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your estimate costs come from vendor quotes.

Markup Analysis Price Status Cost Source Resource Utiization Minority Goals Subcontract Status Vendor Status

Vendor Analysis (based on Bid quantities)

Mumber of Vendors 2

Total Vendor Amount $1,442,571.90

%% of Target Price 21.96

Company Name Contact Fhone Amount  Currency Percent Street Address
Example Vendar 4 DEE Slim, Lester 111-122-1321 £271,471.20 .5, Dollar 4,13 400 Fourth Street
Example Vendar 1 Roberts, Pat 111-123-2134 $1,171,100.70  U.S. Dollar 17.83 100 Tenth Street

9.3 SPREAD TARGET PRICE OVER PAY ITEMS

In the Cost Breakdown Structure you generated your direct and indirect costs, and in the Price
Breakdown Structure you added profit to come up with a Target Price for the bid, but you still haven’t
decided how to spread the Target Price over your pay items.

In Lesson 4 you created pay items for the project in the Pay Item & Proposal Register. You can now go
back to the Pay Item & Proposal Register to distribute your Target Price over those pay items.

9.3.1 CURRENT PRICE VS. TARGET PRICE

In InEight Estimate, Current Price means the total price that is currently assigned on your pay items.
Open the Pay Item & Proposal Register to see what the Current Price is for your pay items (Price > Pay
Iltem & Proposal).

At this point there is no pricing on your pay items, so your Current Price is $0.00. This is because you
have not yet spread your Target Price (the total of your cost and profit) over your pay items.

P Forecast Urit of Linit Total
Description ay (Tja) nit o Price = Price
LT Quantity - (cu... (current)
+ Maobiliation 1.00 1.00  Each £0.00 £0.00
+ Clearing and Grubbg 10.00 15.00 Acre £0.00 &0.00
+ Excavation 50,000.00 40,000.00 CY £0.00 £0.00
+ 10 " PVC Pipe 1,000,00 1,000,000  LF £0.00 £0.00
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9.3.2 PROPOSAL RECAP

On the Pay Item & Proposal Register, there is a Proposal Recap table where you can compare your
Current Price to your Target Price to see if there is any variance.

Proposal Recap - Training Job

Current Target Forecast ‘Variance

Price: £6,455,450.00 £6,506,904.35 56,462,850.00 [ 55145435 JADD

Profit: 5599,221.88 5650,676.22 5655,858.61 55,182.39 |[CUT
Margin%a: 9.28 10.00 10.15 | s510,653.01 |CUT

Ideally, you want to add pricing to your pay items until your Current Price equals your Target Price, so
that your Variance equals zero. That way you know you are covering all your costs and getting the
profit you want.

Notice the Variance column will indicate if you need to ADD or CUT pricing on your pay items to hit
your Target Price.

9.3.3 SPREAD THE TARGET PRICE

For lump sum contracts, spreading the Target Price may be as simple as spreading it to a single pay
item that represents the entire project. However, most jobs will have at least a few pay items defined
by the owner, and Unit Price contracts will have many pay items.

There are two main ways to distribute pricing onto your pay items:

1. Define pay item prices manually, by entering a unit or total price, or a margin percentage.

2. Use InEight Estimate’s AutoPrice feature to distribute pricing automatically.

9.3.4 DEFINE PRICING FOR PAY ITEMS MANUALLY

First, you will walk through the process of defining pricing manually. This method requires filling in
each item’s price based solely on your own judgment.
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STEP BY STEP — DEFINE PRICING MANUALLY

1. From the Estimate landing page, select the Price tab.

2. Select Pay Item & Proposal from the Pay Items section.
3. Select a Pay Item row.
4

. In either the Unit Price (current), Total Price (current), or % Margin field of a pay item, type a
numeric value.

For this example, we’ll do the following:
» Mobilization pay item — change Total Price (current) to $20,000.

e Clearing & Grubbing pay item — change % Margin to 5%.

Forecast
Pasition . Pay Item . Pay Unit of Unit Price Total Price :
Code = Number Description Quantity (T/o) . Measure (current) (ourrent) % Margin
Quantity
=1 200 SITEWORK & ROADWAY $51,369.60
+ 11 6410100 Mobilization 1.00 LS $20,000.00 $20,000.00 -34.67

T P S I T ) ) S Y )

9.3.5 USE AUTOPRICE TO BALANCE AND HIT THE
TARGET TOTAL

Perhaps you want to get a head start and have InEight Estimate spread your Target Price
proportionately over your pay items for you. This can be done using the InEight Estimate AutoPrice
feature.

TIP Once distributed, you will still have the ability to adjust your pricing on pay items
manually as needed.

Look at how you can use the AutoPrice feature.

STEP BY STEP — USE AUTOPRICE TO BALANCE AND HIT THE

TARGET TOTAL

1. Open the your job in Estimate.
2. From the Estimate landing page, select the Price tab.

3. Click on Pay Item & Proposal to open the Pay Item & Proposal Register.
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4. On the Pay Iltem & Proposal Register menu, choose Actions > Balanced Bid > Hit Target Total.

5. Review the Proposal Recap and see that the Variance is now $0.00. Now that the job is balanced,
you can see that the Current Price and the Target Price are the same, indicating that the costs
and profit are spread proportionately over your pay items.

9.3.6 USE AUTOPRICE TO UNBALANCE AND HIT THE
TARGET TOTAL

The Autoprice to Unbalance feature in InEight Estimate can automatically distribute profit to account
for your over- and underrun items.

InEight Estimate will take profit from your underrun and put it on your overrun by using the Actions >
Unbalanced > Hit Target Total feature. The purpose is to maximize your profit by spreading it
strategically between these items.

STEP BY STEP — UNBALANCE HIT TARGET TOTAL

1. You may encounter overrun and/or underrun items in the Pay Item & Proposal Register of your

job.
Forecast )
L — Pay Unit of
Description = 7T Quantity glfaﬂgﬁty Meas. .. Curre...
Excavation 10.00 15.00 § Cubic Yard 115, Dollar
Clearing & Grubbing 50,000.00 40,000.00 | Acre LL.5. Dallar

2. If you do, highlight the row for each item to view it’s current balanced item recap.

Item Recap - 2000 Clearing && Grubbing Item Recap - 3000 Excavation
Balanced Unit | Current Unit Balanced Unit | Current Unit
A Price: $4,98570 | $4,994.91 A Price: 52.86 $2.86
Profit: $515.91 $525.12 i Profit: £0.29 50.29
Total Cost: §4469.79 $4,469.79 Total Cost: §2.57 §2.57
) Business Overhead: £245.35 & Business Qverhead: £0.15
= Job Overhead: £1,681.60 F Job Overhead: 50.91
am |Unassigned Direct Cost: 50.00 am |Unassigned Direct Cost: £0.00
| Assigned Direct Cost: 52,542.84 am | AssignedDirect Cost: £1.52
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3. On the Pay Item & Proposal Register menu, choose Actions > Unbalanced Bid.

_

&=, Link Field [ Assigned Direct Cost Only |+ | Overwrite Locked Pay Items

24, Unlink Field | €&, Balanced Bid ~ == Custom Auto Price

=1 Unbalanced Bid

Workbook Auto Price

¢ You will see the changes reflected and how the profit was spread to your overrun and
underrun items

IInit Price - Total Price %G
{current) = (current) Margin
$3,000.00  $150,000,000.00 .25
$4,371.84 $48,718.40 57.68
591,100.00 591,100.00 10,05

* |In the example shown, highlighting each item will show that all your overhead and
profit from Excavation was put onto Clearing & Grubbing.

Ttem Recap - 2000 Clearing && Grubbing Item Recap - 3000 Excavation
Balanced Unit | Current Unit Balanced Unit | Current Unit
A Price: 438570 | $11,706.11 A Price: $2.86 $1.52
Total Cost: §4,469.79 §4,469.79 Total Cost: £2.57 $2.57
) Business Qverhead: $245.35 = Business Overhead: $0.15
) Job Overhead: $1,681.60 = Job Overhead: $0.91
am |Unassigned Direct Cost: £0.00 am |Unassigned Direct Cost: $0.00
am | Assigned Direct Cost: £2,542.84 | Assigned Direct Cost: £1.52

9.4 SELECTIVE PAY ITEM MARKUP

Estimate has a streamlined process to estimate the cost of a project and price the work to ensure all
unassigned costs and markup are included in the final price of the project. For markup to be spread to
pay items, a weighted distribution method is used as determined in the Job Properties, Pricing tab. It
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might be desirable for markup percentages to not be distributed, but rather directly applied to the
costs assigned to any particular pay item.

This option can be set to keep markup with assigned costs for establishing a pay item price.

Job Properties ©

Owerview Security Cover Sheet Cost Basis Minority Setup Fuel Cost Pricing

Balanced Price Options
Calculate Balanced Pay Item Prices using:

{®) Cost Amount
() Billing Amount

Distribute Unassigned Cast/Billing Amount by:

{® Individual Categories
() Top level Categories
() Total Cost/Billing amount

Markup Options
Markup Pay Item by:

(®) Using Weighted Distribution
() Keeping Markupwith Assigned Costs

Categorize Business Overhead as:

() Indirect Cost
(@) Markup

Calculate Proposal Recap Forecast Markup using:

(®) Unit Markup (current) x Forecast (T/0) Quantity
(") Forecast Price - Total Cost/Billing

Additionally, this option can be used to isolate the markup and apply it only to specific pay items. The
following is an example of a dependent cost item being used to mark up the labor of select site work

pay items by 25%.
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= Print O new Copy Togale Suspended Link Field
R Preview Delete Paste Lock Quantities Unlink Field
& Export to Excel cut Fil Down [ v] Lock Prices
Print Edit Workbook
Pay Item & Proposal Regi L]
Drag columns here to group
st Ttem Lock: Lock: Desaription Pay
umber Quantity Price Quantity
S EARTHWORK AND UTILITIES
+ 2 ACPAVING
+ 3 PAVMENT MARKINGS
+a SITE CONCRETE
+ 5 FENCING
+ 6 LANDSCAPING
+7 PILES AND PIERS
+ 8 CONCRETE
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Insert

[0 Assigned Cost Oniy

Insert Subordinate

Insert

Forecast (T/0)
Quantity

100

100

100

100

100

100

100

100

100
100
100
100
100
100
100

100

4 Balanced Bid ~

== Custom Auto Price

=1 Unbalanced Bid
Auto Price
e o — LABOR
ieasure Cost
Lump Sum .S, Dallar $52,901.68
Lump Sum .S, Dallar $29,711.17
Lump Sum .S, Dallar $14,545.57
LumpSum .S, Dollar $0.00
LumpSum .S, Dollar $7,163.88
LumpSum | U.S. Dollar $0.00
LumpSum .S, Dollar $0.00
Lump Sum .S, Dollar 50.00

.c.r

Defauit Data Blocks

View

Expand /
Callapse +
WOOR g
Distrbuon 2P
000 $15,600.92
w0 $,422.7
w0 $36%.3
.00 0.00
w00 $4,790.97
.00 .00
.00 .00
.00 .00

[ Compare Alterate Scenarios

LABOR
Markup %

200
2500
2500
0.00
2500
0.00
0.00

0.00

=

9.4 Selective Pay Item Markup

pewons —

Overwrite Locked Pay Ttems % Bid Wizard

() _/ Reset Rounding Predision
Configure Frice
Categories [ Import DT Pay Item File
Tools
o LABOR Uit Price Total Price
o) Price (aurrent) (current) (current)
$78,002.08 $72,664.87  $10,700.00  $170,700.00
$37,138.% $34,430.26 97,282.00 $97,253.00
$18,131.% $16,940.04 £44,200.00 $44,200.00
<0.00 000 21630000 $216,300.00
505484 3,088.23 $42,300.00 $42,300.00
<0.00 0.00 £39,900.00 £33,200.00
<0.00 .00  §1625,000.00  $1,625000.00
0.00 5000 §5370,340.00  $5,370,940.00
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EXERCISE 9.1 — MANUALLY PRICE PAY ITEMS

To finalize your bid proposal, you will apply final pricing (costs and profit) to your pay items either
manually or using the AutoPrice tool. In this exercise, you will practice entering prices manually for
your pay items. Complete the following steps, using your job.

1. Continue manually pricing items in the Pay Item & Proposal Register.
2. Type 2.75 in the Unit Price (current) column for pay item Excavation.
3. Type 2 in the % Margin field for pay item 4000 — 10” PVC Pipe.

4. Check your variance to see if you need to add or cut your current pricing to hit your
Target Price.

You should end up with similar results

e e o W GO e me
Quantity (current) (current)

+ 1000 1 Mobilization 1,00 1,00 Lump Sum $20,000,00 $20,000,00 -40,04

+ 2000 2 Clearing & Grubbing 10.00 1500 Adge $4,705.04  $47,050.40 5.00

+ 3000 3 Excavation 50,000.,00 40,000.00 CY §2.75  §137,500.00 6.44

+ 4000 4 10" PVC Pipe 1,000,00 1,000,00  LF £22.00 $22,000,00 1.99

Congratulations, you have completed this exercise!
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9.5 BID ADJUSTMENTS

Often you will want to continue adjusting certain pay items and then rebalance to hit the target total.

9.5.1 LOCK PRICE

You can lock down a pay item price and it will not factor in future rebalancing.

STEP BY STEP — LOCK PRICE

1.

2.

Select the Lock Price checkbox on an item's row.

Forecast
Pay Item - — Lock Pay
Description =T ) ) (T/0)
Mumber Price Quantity Quantity
+ 20201583 Lndassified Excavation 50,000,00 50,000.00
+ 5410100 Maobilization W 1.00 1.00
+ 2010102 Clearing & Grubbing 10,00 10.00

After making further adjustments in the next step by step, you will return to the Pay ltem &
Proposal to rebalance.

e You can continue to adjust at previous levels aside from solely in the Pay Item & Proposal
Register

¢ For example, you could make a last-minute adjustment in the PBS or CBS. You can make
adjustments anywhere, but for this example an adjustment will be made in the Direct Cost
Add-On record at the CBS level

STEP BY STEP — MAKE LAST MINUTE BID ADJUSTMENTS

. With your job open, select the Estimate tab.

1
2. Click on Cost Breakdown Structure to open the CBS.
3.
4

Double click on the row header to open the Direct Cost Add-On dependent cost item record.

. Under the Description tab on the left, click in the blank row under the Description column.
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5. Type in a description.

6. Make the adjustment by typing a numeric value in the Cost column of the Materials Cost
category under the Cost Breakdown section on the right.

Cost Breakdown

Cost Category Subject Cost Rate Cost
~ Total £130,759.83 -0.7% (51,000.00)
»  Labar £58,969.83 0.00 £0.00
» | Owned Equipment 568,251.92 0.00 50,00
» Rented Equipment £0.00  0.00 £0.00
»  Supplies £0.00 0.00 50,00
»  Materials $3,276.00 -30...
»  Subcontract g0.00  0.00 20,00
» | Fees §262.08  0.00 £0.00
»  Allowance €0.00  0.00 £0.00
Custom Categoryl 20,00  0.00 3 £0.00
Undefined €000 000 -3 £0.00

» To make a cut, enter a negative value, i.e. -1000

7. Press the Tab key, and your adjustment will be reflected on the left-hand side.

Description Dependency Cost Categorization Allocation

Lrag columns Nere

roup

(=]

Description Curre... F;ran!:faﬂs% g;'
Small Tools LS. Dollar $5,896.98
Safety & Training L5, Dollar £2,945.49

=  Cut L.5. Dollar (£1,000.00)

Finally, return to the Pay Item & Proposal.
On the Actions menu, select Balanced Bid > Hit Target Total.

10. An Auto Price Warning may display, informing you of rounding variances. After reading the
details, click the Close button.
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a Auto Price Warning = x

Variance due to rounding predision

Estimate attempted to hit your Target Price by spreading the total variance amount
across the unlocked pay items in accordance with your selected pricing method.
However, due to the items' rounding precision, a variance still exists,

Initial rounding variance: (%84.43)

Total amount still remaining as a variance after
attempting to spread the initial rounding variance
proportionately inta sach unlocked item: (%0.03)

[] Turn off this warning about rounding variances for ALL JOBS.

TIP: You can minimize variances due to rounding by specifying greater rounding
precision for the unlocked items, and by unlocking items with a quantity of 1.

Undo AutoPricing | Close |

¢ Note on the proposal recap that a variance may still exists because there are limited
number of pay items to spread the rounding error over

¢ Note that the locked item did not adjust, but the other pay items were updated

¢ Note that you can overwrite locked items for spreading your price by checking the
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Overwrite Locked Pay Items option on the Actions menu

_

eld [T Assigned Direct Cost Only Cwverwrite Locked Pay Items

Field ﬂ Balanced Bid - = Custom Auto Price
=1 Unbalanced Bid

ok Auto Price

9.5.2 SUSPEND PAY ITEMS

Like suspending cost items in the CBS Register, you can suspend pay items in the Pay Item & Proposal

Register. Suspending a pay item causes it to no longer contribute quantities and pricing to the
estimate.

This can be helpful when considering alternate items on a bid submission. Should the client decide to
not require a pay item, you can suspend it, causing the pay item and any of its assigned cost items to

no longer contribute any cost or price. It will no longer show up on your bid and no longer contribute
to the overall total price.

You can suspend/unsuspend pay items in one of three ways:

¢ Right click on the pay item and select Toggle Suspended

L ouu uaau u | uu LT LI VL 1YLy JTWE LILT ) RV VPRV RV YRV

B | BB o e ey o

+ 501(a) 1306 10 100 Structural Excavation & Backfill Dpen 00.00  Cubic
+ SoaA) 1322 i1 110 Steel Reinforcement e Hew 00,00 | Pounc
+ 503(a) 1313 12 120 Retaining Wall 0 Delete 50.00  Cubic
+ 600 0300 13 130 Paint Existing Steel Bridge Stry 7\: Cut 100 Lumj
+ 700 14 140 Process Equipment fﬁ Copy. 100 Each

+ 1000 15 150 Removal of Underground Storage T 2 Paste 2, Each

+ 1010 16 160 Disposal of Contaminated Soil f+ FEill Down Cubit
+ 12000100 17 170 Toll Booth &5 Link this field to Excel 1.00 Each
+ 15000100 18 180 Guardrail Type 2 X UnLink from Excel 00.00  Linear
+ 15000200 13 190 Guardrail Type 34 I ',:; Toggle Suspended m Linear
+ 16000230 20 200 Type 4 Signs T,000.00 T Squa
+ N1 1N Realinnment of Water | ine 1.00 1.00  Farh
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e Select the pay item and

Estimate Quote

Actions

9.5 Bid Adjustments

click Toggle Suspended under the Edit section of the Actions Tab

[@] Assigned Direct Cost Only
g Balanced Bid ~

Overwrite Locked P:

== Custom Auto Price

=1 Unbalanced Bid

& Print [Aopen 5<cut Fill Down Lock Prices | & Link Field

'%. Preview e Mew % Copy a Toggle Suspended &4, Unlink Field

EF Export to Excel e Delete % Paste Lock Quantities

Print Edit Workbook
Pay Item & Proposal Register ©
Proposal Recap - Training Job
Current Target Forecast Variance
Price: $6,455,450.00 $6,514,915.53 56,462,850.00 §59,465.53 | ADD
Profit: $592,026.02 $651,491.55 $658,609.04 §7,11749 | QUT
Margin%a: 9.17 10.00 10.19 §13,693.38 |QUT

Drag columns here to group
Pay Item Lock L. Row - Line -
Number Qua... ... Nu... = Mu.. pescipt
+ 6410100 1|10 Mobilization
+ 2010102 2 20 Clearing & Grubbing
+ 2020183 3|30 Undassified Excavation
+ 3035912 4 40 Agaregate Base
+ 3034263 5 50 Asphalt Concrete Hot Mix Type A
+ 413(B) 0464 6 60 36 Inch RCP Culvert Class IIT
+ 8000220 7 70 10 Inch PVC Force Main (SDR21)
+ 3000330 8 80

B oo [ W m

Auto Price
Pay ?;55351: Unit of
Qua... Quantity Meas...
1.00 1.00 | Lump Sur
10.00 10,00 Acre
50,000.00 50,000.00  Ton
40,000.00 45,000.00 Ton
38,000.00 35,000.00 Ton
1,000.00 1,024.00 LinearF
12,000.00 12,000.00  Linear Fe

24 Inch PVC Gravity Sewer (SDR35) 3,000.00 3,000.00__Linear Fe

[ 4 Foot Diameter Manhole

+  EAAMAY 130A

An

A0

T hral Eurawatinn & BarlAl

ann an QAN AN | Caikie Y

¢ Open the pay item record and checking/unchecking the Suspend box

Pay Item & Proposal Register

Pay Ttem Record @

Pay Item Number:

balll=00 0400

| Line Number:

Description: 4 Foot Diameter Manhole Alternate: | BASE -
Suspend:
Quantity
Lock Quantity:  Pay Quantity: Forecast (T/Q) Qty:  Unit of Measure: Qty Variance: Qty Variance %: Qty Variance Group:
O \ 16.00] | 16.00] | Each - 0.00 0.00  EvenRun
Price
Lock Price: Unit Price Precision: ~ Unit Price: Total Price: Currency: Payment Method: % Margin:
= 1T = 1T p— 1 [p— P | —— |
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LESSON 9 REVIEW

1. Markup is a function of cost, while margin is a function of
a. billing
b. price
C. job overhead

d. indirect costs

2. When adding profit, it must be the same amount for direct and indirect costs.
a. True

b. False

3. What options do you have to enter profit on the PBS?
a. % Mark-Up, % Margin, and Fixed Dollar Amount
b. % Mark-Up or % Margin

C. Fixed Dollar Amount Only

4. Once distributed, you still can adjust your pricing on pay items manually as needed.
a. True

b. False

LESSON 9 SUMMARY

As a result of this lesson, you can:

Add job markup (profit)

Use tools on the PBS form to review your estimate

Spread Target Price over pay items

Make bid adjustments
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